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OPCODE DISCLAIMER

OPCODE SYSTEMS, INC. (“OPCODE”) 
MAKES NO WARRANTIES, EXPRESS OR 
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MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING THE 
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USE OR THE RESULTS OF THE USE OF 
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ITY, CURRENTNESS OR OTHERWISE. THE 
ENTIRE RISK AS TO THE RESULTS AND 
PERFORMANCE OF THE OPCODE SOFT-
WARE IS ASSUMED BY YOU. THE 
EXCLUSION OF IMPLIED WARRANTIES IS 
NOT PERMITTED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO 
YOU.

IN NO EVENT WILL OPCODE, ITS DIREC-
TORS, OFFICERS, EMPLOYEES OR 
AGENTS BE LIABLE TO YOU FOR ANY 
CONSEQUENTIAL, INCIDENTAL OR INDI-
RECT DAMAGES (INCLUDING DAMAGES 
FOR LOSS OF BUSINESS PROFITS, BUSI-
NESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING 
OUT OF THE USE OR INABILITY TO USE 
THE OPCODE SOFTWARE EVEN IF 
OPCODE HAS BEEN ADVISED OF THE 
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CHAPTER 1: Introduction to the MIDI 
Reference Manual
WELCOME TO VISION

Congratulations on your purchase of 
Opcode’s Vision—a powerful and intuitive 
sequencer for both MIDI and digital 
audio. With it, you can record and arrange 
music using your computer, MIDI instru-
ments, and digital audio hardware.

Vision offers a wide range of capabilities 
for editing and mixing your music. You 
can even preview and print songs using 
standard music notation.

This MIDI Reference Manual should be 
your starting point for learning about how 
to use Vision. In addition, it contains tuto-
rial and reference material for all of 
Vision’s MIDI features.

Digital audio topics, on the other hand, 
are covered in the Audio Reference Man-
ual, which should be read after reading 
this manual.

IMPORTANT: The MIDI and Audio Refer-
ence Manuals are identical for both Vision 
and Studio Vision Pro. For the sake of con-
sistency, however, both manuals refer to the 
discussed application as “Vision” (except, of 
course, when referring to topics and fea-
tures specific to Studio Vision).
Vision & Studio Vision Pro — MIDI Reference M
Installation and System 
Requirements

The Vision Quick Start card is your guide 
to configuring your computer for Vision. 
If you haven’t already, please read it. It 
contains:

• Detailed system requirements;
• Installation and configuration steps 

for Vision and OMS;
• Answers to frequently asked 

questions.

Registering your Software

If you are a new user, please complete and 
return your registration card right away. 
Doing so will enable Opcode to deliver 
the best possible support to you; it also 
ensures you’ll receive important update/
upgrade notices.

IMPORTANT: Please write down your 
Vision serial number here. The serial 
number is located on your original Master 
Key disk.

S/N _______________________________

Purchase Date ______________________
anual 3



 

PART 1: Introduction

              
Contacting Opcode

Opcode provides a variety of phone, fax, 
and online support options. Consult your 
Technical Support Information booklet on 
how best to contact Opcode.

HOW TO USE THIS MANUAL

If you are reading this manual, we have 
assumed the following:

• You have a basic understanding of 
the Macintosh and its operating 
system;

• Your music hardware is properly con-
nected and configured;

• You have already successfully 
installed Vision and the Open Music 
System (OMS);
Consult the Vision Quick Start card 
for installation details.

• You have created an OMS Studio 
Setup with the OMS Setup 
application;
Vision uses OMS to communicate 
with MIDI devices. Those unfamiliar 
with OMS should read the OMS 
Manual.
4

Manual Organization

This book is divided into the following 
seven parts:

• Part 1: Introduction is what you’re 
reading right now. It details the 
layout of the manual, MIDI funda-
mentals, and some Vision basics.

• Part 2: Recording has chapters on 
recording in real time, step time, and 
also inserting notes with the pencil 
and magic drumstick.

• Part 3: Playback & Editing covers 
basic track and sequence controls, 
transposing and quantizing, and 
mixing and arranging. 

• Part 4: Advanced Concepts contains 
chapters on some of the more excit-
ing features in Vision like segments, 
generated sequences, and the Players 
& Queue Window.

• Part 5: Customizing Vision explains 
how to save configuration settings, 
store and recall various templates, 
create custom Instruments, and cus-
tomize key commands and 
MIDIKeys.

• Part 6: Windows is a reference section 
that details every button, command 
and option in each of Vision’s 
windows.

• Part 7: Menus is a reference section 
that details all of Vision’s menu 
commands.

NOTE: Although digital audio features 
may be mentioned from time to time in this 
manual, they are not covered in depth. For 
complete information about digital audio, 
consult the Audio Reference Manual.
Opcode Systems, Inc.
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MANUAL CONVENTIONS 

The Vision manuals use a number of con-
ventions that make it easier to discuss and 
understand the program.

Mouse Actions

The following terms are used to describe 
various mouse actions:

• Click: When the manual instructs 
you to click, position the mouse 
where you’re told and press once on 
the mouse button, then immediately 
release it.

• Double-click: When the manual 
instructs you to double-click, position 
the mouse where you’re told and rap-
idly press and release the mouse 
button twice.

• Press and hold: When the manual 
instructs you to press and hold, posi-
tion the mouse where you’re told, 
press the mouse button and hold it 
down until instructed to release it.

• Release: When the manual instructs 
you to release, let up on the mouse 
button (which you were probably 
holding down because of an earlier 
press and hold instruction).

• Drag: When the manual instructs you 
to drag, position the mouse where 
you’re told, then press the mouse 
button and hold it down as you move 
the mouse.

• Move: When the manual instructs 
you to move the mouse, simply move 
it to another location on the screen 
without pressing its button.
Vision & Studio Vision Pro — MIDI Reference M
Choose vs. Select

The words “choose” and “select” are often 
interchangeable in conversational 
english. In this manual, however, there is 
a distinction between the two terms.

• Select: When the manual tells you to 
select something, it stays selected. 
This is the case with menu options 
that turn something on/off.

• Choose: When the manual tells you 
to choose something, a one-time 
action is performed. This is the case 
with most commands; they perform 
their chosen action only once.

Menu Items

This manual uses a shorthand technique 
to invoke various menu items. For 
instance, this manual might say:

“Select Audio>Waveform 
Display>Fast.”

What this means in plain English is 
“select the Fast option from the Audio 
menu’s Waveform Display submenu.” 
Although the shorthand technique results 
in sub-standard grammar, it’s easier to 
read and decipher than a complete sen-
tence because it displays the menu’s 
hierarchical structure plainly and simply.

Figure 1.1: Shorthand Invocation of Menu Items
anual 5
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CHAPTER 2: About MIDI
Before we start talking about Vision and 
its capabilities, we will first touch briefly 
on some MIDI fundamentals. Those 
already familiar with these topics can skip 
ahead to Chapter 3: Vision Basics.

In addition to MIDI, Vision can of course 
record digital audio. For a discussion of 
digital audio basics, see your Audio Refer-
ence Manual.

WHAT IS MIDI?

MIDI (an acronym for Musical Instru-
ment Digital Interface) is a 
communication protocol for musical 
instruments. This industry standard 
enables connections between a variety of 
devices from different manufactures. 
MIDI compatible equipment includes syn-
thesizers, sound modules, drum 
machines, patch bays, effects processors, 
MIDI interfaces, and sequencers.

MIDI devices are equipped with 5-pin 
DIN connectors, labeled as either IN, 
OUT, or THRU.

Figure 2.1: MIDI connectors
Vision & Studio Vision Pro — MIDI Reference M
The MIDI OUT port transmits messages; 
the MIDI IN port receives messages; and, 
MIDI THRU echoes whatever is received 
from the IN port. MIDI devices are con-
nected via “MIDI cables,” readily 
available at most music stores.

Figure 2.2: MIDI signal flow

NOTE: Not all devices will have all three 
MIDI ports (IN, OUT and THRU).

A single MIDI cable can transmit a sepa-
rate set of messages for each of 16 
channels. These 16 channels correspond 
to separate MIDI devices or to multiple 
channels within a single device (if the 
device is multi-timbral). Fundamentally, 
each channel represents a discreet instru-
ment sound; for instance, bass on 
channel 1, piano on channel 2 and drums 
on channel 10. Similar to a multitrack tape 
recorder, a MIDI sequencer can therefore 
record complex arrangements—even 
using a single multi-timbral keyboard.

echoed from IN
anual 7
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MIDI Terminology

Basic MIDI terminology is used through-
out this manual. If necessary, take a 
moment to familiarize yourself with the 
following terms:

• MIDI Interface: Hardware that 
allows computers to connect to and 
communicate with MIDI devices. 

• MIDI Device: Any keyboard, sound 
module, effects device or other equip-
ment that can send or receive MIDI 
information.

• MIDI Controller: Any MIDI device 
that transmits MIDI performance 
data. These include keyboards, MIDI 
guitar controllers, MIDI wind instru-
ments, and others. Controllers 
transmit MIDI via their MIDI OUT 
ports.

• MIDI Sound Source: Any MIDI 
instrument that plays back in your 
arrangements. Sound sources receive 
MIDI from their MIDI IN ports.

• Multi-timbral: The capability of play-
ing several different instrument 
sounds (i.e. piano, bass, and drums) 
simultaneously on separate channels. 
This makes it possible for a single 
MIDI sound source to play back 
entire arrangements.

• MIDI Channel: Up to 16 channels of 
MIDI performance data can be trans-
mitted on a single MIDI cable. The 
channel number separates the differ-
ent messages so your sound sources 
can receive the right ones.
8

• Program Change Event: A MIDI 
command that tells a sound source 
which sound patch to use. The MIDI 
protocol lets you choose from a range 
of 128 patches.

• Bank Select Message: A MIDI com-
mand that specifies the bank of 
patches from which to choose. Many 
devices have more than 128 patches 
and Bank Select messages provide a 
means of accessing them.

• Local Control: A controller setting 
found on most MIDI keyboards that 
allows it to play its own sound source. 
Disabling “local control” ensures that 
a device’s internal sound source is 
only played via external MIDI 
messages.
When using Vision, “local control” 
should be disabled. When “local con-
trol” is off, your keyboard still 
transmits data to its MIDI OUT port.

• Continuous Controller Events: 
MIDI instructions that allow real-time 
changes to notes that are currently 
sounding. These include pitch bend, 
modulation, volume, pan, and many 
others.

• System Exclusive Data: MIDI data 
commonly used for sending and 
retrieving patch parameter informa-
tion for storage purposes.
Opcode Systems, Inc.



CHAPTER 2: About MIDI
Common Misconceptions about 
MIDI

It is important to understand that MIDI is 
not audio. The messages that travel down 
a MIDI cable are only numbers that trans-
late to specific instructions. For instance, 
when you strike a key on your MIDI key-
board it sends a message to its MIDI OUT 
port telling another device (if connected 
and set to the same MIDI channel) to play 
that particular note.

Figure 2.3: Signal paths for MIDI instruments

However, in order to actually hear that 
second device (sound source) you’ll need 
to connect its audio outputs to a sound 
system. Your MIDI instruments therefore 
have two signal paths, one for audio and 
another for MIDI.

Another point to note is that MIDI does 
not allow you to use your devices beyond 
their capabilities; instruments have their 
own sound generation, polyphony, and 
multi-timbral limitations.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 3: Vision Basics
THE OPEN MUSIC SYSTEM 
(OMS)

To use Vision you must first install and 
configure the Open Music System 
(OMS). OMS, which is included with 
your Vision package, has the following 
capabilities:

• OMS keeps track of which MIDI 
devices you are using, how they are 
connected, and which patches 
(sounds) they are using;

• OMS makes it easy for music soft-
ware to communicate with your MIDI 
hardware;

• OMS provides timing services and 
inter-application communication.

OMS stores a description of your MIDI 
studio in Studio Setup documents, which 
are created and edited in the OMS Setup 
application. Once OMS is configured, 
using Vision is quite seamless. Any 
devices contained in your Studio Setup 
are automatically available as Vision 
Instruments. If at some point you make 
changes in your current Studio Setup, 
Vision, and any other OMS applications, 
are updated.
Vision & Studio Vision Pro — MIDI Reference M
It’s very important that you have a clear 
understanding of OMS before attempting 
to use Vision. If you are new to Vision, 
and OMS, please read the OMS Manual 
included with your Vision package.

TRACKS

The most basic building block in Vision is 
a track. In addition to digital audio, tracks 
can record and play back a variety of 
MIDI data such as notes, aftertouch, pitch 
bend, modulation wheel, continuous con-
troller events, patch changes, and system 
exclusive information.

Each of Vision’s 99 tracks (per sequence) 
has its own track length and may be inde-
pendently looped. Track’s are viewed and 
edited in Vision’s five edit windows: 
Tracks, Pulse, Graphic, Notation and List 
(see page 14).

Drum Tracks

Drum tracks are specially defined Vision 
tracks that are edited in the Pulse Win-
dow. A drum track is comprised of 
individual note lines that correspond to 
particular notes or drum sounds (i.e. bass 
drum, snare, hihat).
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PART 1: Introduction
Sequences Window

Tracks Window

OMS Studio Setup

Name Manager Window

Instruments Window

Current Patch pop-up
Tracks Window with chained Sequences
Instruments

Tracks are assigned to and play back via 
MIDI and Audio Instruments. Vision’s 
MIDI Instruments are automatically cre-
ated from the current OMS Studio Setup. 
Audio Instruments, on the other hand, are 
based on your digital audio hardware.

NOTE: Tracks can contain data assigned 
to more than one Instrument. These tracks 
are referred to as “Multi” tracks.

NOTE: For drum tracks, each of its note 
lines can be assigned to a different MIDI 
Instrument.
12
Patch Names

An Instrument’s current patch determines 
the type of sound it plays. Using OMS 
Name Manager, Instruments can be sub-
scribed to Patch Name documents; this 
lets you view and select patches, notes, 
and controllers by name instead of 
number. 

You can get names from the Factory 
Names files included with OMS, Galaxy 
Bundles, or you can create your own 
custom (typed-in) Patch Name docu-
ments (see Chapter 33: The Names 
Window).
Opcode Systems, Inc.



CHAPTER 3: Vision Basics
SEQUENCES

Vision records tracks into sequences, 
each of which can be thought of as a song, 
song section, or music layer. A Vision file 
can contain hundreds of sequences (lim-
ited only by the amount of RAM you 
have). Each sequence has its own name, 
length, meter, key, and tempo. Sequences 
can be triggered in real time from your 
computer keyboard or from a MIDI 
controller.

Arranging Sequences

Sequences can be chained together and 
layered to create song structures. 
Sequences are called from other (parent) 
sequences with sequence events. Sequence 
events describe how to play the refer-
enced sequence from the parent 
sequence.

Segments and Loops

Tracks or portions of tracks can be made 
into segments, which are very similar to 
sequences. Segments provide a great way 
to turn existing track material into modu-
lar components that can be played from 
other sequences. 

With segments you can loop any region of 
a track, and these regions can loop inde-
pendently of the track’s loop setting—
thereby creating a “nested loop.”
Vision & Studio Vision Pro — MIDI Reference M
THE CONTROL BAR

Figure 3.1: Control Bar

Vision’s Control Bar acts as the control 
center for a host of commonly used func-
tions. This section will briefly acquaint 
you with some of the more important Con-
trol Bar items.

For a complete and thorough explanation 
of the Control Bar, see Chapter 23: The 
Control Bar.

The Control Bar has traditional transport 
controls for play, stop, record, pause, fast-
forward and rewind. In addition, there are 
8 locator buttons for storing frequently 
accessed Counter locations.

Figure 3.2: Transport Controls

Shuttle Bar
Previous 
Rewind to

Record

Play from Start
Stop

Play from Counter

Pause

Marker

Fast Forward
to Next Marker

8 Locator 
Buttons
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PART 1: Introduction
The Counter provides feedback for the 
measure and SMPTE location of the cur-
rent sequence. You can click in the 
Counter and type in a precise location to 
automatically locate there.

Figure 3.3: Counter in Control Bar

The left portion of the Control Bar (see 
Figure 3.4) contains a number of pop-ups 
related to where and how information is 
recorded. The Record Mode specifies 
whether Vision replaces or overdubs 
material, and whether recording is done 
in real time or step time. The Current 
Sequence and Current Track pop-ups 
determine where the data is recorded; 
and the Thru Instrument and Current 
Patch indicate the assigned Instrument 
and patch.

Figure 3.4: Control Bar pop-ups

In addition to acting as graphic labels, the 
buttons located to the left of the pop-ups 
in Figure 3.4 open an appropriate window 
when clicked. These buttons open the 
Record Monitor ( ), Tracks Window 
( ), Graphic Window ( ), Instru-
ments Window ( ), and Names 
Window ( ).

Record Mode

Current Sequence

Current Track

Thru Instrument

Current Patch
14
The Punch and Loop controls in 
Figure 3.5 determine the range of mea-
sures used when either punch or loop 
recording.

Figure 3.5: Punch and Loop controls in Control Bar

Click on the Control Bar’s window but-
tons to open or activate the corresponding 
window.

Figure 3.6: Window Buttons in Control Bar

THE EDIT WINDOWS

Vision has five edit windows, each of 
which has special capabilities suited for 
certain tasks. This section briefly touches 
on each of these windows.

For a complete and thorough description 
of Vision’s edit windows, consult the chap-
ters in Part 6: Windows.

Out Point

In Point

Loop togglePunch toggle
(enabled)

Sequences
Tracks

Pulse
List

Graphic
Notation
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CHAPTER 3: Vision Basics
The Tracks Window lists all tracks in a 
given sequence. In addition to having a 
variety of sequence and track controls, 
the Tracks Window also contains a “Track 
Overview” area for displaying individual 
track data.

Figure 3.7: Tracks Window

The Track Overview offers good visual 
feedback on the overall shape of music 
contained in a sequence. Use this edit 
area to easily move around blocks of mea-
sures and phrases.

The Pulse Window has a rhythmic-
based “Note Grid” display for viewing and 
editing a sequence’s drum tracks.

Figure 3.8: Pulse Window

In the Pulse Window, drum patterns are 
constructed by inserting and deleting 
notes with the Magic Drumstick tool.
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The Graphic Window shows notes from 
a single track using a “Piano Roll” style of 
display.

Figure 3.9: Tracks Window

Notes are inserted in the Graphic Window 
with the Pencil tool. Notes can also be 
dragged to a new pitch or location, and 
even made longer or shorter.

The List Window displays all data con-
tained in a single track using text and 
numbers. This window is great for precise 
editing over each MIDI event. The List 
Window displays every event contained 
within a track.

Figure 3.10: List Window

List Windows are also used to display and 
edit Meter and Tempo tracks.
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PART 1: Introduction
The Notation Window displays and edits 
multiple tracks with standard musical 
notation. From this window you can open 
the Print Preview Window, where tracks 
are prepared for printout.

Figure 3.11: Notation Window

The Strip Chart

Each of the graphic based edit windows 
(Tracks, Pulse, Graphic and Notation) has 
an option called the Strip Chart. The Strip 
Chart, which is very similar to a “bar 
graph” display, works with data that is in 
most cases not related to notes.

Figure 3.12: Strip Chart
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Use the Strip Chart to insert and edit the 
following data types:

• Continuous events such as control-
lers, pitch bend, after touch, and 
tempo;

• System exclusive information;
• Patch change events;
• Note velocities and durations (edit 

only);
• Various forms of text.

VISION ON-SCREEN HELP

A useful tool for quickly learning about a 
feature in Vision is its online, context sen-
sitive help. Just hold down the Command, 
Shift and Option keys and click on any 
field, button, icon or menu item for pop-up 
help on that item.

NOTE: Additional help items are available 
from Vision’s Help menu.

For instance, to get help on Vision’s Begin 
Record toggle:

a Hold down the Command, Shift 
and Option keys.

The help cursor appears
Opcode Systems, Inc.



CHAPTER 3: Vision Basics
b Position the cursor over the 
Begin Record toggle and press 
and hold.

A pop-up help screen for the Begin 
Record toggle appears.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 4: Navigating in Vision
This chapter discusses user-interface 
capabilities unique to Vision. Like most 
Macintosh applications, Vision’s windows 
contain scroll bars to navigate through 
data, and fields into which you can type 
new values. However, Vision also offers a 
number of flexible ways to navigate its 
various windows, select and organize data 
types (like sequences, tracks, and Instru-
ments), and enter new values into edit 
fields.

Since these user-interface techniques are 
referred to frequently throughout this 
manual, you should familiarize yourself 
with them now.

NAVIGATING WINDOWS, 
SEQUENCES, AND TRACKS

Sequence and Track Select 
Pop-ups

When using Vision, you’ll often want to 
switch to working with another sequence 
or track. Rather than opening a new edit 
window each time, you can use the 
Sequence and Track Select pop-ups to 
easily switch the current sequence or 
track. These pop-ups are accessed by 
Option-clicking on the title bar of the 
desired edit window.
Vision & Studio Vision Pro — MIDI Reference M
Switching the Current Sequence

To switch the current sequence from the 
Tracks or Pulse Window:

a Hold down the Option key and click in 
the title bar of the Tracks Window.

The Sequence Select pop-up appears.

b Highlight the desired sequence and 
release the mouse.

A Tracks Window for the selected 
sequence replaces the previous one.
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PART 1: Introduction
NOTE: When switching the current 
sequence with the Sequence Select pop-up, 
the newly opened Tracks or Pulse Window 
uses the display properties (window size, 
location, zoom value, etc.) stored with that 
sequence.

Switching the Current Track

The Track Select pop-up in the Graphic 
and List Windows works in similar fash-
ion as the Sequence Select pop-up—only 
it switches the current track, rather than 
the current sequence.

NOTE: Unlike the Sequence Select pop-up, 
the Graphic and List Windows retain their 
display properties when selecting a track 
from the Track Select pop-up.

Figure 4.1: Option-click the title bar of the Graphic 
and List Windows to switch the current track
20
To add a new track from the Graphic and 
List Windows, choose New Track from 
the Track Select pop-up.

Figure 4.2: Specifying a “New Track” from the 
Track Select pop-up in the Graphic Window

In the List Window, you can also use this 
pop-up to switch to the Meter or Tempo 
tracks.

Figure 4.3: Using the Track Select pop-up to 
switch to the Tempo track in the List Window
Opcode Systems, Inc.



CHAPTER 4: Navigating in Vision
Showing and Hiding Tracks in the 
Notation Window

The Track Select pop-up works a little dif-
ferently in the Notation Window. 
Although it’s invoked in the same way, it 
instead adds or hides tracks to the dis-
play—as opposed to merely changing the 
current track.

Figure 4.4: Option-click the title bar of the 
Notation Window to show and hide tracks

Currently displayed tracks are shown as 
checked in the Track Select pop-up. To 
hide a displayed track, select it from the 
pop-up. When just one track is displayed, 
it appears as grayed out—you cannot 
have a Notation Window with no tracks.
Vision & Studio Vision Pro — MIDI Reference M
To change the order of tracks in the Nota-
tion Window, rearrange them in the 
Tracks Window (see The Move Cursor 
(pg. 22)).

Open Windows Pop-up

The Open Windows pop-up lists all cur-
rently open windows. Choose any window 
title from this pop-up to bring that window 
to the front. The Open Windows pop-up is 
available at any time, anywhere in Vision:

a Hold down the Command and Option 
keys and click in any Vision Window.

The Open Windows pop-up appears.

b Highlight the desired window title and 
release the mouse.

The specified window becomes acti-
vated and moves to the front.
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PART 1: Introduction
SELECTOR DOTS AND MOVE 
CURSOR

Items in the Sequences, Tracks, Pulse, 
and Instruments Windows are high-
lighted with selector dots, and moved with 
the move cursor.

Selector Dots

When you need to select a sequence, 
track, drum note line, or Instrument, click 
on its selector dot in the left column of the 
window. A selected dot changes into a tri-
angle and the item becomes highlighted.

Figure 4.5: Selected tracks in Tracks Window

• To select multiple items, Command 
or Shift-click each selector dot—or 
drag over multiple selector dots. 

• To de-select a selected item, either 
select a different item, or Command 
or Shift-click the selected triangle.

• Double-click a selector dot in the 
Sequences Window to open a Tracks 
Window for that Sequence. 
Double-click a selector dot in the 
Tracks Window to open an edit 
window for that track.

Selector dots
Selected tracks
22
The Move Cursor

When placed to the left of the selector 
dots, the cursor changes to a move cursor 
( ). When the move cursor appears, click 
and drag up or down to move the item to a 
new location.

Figure 4.6: Dragging a sequence in the Sequences 
Window

Repositioning items does not change your 
MIDI information—it only changes the 
position of your tracks, sequences or 
Instruments in their respective windows.

NOTE: Changing the position of tracks in 
the Tracks Window also changes their rela-
tive positions in the Notation and Print 
Preview Windows.

If more than one item is selected, you can 
drag them all to the new location while 
keeping their relative order.

Figure 4.7: Dragging multiple Instruments
Opcode Systems, Inc.



CHAPTER 4: Navigating in Vision
MOVING AND RESIZING 
COLUMNS

Columns in the Sequences, Tracks, and 
Pulse Windows can be re-ordered and 
resized. This allows you to rearrange 
these columns as desired, using window 
and screen space more efficiently.

For instance, to resize the Instrument 
column in the Tracks Window:

a Place the cursor in the column head 
near the line separating Instrument 
and Patch.

The cursor turns into the resize cursor.

b Click the mouse and drag to the left.

An outline of the Instrument columnÕs 
right side appears and moves left with 
the cursor.

Figure 4.8: Resizing the Instrument column

c When the Instrument column reaches 
the desired size, release the mouse.

The Instrument column is resized to the 
new size and the columns to its right are 
adjusted accordingly.

Figure 4.9: Instrument column, resized
Vision & Studio Vision Pro — MIDI Reference M
To move the Key column in the 
Sequences Window:

a In the Sequences Window, Option-
click at the top of the Key column and 
drag to the left.

An outline of the Key column appears 
and moves to the left with the cursor.

Figure 4.10: Dragging a column in the 
Sequences Window

b When the space to the right of the 
MIDI column becomes highlighted, 
release the button.

The Key column moves to the new loca-
tion and the MIDI column moves to the 
left to accommodate it.

Figure 4.11: Key column moved to a new 
position in Sequences Window
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PART 1: Introduction
ZOOMING, SCROLLING, AND 
SCRUBBING

Zooming

“Zooming” lets you view your music in dif-
ferent sizes. At small sizes, you can fit 
more music in an edit window. At large 
sizes, you can view your data in greater 
detail.

Depending on the particular zoom tool, 
you can zoom horizontally, vertically, or a 
combination of the two. Zooming out hori-
zontally lets you see more bars; zooming 
out vertically lets you see more of the 
MIDI pitch range.

Zoom tools in Vision include the horizon-
tal and vertical Zoom Buttons, located 
near the window scroll bars, and the 
Zoom to Fit button, located in the top of 
each edit window. You can also Option-
click with the mouse for various zooming 
functions. Each of these is explained in 
the following sections.

NOTE: In addition to the zoom tools, the 
edit window menus have commands for 
Zoom Back (which recalls the previous 
zoom level) and Zoom to Fit (which views 
the entire contents of the edit window).
24
Zoom Buttons

• Click the Zoom In buttons (hori-
zontal or vertical) to zoom in 
incrementally. Use Option-click to 
zoom all the way in, Shift-click to fit 
the current selection.

• Click the Zoom Out buttons 
(horizontal or vertical) to zoom out 
incrementally. Use Option-click to 
view the window’s entire contents, 
Shift-click to fit the current selection.

Zoom to Fit Button

Figure 4.12: Zooming to fit in Tacks Window

• Click the Zoom to Fit button to 
fit the current selection in the active 
edit window. Option-click this button 
to view the entire track’s contents (or, 
in the case of the Tracks or Pulse 
Window, the entire sequence).

Zoom In Horizontal

Zoom Out Vertical
Zoom In Vertical

Zoom Out Horizontal
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CHAPTER 4: Navigating in Vision
Zooming with the Mouse

Figure 4.13: Option-dragging a selection

• Option-click with the mouse to 
zoom out incrementally, or Option-
drag around a selection to view it in 
more detail.
Option-click in the ruler to zoom out 
horizontally, or Option-drag a section 
of the ruler to zoom into a range of 
measures.

Figure 4.14: Zooming in the ruler and margin

Option-click in the left-margin to 
zoom out vertically, or Option-drag a 
section in the left margin to zoom a 
range of notes. 
Vision & Studio Vision Pro — MIDI Reference M
Hand Scrolling

In the Graphic and Notation windows, you 
can change which part of the window is 
displayed by Shift-Option-dragging. This 
is helpful when you want to center a selec-
tion for better viewing. 

To scroll with the hand cursor:

a In the Graphic or Notation Window, 
position the cursor over the desired 
display area and hold down the Shift 
and Option keys.

The hand cursor appears.

b Click and drag the windowÕs contents 
to the desired position, then release 
the mouse.

Figure 4.15: Scrolling with the hand cursor
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Auditioning with the Scrub 
Command

In the Tracks, Pulse, Graphic, and Nota-
tion Windows, you can Command-drag 
over a selection to audition it. This is com-
monly referred to as “scrubbing.”

To scrub a range of music:

a Position the cursor in the edit area of 
one of the edit windows and hold 
down the Command key.

The scrub cursor appears.

b Click and drag the mouse (forward or 
backward) over the desired music.

A vertical line appears, indicating which 
notes are auditioned.

Figure 4.16: Scrubbing with the mouse

Vision plays the data as the mouse 
ÒscrubsÓ over the notes. To play more 
slowly or quickly, vary the speed of the 
mouse movements.
26
USING WINDOW MENUS

In addition to the menus accessed in the 
menu bar at the top of the screen, Vision 
also uses specialized window based 
menus. These menus are accessed by 
clicking the small triangle located in the 
left side of the title bar (see Figure 4.17). 

Figure 4.17: Menu in Sequences Window

The first item in the Do menu always lets 
you access the window menu for the 
active window. For example, when the 
Sequences Window is active, choose 
Do>Sequences Window> for a sub-
menu of the commands located in the 
Sequences Window menu.

Figure 4.18: Sequence Window commands 
accessed from the Do menu

For more information on the Do menu, 
see Chapter 43: The Do Menu.
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EDITING DIFFERENT FIELD 
TYPES

There are a number of different field 
types in Vision, each of which is edited 
differently. The track fields in the Tracks 
Window (see Figure 4.19) are a good 
example of this.

Figure 4.19: Track fields in Tracks Window

The track name column is a text field. To 
edit text fields, simply click in them and 
type.

Figure 4.20: Track name column in Tracks Window

The track length field is an example of a 
numerical field. Like a text field, it too 
can be edited by typing a new value. But 
numerical fields can also be changed by 
clicking and dragging up or down with 
the mouse; or to increment the value in 
single steps, you can click just once when 
the cursor changes to an up or down 
arrow; the “+” and “-” keys also work to 
increment and decrement the value.

Figure 4.21: Track Length column in Tracks 
Window

Text field
Numerical field

Pop-up menus
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The track Instrument field is changed by 
choosing from a pop-up menu of 
choices. Click in the field and hold down 
the mouse for the menu to appear, then 
highlight the desired item and release the 
mouse. You can also use the “+” and “-” 
keys to scroll through choices in the pop-
up menu, or you can type a number corre-
sponding to a particular Instrument.

Figure 4.22: Instrument column in Tracks Window

NOTE: A shortcut for using the pop-up 
menu in the Patch column is to click in the 
field and then type the first few letters of the 
actual patch name (followed by Enter).

Changing Values with a MIDI 
Controller

In some cases you can highlight a MIDI 
value (such as a MIDI note or velocity val-
ues) and use your MIDI keyboard to 
enter a new value. This works well, for 
instance, for editing values in the List 
Window, defining MIDI events in the 
MIDIKeys Window, or when configuring 
the notes for the Metronome Sound.

Figure 4.23: Metronome Sound settings 
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To adjust the Velocity setting for the Met-
ronome Sound, simply click in the field 
with the mouse and play a note on your 
MIDI controller. The field is automatically 
updated with the velocity played.

Editing Fields for Bar/Beat/Unit 
and SMPTE

Some fields in Vision require that you 
specify a location in either bar/beat/unit 
or SMPTE values. You can automatically 
enter a value in these fields based on a 
marker location.

NOTE: Markers, which reside in a 
sequence’s Meter track, are stored locations 
that can be recalled by name.

The following example shows how to 
define the Out Point using a marker 
location:

a Option-click the Out Point field.

A pop-up menu of marker locations 
appears.
28
b Select the desired marker and release 
the mouse.

The location for the selected marker is 
automatically entered into the Out Point 
field.

Typing into the Time Fields

Depending on the configuration in the 
Settings Window (see Clear Beat/Unit 
when Entering Bar (pg. 333)), typing into 
a field for bar, beat, hours, minutes, or 
seconds clears all fields to the right. See 
Figure 4.24.

Figure 4.24: Typing a new value in a time field on 
the left, clears all fields to the right

To avoid this, uncheck the option for 
Clear Beat/Unit when Entering Bar in 
the Settings Window. You can then type 
into any of the time fields and the others 
to the right remain unaffected.

Typing a new value into this field...

...clears fields to the right
Opcode Systems, Inc.



1

Recording 22

3

4

5

6

7

8

Vision & Studio Vision Pro — MIDI Reference Manual 29



PART 2: Recording
30
 Opcode Systems, Inc.



CHAPTER 5: Real-Time Recording
Although this chapter focuses primarily 
on recording MIDI data in real time, it 
also covers basic recording topics rele-
vant to recording in step time. Therefore, 
please read this chapter completely 
before moving on to Chapter 6: Inserting 
and Step Recording Notes.

RECORD SETUP

The following sections discuss a number 
of Vision record options you should be 
familiar with before attempting to record 
your tracks.

Record Mode

Vision’s Record Mode determines how 
track material is recorded.

Figure 5.1: Record Mode pop-up
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The four available record modes, chosen 
from the Record Mode pop-up in the Con-
trol Bar, include:

• Replace: Records in real time, replac-
ing existing track data.

• Overdub: Records in real time, 
adding to existing track data.

• Step Replace: Records in step time, 
replacing existing track data.

• Step Overdub: Records in step time, 
adding to existing track data.

KEY EQUIVALENTS: Type Shift-Tab to 
toggle between Real-time and Step record-
ing; use Shift-5 to switch between Replace 
and Overdub.

NOTE: Step recording is a process where 
MIDI events are recorded individually, one 
step at a time. For details, see 
Chapter 6: Inserting and Step Recording 
Notes.

With Replace or Overdub, you can use 
loop recording (see page 35) or punch 
recording (see page 34). You can also use 
punch recording when step recording.
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Begin Record Toggle

The Begin Record toggle, located in the 
Control Bar, specifies how Vision starts 
recording. It’s two options are:

• Wait for Note: Recording begins 
when the first MIDI note is received. 
This method ensures that you begin 
recording when you’re ready to play, 
and that the first note is recorded at 
the precise beginning of the section.

Figure 5.2: Wait for Note

• Countoff: Recording begins after the 
Counter counts the number of bars 
specified in the Countoff field.

Figure 5.3: Countoff with a setting of 2 bars

Metronome Sound and Setup

In order to stay in time with the 
sequence’s tempo setting, you must listen 
to the metronome while recording. This 
ensures that recorded material aligns 
with the bar and beat lines in Vision, 
which is very important for display and 
editing purposes.

To configure the metronome sound, 
choose Options>Metronome Sound. In 
the Metronome Sound dialog, set the met-
ronome to either “Internal Click” or 
“MIDI Note.” When using MIDI Note, 
you can have independent Note, Velocity 
and Duration settings for the accented 
and unaccented beats.
32
Figure 5.4: Metronome Sound dialog

Enable the Click in Record option so the 
click is heard while recording.

Meter and Tempo in Sequence

Although this may seem obvious, you’d 
be surprised how often this detail is over-
looked. Before attempting to record you 
should make sure the sequence’s meter 
and tempo are set appropriately. For infor-
mation on settings these fields, see 
Chapter 25: The Tracks Window.

Figure 5.5: Meter and tempo tracks

If the meter does not match the music 
you’re recording, the accented clicks of 
the metronome won’t line up with what 
you’re playing. In addition, the recorded 
material won’t align with the bars and 
beats in Vision’s edit windows. 

And, to achieve good track recordings 
(with the right feel), it’s always wise to 
record at or around the tempo that will 
eventually be used for the sequence.
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More Miscellaneous Record 
Setup Details

Before moving on to the first recording 
example, there are just a few more details 
worth mentioning:

• Keyboard Thru: Make sure Set-
ups>Keyboard Thru is enabled. It 
routes data from your MIDI control-
ler to the current Thru Instrument, 
thereby allowing you to monitor 
what’s being recorded. See Keyboard 
Thru (pg. 427).

• Input Map Enabled: Unless you’re 
recording or routing multiple MIDI 
channels, make sure Setups>Input 
Map Enabled is not checked. See 
Chapter 34: The Input Map Window.

• Record Quantize Enabled: 
Uncheck this item in the Setups 
menu, unless you want your tracks 
quantized automatically when 
recorded. See Record Quantize 
Enabled (pg. 428).

• Record Filter: If you don’t want cer-
tain types of MIDI events recorded, 
choose Setups>Record Filter to open 
this dialog—it specifies which MIDI 
events are recorded and which are 
ignored. See Record Filter (pg. 429).

• Enable Input Devices: Choose Set-
ups>Enable Input Devices to open 
this dialog. Make sure to enable 
(check) any devices from which you 
will record MIDI data. See Enable 
Input Devices (pg. 429).
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RECORDING A TRACK

This section explains how to record a 
track in real time with Replace mode. In 
this example, the track will be recorded 
from the beginning of the sequence with-
out looping. Loop and punch recording 
are discussed later in this chapter, see 
Punch Recording (pg. 34) and Loop 
Recording (pg. 35).

To record a track in real time with 
Replace mode:

a In the Control Bar, select Replace 
from the Record Mode pop-up.

Use Replace to record over existing 
track material (replacing it), or use 
Overdub to add new material without 
replacing existing track contents.

b For this example, disable the Punch 
and Loop toggles in the Control Bar.

Figure 5.6: Punch and Loop toggles off

c In the Control Bar, set the Begin 
Record toggle to Wait for Note.

This ensures youÕll begin recording pre-
cisely on bar 1, beat 1.

d Configure the Metronome Sound and 
set it to Click in Record.

See Metronome Sound and Setup 
(pg. 32) for details.
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e Record-enable a track from the 
Tracks Window.

To do this, click in the Record column for 
the desired track.

f Make sure Setups>Keyboard Thru 
is checked.

g In the Control BarÕs Thru Instrument 
pop-up, select the desired Instrument

Play a few notes on your MIDI controller 
to verify data is routed to the selected 
Instrument.

h Click the Record button in the 
Control Bar, or type the Tab key.

The metronome starts to click and the 
Record button flashes. If necessary, 
adjust the SequenceÕs Tempo setting.

i Play some notes on your MIDI 
controller.

Vision enters record mode and the 
counter advances. When done, click the 
Control BarÕs Stop button, or hit Return.

The record track is automatically named 
and assigned to the Thru Instrument. 
Any recorded data appears in the Track 
Overview section of the Tracks Window.
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PUNCH RECORDING

Like on a tape deck, punch recording 
allows you to record only during a speci-
fied time range. Punch recording, often 
called “punching,” can fix an otherwise 
good performance by replacing only the 
bad material.

To enable punching, click the Punch 
toggle in the Control Bar. The punched 
region is defined by the In Point and 
Out Point.

Figure 5.7: Punch enabled

The following example shows how to 
punch in and replace the material in mea-
sure 5:

a In the Control Bar, set the Record 
Mode pop-up to Replace.
This ensures that the previously 
recorded material in measure 5 is 
replaced.

NOTE: Punch recording does function in 
Overdub mode. Use it to overdub mate-
rial in the middle of a track.

b Enable the Punch toggle in the 
Control Bar.

Punch toggle (enabled)

Out Point

In Point
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CHAPTER 5: Real-Time Recording
c Set the In Point to 5¥1¥0 and the Out 
Point to 6¥1¥0.

To set the In/Out Points, click in each 
field and type in the desired location.

d Make sure the Begin Record toggle is 
set to Countoff.

Using Countoff lets you hear the mea-
sures leading up to the In Point, thereby 
allowing for a smooth transition into 
recording the punch.

e Record-enable a track and set the 
Current Thru Instrument.

f Click the Record button to begin 
recording.

The sequence begins playing from the 
Countoff. The Record button flashes 
until the In Point is reached.

g When the sequence nears the In 
Point, begin playing.

It is often helpful to play along during the 
Countoff period. DonÕt worry though, 
material played before the In Point is not 
recorded.

h Click the Stop button when you are 
finished recording.

If you want Vision to automatically stop 
playing at the Out Point, select (check) 
Options>Stop at Punch Out.
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LOOP RECORDING

When loop is enabled, Vision plays contin-
uously from the In Point to the Out Point. 
To enable looping, click the Loop toggle 
in the Control Bar.

Figure 5.8: Loop enabled for bars 3-4

You can record with loop enabled, build-
ing track data by adding more and more 
layers. The Thru Instrument and record 
track can even be changed “on the fly” 
while recording. While recording, mate-
rial is saved by typing the Enter key, or 
discarded by typing the Delete key.

The following example shows how to con-
figure Vision to loop record bars 1-2:

a In the Control Bar, set the Record 
Mode pop-up to either Replace or 
Overdub.

In Replace mode, any data contained in 
the track before recording is erased. 
Anything recorded is not replaced when 
the sequence Òloops around.Ó

b Enable loop mode by clicking the 
Loop toggle in the Control Bar.

Loop toggle

Out Point

In Point

(enabled)
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c Set the In Point to 1¥1¥0 and the Out 
Point to 3¥1¥0.

To set the In/Out Points, click in each 
field and type in the desired location.

d Record-enable a track and set the 
Current Thru Instrument.

e Click the Record button or type the 
Tab key to begin recording.

f Begin playing when ready, you can 
jump in at anytime.

Each time the sequence loops, the previ-
ously recorded material plays.

When the sequence ÒloopsÓ you will hear 
what you just recorded. 

g When satisfied with your 
performance, type the Enter key on 
your computer keyboard to keep the 
material.

Vision continues loop recording.

h To discard recorded material, type the 
Delete key.

Vision erases everything recorded since 
the last time the Enter key was typed.

i To change the record track, select 
from the Current Track pop-up in the 
Control Bar.

You can also type Command-Shift-­ to 
enable recording on the previous track, 
or Command-Shift-¯ to enable record-
ing on the next track.
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j To change Instruments, select from 
the Thru Instrument pop-up in the 
Control Bar.

k Repeat the above steps until you have 
recorded the desired performance. 
When finished recording, click the 
Stop button in the Control Bar.
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CHAPTER 6: Inserting and Step Recording 
Notes
In addition to recording in real time, 
Vision offers a few other ways of getting 
notes into tracks. This chapter discusses 
some of these other methods, which 
include inserting notes with the Pencil in 
the Graphic and Notation Windows, 
inserting notes with the Magic Drumstick 
in the Pulse Window, and step recording.

THE PENCIL TOOL

Use the Pencil tool to insert notes in the 
Graphic and Notation Windows. This 
allows note entry without a MIDI 
controller.

The duration and velocity of inserted 
notes is specified in the Insert Notes sec-
tion of the Settings Window (see 
page 331). You can automatically go to 
these settings by double-clicking the 
Pencil tool from the Graphic and Notation 
Windows.

In the Graphic Window, notes can be 
“drawn” with variable durations by Shift-
dragging in the edit area.
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Before moving on to some tutorials, you 
should first become acquainted with 
Cursor Quantize and Cursor Display— 
toolbar items found in the graphic based 
edit windows.

Cursor Quantize restricts cursor move-
ment to a specific rhythmic value. This 
allows for precise data selection, edit 
operations, and placement of inserted 
notes. To turn on Cursor Quantize, simply 
click on its icon—to turn it off, click it 
again. Choose from the Cursor Quantize 
pop-up to specify the rhythmic value.

The Cursor Display provides feedback for 
the current cursor position. When the 
cursor is moved into an edit area, the 
Cursor Display shows both pitch and loca-
tion. Location can be displayed in bar/
beat/unit or SMPTE (specified in the edit 
window’s menu), or click on the display 
toggle ( ) to show both time formats.

Cursor Quantize on, Cursor Display showing
set to 8th notes pitch and location
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Inserting Notes in the Notation 
Window

Following is an example of entering a 
simple arpeggio of notes in the Notation 
Window:

a Select a track in the Tracks 
Window and choose 
Windows>Notation.

The Notation Window opens.

b Double-click the Pencil tool to 
open the Insert Note section of 
the Settings Window.

Set the Duration pop-up to Indepen-
dent with a value of 8th notes (240 
units). Set the Velocity value to 64.

c Close the Settings Window.

d In the Notation Window, turn on 
Cursor Quantize with a value of 
8th notes.

e Click on the Pencil icon to 
select it.

The cursor changes to a note with a 
length corresponding to the Duration 
value in the Settings Window.
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f Enter a note of C3 on beat 1 of 
bar 1.

If youÕre unsure about the placement, 
watch the Cursor Display. When it reads 
as in Figure 6.1, click the mouse (you 
can drag the note into the correct posi-
tion before releasing the mouse).

Figure 6.1: Cursor Display

The note is entered as in Figure 6.2. The 
remaining portion of the measure is 
automatically filled with rests.

Figure 6.2: Entered Note

g Next enter a note of E3 by 
clicking directly on the rest next 
to the first noteÑthis will 
ensure itÕs correct placement. 

With each new note entered, move the 
cursor to the right so the note is placed 
on the next 8th beat.

Figure 6.3: Entered notes

Continue entering each note until your 
measure looks like Figure 6.3.
Opcode Systems, Inc.



CHAPTER 6: Inserting and Step Recording Notes
Painting Notes in the Graphic 
Window

Notes can also be inserted with the Pencil 
in the Graphic Window. One advantage of 
using this window is that you can Shift-
click and drag to “paint” in notes of any 
duration:

a Select a track in the Tracks 
Window and choose 
Windows>Graphic.

The Graphic Window opens.

b Click the Pencil icon to select it.

The cursor changes to a note with a 
length corresponding to the Duration 
value in the Settings Window.

c Position the note cursor in the 
edit area at the desired pitch 
and location.

If necessary, use the Cursor Display to 
verify the desired note placement.

d Hold down the Shift key and 
click and drag to the right. 
Release the mouse when the 
note is the desired duration.

Figure 6.4: Shift-dragging note durations

Shift-click with Pencil,

drag...

and release mouse.
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When entering notes in this fashion, the 
parameters in the Insert Note section of 
the Settings Window are almost com-
pletely irrelevant, since the duration is 
determined “on the fly.” The only Insert 
Note parameter that is used is the Veloc-
ity setting.

NOTE: The placement and duration of 
Shift-clicked notes is also affected if Cursor 
Quantize is enabled. The entered notes will 
snap to the location and duration as speci-
fied by the Cursor Quantize value pop-up.

Click-Dragging to the Correct 
Pitch and Location

When using the Pencil tool, you can drag 
a note to the correct location and pitch 
even after you’ve clicked (so long as the 
mouse button has not been released). 
This is very useful because you can actu-
ally see the note’s placement within the 
Graphic or Notation Windows:

a From either the Graphic or 
Notation Window, select the 
Pencil tool and move the cursor 
over the edit area.

b Click and hold the mouse button 
while dragging vertically and/or 
horizontally. 

Release the mouse button once the 
desired pitch and location are found.
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If necessary, use Cursor Feedback to 
verify the precise placement of the note.

THE MAGIC DRUMSTICK TOOL

Vision’s Pulse Window provides an intui-
tive environment for creating and editing 
drum tracks (see Chapter 26: The Pulse 
Window). The Magic Drumstick tool is 
used to insert and delete notes in the Note 
Grid area of the Pulse Window.

The Magic Drumstick works as a toggle 
for inserting and deleting notes. Notes are 
entered by clicking in an empty grid 
space. To remove an existing note, simply 
click on it with the Drumstick. 

The Drumstick points in a different direc-
tion depending on its mode of operation 
(inserting or deleting).

Click in empty space
to insert note

Click on an existing note
to delete it
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A series of notes can be entered, or 
removed, by clicking and dragging with 
the Drumstick. The spacing, duration and 
velocity for the entered notes is taken 
from the Insert Note settings in the Set-
tings Window (see page 331).

Figure 6.5: Drag-entering with Magic Drumstick 

Building a Drum Track

Following is a short example of how to 
build a drum track using the Magic 
Drumstick:

a Choose Windows>Pulse.

The Pulse Window opens.

b Choose New Drum Track from 
the menu in the Pulse Window.

A new drum track, containing just one 
note line, is added to the sequence and 
is displayed in the Pulse Window.

c Use the Note and Instrument 
pop-ups to specify the note 
lineÕs drum sound. For this note 
line, use a bass drum sound.

You can view and select notes by name 
if youÕre subscribed to a Patch Names 
document that contains note names.

d Click the Add button to add 
another note line to the drum 
track.
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CHAPTER 6: Inserting and Step Recording Notes
Use the Note and Instrument pop-ups to 
assign a snare sound to the new note 
line.

e Set the Pulse WindowÕs Display 
Mode pop-up to Matrix with a 
value of 16ths.

This specifies the number of grid lines 
and spaces displayed per measure.

f Double-click the Drumstick tool 
to open the Insert Note settings. 

Set the Duration pop-up to Percent of 
Spacing with a value of 100. Set the 
Velocity value to 64.

g Choose a value of 16ths from 
the pop-up next to the 
Drumstick.

This pop-up corresponds to the Spacing 
parameter in the Insert Note section of 
the Settings Window,

h Select the Magic Drumstick tool 
and click in notes on beats 1 
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and 3 for the Òbass drumÓ line; 
then add notes on beats 2 and 4 for 
the ÒsnareÓ line. See Figure 6.6.

Figure 6.6: Drum and snare notes

i Click the Play button in the 
Control Bar to audition the 
track.

If desired, set the drum track to loop for 1 
bar so it plays continuously as you work.

j Click the Add button to add 
another note line to the track. 
Assign this note line to a closed 
hihat sound.

k For these notes we will want 
some control over the 
velocities. Click the Velocity 
toggle for the ÒhihatÓ note line.

The grid display expands for displaying 
velocities on that note line.

l Click in the first grid space with 
the Drumstick and drag to the 
right, moving up and down as 
necessary to vary the velocities.
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Release the mouse button when each of 
the spaces in the first measure is filled 
with a note.

m Click the Velocity toggle to hide 
the velocities for the ÒhihatÓ 
line.

n To add even more variety to the 
hihat notes you could assign 
some of them to a different note 
line (one set to playback with an 
open hihat sound).

Select the Pencil tool, place your cursor 
over the note, drag down, and release 
the mouse button.

Figure 6.7: Dragging a note to a different note 
line

STEP RECORDING

Step recording uses a MIDI controller to 
enter notes individually, one step at a time 
(while ignoring tempo). This allows pre-
cise control over note duration, 
placement, and velocity. Properties and 
spacing for step entered notes are speci-
fied in the Step Window.

Using a MIDI controller to step record 
notes has several advantages over insert-
ing notes with the Pencil or Magic 
Drumstick:
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• The insertion point automatically 
advances after each note is entered;

• Velocity can be entered “As Played,” 
allowing the dynamics to occur more 
naturally;

• Chords can be entered as easily as 
single notes by simply playing a 
chord on the MIDI controller.

Following is an example of step recording 
a simple C major scale:

a In the Control Bar, set the 
Record Mode pop-up to Step 
Replace.

b Record-enable a track and press 
the Record button in the Control 
Bar.

The Step Window opens.

Figure 6.8: Step Window

c Set the Step Spacing to 8th 
notes (240 units).

This value determines how far the 
Counter advances each time a note is 
entered.
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d Configure the Step Duration 
pop-up to Percent of Spacing 
with a value of 100, and set the 
Step Velocity to As Played.

e Play a C major scale on your 
MIDI controller, starting at C3 
(middle-C) and ending at C4.

Each time you play a note, it is recorded 
into the track and the Counter advances.

f When done, press the Stop 
button in the Control Bar, or 
type the Return key.

Step recording also stops when youÕre in 
Punch mode and the Out Point is 
reached, or if you close the Step 
Window.

You can step record most types of MIDI 
data—notes, chords, patch changes, and 
even sequence events. Music appears in 
the edit windows as it is step recorded.

You cannot use step recording to record 
pitch bends, aftertouch, or controller 
information. In addition, you will not hear 
other tracks play when step recording.

For a complete explanation of each com-
ponent in the Step Window, see 
Chapter 36: The Step Window.

Step Recording Tips
• Entering Chords: Step record 

chords by playing the desired notes 
simultaneously; or hold down your 
MIDI controller’s sustain pedal and 
enter the chord’s notes one at a time. 
The Counter doesn’t advance while 
the sustain pedal is held down.
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• Sustaining Individual Notes: To 
record notes that are longer than the 
Duration value in the Step Window, 
simply hold down the notes and 
advance the Counter (by either press-
ing the Spacebar or by playing 
another note). The length of the 
recorded notes is equal to the 
number of steps advanced while hold-
ing down the note.

• Deleting Notes: Type the Delete key 
on your Macintosh keyboard to erase 
previously entered notes. Each time 
you press this key, the last step is 
erased and the Counter moves 
backward.

• Entering Rests: Type the Spacebar 
to advance the Counter without enter-
ing any data. This will effectively 
enter a rest.

• Entering Patch Events: You can 
send a program change from your 
MIDI controller and Vision will 
record a patch change event. Alter-
nately, you could choose from the 
Patch pop-up in the Control Bar to 
record the patch change event. See 
Current Patch (pg. 186) for details.
NOTE: The Counter does not advance 
when patch change events are 
recorded.

• Sequence Events: Type a 
sequence’s key equivalent to step 
record a sequence event for that 
sequence. In this case, the Counter 
advances the length of the referenced 
sequence, not the Spacing Size.
See Chapter 13: Segments, Loops, and 
Sequence Events for more information 
on sequence events.
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• Changing Spacing Size: The Step 
Spacing is easily changed by typing 
the corresponding key equivalent on 
your Macintosh keypad. You can 
even use the “+” and “-” keys to calcu-
late the Step Spacing.
See Using Keystrokes to set the Spacing 
(pg. 338) for details.
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CHAPTER 7: Advanced Recording Techniques
DRUM MACHINE STYLE LOOP 
RECORDING

Using techniques commonly found on 
drum machines, you can record drum pat-
terns with the following Vision features:

• Record Quantize (see page 76)
• MIDIKeys (see page 171)
• Input Effect (see page 115)

For the following procedure, you should 
use a “drum kit” patch on your MIDI 
sound source—one that allows you to 
access many different drum sounds from 
a single MIDI channel.

The following section illustrates how to 
enable Record Quantize, erase notes 
“on the fly” with MIDIKeys, and record 
repeated notes with the Input Effect:

a Select Setups>MIDIKeys Enabled 
so it is checked, then choose 
Windows>MIDIKeys.

The MIDIKeys Window opens.

b Define the Erase and Input Effect 
MIDIKeys with a MIDI event that you 
will not use while recording.
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Foot switches and MIDI notes (that are 
out of the normal record range) should 
work well for this procedure.

To define one of the special MIDIKeys, 
click in the desired MIDI Event field and 
play the event on your MIDI controller.

c Choose Windows>Input Effect.

The Input Effect Window opens.

d Disable the Input Effect toggle and set 
the type pop-up to Repeat.

YouÕll want the Input Effect disabled so 
you can toggle it ÒonÓ from the special 
MIDIKey in real time, when you want to 
record the repeated notes.

e Set the Input EffectÕs Spacing to Grid 
mode with a value of 16th notes.

f Choose Windows>Settings to open 
the Settings Window.
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g From the Real-Time section of the 
Settings Window, enable Aftertouch 
sets Effect Velocity.

This lets you use key pressure on your 
MIDI controller to affect the velocity of 
notes recorded with the Input Effect.

Not all keyboards have aftertouch, con-
sult your manufacturerÕs documentation 
if unsure.

h Use the procedure described in Loop 
Recording (pg. 35) to configure Vision 
for loop recording.

i Select Setups>Record Quantize 
Enabled so it is checked.

j Record-enable a track. Then click this 
trackÕs selector dot to view and 
configure itÕs Play Quantize settings.

Set the Quantize value to 16th notes.

NOTE: Each track has its own set of 
Play Quantize settings, which are used 
when Record Quantize is enabled.

k Click the Record button in the 
Control Bar and play some notes on 
your MIDI controller.

The notes are recorded and automati-
cally quantized.

l To record a string of repeated notes, 
hold down the MIDI note or pedal 
defined as the Repeat MIDIKey while 
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simultaneously playing the desired 
note or notes.

The notes are repeated (and recorded) 
with the rhythmic value specified by the 
Input EffectÕs Spacing settings.

m To erase a note, hold down the MIDI 
note or pedal defined as the Erase 
MIDIKey along with the note you wish 
to erase (while it is playing).

MULTI-CHANNEL RECORDING

Although Vision doesn’t record on more 
than one track at a time, it can record mul-
tiple MIDI channels onto a single track. 
Tracks containing data for multiple chan-
nels are called “Multi” tracks; they can be 
unmerged into separate tracks by choos-
ing Edit>Separate Multi Track.

In order to record multiple channels in 
Vision, you must set up an Input Map. 
Input Maps route incoming MIDI chan-
nels to individual Vision Instruments. For 
a complete explanation of Input Map capa-
bilities, see Chapter 34: The Input Map 
Window.

Recording tracks with Vision’s Input Map 
lets you:

• Record multiple tracks from an exter-
nal MIDI sequencer in a single pass;

• Record data from a single controller 
that transmits on multiple channels 
(like some guitar synths);

• Record data from more than one 
MIDI controller, such as in a “jam 
session.”
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CHAPTER 7: Advanced Recording Techniques
The next sections discuss how to record 
data from an external MIDI sequencer 
into Vision using an Input Map.

Recording Tracks from an 
External MIDI Sequencer

Transferring tracks from an external 
MIDI sequencer is comprised of three 
steps: configuring an Input Map, record-
ing the data, and unmerging the multi-
channel track.

Create an Input Map

To configure an Input Map that routes 
external sequence tracks into Vision:

a Make sure the device from which you 
are recording is contained in your 
OMS Studio Setup.

This device must be defined as a Con-
troller, and set to transmit MIDI Beat 
Clock.

b Launch Vision and make sure that 
Setups>Input Map Enabled is 
checked. 

c Choose Windows>Input Map (or 
type Command-M) to open the Input 
Map Window.

d Next choose Add Line from the 
menu in the Input Map Window.

A line is added to the Input Map Window.
Vision & Studio Vision Pro — MIDI Reference M
Click in the Input Device column and 
select the device from which you are 
recording (in this case, the MC50).

e Add an additional line for each 
channel you wish to record.

An easy way to add lines in the Input 
Map Window is to type Option-=.

For each line added, specify the correct 
Input Channel. These channels should 
correspond to the data received from the 
external sequencer.

f Next, assign an Instrument in the 
Thru/Trigger column for each line.

Once the data is recorded from the 
external sequencer, the Thru/Trigger 
Instruments are automatically assigned 
to their corresponding channels.

NOTE: DonÕt worry about the Sequence 
and Player columns in the Input Map 
Window. These items are not relevant to 
this tutorial.
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Record a Multi-Channel Track

The following example shows how to sync 
to and record from the external MIDI 
sequencer:

a Choose Options>Sync Options.

The Sync Options dialog opens.

Figure 7.1: Sync Options dialog

b Configure the Receive Sync mode to 
External Beat Clock and set the 
sync source to the external 
sequencer device.

In addition, make sure Send Sync is 
unchecked. 

c Click OK to close the Sync Options 
dialog.

d Choose Setups>Enable Input 
Devices.

The Enable Input Devices dialog opens.
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Make sure the external sequencer 
device is enabled (checked) as an input 
device. Then click OK.

e In the Control Bar, select Replace 
from the Record Mode pop-up. Also, 
set the Begin Record toggle to Wait 
for Note.

f Record-enable a track and press the 
Control BarÕs Record button.

The Record button flashes, indicating 
Vision is waiting for sync from the exter-
nal sequencer.

g Hit play on the external sequencer.

Vision begins recording as soon as the 
sync is received. The Control BarÕs 
Tempo Display indicates the received 
tempo.

NOTE: If nothing happens, verify that 
your external sequencer is configured to 
send Òsync.Ó

h When you have finished recording, 
stop the external sequencer, then 
click the Stop button in VisionÕs 
Control Bar. 

Data for the new track appears in the 
Tracks Window and shows up as 
assigned to Multi in the Instrument col-
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umn. Tracks appear as ÒMultiÓ whenever 
they contain data for more than one 
channel.

i To audition the new track, set the 
Sync Mode in the Control Bar to 
Internal and then press the Play 
button.

The tracks recorded from the external 
sequencer play back on the Instrument 
channels assigned in the Input Map.

j Choose File>Save As to save the 
new file.

Separating the Multi-Track

Once you’ve recorded your multi-track, 
you may wish to unmerge the channels 
into separate tracks—thereby making it 
easier to work with the data.
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To unmerge a multi-track:

a In the Tracks Window, highlight the 
multi-track by clicking its selector 
dot.

b Choose Edit>Separate Multi 
Track (or type Command-U).

The MIDI channels are unmerged and 
placed on their own tracks. Tracks are 
assigned based on the routings in the 
Input Map Window.

c Rename each track as desired.

d To save changes, choose File>Save. 
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CHAPTER 8: Sequence and Track Controls
This chapter discusses the sequence and 
track controls that primarily affect play-
back. For a complete description of every 
component in the Tracks Window, please 
see Chapter 25: The Tracks Window.

SEQUENCE CONTROLS

The following sequence settings are avail-
able from both the Tracks and Pulse 
Windows.

Figure 8.1: Sequence controls in Tracks Window

• Meter: A sequence’s meter deter-
mines the number of beat lines 
displayed in Vision’s edit windows, 
and the number of unaccented clicks 
heard when the metronome sounds.
“Meter Track” is displayed in this 
area when a sequence contains meter 
changes. Double-click the Meter 
track’s selector dot to open a List 
Window for the sequence’s meter 
events.
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• Tempo: Specifies how fast the 
sequence plays back, and the speed 
of the metronome click.
“Tempo Track” is displayed in this 
area when a sequence contains tempo 
changes. Double-click the Tempo 
track’s selector dot to open a List 
Window for the sequence’s tempo 
events.
The Tempo track can be record-
enabled ( ) or muted ( ). For details 
on setting the tempo, or recording 
into the Tempo track, see Virtual 
Conducting—Recording Tempo 
Changes (pg. 137).

• Sequence Length/Loop: Deter-
mines the number of measures the 
sequence plays, and whether it loops. 
Click in the left or right edge of this 
field ( ) to turn looping on and off.
You can Option-click in this field to 
lock the sequence length. When 
locked ( ), the sequence length is 
not automatically adjusted after 
recording.
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Information Toggle

Figure 8.2: Information toggle in Tracks Window

Click on the Information toggle( )in the 
Tracks and Pulse Windows to view 
sequence settings for Offset, Start, and 
Sync mode.

Figure 8.3: Offset, Start, and Sync mode settings

• SMPTE Offset: The sequence 
begins playing at this SMPTE time. 
The Offset ensures that sequence 
tracks line up with video or film (or 
tape tracks) when syncing to SMPTE, 
and that SMPTE event times are dis-
played accurately in Vision’s edit 
windows.
Click on the Offset button to grab the 
current SMPTE time in the Counter.

• Sequence Start Point: The 
sequence starts playing at this bar, 
beat and unit. Adjust the Start Point if 
your sequence contains a pickup 
note. 
For instance, a sequence with a quar-
ter-note pickup would have a Start 
time of 0•4•0.
When a sequence is set to loop, it 
always loops back to the Start Point. 
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• Sync Mode: Determines how the 
sequence “syncs” to the Master 
Tempo when played from a parent 
sequence, or when triggered in real 
time from the Players & Queue 
Window.
When set to “Off,” the sequence plays 
with its own tempo, independent of 
the Master Tempo.
“Speed” ignores the sequence’s own 
tempo setting so it plays in sync with 
the Master Tempo; 
“Start,” which also uses the Master 
Tempo, waits until the sequence’s 
Start Point is reached before trigger-
ing its playback.

TRACK CONTROLS

Each of a sequence’s 99 tracks has the fol-
lowing controls, which are available from 
the Tracks Window. Some of these con-
trols are duplicated in other edit windows.

Figure 8.4: Track columns in Tracks Window

• Record ( ): Click in this column to 
record-enable the track. Only one 
track can be record-enabled at a time.

• Mute ( ): Click in this column to 
mute playback for a track (or group of 
tracks). This lets you listen to and 
focus on other tracks within 
sequence.
Click in the column head to toggle 
the mute status of all selected tracks. 
Command-click to unmute all tracks.
Opcode Systems, Inc.



CHAPTER 8: Sequence and Track Controls
• Solo ( ): Click in this column to hear 
only that track, or group of tracks.
Click in the column head to toggle 
the solo status of all selected tracks. 
Command-click to unsolo all tracks.

• Track Length/Loop: Determines 
the number of measures the track 
plays, and whether it loops.
Click in the left or right edge of this 
field ( ) to turn looping on and off.
You can Option-click in this field to 
lock a track’s length. When locked 
( ), a track’s length is not automati-
cally adjusted after recording.

• Drum Track ( ): This column tog-
gles whether the track is defined as a 
drum track, which allows it to be 
viewed and edited in the Pulse 
Window.

• Instrument: Choose from this pop-
up menu to assign a MIDI Instrument 
for playback. The Instrument’s color 
determines the color of track data dis-
played in the various edit areas.
If a track contains data assigned to 
multiple Instruments, the word 
“Multi” appears in this column.

• Patch: Choose from this pop-up 
menu to insert a patch event in the 
track for the assigned Instrument. 
A patch displayed in parenthesis in 
this column indicates it is current, but 
has not been inserted in the track.
Patch names appear in this column 
only if the track’s Instrument is sub-
scribed to a Patch Name document.
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Track Controls in Graphic and List 
Windows

Figure 8.5: Track controls in Graphic Window

Some of the track controls are also avail-
able from the Graphic and List Windows. 
These controls, which apply to the indi-
vidual track displayed in the edit window, 
include Instrument, track length, loop on/
off, and buttons for record, mute and solo.

One advantage to adjusting the track 
length from the List Window is that you 
can specify a finer control over the length 
(with beats and units), unlike in the 
Tracks or Graphic Windows.

Figure 8.6: Track length field in List Window

Play Quantize Settings

When a track’s selector dot is clicked, that 
track’s Play Quantize settings appear in 
the info area of the Tracks and Pulse 
Windows.

Selected Track

Play Quantize

Quantize Value

Play Shift

pop-up

Play Shift toggle
(disabled)

Value
toggle (enabled)
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To enable either Play Quantize or Play 
Shift for the selected track, click the 
appropriate toggle button. The Quantize 
and Shift values used are displayed 
directly to the right of each button. To 
view all of the Play Quantize parameters, 
click the info area’s triangle ( ).

Figure 8.7: Info area, open

Play Quantize and Play Shift are dis-
cussed in greater detail in Play Quantize 
(pg. 72).

Click triangle to open and close info area
56
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CHAPTER 9: Basic Editing Procedures
This chapter explores some basic editing 
procedures, which include cursor tools, 
note editing, selecting and copying track 
regions, and selecting and copying track 
blocks and phrases.

It’s pretty important to that you under-
stand these concepts before moving on to 
the following chapters on Quantize, 
Transpose, and Mixing and Arranging.

CURSOR TOOLS

Following is a description of the edit cur-
sors found in Vision’s edit windows:

•  Arrow tool 
The Arrow tool is only available in the 
Tracks Window. Use it to select and 
drag track blocks in the Track Over-
view section.

•  Marquee tool
The Marquee tool is available in the 
Tracks, Pulse, Graphic and Notation 
Windows. Use it to select a range of 
pitches and time, or portions of one or 
more tracks in the Tracks Window. 
Shift-drag with the Marquee to 
extend the selection, or Command-
Shift-drag to add a non-contiguous 
selection.
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•  I-beam tool
The I-beam tool is available in the 
Tracks, Graphic, and Notation Win-
dows. Click and drag with this tool to 
select a time range of notes in the 
Graphic and Notation Windows—or a 
time range of all data in the Tracks 
Window. Use Shift-drag to extend the 
selection, or Command-Shift-drag to 
add a non-contiguous selection.

•  Pencil tool 
Use the Pencil tool to insert notes in 
the Graphic, Notation, and Pulse Win-
dows. See The Pencil Tool (pg. 37).

•  Magic Drumstick tool 
Use the Magic Drumstick tool to 
insert and delete notes in the Note 
Grid area of the Pulse Window. You 
can even click and drag to insert and 
delete a range of notes. See The 
Magic Drumstick Tool (pg. 40).

In addition to the above mentioned items, 
there are a number of specialized tools 
available in Vision’s Strip Chart. For a 
description of these, please see 
Chapter 28: The Strip Chart.
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Cursor Quantize

Although not a tool, the Cursor Quantize 
option (found in the Tracks, Pulse, 
Graphic, and Notation Windows) is very 
much related to editing with the cursor. 
Once enabled, all cursor selections and 
movements are restricted in time to the 
value specified in the Cursor Quantize 
pop-up. This allows you to make precise 
selections and edits that “snap” to the 
Cursor Quantize value.

To turn on Cursor Quantize, simply click 
its toggle button—to turn it off, click it 
again. Choose from the Cursor Quantize 
pop-up to specify the rhythmic value. 

The Graphic, Notation, and Pulse Win-
dows share the same Cursor Quantize 
settings—change the settings in one 
window and they change in the others. 
The Cursor Quantize settings in the 
Tracks Window are independent of the 
other edit windows.

Cursor Quantize toggle

Cursor Quantize value
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Cursor Display

Whenever the cursor is moved into an 
edit area, the Cursor Display provides 
feedback on its position. For the Track 
Overview and Note Grid areas, location is 
displayed; for the Graphic and Notation 
Windows, location and note pitches are 
displayed; and for the Strip Chart area, 
location and event values are displayed.

NOTE: If an Instrument is subscribed to a 
Patch Name document that contains note 
names (i.e. bass drum, snare, crash), the 
Cursor Display uses note names instead of 
pitches.

The cursor location is displayed in either 
bar/beat/unit or SMPTE (specified in the 
edit window’s menu). To display both time 
formats, click the Cursor Display toggle.

Figure 9.1: Click the Cursor icon to toggle 
between displays

Use the Cursor Display information to 
ensure accurate positioning of inserted 
notes and Strip Chart data, and to verify 
correct placement of dragged notes and 
track blocks.

Cursor icon

Pitch
Location
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Exact Mode

Figure 9.2: Exact mode toggle, disabled

It is often helpful to specify exact values 
when editing or inserting certain data 
types. Using Exact mode allows precise 
adjustments that might not be possible 
from one of Vision’s edit windows. 

Exact mode is enabled by clicking its tog-
gle, which is located in the tool palette of 
the Tracks and Pulse Windows, and at the 
bottom of the Graphic and Notation 
Windows.

When Exact mode is enabled, performing 
any of the following operations opens the 
Select & Modify Window, appropriately 
configured, for fine tuning the command:

• Dragging notes up or down with the 
mouse accesses the Transpose 
command;

• Resizing notes accesses the Change 
Duration command;

• Dragging notes or track blocks for-
ward or back in time accesses the 
Move Events command;

• Inserting events in the Strip Chart 
automatically accesses the Change 
Value command;

• Selecting a data range in the Graphic 
and Notation Windows accesses the 
Select command.

For details on Select & Modify capabili-
ties, see Chapter 16: Select & Modify.
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THE RULER

The Ruler is part of the Tracks, Pulse, 
Graphic, and Notation Windows. Use it as 
a reference for locating, selecting and 
editing track data.

Figure 9.3: Indicators in the Ruler

Bar/Beat 
Indicators

The Ruler shows the time scale in bars, 
beats, and divisions of beats. Whether bar 
and beat numbers are displayed depends 
on the horizontal zoom level.

Edit Indicators

The edit indicators show the Edit In/Out 
points for the current selection. Vision 
updates these indicators as the selection 
changes, see Edit Points—Defining the 
Current Selection (pg. 66).

Loop Indicators

These are displayed in the Notation and 
Graphic Windows if the current track is 
looped. The loop indicators show the 
points where the track repeats.

Bar/BeatEdit Indicators

Loop Indicator

Indicators
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NOTE EDITING

The following sections discuss basic note 
editing operations.

Adjusting Notes in the Graphic 
and Notation Windows

Figure 9.4: Adjusting note properties in Graphic 
and Notation Windows

A note’s pitch, duration and placement 
can be edited with the mouse in the 
Graphic and Notation Windows. Depend-
ing on where the cursor is placed in 
relation to the note, one of the following 
special cursor types appear: 

•  If positioned to the left of a note, 
a Move cursor appears. Click and 
drag left or right with the Move 
cursor to change the start time of a 
note. Any other selected notes are 
dragged along with it. You can only 
move notes horizontally with this 
cursor.

location

duration pitch
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•  When positioned in the middle of 
a note, the Transpose cursor 
appears. Drag up or down with this 
cursor to change the pitch of all 
selected notes.

•  When placed just near the right 
edge of a note, the cursor becomes a 
Duration cursor, which lets you 
change the length of the note. In the 
Graphic Window drag left or right to 
shorten or lengthen any selected 
notes; in the Notation Window, click 
and hold the mouse for a pop-up of 
duration values.

Regardless of the currently selected edit 
cursor (Marquee, I-beam, or Pencil), the 
note edit cursors always appear when 
moving the mouse near a note.

Each of the edit cursors can also be used 
to select a note by clicking on it (hold 
down the Shift key to select multiple 
notes). And, when moving or transposing 
notes, you can hold down the Option key 
to perform the edit on a copy of the 
note—leaving the original data intact.

NOTE: The note edit cursors work a little 
differently in the Pulse Window. For details, 
see Chapter 26: The Pulse Window.
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Editing Notes in the List Window

Vision’s List Window provides precise 
editing of each individual event. In fact, 
the List Window is the only place where 
you can actually see every event con-
tained within a track.

Figure 9.5: List Window

In addition to listing the type of each 
event and its location, all other relevant 
event values are also displayed. A note 
event, for instance, has values for pitch, 
duration, velocity on, and velocity off.

Figure 9.6: Note properties in List Window

Any property of a note event is easily 
edited in the List Window. Simply click in 
the desired numerical field and type in a 
new value—or drag up or down with the 
mouse.
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Note Velocities in the Strip Chart

You can affect the dynamics and phrasing 
of notes by editing their velocities. The 
Strip Chart is the perfect environment 
with an impressive array of tools for shap-
ing note velocities.

The following example adds a slight cre-
scendo to a group of note velocities with 
the Strip Chart’s Parabola shape:

a Select the desired Track and 
choose Windows>Graphic.

The Graphic Window opens.

b Open the Strip Chart by clicking 
its toggle button.

The Strip Chart opens.

c Make sure the Strip Chart is set 
to display Key Velocity.
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d Select the Strip ChartÕs Pencil 
tool.

Specify Parabola as the drawing 
shape.

e Zoom out so you can see the 
desired note range. Do this by 
Option-clicking in the edit area 
of the Graphic Window

f In the Strip Chart area, click at 
the beginning of the note range 
(near the desired velocity start 
point) and drag to the right and 
up slightly.

Once the range of notes is covered by 
the shape of the velocity curve, release 
the mouse button.

The note velocities are automatically 
adjusted based on the drawn curve.
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WORKING WITH TRACK 
BLOCKS AND PHRASES

The Track Overview section of the Tracks 
Window provides a graphic overview of 
the data contained in each track. Depend-
ing on the Display Mode pop-up, track 
data is displayed as Phrases, Blocks, or 
Tracks.

Figure 9.7: Display Mode pop-up

These different display modes offer you 
the flexibility of viewing your music as 
you see fit—based either on the type of 
music contained in the tracks, or the type 
of edit operations to be performed.

Figure 9.8: Display modes from Tracks Window

In Phrases mode, track data is broken up 
by a specified amount of silence, which is 
effective when working with music that 
doesn’t begin and end cleanly on the bar 
line. In Blocks mode, data is broken 
down into contiguous, equally sized 
blocks; you can specify the size of the 
blocks. In Tracks mode, the track’s con-
tents are displayed as a single block. 

Phrases mode, Silence set to quarter- note

Blocks mode, Size set to 1 measure

Tracks mode
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The Markers Break Blocks option fur-
ther breaks the blocks based on markers.

The important thing to remember about 
the Track Overview section is that it lets 
you get at any of your track data rather 
easily. This is handy for performing edit 
operations, or for moving blocks around 
to try out different arrangements.

In the Track Overview section you can 
use the Arrow tool to:

• Click on a block to highlight it, or 
Shift-click to select several blocks;

• Click and drag a block to a new loca-
tion or another track;

• Option-drag a block, or group of 
blocks, to make a copy of the data. 

• Double-click a block to open an edit 
window for that data.
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SELECTING DATA REGIONS

Before data can be cut, copied, moved, or 
modified by an edit operation, it must first 
be selected. To select an entire track, 
simply click its selector dot; to select 
track blocks, click or Shift-click them with 
the arrow tool; and to select individual 
notes, click or Shift-click them with any 
cursor tool.

The Marque and I-beam tools, on the 
other hand, are used to select contiguous 
regions of tracks, thereby allowing you to 
affect just the data you want. The follow-
ing sections discuss these methods.

Selecting Data with the Marquee

Use the Marquee tool to select groups of 
notes in the Graphic and Notation Win-
dows. Simply click and drag around the 
desired region. Notes that begin within 
the dragged rectangle are selected. In 
these windows, the Marquee does not 
select pitch bend, modulation, or control-
ler events.

Figure 9.9: Selecting with Marquee in Graphic and 
Notation Windows
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In the Track Overview section of the 
Tracks Window, use the Marquee tool to 
select portions of blocks, or even groups 
of blocks across several tracks. All data 
types (notes and continuous controller 
events) falling within the highlighted 
region are selected.

Figure 9.10: Selecting with Marquee in Tracks 
Windows

In the Note Grid section of the Pulse Win-
dow, use the Marquee tool to select notes 
across several note lines and tracks. The 
Marquee tool does not select pitch bend, 
modulation, or controller events in the 
Note Grid area.

Figure 9.11: Selecting with Marquee in Pulse 
Window

NOTE: You can Shift-drag with the Mar-
quee tool to extend a selection, and even 
Command-Shift-drag to add a non-contigu-
ous selection.
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Selecting all Notes in a Time 
Range with the I-Beam

Figure 9.12: Selecting a time range of notes in the 
Graphic Window

In the Graphic and Notation Windows, 
use the I-beam tool to select all notes in a 
time range. With the I-beam tool selected, 
click and drag across the edit area to 
select the desired time range. All high-
lighted notes in the displayed track(s) are 
selected.

Selecting All Data in a Time Range

Figure 9.13: Selecting a time range all data in the 
Graphic Window

Move the cursor into the Ruler of the 
Graphic and Notation Windows to auto-
matically switch to the I-beam tool. 
Dragging horizontally with this tool in the 
Ruler selects all data types in the track 
(including pitch bend data, patch events, 
digital audio events, etc.).
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Selecting All Notes in a Pitch 
Range with I-Beam

Figure 9.14: Selecting a pitch range in the 
Notation Window

Move the cursor into the left margin of 
the Graphic and Notation Windows to get 
a horizontal I-beam tool. Click and drag 
vertically with this tool in the margin to 
select all notes within a pitch range. 
Selecting a pitch range in this fashion 
selects over the entire track length.

Figure 9.15: Selecting a single note in the Graphic 
Window

Figure 9.15 illustrates clicking a single 
note in the left margin of the Graphic Win-
dow, which selects all notes like it in the 
track. This is useful for adjusting the 
properties of just those notes, or for drag-
ging the note to another pitch (to reassign 
a drum sound, for instance).
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Selecting Multiple Tracks with 
I-Beam

Figure 9.16: Selecting all tracks in the Track 
Overview

Use the I-beam tool in the Tracks Window 
to select a time range on all tracks. With 
the I-beam tool selected, you can click 
anywhere in the Track Overview section 
and drag horizontally to select all track 
blocks that fall in that range.

Selecting Multiple Note Lines with the 
I-Beam 

Figure 9.17: Selecting all note lines in the Note 
Grid 

You can also select across multiple note 
lines and tracks in the Pulse Window. To 
do this, move your cursor into the Ruler 
and click and drag horizontally. This 
selects all data contained within the high-
lighted region.

NOTE: Since Vision allows selection of 
multiple tracks from the Tracks and Pulse 
Windows, any edit functions may be applied 
to all selected tracks.
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EDIT POINTS—DEFINING THE 
CURRENT SELECTION

Figure 9.18: Edit Points

The current selection defines the time 
range of data affected when you perform 
an edit operation. Vision displays the cur-
rent time selection in the Edit Points of all 
edit windows.

These Edit Points are updated automati-
cally each time the current selection 
changes. This includes dragging in the 
Ruler, clicking on a note, or dragging a 
selection rectangle with the Marquee 
tool.

You can enter an Edit Point manually by 
clicking in its field and typing a new value, 
or by clicking and dragging with the 
mouse (you can also Option-click the field 
to grab a marker location).

Figure 9.19: Typing into Edit Point fields

When you adjust Edit Points manually, 
the edit indicators in the Ruler are auto-
matically updated, and MIDI events are 
either selected or de-selected as a result.
66
LOOP EDITING

Any of Vision’s vast array of editing capa-
bilities can be performed in real time, 
while the sequence plays.

Loop editing is a powerful interactive pro-
cess allowing construction of complex 
sequences from loops created “on the fly.” 
After creating a loop, the MIDI data may 
be edited while listening to the loop, with-
out stopping playback.

The following example sets up a loop to 
perform editing functions from the 
Graphic Window, though this procedure 
will work from any edit window.

a Select the desired track to edit and 
choose Windows>Graphic.

The Graphic Window opens.

b In the Ruler, select the time 
range that will be looped.

c In the Control Bar, enable Loop 
mode by clicking its toggle.

d Click the Set In Point and Set 
Out Point buttons.

The loop range is set based on the previ-
ously selected time range.
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e Click the Play button or press 
the Spacebar.

The sequence starts playing.

f Perform any edits within the 
selected time range.

When the sequence loops back and 
starts playing from the In Point, edits 
from the previous pass are heard. 

g When finished editing, click the 
Stop button.

NOTE: Choosing File>Undo undoes the 
previous edit made while playing.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 10: Quantize, Shift, and Nudge
ABOUT QUANTIZE

Quantize adjusts event locations so that a 
track’s timing is improved or altered—or 
so that a certain rhythmic “feel” is 
achieved.

Events such as notes, audio events, and 
sequence events, can be quantized to the 
nearest beat boundaries with Grid Quan-
tize, or they can be quantized based on an 
existing Vision track with Groove 
Quantize.

Tracks in Vision can be adjusted perma-
nently with the Quantize command, or 
for playback only with the Play Quantize 
settings. In addition, you can use Record 
Quantize to automatically quantize mate-
rial as it’s recorded.

Grid Quantize

Grid Quantize aligns events to the nearest 
beat boundary as defined by standard 
note durations. For example, if you quan-
tize by eighth notes, the selected events 
are moved to the nearest eighth note beat.

Figure 10.1 shows how a note quantized 
by eighth notes, previously residing at 
1•2•50, is moved to 1•2•0 (the nearest 
eighth note beat).
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Figure 10.1: Quantizing an eighth note

Note durations can also be quantized. 
Figure 10.2 shows the result of quantizing 
both the placement and duration of notes. 
Notes that are slightly shorter or longer 
than the specified note value are automati-
cally adjusted.

Figure 10.2: Quantizing durations

Unquantized note

 

Quantized note
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In addition to getting your music to play 
back properly, Grid Quantize (for both 
note placement and duration) helps clean 
up tracks for printout by eliminating 
unwanted rests and tied or dotted notes.

Groove Quantize

While Grid Quantize moves events to reg-
ular intervals (like 16th notes), Groove 
Quantize is based on the rhythm, veloci-
ties, and durations of an existing Vision 
track. This allows you to map the “feel” of 
one track (with notes starting at wildly 
irregular times) to another. And, since 
durations and velocities are automatically 
copied from the “groove source,” Groove 
Quantize can be used to achieve the 
desired phrasing for your tracks.

For example, imagine trying to duplicate 
the feel of a hi-hat track consisting of 16th 
notes played with a shuffle feel. Since the 
start times are slightly “swung,” using 
Grid Quantize to accomplish this would 
likely not work. In addition, certain notes 
and beats may be emphasized with veloci-
ties and durations. Trying to map start 
times, durations, and velocities to a differ-
ent track would be a tedious job, 
particularly if it needs to be done more 
than once. With Groove Quantize, you 
can use the hi-hat track as the groove 
source and have Vision do the work for 
you (see Figure 10.3).
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Figure 10.3: Groove Quantize

The Groove Quantize source tracks are 
stored in the “Vision Grooves” file. You 
can edit this file as you would any other 
Vision file—it must, however, remain in 
the same folder as your Vision 
application. 

See Creating Your Own Grooves (pg. 167) 
for details on customizing the Vision 
Grooves file.

APPLYING QUANTIZE

Vision’s Grid and Groove Quantize capa-
bilities can be used for Play Quantize, or 
for permanently quantizing data with the 
Quantize command.

Groove Source

Applying before

after
Groove Quantize
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When using the Quantize command, the 
quantize parameters are configured in the 
Select & Modify Window. When using 
Play Quantize, an identical set of quantize 
parameters (for each track) is configured 
in the info area of the Tracks and Pulse 
Windows; Record Quantize uses the Play 
Quantize settings for each track.

The quantize parameters vary depending 
on whether you are using Grid or Groove. 
Use the Type pop-up to specify Grid or 
Groove.

Figure 10.4: Type pop-up for specifying Grid or 
Groove

When using Grid, the Quantize Value 
determines the grid size used for the 
quantize.

Figure 10.5: Grid Quantize parameters

The Quantize Value can be specified as 
either a note duration or a number of 
units.

Figure 10.6: Quantize Value
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When using Groove, the Seq and Track 
pop-ups determine the source material for 
the quantize.

Figure 10.7: Groove Quantize parameters

The Seq pop-up determines which 
sequence’s tracks appear in the Track 
pop-up. The Track pop-up specifies the 
actual groove source track.

Figure 10.8: Seq and Track pop-ups for specifying 
groove source

Because there is such a wide range of pos-
sible quantize configurations, Quantize 
Templates can be used to store and 
recall your favorite settings. For details, 
see Quantize and Transpose Templates 
(pg. 163).

This chapter is a general discussion of 
quantize methods and types. While this 
chapter frequently refers to the settings 
for Play Quantize and the Quantize com-
mand, it does not go into detail about their 
various parameters. For detailed informa-
tion on each quantize parameter, please 
see Quantize Parameters (pg. 129).
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Play Quantize

Play Quantize is non-destructive and only 
affects how a track plays back—it does 
not change MIDI data. Each track can 
have its own Play Quantize settings, using 
either Grid or Groove.

Play Quantize settings are accessed from 
the info area in the Tracks and Pulse Win-
dows. Once a track is selected, its Play 
Quantize parameters appear:

Figure 10.9: Play Quantize Parameters

When the info area is closed, the follow-
ing track settings are visible:

• Play Quantize: Enables Play Quan-
tize for the selected track.

• Play Quantize Value: Specifies the 
rhythmic value (or Groove source) 
used for the track’s Play Quantize.

• Play Shift: Enables Play Shift for the 
selected Track.

• Play Shift Value: Specifies how 
many units (+/-) the selected track is 
shifted for playback.

Selected Track

Play Quantize

Quantize Value

Play Shift

pop-up

Play Shift toggle
(disabled)

Value
toggle (enabled)
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There is, however, a much larger number 
of parameters that specify how a track is 
Play Quantized. These parameters are vis-
ible when clicking the info area’s triangle.

Figure 10.10: Open/close triangle for info area

Figure 10.11 shows the info area open, 
displaying all Play Quantize parameters. 

Figure 10.11: Info area, open

The Type pop-up specifies whether Grid 
or Groove is used. The Template pop-ups 
are for saving and recalling Quantize 
Templates. See Quantize Parameters 
(pg. 129) for an explanation of each quan-
tize parameter.

Enabling Play Quantize

The following example shows how to 
enable Play Quantize for a track with an 
eighth note “swing” feel:

a From either the Tracks or Pulse 
Window, highlight the desired 
track.

b Click the info areaÕs triangle so 
all of the Play Quantize 
parameters are visible.
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c Enable Play Quantize for the 
track by clicking its toggle 
button.

d Select Grid from the Quantize 
Type pop-up.

Next specify eighth notes in the Quan-
tize Value pop-up.

e Enter a value of 60.0% for 
Swing.

Leave Shift and Smear set to 0 units, 
Sensitivity and Strength to 100%.

Uncheck the options for Tuplet and 
Quantize Durations.
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f Click the Play button in the 
Control Bar to audition the Play 
Quantize settings.

The track plays back with an eighth note 
ÒswingÓ feel.

g Experiment with different values 
for Swing until the desired feel 
is achieved.

To use the trackÕs original MIDI data, 
unclick the Play Quantize toggle.

Enabling Play Shift

Enabling Play Shift causes a track’s MIDI 
events to play back early or late. It shifts 
the contents of the track by the number of 
units specified in the Play Shift field.

You can use Play Shift to:

• Compensate for synth patches with 
slow attacks;

• Achieve a certain “pushed” or “laid 
back” feel;

• Create MIDI delays (copy a track, 
lower its volume, and apply Play 
Shift).

To enable Play Shift for a track:

a Select the desired track from 
the Tracks or Pulse Window.
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b Click the Play Shift toggle and 
enter a value (+/- 480 units) in 
the Play Shift field.

Positive values cause events to play 
later than the rest of the sequenceÑneg-
ative values cause events play earlier.

To permanently shift your MIDI data see 
Permanently Shifting Track Data (pg. 77).

The Quantize Command

The Quantize command permanently 
alters the selected track data. There are 
several reasons you’d want to use the 
Quantize command instead of Play 
Quantize:

• While Play Quantize affects all notes, 
audio events, and sequence events 
contained within a track, the Quantize 
command can be used selectively on 
portions of a track—and on other 
event types.

• Track data is always displayed based 
on the original MIDI data—not the 
Play Quantize values. Permanently 
quantizing a track ensures that its 
playback will match what’s displayed 
in the edit windows.

• Permanently quantizing data, rather 
than having Vision calculate for play-
back, increases your computer’s 
processor performance.
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You can use the Quantize command on 
any selected sequence, track, group of 
tracks, or track region. Parameters for the 
Quantize command reside in the Select & 
Modify Window. Choose Do>Quantize 
to open the Select & Modify Window 
automatically configured for Quantize.

Figure 10.12: Select & Modify Window, configured 
for Grid Quantize

The Quantize parameters in the Select & 
Modify Window are identical to (but inde-
pendent of) those used for Play Quantize.

To actually invoke the Quantize com-
mand, click the Quantize button in the 
Select & Modify Window. Click Undo to 
revert back to the original data (clicking 
the Undo button turns it into a Redo but-
ton, and vice versa).

You can also call the Quantize command 
by choosing Do>Quantize Track (or, 
depending on the selected material, 
Do>Quantize Selection), or type Com-
mand-G.

IMPORTANT: Unlike other Select & 
Modify commands, the Quantize command 
is always accessible from the Do menu, or 
by typing its key equivalent (Command-G).
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Quantize Value Pop-up

The Quantize Value pop-up, found in the 
Graphic, Notation and List Windows, 
offers a way of remotely adjusting Quan-
tize parameters in the Select & Modify 
Window. Setting this value from one Win-
dow, changes it in all others.

With the Quantize command set to Grid, 
click this pop-up to set the note duration 
for the grid size.

Figure 10.13: The Grid Size pop-up

With the Quantize command set to 
Groove, click this pop-up to choose the 
track used for the groove source.

Figure 10.14: Groove Source pop-up
Vision & Studio Vision Pro — MIDI Reference M
The Quantize Value pop-up can also be 
used for the following purposes:

• Command-click to toggle between 
Grid and Groove Quantize;

• Shift-click when in Groove mode for a 
pop-up of groove sequences;

• Option-click to open the Select & 
Modify Window configured for 
Quantize.

NOTE: Changing the Quantize Value pop-
up from the Select & Modify Window, or 
from the Graphic, Notation or List Win-
dows, does not affect Play Quantize settings 
for any tracks.

Groove Quantizing a Track Region

Following is an example of quantizing a 
track region with one of the groove 
examples:

a Highlight the desired track 
region and choose Do>Quantize.

The Select & Modify Window, configured 
for Quantize, opens.

b Select Groove from the Type 
pop-up.

c From the Seq pop-up, select 
1¥Shuffles. From the Track pop-
up, select 3¥Med Shuffle A.
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d Click the Quantize button.

The selected material is modified 
according to the settings in the Select & 
Modify Window.

e Click the Play button in the 
Control Bar to audition the 
change.

To go back to the original MIDI data, 
click the Undo button before performing 
any other operations.

Experimenting with Quantize

Using quantize, with either the Quantize 
command or Play Quantize, takes some 
experimenting. In fact, you won’t always 
get the results you’re expecting. 

You may have to try different values for 
Sensitivity and Strength; these parame-
ters determine which notes are affected 
and how drastically they are changed. In 
addition, the Smear parameter, which 
adds a percentage of randomness to the 
quantize, can be used to make tracks feel 
less mechanical—less perfect. For an 
explanation of these and other Quantize 
parameters, see Quantize Parameters 
(pg. 129)).

Although quantize is a wonderful tool for 
cleaning up tracks and working with the 
feel of your music, sometimes the 
recorded data may not be salvageable. In 
these instances it is wise not to spend too 
much time trying to fix something that 
should probably just be rerecorded.
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RECORD QUANTIZE

Select Setups>Record Quantize 
Enabled to turn on Record Quantize, or 
simply click the toggle in the info area of 
the Tracks or Pulse Window.

Figure 10.15: Record Quantize toggle, enabled 

By default, the recorded track uses its 
own Play Quantize settings for Record 
Quantize. If you have a set of Quantize 
parameters that work well for Record 
Quantize, choose Save as Default from 
the Template pop-up in the Info Area—
each new track will then use those Quan-
tize settings.

Figure 10.16: Saving default Quantize parameters

To record durations as quantized, make 
sure to check that option as well.

For details on changing the Record Quan-
tize source, see Record Quantize Source 
(pg. 335).
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PERMANENTLY SHIFTING 
TRACK DATA

If you find a Play Shift setting you like, 
you can permanently shift the data so that 
what you hear matches what’s displayed.

Although there are many ways to shift 
events in Vision, the following sections 
describe how to use the Move Events 
and Nudge commands.

NOTE: If the beginning of a selection starts 
at 1•1•0, it will not be possible to shift any 
of the selected events back in time with 
Move Events or Nudge.

NOTE: The Nudge and Move Events com-
mands are not affected by Cursor Quantize 
settings.

Move Events

Following is an example of permanently 
shifting track data with the Move Events 
command. This example assumes you 
have a track Play Shifted by 30 units and 
would like to permanently shift the data.

a Select the desired track or track 
region.

b Choose Edit>Move Events (or 
type Command-,).

The Move Events Window opens.
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For complete information on this dialog 
box, see Move Events (Command-,) 
(pg. 413).

c Select the Move later option 
with a value of 30 units.

d Click the Move button.

The data is permanently shifted.

e Disable the Play Shift toggle for 
the track.

If you donÕt complete the last step, your 
data will be shifted again during play-
back, which is probably not desirable.
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Nudge

You can also use the Nudge command to 
permanently shift track data. Unlike the 
Move Events command, Nudge is typi-
cally used for tweaking the “feel” of a 
track during playback.

The Nudge command can be invoked 
from the Do menu—or by typing Com-
mand ® for forward, Command ¬ for 
back. The amount nudged is specified in 
the Strip Chart & Nudge section of the 
Settings Window.

Following is an example of nudging a 
track forward by 10 units:

a Disable the Play Shift toggle for 
whichever tracks you will 
Nudge.

While this step is not mandatory, it will 
lessen the confusion in keeping track of 
whether the track is ÒshiftedÓ or 
Ònudged.Ó

b Choose Windows>Settings.

The Settings Window opens.

Figure 10.17: Strip Chart & Nudge section of 
Settings Window
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c With the Settings Window pop-
up set to Strip Chart & Nudge, 
set the Nudge direction value to 
10 units.

Figure 10.18: Nudge transpose set to 10 units

d Highlight the desired track data 
and choose Do>Nudge>Later (or 
type Command ®).

The track data is nudged later by 10 
units.

If you don’t like the effect of a Nudge com-
mand, simply use the opposite Arrow key 
to return to the previous event locations.
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This chapter discusses the many ways 
that Vision transposes notes, which 
include dragging notes in the Graphic and 
Notation Windows, editing pitch values in 
the List Window, using the Transpose 
command, and defining transposed Vision 
Instruments.

TRANSPOSING IN THE 
GRAPHIC, NOTATION, AND LIST 
WINDOWS

Notes and groups of notes can be trans-
posed in the Graphic and Notation 
Windows by dragging up or down with 
the mouse.

Figure 11.1: Transposing in the Graphic Window

When positioning the cursor in the 
middle of a note, it becomes a transpose 
cursor ( ), which can be dragged up or 
down to change the pitch of the note. In 
addition, you can use Option-drag to 
transpose a copy of the note. 
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Figure 11.2: Transposing in the Notation Window

To transpose a chord or a group of notes 
(or even an entire track), simply make the 
selection and then drag just one of the 
notes. All of the selected notes will follow 
the dragged note.

Figure 11.3: Transposing a chord in the Graphic 
Window

You can also edit the pitch of individual 
notes in the List Window. To do so, click 
in the pitch field and drag up or down with 
the mouse, or type in a new value.

Figure 11.4: Editing a note’s pitch in the List 
Window
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TRANSPOSING WITH NUDGE

A quick and easy way to transpose tracks 
(or portions of tracks) by semitones, 
octaves, or scale degrees is with the 
Nudge command. The transpose type 
used with Nudge is specified in the Set-
tings Window.

To transpose a track up by an octave with 
Nudge:

a Choose Windows>Settings.

The Settings Window opens.

Figure 11.5: Settings Window set to display 
Strip Chart & Nudge parameters

b With the Settings Window pop-
up set to Strip Chart & Nudge, 
set the transpose value to 1 
octaves.

Figure 11.6: Nudge transpose set to 1 
octave

c Close the Settings Window.

d Select the desired track or track 
region from the Tracks Window 
80
and choose Do>Nudge>Up (or 
type Command-­).

The track data is transposed up an 
octave. 

Invoking Nudge with the Command and 
Arrow keys is a very convenient method 
of auditioning transpositions while Vision 
plays. And if you don’t like a nudged 
transpose, simply use the opposite Arrow 
key to return to the previous pitch values.

THE TRANSPOSE COMMAND

Vision’s Transpose command offers the 
widest range of capabilities for perform-
ing transpositions. Choose 
Do>Transpose to open the Transpose 
Window.

Figure 11.7: Transpose Window 

The Transpose Type pop-up specifies 
what kind of transposition is used. Follow-
ing is a brief explanation of each type:

• Chromatic transposes by a specified 
number of semitones.

• Interval transposes by semitones, as 
expressed by one specified pitch to 
another.

• Diatonic transposes by scale degrees 
for a specified key and scale type.
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• Invert creates a mirror transposition 
(chromatically or diatonically) around 
a specified pitch.

• Key/Scale transposes from one key 
and scale type to another.

• Auto Map lets you specify the 
number of notes per octave for source 
and destination maps.

• Octave Map is just like Auto Map 
except you can specify which notes 
are contained in the octave.

• Manual Map lets you remap any of 
the 128 MIDI pitches to any other 
pitch.

• Drum Map is for remapping drum 
assignments from one Instrument to 
another. This is the same as Manual 
Map except note names are displayed 
instead of pitches.

Once a Transpose Type is chosen and its 
settings are configured, click the Trans-
pose button to modify the selected data. 
Alternately, click the Harmonize button 
to automatically make a transposed copy 
of the original data.

For a detailed description of the Trans-
pose Window, including configuration 
details on each Transpose Type, see 
Transpose Types (pg. 134).

The following sections illustrate some 
practical applications for the Transpose 
command.
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Transpose up a Fifth

To transpose up a fifth using a Transpose 
Type of Chromatic:

a Highlight the desired track or 
track block from the Tracks 
Window.

b Choose Do>Transpose.

The Transpose Window opens.

c Set the Transpose Type to 
Chromatic.

d Set the Transpose direction 
pop-up to Up, then click and 
drag in the Transpose value 
field until Òa perfect fifthÓ is 
displayed.

You can also type a value of 7 into this 
field (referring to the number of 
semitones).

e Click the Transpose button.

The selected material is transposed up a 
fifth.
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Using Transpose to Add Harmony

To harmonize a track with thirds using a 
Transpose Type of Diatonic:

a Highlight the desired track.

This example assumes the selected 
track material is in the key of C major.

b Choose Do>Transpose.

The Transpose Window opens.

c Set the Transpose Type to 
Diatonic.

d Set the direction pop-up to Up 
and specify a transpose value of 
Òa third.Ó In addition, make sure 
that C major is the specified 
key.

NOTE: The Constrain to Scale option 
does not need to be checked, since the 
track material is already in the key of 
C major.

e Click the Harmonize button.

A transposed copy of the selected track 
data is merged into the source track. 
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Drum Instruments and the 
Transpose Command

Most MIDI keyboards and drum 
machines map a number of different drum 
and percussion sounds across a range 
MIDI note numbers. When drum tracks 
in Vision are recorded, each note corre-
sponds to a specific drum sound. 
Transposing these notes, therefore, usu-
ally results in a different (or even no) 
drum sound playing back.

To avoid this problem, Vision lets you 
define Drum Instruments. Tracks 
assigned to Drum Instruments (which are 
defined as such in the Instruments Win-
dow) are not altered with the Transpose 
command.

To define a Drum Instrument:

a Choose Windows>Instruments 
to open the Instruments 
Window.

b Click in the Drum Transpose 
column ( ) for the desired 
Instrument.

The Drum Instrument icon is added to 
the Drum Transpose column, indicating 
that Instrument is a Drum Instrument.

NOTE: Click again in the column to turn 
the Drum Instrument back to a normal 
Instrument.
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For information on MIDI Instruments, 
see Chapter 32: The Instruments Window.

TRANSPOSING WITH VISION 
INSTRUMENTS

Another way to transpose in Vision is with 
MIDI Instruments. An Instrument can be 
transposed by octaves or semitones by 
editing the appropriate fields in the Instru-
ments Window (see Figure 11.8).

Figure 11.8: Instrument transposed up 1 octave 
and 5 semitones

An Instrument can also use Transpose 
Maps, thereby taking advantage of any of 
the capabilities in Vision’s Transpose Win-
dow. With Transpose Maps, you can have 
Instruments that are “constrained” to 
playing notes only in a certain key, that 
map notes played in one key or mode to 
another, or that remap drum sounds from 
one device to another.

The following example illustrates how to 
add a map that restricts an Instrument to 
only playing notes in the key of C major:

a Choose Windows>Instruments 
to open the Instruments 
Window.
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b Click in the Map column of the 
desired Instrument.

The Transpose Map dialog opens.

c Set the Transpose Type to 
Diatonic.

Set the transpose value to Ò0 semitonesÓ 
and make sure that C major is the 
specified key.

d Enable the Constrain to Scale 
option by clicking its checkbox.
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e Click OK.

The Transpose Map dialog closes and 
the column in the Instruments Window 
indicates a Transpose Map is in use.

Once an Instrument is transposed, any 
tracks assigned to that Instrument play 
back with that transposition. The main 
advantage of using transposed Instru-
ments is that the original track data 
remains unaltered.

For detailed information on MIDI Instru-
ments, see Chapter 32: The Instruments 
Window.
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Once your tracks are recorded and edited 
as you like, the next logical step is to final-
ize the arrangement. This chapter 
explores building song structures, saving 
patch selections, and saving volume and 
pan settings.

ARRANGING SECTIONS OF 
MUSIC

Vision is both a pattern and linear based 
sequencer. This means you can build 
your music by creating individual 
sequences that are chained together, or 
you can work within a single, linear 
sequence (much like a multitrack 
recorder). Vision provides the flexibility 
to work with either method—or even a 
combination of the two.

Chaining Existing Sequences

A very powerful capability of Vision is 
playing existing sequences from other 
parent sequences, which makes it very 
easy to chain together sequences, or even 
play back multiple sequences at the same 
time. This modular approach to using 
sequences as building blocks is a very 
flexible and effective way of constructing 
music in Vision.
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Sequences (and segments) are called 
from parent sequences by inserting or 
recording sequence events, which describe 
how to play back the referenced data.

The following example illustrates how to 
chain together three existing sequences 
(Verse, Chorus, and Bridge) with step 
record:

a From the menu in the Sequences 
Window, choose New Sequence.

b In the Control Bar, set the Record 
Mode pop-up to Step Replace.

c Record-enable a track in the Tracks 
Window.

d Click the Record button in the 
Control Bar.

Vision enters record mode and the Step 
Window opens.
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e Type the key equivalent for each 
sequence in the desired order. 

The Counter advances each time a 
sequenceÕs key trigger is typed, and a 
corresponding sequence event block 
appears in the Track Overview section of 
the Tracks Window.

Figure 12.1: Step Recorded Sequence Events

f When done, press the Stop button in 
the Control Bar.

g To audition the new arrangement, 
click the Play button in the Control 
Bar.

Sequence events show up in the Track 
Overview section as white (named) 
blocks. Like other data in the Track Over-
view, sequence event blocks can be 
dragged, copied, and pasted. If you wish 
to edit the referenced sequence, double-
click the sequence event block to open a 
Tracks Window for that sequence.

NOTE: Sequence event blocks that refer-
ence single-track sequences (or segments) 
are not named, and instead display the 
data from the referenced track. For details, 
see Single-track Segments (pg. 94).
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Adding Linear Tracks to Chained 
Sequences

Within a parent sequence, you can add or 
record additional (linear) tracks on top of 
the chained sequences. This is an impor-
tant feature because phrases or notes may 
sometimes overlap song sections. You 
can also use these extra tracks to add mix 
and patch events for the Instruments con-
tained in the chained sequences.

Figure 12.2: Sequence with chained sequences 
and additional linear tracks

Making Segments

As discussed in Working with Track 
Blocks and Phrases (pg. 62), it’s pretty 
easy to try out different song arrange-
ments by moving around and copying 
track blocks in the Track Overview sec-
tion. This can, however, get rather 
laborious if your sequences have a lot of 
tracks.

One way to simplify this process is to 
combine the various track sections into 
segments. Once this is done, rearranging 
song sections is a much simpler process.

a Open the Tracks Window for the 
desired sequence.

b Turn on Cursor Quantize and set it 
to whole notes.
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c Using the Marquee tool, click and 
drag around the track regions that 
comprise the first song section.

Release the mouse button to select the 
track regions.

d Choose Edit>Make Segment Loop.

The Make Segment dialog opens.

e Enter a Name for the new segment.

f Click the Make one segment 
option.
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This combines the selected track regions 
into a single segment, making it easier to 
move or copy.

If you would like the flexibility of keeping 
the individual track data separate, 
choose the Make single track seg-
ments option.

g Click the Make button.

The selected track material is turned into 
a segment (which then appears in the 
Segments section of the Sequence 
Window). 

The previously selected track blocks are 
replaced by a single sequence event 
block in the Track Overview section.

h Repeat the previous steps until each 
of the song sections is turned into a 
segment.

Once the segments are created, you can 
rearrange them as desired—drag them to 
a new location, or use copy and paste. 
Individual sequence events can also be 
resized to play just a portion of the origi-
nal data, looped (independently of their 
parent track), and even transposed.

For more information on segments and 
sequence events, see Chapter 13: Seg-
ments, Loops, and Sequence Events.
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SAVING PATCH SELECTIONS

Part of finalizing your songs is making 
sure your MIDI devices play back with 
the right patches. Patch events can be 
recorded or inserted into a track in a 
number of ways. You can insert them in 
the List Window or Strip Chart, and you 
can even step record them.

NOTE: The following sections assume that 
your Instruments are subscribed to Patch 
Name documents, see Chapter 33: The 
Names Window.

Using the Patch Column in the 
Tracks Window

Perhaps the easiest way to insert a patch 
event into a track is with the Patch 
column in the Tracks Window:

a In the Tracks Window, click in the 
Patch column for the desired track.

If there is a current patch selection for 
the assigned Instrument, that patch 
appears in the column in parentheses.

A pop-up menu of patches appears.
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b Highlight the desired patch and 
release the mouse.

A patch event is inserted into the track at 
1¥1¥0. The patch name appears in the 
Patch column (without parentheses).

Using the Copy Patches 
Command

One drawback of using the Patch column 
in the Tracks Window is that the inserted 
patch events are erased if you record over 
the track (in Replace mode).

Another method of recalling patch events 
is to insert them into their own, dedicated 
track with the Copy Patches command:

a Using the Current Patch pop-up in the 
Control Bar, select a patch for each 
Instrument used in your sequence.

b Choose Do>Copy Patches.

The current patches are copied to the 
Clipboard.
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c Select a blank track in the Tracks 
Window and choose Edit>Paste 
Track.

The patch events are pasted into the 
selected track. The track is automatically 
named ÒPatchesÓ and the Instrument 
column is assigned to Multi.

To view the pasted patch events, open 
the List Window.

Figure 12.3: Pasted patch events for multiple 
Instruments

Patch Event Placement

Some MIDI devices have trouble switch-
ing patches while playing. As a result, 
these devices may “hiccup” or drop some 
notes when receiving a patch event.

To get around this problem, you’ll need to 
allow enough time between the patch 
event and track playback. If a track begins 
playing at 1•1•0, you can use a pickup 
measure for the patch event (see 
Sequence Start (pg. 212)). 

Another method is to put all of your patch 
events into a dedicated sequence and play 
it back separately— triggering it with its 
key equivalent, or playing it from a opti-
mally placed sequence event.
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SAVING VOLUME AND PAN 
SETTINGS

This section discusses how to set the 
volume and pan levels for Instruments, 
and how to save them to a sequence.

Volume and pan data can be inserted in 
the List Window and Strip Chart, or it can 
be recorded or copied from consoles and 
faders.

Saving a Mixer Snapshot

The following example explains how to 
copy and save the mixer settings from a 
Console Window:

a Once your tracks are recorded and 
assigned to the correct Instruments, 
choose Windows>Consoles>
Console 1.

The Console Window opens.

b From the menu in the Console 
Window, choose Build Consoles 
From>All Instruments In Use.
Each of the Instruments used in your 
sequence is automatically assigned to a 
console channel.

c Click the Play button in the Control 
Bar to listen to the sequence.
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d Make any Mute or Solo settings that 
apply at the beginning of the 
sequence.

e While the sequence plays, adjust the 
Volume and Pan sliders for each 
console channel.

You can also adjust these values by 
typing into their fields.

f Once the desired volume and pan 
levels are achieved, choose 
Edit>Copy Faders.

The volume and pan data is placed on 
the Clipboard.

g Select an empty track in the Tracks 
Window and choose Edit>Paste 
Track.

The volume, pan, mute, and solo events 
are pasted into the selected track. One 
of each type of event is pasted in for 
each Console channel.

h Choose File>Save to save the new 
track containing the fader values.

Click to enable or disable any
mutes or solos.

Click and drag vertical
sliders to adjust volume

Click and drag horizontal
sliders to adjust pan
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i Also, when prompted, make sure to 
Save the Fader Values and Fader 
Assignments with the sequence.

Fader movements can also be recorded in 
real time while the sequence plays back. 
This lets you create dynamic mixes for 
your tracks. For more details on using 
faders and consoles, see Chapter 37: The 
Faders Window and Chapter 38: The Con-
sole Windows.
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CHAPTER 13: Segments, Loops, and 
Sequence Events
SEGMENTS

Segments, which are very similar to 
sequences, are created from tracks or 
groups of tracks. Segments provide a 
great way to turn existing material into 
modular components that can be played 
from any of the sequences in a file. Use 
them as song sections, music layers, reoc-
curring phrases and riffs, or even nested 
track loops. They can also be used to 
break an existing linear sequence into 
sections that can be rearranged.

Segments are “made” by selecting track 
material (which can reside across several 
tracks) and choosing Edit>Make Seg-
ment/Loop. The selected material is 
replaced by a sequence event block that 
references the new segment. The original 
material then resides in the newly created 
segment, which is listed in the Segments 
section of the Sequences Window.

Figure 13.1: Making a segment
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Once they’re created, segments act pretty 
much like regular sequences; double-
click on them from the Sequences 
Window and they open up in a Tracks 
Window, where they can be played or 
edited. There are, however, some impor-
tant differences between segments and 
sequences:

• Segments and sequences reside in 
different sections of the Sequences 
Window;

• Unlike sequences, key equivalents 
and MIDIKeys cannot be assigned to 
segments;

• When no longer referenced by any 
parent sequences, segments are auto-
matically deleted.
NOTE: If you uncheck the Automati-
cally Remove Unused Segments 
option in the Sequences Window 
menu, segments are not auto-deleted.

If you need to assign a key equivalent or 
MIDIKey to a segment, you can turn it 
into a sequence. Do this in the Sequences 
Window by dragging it from the Seg-
ments section to the Sequences section.

For details on sequence event parame-
ters, which describe how to play 
segments and sequences, please see 
Sequence Events (pg. 96).
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Making a Segment

The following example illustrates how to 
make a segment from existing tracks:

a In the Tracks Window, highlight 
the desired track blocks.

b Select Edit>Make Segment/Loop.

The Make Segment dialog opens.

With multiple tracks selected, you can 
specify to combine them into one seg-
ment by choosing ÒMake one segment 
with multiple tracks,Ó or you can keep the 
tracks separate with ÒMake single-track 
segments.Ó

c For this example, specify the 
Make one segment option. Enter 
a name for the segment and 
click Make.
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The previously selected track material is 
replaced by a sequence event block in 
the Tracks Window, and the new seg-
ment is listed in the Segments section of 
the Sequences Window.

Figure 13.2: Sequence event block

Single-track Segments

In the previous example, four existing 
tracks were combined into one segment. 
As seen in Figure 13.2, sequence events 
that reference segments, or sequences, 
with multiple tracks are displayed as 
white (named) blocks.

However, when you make a segment from 
just one track (or if you choose the “Make 
single-track segments” option in the 
Make Segment/Loop dialog), the result-
ing sequence event block displays the 
track data and color, see Figure 13.3.

Figure 13.3: Making a single-track segment

NOTE: Double-clicking a single-track 
sequence event opens the default edit 
window (Graphic or List), instead of a 
Tracks Window.

Single-track segments always play back 
using their parent track’s Instrument.
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Looping Track Regions with 
Segments

Segments can loop independently of 
tracks. This means that tracks can contain 
nested loops. For instance, your track 
could be set to loop for 12 bars while a 3 
bar segment, within the track, also loops a 
number of specified times. Looped seg-
ments can begin playing anywhere within 
a track, and can be set to any loop length.

The following example illustrates how to 
loop a one measure phrase by turning it 
into a segment:

a Highlight the desired track 
region and select Edit>Make 
Segment/Loop.

b In the Make Segment/Loop 
dialog, check the Loop option 
and specify the number of times 
youÕd like the material to repeat.

In addition, make sure the selected 
material for the loop has the correct 
Start and End times. If necessary, use 
the ÒRound to nearest bar linesÓ 
checkbox.
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c Enter a name for the segment 
and click Make.

The previously selected track material is 
replaced by a sequence event block in 
the Tracks Window, and the new seg-
ment is listed in the Sequences Window.

Figure 13.4: Looped segment

The resulting sequence event block dis-
plays the looped material, followed by 
grayed regions that indicate the number 
of times it repeats (see Figure 13.4).

Using Segments to Create Loops in the 
Middle of a Track

An advantage of using segments for loops 
is that they can start and end anywhere in 
a track. The material you select, just 
before “making” the segment, doesn’t 
have to start at measure 1; in fact, it can 
start anywhere in the track and it needn’t 
fall precisely on the bar line.

Figure 13.5 illustrates looping a track 
region that begins just before the bar line.

Figure 13.5: Use segments to loop any region of a 
track
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When making a segment that doesn’t fall 
squarely on the beat, make sure to 
uncheck Round to nearest bar lines in 
the Make Segment/Loop dialog.

Of course once a segment is made, it can, 
like any other track block, be moved or 
nudged to your liking.

Resizing Segments/Loops Graphically

Once a segment is made you can still 
adjust the loop length and number of 
repeat times. You can type in new values 
for these numbers in the info area or List 
Window (see Sequence Events (pg. 96)), 
or you can graphically edit the segment in 
the Tracks Window.

When moving the cursor near the end of a 
looped segment, the Repeat cursor 
appears. Click and drag left or right to 
change the number of times the segment 
repeats.

When placed near a segment’s loop end 
point, your cursor changes to a Resize 
cursor. Click and drag to the left or right 
to resize the loop range.

Repeat cursor Click and drag to adjust
number of repeats

Resize cursor Click and drag to adjust
loop end point
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SEQUENCE EVENTS

Sequence events are aliases to sequences 
and segments. Sequence events, which 
reside in a parent sequence, describe how 
to play the referenced material.

Sequence events can be:

• Recorded in step or real time by 
typing a sequence’s key equivalent;

• Inserted in the List Window from the 
Insert Event pop-up.

• Pasted into a Tracks or List Window 
(after copying a sequence or segment 
from the Sequences Window).

In addition, whenever using the 
Do>Make Segment/Loop command, 
(see page 94), a corresponding sequence 
event is automatically inserted to replace 
the original material.

Sequence Event Parameters

Sequence event parameters can be 
viewed and edited from the Info Area of 
the Tracks and Pulse Windows. Simply 
click on the sequence event block and 
information for that sequence event is dis-
played, see Figure 13.6.

Figure 13.6: Sequence event info

Click on sequence event block
Info Area to view parameters in info area
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The sequence event parameters from the 
info area, as shown in Figure 13.7, are 
described below:

Figure 13.7: Sequence event parameters in info 
area of Tracks Window

A Sequence/segment: This pop-up 
lists the name of the referenced 
sequence or segment. Choose from 
the pop-up to reference a different 
sequence or segment.

B Record: Use this toggle, which is 
only available for single-track 
sequence events, to record-enable the 
referenced track, which lets you 
record into the track from the parent 
sequence.

C Mute: This toggle mutes all tracks in 
the referenced sequence (for that 
sequence event).
Selected sequence events can also be 
muted by choosing Do>Mute>Mute 
Seq & Audio Events.

D Length: Specifies the duration of the 
sequence event. This value is inde-
pendent of the actual length of the 
referenced sequence or segment. For 
instance, you could have a sequence 
that is 32 measures long and only play 
the first 8 measures.
Click in the left or right edge of this 
field ( ) to turn looping on and off.
You can also change sequence event 
lengths graphically in the Track Over-
view section (see page 96).

1 23 4 5 6
7

8
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E Loop: If the sequence event is 
looped, this field determines how 
many times the material repeats.
You can also edit the number of 
repeats graphically in the Track Over-
view section (see page 96).

F Transpose: Click in this field to 
transpose the referenced material up 
or down by a specified number of 
semitones.
This lets you transpose a sequence’s 
playback without affecting the origi-
nal track material.

G Instrument: Use this pop-up, which 
is only available for single-track 
sequence events, to reassign the 
parent track’s Instrument.
A single-track sequence event always 
plays back with the parent track’s 
Instrument.

H Player: Determines the assigned 
Player for the sequence event. This 
parameter is only visible with the info 
area open.
In order for two sequence events to 
play at the same time in the same 
time track, they must be assigned to 
different Players. Each track can use 
up to 9 Players.

NOTE: A similar set of sequence event 
parameters can also be viewed and edited 
in the List Window. For details see 
Sequence Events in the List Window 
(pg. 103).
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With the info area open, you can view and 
edit the Play Quantize settings for single-
track sequence events. These settings are 
those of the track residing in the refer-
enced sequence or segment—all parent 
tracks referencing that sequence will be 
affected by changes.

Click the open/close triangle to open the 
info area in the Tracks and Pulse 
Windows.

Figure 13.8: Info area displaying Play Quantize 
settings for sequence event

For information on Play Quantize and 
other Quantize topics, see 
Chapter 10: Quantize, Shift, and Nudge.

NOTE: The Play Quantize settings for a 
parent track (which is separate and distinct 
from the tracks in the referenced sequence) 
do not affect how sequence event material is 
played.

The actual placement of sequence events, 
however, is affected by the parent track’s 
Play Quantize settings.

Click triangle to open info area
98
ARRANGING/EDITING 
SEQUENCE EVENTS

You can work with sequence event blocks 
in the Track Overview much like any 
other track data. Simply drag, copy, paste 
and nudge the sequence events blocks as 
desired. As mentioned on page 96, you 
can also graphically adjust the length or 
number of times the event loops.

NOTE: Deleting the sole remaining 
sequence event that points to a segment, 
automatically deletes that segment, remov-
ing it permanently from the Sequences 
Window. You can avoid this by unchecking 
Automatically Remove Unused Seg-
ments in the Sequences Window menu.

The Parent-Child Relationship

Generally, sequence event material acts 
as part of the parent sequence that con-
tains it. Even though referenced 
sequences and segments have their own 
Meter and Tempo tracks, these tracks are 
usually ignored when the material plays 
from a parent sequence. Instead, the 
meter and tempo information from the 
parent sequence is used.

NOTE: If a sequence’s Sync Mode is set to 
“Off,” it will use its Tempo track when play-
ing from a sequence event. See Sequence 
Controls (pg. 53) for details.
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Opts: Song Track and Keep Sequences 
End-to-End

Figure 13.9: Sequence event pop-up menu

When selecting a track that contains 
sequence events in the Tracks Window, 
the Opts pop-up menu displays the fol-
lowing options:

• Song Track
Check this option to copy the tempo 
information from the referenced 
sequences (in that track) to the 
parent sequence. This lets the parent 
sequence play back with the tempo of 
the referenced material. 
The parent sequence’s Meter and 
Tempo tracks are updated automati-
cally if any changes are made to the 
sequence events contained in the 
Song Track.
Each sequence can only have one 
Song Track. If you already have Song 
Track enabled for one track, enabling 
it for another track disables the 
option for the previous track.

• Keep Sequences End-to-End
When both Song Track and Keep 
Sequences End-to-End are checked, 
Vision keeps sequence event blocks 
neatly together, one after another 
(the end point of one sequence event 
is the start point of the following 
sequence event). This is a handy 
option when chaining together 
sequences to make songs.

Sequence event
pop-up menu
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Dragging, resizing, or changing the 
number of repeats for any sequence 
event block (as well as inserting or 
deleting sequence events), causes 
existing sequence events to move 
accordingly.

Also, the Meter and Tempo tracks of 
the parent sequence automatically 
change to match those of the 
sequence events residing in the Song 
Track. All meter, tempo, key, and 
marker events in the referenced 
sequences therefore end up in the 
parent sequence. In addition, a 
marker is automatically inserted at 
the beginning of each sequence event 
with the name of the referenced 
sequence or segment.
IMPORTANT: In order for a parent 
sequence to use both the Meter and 
Tempo tracks of the sequence events in 
the Song Track, both options in the 
Sequence Event pop-up must be 
checked.
anual 99



PART 4: Advanced Concepts
The Opts pop-up also displays “Song 
Track” and “Keep Sequences End-to-End” 
in the List Window of any track containing 
sequence events.

Figure 13.10: Sequence Event pop-up in List 
Window

For information about “Lock Event 
SMPTE Times”, see Opts Menu (pg. 262).

Editing the (Actual) Referenced 
Material

You can double-click a sequence event 
block to edit the referenced sequence or 
segment. Doing so opens a Tracks 
Window for the referenced material. If, 
however, you double-click a single-track 
sequence event, the default edit window 
opens instead.

NOTE: Double-clicking a single-track 
sequence event that references a drum track 
opens a Pulse Window.

Referenced material is displayed in edit 
windows in terms of its place within the 
parent sequence. For instance, if the 
sequence event starts at bar 5, each of its 
edit windows display barlines beginning 
with bar 5, using the parent sequence’s 
meter. The SMPTE times shown are 
based on the parent sequence’s SMPTE 
offset and tempo track. There are, how-
ever, two exceptions to this:
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• If Options>Local Sequence Times 
is checked, editing and playing a 
sequence event works independently 
of the parent sequence. Its SMPTE 
offset, markers, meter, and tempo will 
all affect display and playback. How-
ever, even in this case, playing the 
parent sequence still ignores meter 
and tempo information in the refer-
enced sequence or segment.

• If a sequence’s Sync Mode is set to 
“Off,” then its tempo is used when 
playing from a sequence event. How-
ever, the SMPTE and bar/beat/unit 
times shown in edit windows will still 
use those of the parent sequence—
unless Options>Local Sequence 
Times is checked.

NOTE: Double-clicking any sequence or 
segment from the Sequences Window will 
open it as a normal sequence. It will use its 
own Meter and Tempo tracks, and all edit 
windows will use “local” sequence times.

References

Remember, it is possible for a sequence 
or segment to be referenced by many 
parent sequences. Therefore, editing a 
referenced sequence or segment affects 
its playback in all parent sequences.

If you need to keep tabs on how a 
sequence or segment is referenced, just 
look in the Sequences Window. The Ref-
erences column lists each reference for 
both sequences and segments. Although 
the column displays just one reference at 
Opcode Systems, Inc.
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a time (the first one), you can click in that 
column for a complete pop-up listing of 
each track (along with its first bar occur-
rence) that references it. See 
Figure 13.11.

Figure 13.11: Pop-up of sequence event 
references
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Nested Sequence Events

A sequence event can contain other 
sequence events. This is known as having 
“nested” sequence events. However, this 
can lead to some confusion when double-
clicking a number of sequence events to 
make edits.

You can, however, check the nesting of 
sequence event material by Command-
clicking the title bar of its Tracks Window 
(or any edit window). A pop-up will show 
you the heritage of the sequence event(s). 
Choosing from the pop-up opens the 
Tracks Window for that sequence (or a 
List Window for a track).

For example, assume you have a 
sequence called “Chorus” that contains a 
track called “Track 1.” Within “Track 1” is 
a sequence event referencing a segment 
called “Ostinato.” Command-clicking the 
title bar of the “Ostinato” Tracks Window 
produces a pop-up menu as seen in 
Figure 13.12.

Figure 13.12: Nested sequence event

NOTE: The heritage pop-up menu only 
appears in edit windows when opening a 
sequence or segment by double-clicking a 
sequence event from a parent sequence.

Parent Sequence (ÒChorusÓ)

ÒOstinatoÓ segment

Track in ÒChorusÓ that
contains ÒOstinatoÓ 
sequence event
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Unmaking Sequence Events

This section describes how to unmake a 
sequence event—which is not the same 
as deleting it. When you unmake a 
sequence event, Vision takes the refer-
enced material and places it in the parent 
sequence.

To unmake a sequence event:

a Click on the sequence event block in 
the Tracks Window to select it.

b Choose Edit>Unmake Sequence 
Event.

The track material from the referenced 
segment is placed in the appropriate 
tracks in the parent sequence.

When unmaking sequence events, Vision 
places the track data in tracks with similar 
names and similar Instrument assign-
ments. This ensures that if you had 
originally turned track material into a seg-
ment from this parent sequence, the 
original data returns to its previous 
tracks.
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For each track in the sequence event that 
does not have a matching track in the 
parent sequence, Vision adds a new track 
at the bottom of the parent’s Tracks 
Window.

NOTE: If a segment has just one sequence 
event referencing it, unmaking that 
sequence event will automatically remove 
the segment permanently from the 
Sequences Window. You can avoid this by 
unchecking Automatically Remove 
Unused Segments in the Sequences 
Window menu.

IMPORTANT: If, in the Track Overview 
area, you select a sequence event block that 
overlaps with other events, Vision selects 
the overlapped events as well as the 
sequence event. When any events other than 
a sequence event are selected, the command 
in the Do menu read “Make Segment” 
rather than “Unmake Sequence Event.” To 
isolate the sequence event from the other 
events, open a List Window and select it 
there (see Sequence Events in the List 
Window (pg. 103)).
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SEQUENCE EVENTS IN THE 
LIST WINDOW

Sequence events can be inserted and 
edited from the List Window. The List 
Window displays a set of sequence event 
parameters very similar to those found in 
the info area of the Tracks and Pulse Win-
dows (see Sequence Event Parameters 
(pg. 96)).

Figure 13.13: Sequence event in List Window

While sequence events are transposed 
from the info area by a number of semi-
tones (+/-), transposing in the List 
Window is done by adjusting a transpose 
value around C3; set it to D3 for instance 
and the sequence plays back a whole step 
higher. And while sequence events can be 
muted and record-enabled from the info 
area, the List Window can only mute the 
sequence event.

To select a sequence event in the List 
Window, click on its selector dot, located 
to the left of its bar/beat/unit location. 
Another selector dot, directly to the left of 
the sequence name, can be double-
clicked to open an edit window for the ref-
erenced sequence or segment.
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Inserting Sequence Events in the 
List Window

Use the List Window’s Insert Event pop-
up to insert sequence events. When 
sequence events are inserted, they refer-
ence an existing segment or sequence. If 
there are no other sequences or segments 
in the file (aside from the parent), a new 
segment is automatically created when 
inserting the sequence event.

Sequence Event Types

Figure 13.14: Sequence Event submenu

Using Vision’s Players & Queue Window 
(see page 113), multiple sequences can 
be triggered for playback “on the fly.” 
And, you can use the Trigger modes from 
the Control Bar (page 185), or from an 
Input Map (page 326), for special gating 
effects and real-time transpositions.

This real-time interaction can be recorded 
into a track. What actually gets recorded 
are sequence events. In addition to basic 
sequence events (which is what most 
users will likely encounter), there are spe-
cial sequence event types that may show 
up in the List Window—depending on 
how the sequences were triggered.
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Each of the sequence event types, which 
can also be inserted from the Insert Event 
pop-up, are described below:

• Sequence Event
This is a basic sequence event; it 
stops all sequences playing on that 
Player and plays the referenced 
sequence.

• +Sequence Event
+Sequence events is similar to a basic 
sequence event, except that it does 
not stop sequences already playing 
on the Player. When you record a per-
formance in Trigger mode, the first 
key you play records a basic 
sequence event. Each additional 
(simultaneous) key you play records 
a +sequence event.
This way, if you play a three-note 
chord, three copies of the sequence 
play simultaneously. When you 
release it and play a new note, the 
three copies stop, and a new one 
begins. When you record a perfor-
mance in Continuous Trigger mode, 
each key you play records a 
+sequence event.

• Gated Sequence Event
A gated sequence event is displayed 
in the List Window with a ± sign. It is 
like a +sequence event, but it has a 
duration. It starts the current 
sequence playing on the current 
Player, transposed as indicated, and 
stops it after the duration indicated. 
Every note played in Gated mode 
records one gated sequence event.
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• Stop Sequence
A Stop Sequence event is recorded in 
Vision by typing Shift-Return during 
playback. It stops all sequences play-
ing on the indicated Player. 

• Transpose
This inserts a transpose event, not a 
sequence event. It transposes all 
sequences playing from the parent 
track, regardless of the Player being 
used. This event cancels any previous 
transposition value and sets a new 
one.

SUBSEQUENCES—THE OLD 
WAY

Vision 3.5 and earlier used to use subse-
quences, not segments. Instead of 
“making” segments, subsequences were 
made and they resided within their parent 
sequence. In addition, when inserting or 
step recording sequences, the referenced, 
original sequence was cloned and placed 
in the parent sequence. 

Subsequences did not appear in the 
Sequences Window. Therefore, the only 
way to view and edit them was to double-
click them from their parent sequence.

When opening older Vision files, each 
occurrence of a subsequence is converted 
into a segment, which then resides in the 
Segments Section of the Sequences Win-
dow. Also, within each parent sequence a 
sequence event is inserted that points to 
the newly converted segments.
Opcode Systems, Inc.
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Although the older files should play as 
before, realize that the new sequence 
events work as aliases that point to the 
sequences and segments in the 
Sequences Window.
Vision & Studio Vision Pro — MIDI Reference M
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GENERATED SEQUENCES

Generated sequences are a special class 
of sequences. Vision uses these 
sequences to generate new and interest-
ing music from existing notes and 
rhythms. 

Use generated sequences to create:

• ostinato patterns
• random percussion parts
• experimental track morphings 

(superimpose rhythms from one 
track onto pitches from another)

To open a new generated sequence, 
choose New Generated Sequence from 
the menu in the Sequences Window.

Figure 14.1: Generated Sequence Tracks Window

Attack Mode

Rhythm track
Note track Order pop-ups

Duration Mode
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The Generated Sequences Window has 
some similarities to the Tracks Window—
such as fields for Meter, Tempo and 
Sequence length, Edit In/Out points, and 
even a Record column (for an explanation 
of these items, please see Chapter 25: The 
Tracks Window).

NOTE: Generated sequences are listed in 
the Sequences section of the Sequences Win-
dow, and can also be saved as Sequence 
Templates.

Generated sequences consist of a Note 
track and Rhythm track. The Note track 
stores notes, chords, and even sequence 
events. The frequency at which the events 
in the Note track play back is determined 
by the Attack Mode; the durations for 
these events is determined by the Dura-
tion Mode.

If the Attack Mode pop-up is set to 
Rhythm track, the events in the Note 
track play back with the rhythms stored 
in the Rhythm track. The actual order in 
which the data in both tracks play is deter-
mined by the Order pop-up.

For right now you don’t need to know 
about all of the details for each of these 
options (they are discussed in Generated 
Sequence Components (pg. 109)). The 
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best way to learn about generated 
sequences is to actually make one and 
experiment with some of the possibilities.

Creating a Generated Sequence

The following example shows how to 
create a very basic generated sequence, 
one which uses the notes in a C major 
scale:

a Choose New Generated 
Sequence from the menu in the 
Sequences Window.

The Generated Sequences Window 
opens.

b Set the Record Mode pop-up in 
the Control Bar to Step Replace, 
then Record enable the Note 
track in the generated 
sequence.

c Click the Record button in the 
Control Bar.

Vision enters record mode and the Step 
Window opens. Set the Step Size to 
eighth notes.

d Using your MIDI controller, play 
in a C major scale (starting with 
C3 and ending with C4).

The notes are step recorded into the 
Note track.
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e In the pop-ups for Attack and 
Duration, select Note track.

This configures the Note track to play 
back with itÕs own rhythm and durations.

f Set the sequence length to 2 
and turn on loop. Click the Play 
button in the Control Bar.

The sequence loops through the notes in 
the C major scale.

g Next select Radom from the 
Note trackÕs Order pop-up.

The notes are played in random order.

h To break up the monotony of the 
Note TracksÕs rhythm, select 
Random in the Duration ModeÕs 
pop-up and set the fields to 1, 2, 
and 16th notes.

The notes are randomly played back 
every 8th or 16th note.

i Click the Stop button in the 
Control Bar to stop playing.
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The previous example represents just the 
tip of the ice berg in terms of possibilities 
for generated sequences. If desired, you 
could have recorded a Rhythm track and 
used it’s timing, even in random order. 
And instead of just single notes, you could 
have recorded chords or even sequence 
events into the Note track.

GENERATED SEQUENCE 
COMPONENTS

The following sections discuss each of the 
main components used in generated 
sequences, which include Attack Mode, 
Duration Mode, Note and Drum Tracks, 
and Order Mode.

Attack Mode

Figure 14.2: Attack Mode Pop-up

The Attack Mode determines how Vision 
generates the timing used for playing the 
notes from the Note track. The following 
choices are available from the Attack 
Mode pop-up:

Rhythm Track
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The Note track plays back with the 
rhythm of the Rhythm track. Use the 
Velocity value to influence the note veloci-
ties (100% uses only the Rhythm track 
velocities, 0% uses only the velocities in 
the Note track; intermediate values aver-
age the two). Click the Quantize toggle to 
enable Grid Quantize for the Rhythm 
track’s playback.

Note Track

The Note track plays back with its origi-
nal timing. Click the Quantize toggle to 
enable Grid Quantize for the Note track’s 
playback.

Constant

Notes from the Note track are played at a 
constant rate, as specified by the number 
of note values. In the above example, 
Vision generates a note every eighth note 
(i.e., every 2 sixteenth notes).

Random

Notes from the Note track are played at a 
random rate, based on the range specified 
in the fields. In the above example, Vision 
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generates a note every eighth note (1 x 8), 
quarter note (2 x 8), or dotted quarter 
note (3 x 8).

Duration Mode

The Duration Mode determines how 
Vision generates durations for the notes 
in the Note track. The following choices 
are available from the Duration Mode 
pop-up:

Rhythm Track

The durations from the Rhythm track are 
used for playing the notes in the Note 
track. Click the Quantize toggle to quan-
tize the durations in this track.

Note Track

The Note track plays back with its origi-
nal durations. Click the Quantize toggle to 
quantize the durations in this track.
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Constant

The notes in the Note track play with 
durations that are constant, as specified 
by the number of note values.

Random

The notes in the Note track play with 
random durations, as specified by the 
range in the fields. The above example 
randomly chooses between eighth notes 
(1 x 8), quarter notes (2 x 8), dotted quar-
ters (3 x 8), and half notes (4 x 8).

Constant Gap

The Note track plays back with a constant 
gap between each note. The gap size is 
specified by the number of note values 
(for instance, 2 eighth notes = 1 quarter 
note gap).
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Random Gap

The Note track plays back with a random 
gap between each note, as specified by 
the range in the fields.

Percent

The Note track plays back with note dura-
tions that are a percentage size. A value of 
100% results in legato; use over 100% for 
notes that overlap; durations under 100% 
result in gaps between the notes.

Random Percent

Similar to the Random setting, this option 
sets the durations to a random percentage 
value within the specified range.

FOR ILLUSTRATIONS of gap and percent 
settings, see the section on Duration 
(pg. 339) in Chapter 36: The Step 
Window.
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Generated Sequence Tracks

Tracks in a generated sequence include 
Meter, Tempo, Rhythm, and Note. Meter 
and Tempo tracks work just as they do in 
regular sequences. 

The Note and Rhythm tracks are 
recorded just like tracks are in the Tracks 
Window. You can also edit these tracks or 
paste data into them from other 
sequences.

Rhythm Track

The Rhythm track, which is optional, 
stores rhythmic patterns that can be 
assigned to the notes in the Note track. 
The Rhythm track is only used if the 
Attack Mode or Duration Mode is set to 
Rhythm Track. Otherwise, it is ignored.

When recording or pasting into the 
Rhythm track, the only events recognized 
are notes, chords, patch and sequence 
events (other data types are discarded). It 
is only the durations and spacings of 
these events that is significant—Vision 
ignores all other information during 
playback.

Note Track

The Note track stores the notes, chords, 
patch and sequence events that Vision 
uses to generate the sequence. The 
Rhythm Mode determines the spacing of 
the events, the Duration mode deter-
mines their durations.
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When recording or pasting into a Note 
track, Vision removes all events except 
notes, chords, patch events, and sequence 
events. The durations and spacings are 
not significant unless the Attack Mode or 
Duration Mode is set to Note Track. Oth-
erwise, the original durations and 
spacings are ignored.

Order Mode Pop-up

The Order Mode pop-up determines the 
order in which the contents of the Note 
track and Rhythm track are played. The 
choices available from this pop-up are:

• Forward plays track events in their 
original order.

• Reverse plays track events in reverse 
order.

• Alternate plays track events in their 
original order, then in reverse order. 
First and last events are only played 
once.

• Random plays track events in 
random order.
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Looping Generated Sequences

Figure 14.3: Click on the edge of the Order column 
to toggle a track’s loop mode

There are a few things you need to know 
about looping tracks in a generated 
sequence. Unlike normal tracks, the 
length of a track is not important in a gen-
erated sequence—the number of events 
is what matters.

An unlooped generated sequence stops 
playing after it has played all of the events 
in an unlooped Note track. However, if its 
Order Mode is set to Alternate, Vision 
plays twice as many notes since it plays 
through the data twice.

If the Note track is looped, the generated 
sequence plays for its Sequence Length 
(or indefinitely if the sequence is looped 
or set to infinity).

When using a Rhythm track that isn’t set 
to loop, the generated sequence stops at 
the end of the Rhythm track. This of 
course depends on the Order Mode of the 
Rhythm track, just like with the Note 
track.
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PLAYERS & QUEUE WINDOW

Sequences can be triggered for playback 
by typing their assigned key equivalent, 
or you can use the sequence’s MIDIKey. 
With the Players & Queue Window, you 
can “queue up” several sequences to audi-
tion a playback order, and you can even 
have multiple sequences playing at the 
same time on different “Players.”

Figure 15.1: The Players & Queue Window

Queue Mode

When the Queue option is checked, you 
can type up to 12 sequence letters, placing 
them in a “queue.” When the current 
sequence is finished playing, the next 
sequence in the queue is played. This is 
useful for auditioning different arrange-
ments of your sequences.

Player selection boxes

Playing sequences Waiting (queued) sequences

Queue checkbox
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NOTE: If you trigger a sequence whose 
length is set to infinity, that sequence will 
play forever (unless stopped) and other 
sequences in the queue will never play.

If the Queue option is unchecked and you 
type a new sequence letter, Vision stops 
the current sequence and plays the new 
one.

Players

The Players & Queue Window has up to 9 
Players, each of which can play its own 
sequence. Therefore you can have up to 9 
sequences playing simultaneously from 
the Players & Queue Window.

Each of the players has its own queue for 
up to 12 sequences. When Queue is 
enabled, typed sequences are entered 
into the queue of the currently selected 
Player. To switch to another Player, click 
on its number in the Players & Queue 
Window—or simply type the Player’s 
number.

NOTE: Typing a Player’s number switches 
to that Player only if the Players & Queue 
Window is open.
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NOTE: When using the Control Bar to play 
a sequence that has a record-enabled track, 
that sequence is not played by a Player. It 
therefore will not be interrupted by typing 
another sequence key.

Following is a short example of how to 
queue up multiple sequences from the 
Players & Queue Window:

a Choose Windows>Players & 
Queue.

The Players & Queue Window opens.

b Make sure the Queue option is 
checked (enabled).

c Select a Player by clicking its number, 
or by typing its number.

d Type the sequence keys youÕd like 
played on the current Player.

The first typed sequence plays and the 
others are placed in the queue.

e To play other sequences 
simultaneously, switch to a different 
Player and type the desired sequence 
keys.
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Sync Mode Affecting Playback

To trigger a sequence’s playback “on the 
beat,” instead of when you type the 
sequence letter, set the sequence’s Sync 
mode to Start. If you want the sequence 
to play with its own tempo setting, inde-
pendent of the Master Tempo, set the 
sequence’s Sync mode to Off.

Figure 15.2: Setting the Sync mode for a 
sequence

To view a sequence’s Sync mode, click 
the Information toggle ( ) in the Tracks 
Window. See Sequence Controls (pg. 53) 
for information on each of the Sync 
modes.

Stopping a Player

Typing the Return key stops all Players 
and clears all queues.

However, you can type Shift-Return to 
stop the sequence on the current Player. 
If there are more sequences in that 
Player’s queue, the next sequence in the 
queue begins playing.

Trigger and Transpose Modes

You can use Vision’s Trigger modes to 
affect how sequences play back when trig-
gered in real time. These special Trigger 
modes can be accessed from the Thru 
Instrument pop-up in the Control Bar 
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(see page 185), or they can be defined as 
part of a key zone in an Input Map (see 
page 326). Depending on the particular 
Trigger mode, sequences can be trans-
posed “on the fly” by playing different 
notes on your MIDI controller, or they 
can be gated with the duration of played 
notes.

Playing multiple sequences, with or with-
out the Trigger modes, can be recorded 
into a track. The events recorded are not 
actual notes but sequence events describ-
ing how the sequences were triggered for 
playback. For a description of the various 
sequence event types, see Sequence Event 
Types (pg. 103).

INPUT EFFECT WINDOW

The Input Effect Window processes notes 
from your MIDI controller. Depending on 
the mode of the Input Effect, the pro-
cessed notes are either repeated or 
arpeggiated. The rhythm of the notes 
played can use either Grid or Groove 
Quantize values.

Choose Windows>Input Effect to open 
the Input Effect Window:

Figure 15.3: Input Effect Window

1 2

3 4

5
6

7 8
9
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Following is a description of the compo-
nents in the Input Effect Window:

A Enable: Click this toggle button to 
enable the Input Effect.
The Input Effect can also be enabled 
by selecting Setups>Enable Input 
Effect. In addition, the Input Effect 
can be enabled “on the fly,” tempo-
rarily, with the Input Effect MIDIKey 
(see page 173).

B Input Effect type: This pop-up deter-
mines which Input Effect is used.
“Arpeggiate” plays the notes one after 
another, based on the setting in the 
Order pop-up. 
“Repeat” plays repeated notes.

C Latch: When checked, you can play a 
chord and remove your fingers from 
the keys—the input effect will con-
tinue to play until you strike a new set 
of notes.

D Sync to Counter: Check this option 
if you’d like the Input Effect to play in 
sync with the Counter (and current 
sequence).
The placement of the played notes is 
determined by the Spacing value. If 
it’s set to 8th notes, for instance, 
notes are played on every 8th beat.
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E Order: Determines the order of notes 
played with the Arpeggiate mode.
“Up” plays the notes in ascending 
order (lowest notes first).
“Down” plays the notes in descending 
order (highest notes first).
“Alternate” plays the notes up and 
then down. First and last events are 
played just once.
“Random” plays the notes in random 
order.

F Octaves: For Arpeggiate mode, 
expands the range of notes played by 
a specified number of octaves (up 
to 3).

G Spacing: Determines the rhythmic 
spacing of the played notes. Click on 
this pop-up to specify the duration 
when using Grid, or the “Groove 
Source” when using Groove.
Command-click the pop-up to switch 
between Grid and Groove. To see the 
full set of Spacing (Quantize) parame-
ters, click the open/close triangle.

H Duration: Specifies the duration of 
the played notes.
“Independent” sets the duration inde-
pendently of the Spacing size. The 
value can be specified by a note dura-
tion or number of units.
“Spacing Minus Gap” lets you set the 
rest space (gap) between notes. The 
gap can be specified by a note dura-
tion or number of units.
“Percent of Spacing” sets the duration 
to a specified percentage of the Spac-
ing size.
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I Open/Close Triangle: Click this 
toggle to open and close the lower 
portion of the Input Effect Window.

With the lower portion open, all of the 
Spacing’s Quantize parameters are 
accessible. For a description of these 
parameters, see Quantize Parameters 
(pg. 129).

Configuring the Input Effect 
Window

The following example shows how to con-
figure the Input Effect as an arpeggiator:

a Choose Windows>Input Effect.

The Input Effect Window opens.

b Enable the Input Effect by clicking its 
toggle, and set the mode to 
Arpeggiate.
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c Set the Spacing value to 16th notes.

If the Spacing mode is set to Groove, 
Command-click on the pop-up to switch 
to Grid.

d Set the Duration pop-up to Percent 
of Spacing.

Then type in a value of 50%. This will 
make the notes play back with a duration 
of 60 units (half that of the spacing), 
adding a staccato feel.

e Select Alternate from the Order 
pop-up.

f Enable the Latch option by clicking 
its checkbox.

g Play a chord on your MIDI controller.

The notes are played arpeggiated in for-
ward and then reverse order.

You donÕt have to hold the chord down 
since Latch is enabled.

Command-click on pop-up to
switch between Grid and Groove 
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h Play a different chord on your MIDI 
controller.

The previous set of notes from the first 
chord automatically stop and the new 
notes are arpeggiated.

i Enter a value of +1 in the Octaves 
field. 

The range of arpeggiated notes is dou-
bled by adding an octave for each note 
in the chord.

j To stop the Input Effect, uncheck the 
Latch option.

Recording with the Input Effect

If the Input Effect is enabled while record-
ing, notes played by the Input Effect are 
recorded. Enable Sync to Counter to 
ensure that each note is recorded pre-
cisely on the beat, or disable it if you want 
the notes recorded as you trigger them—
either way, the Input Effect uses the 
tempo of the recorded sequence (and the 
distance between the notes is determined 
by the Spacing settings in the Input Effect 
Window).

Setting the Input Effect to Repeat works 
well for recording repeated rhythmic 
notes and drum rolls. You can even apply 
aftertouch pressure to affect the velocity 
of the played notes (check the option for 
“Aftertouch Sets Effect Velocity” in the 
Settings Window). 
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For details on using the Input Effect while 
recording, see Drum Machine Style Loop 
Recording (pg. 45).
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Use the Select & Modify Window to per-
form precise and exacting selections and 
edits. This window offers such a wide 
range of capabilities you can even store 
and recall Select & Modify Templates 
with your favorite settings (see 
Chapter 20: Templates).

The Select & Modify Window has prima-
rily two functions: (1) to select data and 
(2) to modify it. The upper portion of the 
window determines the selection criteria 
for the data, the lower portion of the 
window determines the type of modifica-
tion performed. 

Figure 16.1: Select & Modify Window

Modify parameters

Select attributes

Modify type

Events type
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Since both portions of the Select & 
Modify Window can be opened and 
closed by clicking the corresponding 
triangle ( ), you can use either function 
of the window—or both.

When invoking some of the commands in 
the Do menu, the Select & Modify 
Window opens and is automatically con-
figured for that task. This is the case with 
Transpose, Quantize, Modify, Reassign, 
Set Instrument, and Substitute.

Figure 16.2: Set Instrument

If you choose Do>Select>Select by 
Rule, the Select & Modify Window opens 
with just the “Select” function activated.

Figure 16.3: Select by Rule 
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The Select & Modify Window can also be 
opened by choosing Windows>Select & 
Modify. Doing so opens the window in its 
most recent state.

No matter how the Select & Modify 
Window is accessed, its upper and lower 
portions can always be opened and 
closed. And you can always completely 
reconfigure either the selection criteria or 
the modify task as desired.

SELECT & MODIFY WINDOW

Figure 16.4: Select & Modify Window

Following is a brief description of the 
items in the Select & Modify Window:

A Event Type pop-up: Specifies the 
type of events from which to select. 
Depending on the range of events 
selected, these can include events 
(all), note events, audio events, and 
various automation events. 
The events available from this menu 
are those residing in the selected 
track or sequence. If the selected 
track or sequence contains more than 
one event type, “Events” appears 
selected by default.
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The item chosen in the Event Type 
pop-up determines which selection 
attributes are available in the Select 
area.

B Select area: Displays attribute lines 
that further define the selection.

 Click the add button to add an 
attribute line.

 Click the remove button to 
remove a line.

C Modify Type pop-up: Specifies the 
modify type used. The available 
Modify types in this pop-up menu are 
determined by what’s selected in the 
Event Type pop-up. See Modify Types 
(pg. 124) for a complete list.

D Modify area: Displays all parameters 
for the specified Modify type.

E Select button: Selects events based 
on the attributes listed in the Select 
area.

F Add To button: Adds events (match-
ing the attributes in the Select area) 
to the current selection.

G Refine button: Further refines the 
current selection using the attributes 
in the Select area.

H Modify button: Performs the modify 
function as described by the parame-
ters in the Modify area. The name of 
this button changes depending on the 
Modify type (Quantize, Move, Reas-
sign, Delete, etc.).
IMPORTANT: Clicking this button 
automatically selects the material 
based on the attributes in the Select 
area (if the Select area is open).
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I Double button: Performs the modify 
function on a copy of the selection, 
leaving the original data unaltered.
When the Modify type is set to Trans-
pose, this button is named 
Harmonize.
IMPORTANT: Clicking this button 
automatically selects the material 
based on the attributes in the Select 
area (if the Select area is open).

J Undo/Redo button: Undoes or 
redoes the most recent modify func-
tion. This command is also available 
at the top of the Edit menu.

IMPORTANT: If selected tracks or 
sequences contain sequence events, mate-
rial referenced by the sequence events is 
also affected by Select & Modify operations.

Select & Modify Buttons

The buttons in the Select & Modify 
Window are active even if the window is 
not in front. You can click on the Quantize 
or Transpose buttons, for instance, and 
the window won’t come to the front.
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SELECT ATTRIBUTES

The Event Type pop-up specifies the type 
of events selected from. Attribute lines 
allow further refinement of the selection. 
For instance, you could specify “Notes” in 
the Event Type pop-up and then you could 
add an attribute line for selecting only 
notes that fall within a certain velocity or 
pitch range.

Figure 16.5: Select Attributes

Click the add button (+) to add an 
attribute line in the Select area. The type 
of attribute is chosen from the pop-up in 
the new line. The line can be removed by 
clicking the remove button (-).

NOTE: The available attribute types is 
determined by what’s selected in the Event 
Type pop-up.

Adds new

Removes line

Attribute type

attribute line

Conditional

 Event Type
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Attribute Types

Following is a list of attribute types:

• Position: Selects events based on 
their location or time range.

• Event Type: Selects events based on 
their event type.

• Pitch: Selects note events based on 
their pitch range.

• Velocity: Selects note or audio events 
based on their velocity range.

• Duration: Selects note or audio 
events based on their duration.

• Value: Selects continuous controller 
events based on their value, or range 
of values.

• Instrument: Selects events based on 
their assigned Instrument.

• Position in bar: Selects events 
based on their quarter note/units 
position within a bar.

• Position in beat: Selects events 
based on their beat position, as speci-
fied by a number of units (+/-) from 
the beat boundary.

• Position is between bracketed 
events: Selects events that occur 
between two specified event types.

• Position in every group: Selects 
events based on their numeric posi-
tion within a sequential group of 
events (i.e. position in every group of 
“4” of these events is “3”).
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Attribute Conditions

Part of each attribute line is its conditional 
statement, which gives you even more 
flexibility in defining the selection. The 
following conditionals are available: 

• is
Includes events only if they have one 
specified value.

• is not
Includes events if their value is any-
thing except a particular value.

• is… or less
Includes events equal or less than a 
certain value.

• is… or more
Includes events equal or more than a 
certain value.

• is from… thru
Includes a range of events.

• is not from… thru
Excludes a range of events.

• is… or
Includes two different values to 
search for.
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Making a Selection

The following example illustrates some of 
Vision’s selection capabilities.

In this example we want to select some 
hihat notes that are too loud so we can 
edit just them, and not the other notes in 
the track. We know that they are some-
where in bar 2 and have velocities around 
100 or higher.

a Select the desired track and choose 
Do>Select>Select by Rule.

The Select & Modify Window opens con-
figured for Select.

b Click the add button (+) to add an 
attribute line.

c Make the new line read Position is 
from.

Specify Ò2¥1¥0 thru 3¥1¥0Ó for the Position 
range.

This determines that we will only select 
notes from bar 2.

d Add another attribute line and make it 
read Pitch is F#1.

This specifies that only the hihats (F#1) 
are selected.
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e Lastly, add a line that reads Velocity 
is 100 or more.

This last line specifies that only notes 
with velocities equal to 100 or more are 
selected.

f Click the Select button to make the 
selection based on the defined 
attributes.

The notes are selected based on the 
specified attributes.

Figure 16.6: Selected notes in Graphic 
Window

Figure 16.7: Selected notes in List Window

Selected notes
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MODIFY TYPES

The Modify Type pop-up determines 
which modify operation is performed, and 
which parameters are displayed in the 
Modify area.

NOTE: The available Modify types are 
determined by what’s selected in the Event 
Type pop-up.

Figure 16.8: Modify type and parameters

The following Modify types are available:

• Transpose: Transposes or remaps 
the pitches of selected note events 
with any of 9 Transpose types (dis-
cussed on page 134).
Click the Harmonize button to trans-
pose a copy of the selected material, 
leaving the original data unaltered.

• Change Velocity: Adjusts the veloci-
ties of the selected note or audio 
events.

• Change Release Velocity: Adjusts 
the release velocities of the selected 
note events.

• Change Duration: Adjusts the dura-
tions of the selected note or audio 
events.

Modify parameters

Modify type
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• Quantize: Quantizes the specified 
events with either Grid or Groove 
Quantize. 
NOTE: When “Events” is selected in 
the Events Type pop-up, Quantize only 
affects note, audio, and sequence 
events. All other event types (like con-
tinuous controllers) must be specified 
in the Events Type pop-up before they 
will be Quantized.
For a description of each Quantize 
parameter, see Quantize Parameters 
(pg. 129).

• Change Value: Adjusts the values for 
the selected continuous controller 
events. For details, see Modifying 
Note Properties and Automation 
Values (pg. 126).

• Set Density: Adjust the density of the 
selected continuous controller 
events. For details, see Set Density 
(pg. 127).

• Reassign: Changes one continuous 
automation type (MIDI controllers, 
pitch bend, aftertouch, velocity scale, 
audio volume and pan, send levels, 
continuous EQ parameters, and con-
tinuous plug-in parameters) to 
another. For details, see Reassign 
(pg. 127).

• Move: Moves selected events to a 
specific location, or by any increment 
forward or back. For details, see 
Move Events (Command-,) (pg. 413).
Click the Double button to move a 
copy of the selected data, leaving the 
original data unaltered.
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• Trim Start Time: Changes the start 
times of note and audio events with-
out changing their end times. For 
details, see Trim Start Time 
(pg. 129).

• Set Instrument: Sets the Instrument 
for selected events. For details, see 
Set Instrument (Command-I) 
(pg. 418).
Click the Double button to assign a 
copy of the selected data to a new 
Instrument.

• Substitute: Replaces selected events 
with the contents of the Clipboard. 
For details, see Substitute (pg. 419)

• Delete: Deletes the selected events.

SELECT & MODIFY MENU

Figure 16.9: Select & Modify Window

The following commands are available in 
the Select & Modify Window menu:

Save Settings

Stores the configuration of the Select & 
Modify Window to the currently selected 
template.

Select & Modify
Templates
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Save Settings As

Stores the configuration of the Select & 
Modify Window to a new template. With 
this command you are prompted to name 
the new template.

Delete Template

Deletes the currently selected template.

Load From

Lets you load a set of templates from a 
Vision Editing Templates file that is not 
current. The loaded templates are 
merged with the current set.

Templates

The current set of templates is listed at 
the bottom of the Select & Modify menu. 
These templates represent those stored in 
the Vision Editing Templates file.

NOTE: The items listed in the Select & 
Modify menu are also available from the 
Do menu (when the Select & Modify 
Window is the active window).
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MODIFYING NOTE PROPERTIES 
AND AUTOMATION VALUES

With the Modify Type pop-up set to 
Change Velocity, Change Release Veloc-
ity, Change Duration, or Change Value, 
the following operations are available:

• Set to
Sets the note property or continuous 
controller value to a specified 
amount.

• Scale by
Scales the note property or continu-
ous controller value by a specified 
percentage.

• Add
Adds to the note property or continu-
ous controller value by a specified 
amount.

• Max Limit to
Note properties or continuous con-
troller values above the Max Limit 
value are reduced to that value. 

• Min Limit to
Note properties or continuous con-
troller values below the Min Limit 
value are increased to that value. 
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• Compress
Compresses or expands the data 
range while keeping the relationship 
between existing events proportional.
With this command you can specify 
an upper and lower region for which 
events are selected, and an upper and 
lower region for the range of 
compression.

• Set Legato to 
(Change Duration only)
Modifies the space between notes by 
a percentage of the distance between 
their note-on locations.

Change Methods

When modifying note properties or con-
troller data, values can be specified as 
Constant, Changing, or Oscillating:

Constant sets a constant data value for all 
events within the selected time range. 
This is just like using the Flat drawing 
shape in the Strip Chart (see page 247).

Changing sets a start and end value for 
the selected range of data. The shape 
determines how values are drawn for 
events between the start and end points. 
For a description of the Change shapes, 
see The Edit Shapes Pop-up (pg. 246).
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Figure 16.10: Changing Values

Oscillating sets a start and end value for 
the selected range of data. The oscillator 
determines how values are drawn for 
events between the start and end points. 
The period of the oscillator is specified by 
a number bars, beats, or units. For a 
description of each oscillator type, see 
Oscillator Shapes (pg. 247).

Figure 16.11: Oscillating Values

Controller Values

When the Change is modifying controller 
values, you can also specify the density of 
the data, and which Instruments are 
affected. See Figure 16.12

Figure 16.12: Options for Changing Controller 
Values
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SET DENSITY

The density of data for continuous con-
troller events (MIDI controllers, pitch 
bend, aftertouch, and other automation 
events) can be modified with Set Density.

Figure 16.13: Set Density

The selected data is affected by the speci-
fied percentage (of the MIDI data 
stream). If the original events were 
entered at 5%, for instance, using Set Den-
sity with 10% would make the data twice 
as dense.

NOTE: Set Density is only available if the 
Event Type pop-up in the Select Area is set 
to a continuous controller type.

REASSIGN

Reassign changes one continuous control-
ler type (MIDI controllers, pitch bend, 
aftertouch, velocity scale, audio volume 
and pan, send levels, continuous EQ 
parameters, and continuous plug-in 
parameters) to another.

Continuous paramenters are those param-
eters that have a numerical range of 
values. Parameters whose possible set-
tings are on/off, etc. are not continuous, 
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and will not enable the Reassign com-
mand or appear as destinations that 
continuous controllers can be assigned to.

Figure 16.14: Reassign

Events can be changed to any MIDI con-
troller, pitch bend, aftertouch, velocity 
scale, audio volume and pan, send level, 
continuous EQ parameter, or continuous 
plug-in parameter(if a plug-in is assigned).

NOTE: Reassign is only available if the 
Event Type pop-up in the Select Area is set 
to a continuous controller type.

Reassign submenus have the following 
options:

• MIDI

Contains pitch bend, aftertouch, poly 
aftertouch, velocity scale, a generic 
“controller” option, and the eight 
Favorite Controls (as defined in the 
Settings window. When “Controller” 
128
is selected, controller #7 (Volume) is 
chosen by default. You can then click 
on “Volume” and select a new control-
ler from the pop-up that appears.

• Automation

Contains audio volume, audio pan, 
and send levels.

• EQ Band Parameter

Contains only continuous EQ parame-
ters. Note that EQ Type and Enable, 
the other two EQ parameter types 
that are available in the List window, 
are not available here because they 
are not continuous events.

• Plug-in Parameter

Contains the names of plug-ins 
assigned to audio instruments in the 
sequence. After choosing a plug-in, 
another pop-up appears to the right 
displaying the selected plug-in’s 
parameters. Because of the way that 
VST plug-ins are written, all parame-
ters are considered continuous, so all 
parameters are listed in this pop-up.
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Depending on the event types chosen in 
the Select and Reassign areas, another 
pop-up menu may appear asking which 
instrument the events should be reas-
signed to. The Instrument may be Audio 
or MIDI, depending on the event type 
chosen in the Reassign area. If the instru-
ment pop-up is not shown, the reassigned 
events will be assigned to the same instru-
ment that the selected events were 
assigned to in the first place.

For example, if you wish to reassign audio 
volume to audio pan, the Instrument pop-
up won’t appear because audio pan 
defaults to the same Instrument that the 
selected audio volume is assigned to.

If, on the other hand, you wish to reassign 
audio volume to mod wheel (MIDI con-
troller #1), the Instrument popup will 
appear.

The default Instrument (the Instrument 
that the selected events are assigned to 
before the Reassign command is exe-
cuted) is an Audio Instrument, and MIDI 
controllers cannot be assigned to Audio 
Instruments. So, you are prompted to 
select a MIDI instrument. Click and hold 
on the Instrument name to see a pop-up of 
available instruments.
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TRIM START TIME

This command changes the start times of 
note and audio events without changing 
their end times.

Figure 16.15: Trim Start Time

You can trim the start times earlier or 
later by a specified amount, or you can 
move them to start at a precise location. 
Values for the move can be in “bars & 
beats” or “SMPTE time,” as specified by 
the Trim by pop-up.

QUANTIZE PARAMETERS

This section describes the Quantize 
parameters for both Grid and Groove. In 
addition to the Select & Modify Window, 
the Quantize parameters are found in the 
info area (of the Tracks and Pulse Win-
dows) when viewing track Play Quantize 
settings, and in the Input Effect Window’s 
Spacing settings.

NOTE: For a more general discussion of 
Quantize procedures, for both Grid and 
Groove, see Chapter 10: Quantize, Shift, 
and Nudge.

For information on Quantize Templates 
and creating or modifying the Vision 
Grooves file, see Chapter 20: Templates.
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Use the Quantize Type pop-up to switch 
between Grid and Groove. The available 
parameters change depending on the 
selected Quantize type.

Figure 16.16: Quantize Type pop-up

Grid Parameters

Figure 16.17: Grid Quantize parameters

Quantize Value

When using Grid, the Quantize Value 
determines the grid size used for the 
quantize. This value can be specified with 
a duration from the note pop-up, or with a 
number of units.

Figure 16.18: Quantize Value

If you enter a value in the units field that 
is not an equal subdivision of the beat, the 
note pop-up shows a “>” or “<” symbol 
along with the current note size, which 
indicates the approximate value.

Tuplet

Check the Tuplet option to define the 
grid size as a tuplet.
130
Figure 16.19: Tuplet option for Grid Quantize

The grid size is calculated from the Tuplet 
fields and the Quantize Value. If the 
Quantize Value is set to 8th notes, for 
instance, and the Tuplet specifies “5 in 
time of 1,” then the grid size is equal to 
one fifth of the 8th note value (or 48 
units).

Strength

The Strength setting determines how far 
notes are moved from their current loca-
tion toward the quantize boundary. There 
are no negative settings.

• A setting of 100% aligns selected 
notes on the quantize boundary.

• A setting of 0% leaves the notes 
unchanged.

• Other settings move selected notes 
the specified percentage toward the 
quantize boundary from their current 
location.

Sensitivity

The Sensitivity setting defines a region 
in which notes are either selected (posi-
tive values) or excluded (negative values) 
from being quantized. 
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The Sensitivity value is expressed as a 
percentage that, at a maximum setting of 
±100%, defines a region equal to the Quan-
tize Value. This region extends half the 
distance from the quantize boundary to 
the next and previous quantize bound-
aries, respectively (see Figure 16.20). 

NOTE: Since this maximum region exists 
for every quantize boundary in the area 
selected for quantization, neighboring 
regions are contiguous.

Figure 16.20: The area delineated by a Sensitivity 
setting of ±100% for a Quantize Value of 8th note

Positive and negative values for Sensitiv-
ity define the same region but perform 
inverse actions, both achieving useful but 
different musical effects:

• Positive values: Notes located 
within the region defined by the 
selected percentage are quantized. 
Notes beginning outside this region 
remain unchanged. 
This synchronizes notes near the 
quantize boundary but treats notes 
further from the boundary as deliber-
ate phrasing accents.

Quantize 
boundary

halfway to previous and next
quantize boundaries
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• Negative values: Notes located 
within the area defined by the 
selected percentage remain 
unchanged. Notes outside this region 
are quantized.
This considers notes close to the 
quantize boundary as deliberate 
phrasing accents and treats notes out-
side the region as mistakes.

• -100%: Although this setting creates 
the maximum region size, no quan-
tize occurs.

• 0%: No quantize occurs.
• 100%: All notes are selected for 

quantize.

For example, a 50% Sensitivity setting 
applied to a Grid Quantize Value of 8th 
notes defines an area 120 units wide (50% 
of an 8th note), extending 60 units ahead 
and behind the quantize boundary. 
Figure 16.21 illustrates this region. Notice 
that the note is not selected because it 
doesn’t begin in the region.

Figure 16.21: 50% Sensitivity setting with a Grid 
Quantize Value of 8th notes

When using Groove Quantize, the regions 
created from a Sensitivity setting may be 
unequal in size. They may also surround 
the quantize boundaries asymmetrically 
due to the irregular size of the grid ele-
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ments created from the Groove Source. 
Although the exact region is harder to 
define, it doesn’t change the way the Sen-
sitivity works. See Groove Parameters 
(pg. 133).

Smear

Smear adds randomness to the selected 
notes by moving them backward or for-
ward in time after the defined quantize 
occurs. Values are selected randomly 
within the range specified by the Smear 
percentage to the Quantize Value. 

For example, a smear value of 50% with a 
Quantize Value of quarter notes could 
result in a note appearing up to a 16th 
note before or after the quantize bound-
ary. Smear also affects durations if 
Quantize Durations is checked.

Shift

The Shift setting is applied after the 
defined quantize operation occurs. Shift 
values range between -999 and 999 units.

• A negative shift moves the post-quan-
tized notes earlier in time.

• A positive shift moves the post-quan-
tized notes later in time.
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Swing

Jazz musicians often play written 8th 
notes with a “swing” feel resulting in pairs 
of notes with durations between the trip-
let and dotted rhythms (see 
Figure 16.22). Other durations can also 
be swung but 8th notes are the most 
common. 

Figure 16.22: Triplet and dotted representations 
for swung 8th notes

The two notes occupy the same amount of 
time as two “straight” durations, but their 
relative durations are different. The 
Swing setting shifts every other quantize 
boundary in the selection forward or 
backward in time to reflect the unequal 
division of duration between each pair of 
notes. A swing value of 50% is the same as 
no swing at all. Raise the swing percent-
age to add a swing beat.

Quantize Durations

If this option is checked, the durations of 
notes are quantized to the closest multiple 
of the Quantize Durations amount. This 
number is also the minimum note size—
notes will not be quantized to zero.

written 8th notes
are often ÒswungÓ
and played as...

triplet... or... dotted pairs
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The Duration Quantize Value does not 
necessarily have any relation to the Quan-
tize Value, but the default amount is the 
same. The procedure for setting Quantize 
Duration parameters is the same as dis-
cussed in Quantize Value (pg. 130).

Groove Parameters

Figure 16.23: Groove Quantize parameters

Groove Source

Groove Quantize can dramatically 
improve the musical integrity resulting 
from a quantized performance by using 
irregular, non-linear quantize boundaries 
derived from a “Groove Source.” A 
Groove Source is a normal Vision track 
selected from a sequence stored in the 
“Vision Grooves” file (a normal Vision 
document that must be located in the 
same folder as the Vision application). 
The notes in the Groove source act as a 
rhythmic template by imposing their 
rhythmic values in a one to one corre-
spondence with the notes in the track 
being quantized. 

Select any sequence from the Vision 
Grooves file from the Seq pop-up. Each 
track in the selected sequence becomes 
available as a Groove Source from the 
Track pop-up. 

The Sensitivity, Strength, Shift, and 
Smear parameters work as previously 
discussed in Grid Parameters (pg. 130).
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Duration and Velocity

The Duration and Velocity fields allow 
the durations and velocities of notes in the 
Groove Source to influence the quantize. 
Resulting values for both fields are calcu-
lated in the same manner:

• A value of 100% uses the velocities or 
durations from the Groove Source.

• A value of 0% leaves durations or 
velocities unchanged.

• Intermediate values combine the 
velocities or durations of the Groove 
Source track and the track being 
quantized: 
Let X be the percentage in the Dura-
tion (or Velocity) field; D is the 
duration value for the note in the 
Groove Source; Q is the duration 
value in the track being quantized. 
The resulting value used is equal to 
X • D + (100 - X) • Q. 

For example, if a note in the Groove 
Source has a duration of 80 units, and the 
corresponding note in the track being 
quantized has a duration of 100 units, and 
the Duration field is set to 75%, then the 
actual duration used is 
.75(80) + (1.0 - .75)(100) = 85 units.
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TRANSPOSE TYPES

This section discusses each of the differ-
ent Transpose types and their parameters. 
The Transpose parameters appear in the 
Select & Modify Window, and when 
assigning a Transpose Map in the Instru-
ments Window.

NOTE: For a general discussion of Trans-
pose operations, see Chapter 11: Transpose. 
For details on creating Transpose Tem-
plates, see Chapter 20: Templates.

Use the Transpose Type pop-up to specify 
which type of transpose is used. The avail-
able parameters change depending on the 
selected Transpose type.

Figure 16.24: Transpose Type pop-up
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Chromatic

Figure 16.25: Transpose type set to Chromatic

Transposes up or down by a specified 
interval (also displayed as a number of 
semitones). Enter a value in the Octaves 
field to extend the transposition by a 
number octaves. 

Interval

Figure 16.26: Transpose type set to Interval

Transposes chromatically by semitones, 
as expressed by the difference between 
the two specified pitches. 

Diatonic

Figure 16.27: Transpose type set to Diatonic

Transposes up or down by scale degrees 
in a specified key and scale type. Enter a 
value in the Octaves field to extend the 
transposition by a number octaves. 

Click the Constrain to Scale option to 
restrict all transposed notes to the speci-
fied key and scale.
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Invert

Figure 16.28: Transpose type set to Invert

Creates a mirror transposition (chromati-
cally or diatonically) around a specified 
pitch.

Figure 16.29: Invert Transpose, chromatically

Use the diatonic version of Invert to 
ensure that the transposed notes stay in 
the specified key and scale.

Key/Scale

Figure 16.30: Transpose type set to Key/Scale

Transposes from one key and scale type 
to another. Enter a value in the Octaves 
field to extend the transposition by a 
number octaves. 

Click the Constrain to Scale option to 
restrict all transposed notes to the speci-
fied key and scale.

Before transpose

After transpose
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Auto Map

Figure 16.31: Transpose type set to Auto Map

Lets you specify the number of notes per 
octave for source and destination maps. 
Use Auto Map to:

• Transpose all notes to just one note 
with a 128-note octave mapped to a 
1-note octave.

• Perform obscure transpositions like a 
24-notes per octave scale to a 12-notes 
per octave scale.

• Use an Instrument Transpose Map 
play semitones on a device tuned to 
quarter-tones.

Octave Map

Figure 16.32: Transpose type set to Octave Map

Octave Map is the same as Auto Map 
except you can specify which notes are 
contained in the destination octave. To 
change a destination pitch, click in the 
fields located in the scrollable Map area.
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Manual Map

Figure 16.33: Transpose type set to Manual Map

Remaps any of the 128 MIDI pitches to 
any other pitch. To change any destina-
tion pitch, click in the fields located in the 
scrollable Map area.

Drum Map

Figure 16.34: Transpose type set to Drum Map

Remaps drum assignments from one 
Instrument to another. Drum Map is 
essentially the same as Manual Map 
except that note names are displayed 
instead of pitches.

This Transpose type is very useful for 
remapping tracks in Vision so they play 
correctly from one device to another. For 
instance, if you have a track assigned to 
your Roland R-8, you could use a Drum 
Map to make it play back correctly on 
your Korg M-1.
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A Drum Map can be used destructively 
with the Transpose command (perma-
nently altering the note data), or for 
playback only as a Transpose Map 
assigned in the Instruments Window.
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Reclock
VIRTUAL CONDUCTING—
RECORDING TEMPO CHANGES

Recording a MIDI performance usually 
means playing along with a metronome. 
Of course you don’t need to—but if you 
don’t, Vision has no reference for accu-
rately displaying and editing your tracks.

Vision can, however, address material 
recorded without a metronome using the 
Reclock command (see page 142). You 
can also use the Scale Time command 
(see page 140) for global or bar-by-bar 
tempo adjustments. 

If you use a metronome while recording, 
you may notice that your performances 
can sound somewhat stiff. The following 
sections illustrate three ways you can 
manually record tempo changes to add a 
“human feel” to these performances—
allowing you to “conduct” a sequence 
after you have recorded it, speeding up 
and slowing down whenever you want.

Changing the Tempo in the 
Control Bar’s Tempo Display

If you mute the Tempo track in the cur-
rent sequence, you can use the Control 
Bar’s Tempo Display to change the 
Master Tempo. If you change the Master 
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Tempo while recording, Vision records 
these changes as tempo events to the 
sequence’s Tempo track.

To record tempo events from the Control 
Bar’s Tempo Display:

a Record-enable the Tempo track in the 
Tracks Window.

b Mute the Tempo track in the Tracks 
Window.

The Control BarÕs Tempo Display 
becomes editable.

c Set the Begin Record toggle to 
Countoff.

d Click the Record button.

e Highlight the Tempo Display and set it 
to the desired tempo as the sequence 
plays.

You can use the plus and minus keys on 
the Macintosh keypad, or you can click 
and drag with the mouse.

f When finished recording, click the 
Stop button.
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Tapping the Tempo

You can set the tempo in the Control 
Bar’s Tempo Display by tapping the 
single quote (‘) key on your Macintosh 
keyboard—you can even record this into 
the sequence’s Tempo track. When tap-
ping the tempo, Vision averages the last 
four taps.

To record a tapped tempo:

a Record-enable the Tempo track in the 
Tracks Window.

b Mute the Tempo track in the Tracks 
Window.

c Set the Begin Record toggle to 
Countoff with a value of perhaps 6 to 
8 bars.

This ensures enough time to get the feel 
of the desired tempo.

d Click the Record button.

e Tap the single quote key (Ô) on your 
Macintosh keyboard at the desired 
tempo.

f When finished recording, click the 
Stop button.

Using MIDIKeys you can map any MIDI 
event to the single quote key, thereby 
allowing you to use it as the source of the 
tempo tapping. See The MIDIKeys 
Window (pg. 171) for details.
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Using a Fader to Record Tempo 
Changes

You can also assign a fader to control the 
Master tempo. Then, while recording, just 
move the fader to record the tempo 
changes:

a Record-enable the Tempo track in the 
Tracks Window.

b Mute the Tempo track in the Tracks 
Window.

c Choose Windows>Faders.

The Faders Window opens.

d Assign the Tempo field to F1 and set 
the Settings field to Send.

To ensure the maximum fader resolu-
tion, enter an approximate range of 
tempos in the Range field for the 
tempos you will record.

e Set the Begin Record toggle to 
Countoff and then click the Record 
button.

f While the sequence plays, drag the 
F1 Fader to record the new tempo 
events.

g When finished recording, click the 
Stop button.
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CHANGE TEMPO

In addition to setting a tempo for a range 
of measures, the Change Tempo com-
mand lets you:

• Fit a range of measures into a precise 
time range;

• Create tempos that smoothly acceler-
ate or ritard;

• Scale existing tempos.

Choose Do>Change Tempo to open the 
Change Tempo dialog:

Figure 17.1: Change Tempo dialog

Following is a description of the various 
options in the Change Tempo dialog:

A Tempo
Select this radio button to enter a 
tempo (or tempo change range) in 
the accompanying Tempo fields for 
the specified Bar•Beat•Unit range.
The new time range is automatically 
calculated (based on the specified 
tempo) and is displayed in the Time 
Range fields.

1
2

3
4
5
6
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B Time Range
Select this radio button to enter a 
time range in the accompanying time 
fields for the specified 
Bar•Beat•Unit range. 
The new tempo is automatically calcu-
lated (which makes possible the new 
time range) and is displayed in the 
Tempo field(s).

C Bar•Beat•Unit range
These fields determine the 
Bar•Beat•Unit range affected.
When opening the Change Tempo 
dialog, the Edit In/Out points define 
this range.
Entering a new value in the Start field 
automatically updates the corre-
sponding field in the Time Range 
row.

D Use constant tempo
This option sets a constant tempo for 
the entire Bar•Beat•Unit range.

E Accelerate/Ritard from initial 
tempo
This option creates a series of linear 
(smooth) tempo changes between 
the Start and End tempos.

F Scale existing tempos
With the Tempo radio button 
selected, this option scales existing 
tempo events by a specified average 
tempo amount.
With the Time Range radio button 
selected, this option scales existing 
tempo events (while keeping them 
relative to one another) so they fit in 
the specified Time Range.
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You can use the Strip Chart to visually 
draw a tempo change (see page 250). If 
Exact Mode is enabled, the Change 
Tempo dialog automatically opens when 
inserting or editing tempo events in the 
Strip Chart.

NOTE: Change Tempo always preserves 
the metrical placement of events residing in 
the affected time range.

SCALE TIME

The Scale Time command compresses or 
expands the time range for selected 
events. It is most often used to fit a musi-
cal passage into range of time (sometimes 
the for the sake of conforming it to bar 
and beat lines).

NOTE: Scale Time changes the metrical 
placement for all events residing within the 
specified time range of the selected tracks. 
To affect all events in the sequence, use the 
Track Overview to define the selection.

Choose Do>Scale Time to open the 
Scale Time dialog:

Figure 17.2: Scale Time dialog

1
2

3

4 5

6
7
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A Old Start/End Time
These fields define the time range of 
events that will be scaled.

B New Start/End Time
These fields define the new time 
range in which the selected events 
will fit.

C Duration (Old and New)
These fields display the actual length 
of the Old and New time ranges. 
Editing these fields automatically 
updates their corresponding End 
Time fields.

D Display
This pop-up determines the time 
format (SMPTE or Bars/Beats) dis-
played in the Start, End, and Duration 
fields. 

E Scale Factor
Indicates the amount the selected 
events are scaled. Changing this field 
automatically updates the New End 
Time field, and vice versa.

F Insert Tempos to maintain timing
If you are happy with the speed at 
which the current selection plays, 
check this option and Vision inserts 
the necessary Tempo events so that 
the original timing is retained.

G Restore original tempo
Check this option and Vision will 
insert a tempo event (equal to the 
original tempo) at the End Time. This 
ensures that material residing after 
the End Time plays back as it did 
before using the Scale Time 
command.
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Using Scale Time
(to fit an audio loop)

The following example scales time to fit a 
1-bar audio loop. Although we’re not sure 
of the actual tempo of the audio, we can 
use Scale Time to fit the audio (without 
altering it) perfectly into 1 measure in 
Vision:

a Select the desired track block in the 
Track Overview area and choose 
Do>Scale Time.

The Scale Time dialog opens.

Notice that the Start/End fields are auto-
matically set based on the Edit In/Out 
points.

b Enter 2¥1¥0 into the New End Time 
field.

Notice that the Scale Factor field is auto-
matically updated based on the New End 
Time.
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c Check the option for Insert Tempos 
to maintain timing.

In addition, make sure to uncheck the 
option for Restore original tempo 
at End Time.

d Click the Scale button.

A new tempo is calculated and automati-
cally inserted at the Start Time. As a 
result, the audio block now fits cleanly 
into one measure.

Scaling Time in the Ruler

You can also Scale Time in the Ruler of 
the Graphic and Notation Windows. 
Rather than aligning music to bars, you 
can drag individual bar and beat lines to 
line up with your music.

If there are events selected, scaling time 
in the Ruler adjusts the duration and 
placement of those events so they line up 
with the bar and beat lines. If there are no 
events selected, Vision inserts the neces-
sary tempo events to retain the original 
timing of the events in that bar.
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The following example shows how to drag 
a bar line to align four notes (previously 
recorded without listening to the metro-
nome) to the beat. These notes start at 
around 2•1•0 and need to be adjusted so 
they take up that entire measure (ending 
at around bar 3).

a Open the Graphic Window and Shift-
click the desired notes so each is 
selected.

b Position the cursor in the Ruler over 
the bar/beat indicator of 3¥1.

c Then press and hold the Option and 
Shift keys so the Scale Time cursor 
appears.

Unless you position the cursor over a 
quarter note indicator, it will become the 
hand cursor. Otherwise, the cursor will 
indicate that you can now scale the 
selected time.

d Click and drag the bar line so it lines 
up with the end of the last note. 
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Then release the mouse button.

The new bar line is drawn and the dura-
tion and placement of the selected notes 
are adjusted (scaled) so they align with 
each beat. 

NOTE: If the notes had not been selected, 
Vision would have also inserted the neces-
sary tempo changes so that their original 
timing was retained.

RECLOCK

Reclock takes a sequence recorded with-
out a metronome (or from an audio 
source) and aligns it to bars and beats by 
conforming it to a click track. You can use 
material already in the sequence as the 
source of the click track, or you can 
record a click track while listening to the 
sequence.

Reclocking scales the time of all tracks in 
the sequence so that the click events end 
up as exact bars and beats. It also modi-
fies the Tempo track to preserve 
sequence playback.

For step-by-step instructions on using the 
Reclock command, see Reclocking to a 
Click Track (pg. 144).
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Choose Do>Reclock to open the Reclock 
dialog:

Figure 17.3: Reclock dialog

Following is a description of the various 
options in the Reclock dialog:

A Clicks on downbeats only
Select this option to reclock the first 
beat of each measure, instead of 
every beat. The number of beats in 
each measure is determined by the 
current meter of the first bar of the 
sequence. All other meter events are 
ignored.

B Same click on every beat
For maximum flexibility in express-
ing the tempo, select this option to 
reclock each click event on each beat.

C Different click on downbeat
If your sequence has varying meters, 
you can have Vision automatically 
create a Meter track from your click 
events. In this mode, you must use 
two click events: one for the beat of 
every measure, and a different one for 
each of the other beats.

1
2
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6
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D Every beat recorded
If this option is checked, Vision 
assumes that a click event has been 
recorded for each beat (or each bar if 
Click on downbeats only is 
selected) in the sequence. This allows 
dramatic, quick tempo changes.
If this option is unchecked, you won’t 
need a click event for every beat in 
the sequence. However, you must 
have a click event for at least the first 
two beats to establish the initial 
tempo.

E Click events are
“Only” specifies a single event (con-
tinuous controller or note) on a 
particular Instrument as the click 
source. This option is useful if there 
are other events in the same track 
that are not click events.
“Selected notes” uses the notes that 
were selected before opening the 
Reclock dialog as the click source.
“Any note event” uses all notes (from 
the specified source track) for the 
click source.
NOTE: When using Different Click 
on Downbeats, you must define two 
different events for the downbeat and 
upbeats of the click.

F In track
Choose from this pop-up the source 
track that contains the click events.
All click events must reside on a 
single track.
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Following are some possible click track 
sources for reclocking:

• Try using material from the MIDI 
tracks that need reclocking. If a piano 
type performance was recorded, per-
haps the notes in the left hand, which 
often fall on the main beats, can be 
used successfully for the click source.

• If the material that needs reclocking 
came from a multitrack tape, a click 
track or kick drum track also from 
the tape can make a good click 
source. 
Record it directly into Vision as audio, 
use Strip Silence/Slice Audio to 
make each beat an individual event, 
then specify the audio events as the 
click source in the Reclock dialog.
Or run the click track from the tape 
through the Studio 5’s footswitch 
input and record them as MIDI notes. 
Then specify those notes as the click 
source in the Reclock dialog.

• While recording a rubato perfor-
mance (without the metronome), try 
also recording pedal taps (from a sus-
tain or sostenuto pedal) on each beat. 
Then in the Reclock dialog, specify 
the pedal events as the click source.
This is a pretty good method which 
ensures that the click track will line 
up with the recorded material.
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Editing a Rubato Performance

Rubato is a performance that doesn’t 
adhere to a strict sense of time—although 
you can feel a pulse, an expressive perfor-
mance may speed up and slow down. You 
don’t need to use a metronome when you 
record, and when you want to play rubato, 
you probably will not use one.

This raises a potential problem. If you 
don’t record while listening to a metro-
nome, the Counter will not accurately 
reflect the music, and the bar and beat 
boundaries in the edit windows will not 
line up with the recorded tracks. This is 
especially apparent in the Notation Win-
dow, but affects almost all commands, and 
makes it almost impossible to use quantiz-
ing features.

Reclocking to a Click Track

The following procedure illustrates how 
to conform a rubato performance to 
Vision’s bar and beat lines by “reclocking” 
a click track. The Reclock command will 
automatically add tempo changes and 
meter changes to reflect the performance.

a Record-enable a new track. Name this 
track ÒClick Track.Ó Set the 
Instrument of the Click Track to a 
ÒclickÓ sound.

b Set the Begin Record toggle to Wait 
for Note and then click the Play 
button.
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c As you listen to the performance, tap 
the tempo on the MIDI keyboard.

If there are multiple meter changes, you 
should play two different keys (one for 
downbeats and one for upbeats).

d When you are finished recording, 
click the Stop button.

e Play it back and, if necessary, edit the 
click track to correct any mistakes.

f Select the click track and choose 
Do>Reclock.

The Reclock dialog opens, see Reclock 
(pg. 142) for details on each of its 
parameters.

g After making the appropriate settings, 
click the Reclock button.

Vision inserts the necessary tempo 
and meter events so that the rubato 
performance lines up with the bar and 
beat lines.

NOTE: In general, you should use Reclock 
first and then use Scale Time afterwards 
for minor changes.
Vision & Studio Vision Pro — MIDI Reference M
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There are two basic scenarios that neces-
sitate the use of external sync:

• Syncing to external MIDI devices
Vision can be “slaved” to another 
sequencer or drum machine so both 
sets of tracks play in sync.

• Syncing to a tape deck
Vision can be “slaved” to tracks on 
tape. This is a powerful method of 
blending conventional recording 
techniques with the flexibility of 
MIDI.

Vision uses the following MIDI synchro-
nization protocols:

• MIDI Beat Clock: Sends timing 
pulses for each beat, speeding up and 
slowing down as necessary for tempo 
changes.

• MIDI Time Code: MIDI representa-
tion of SMPTE Time Code and 
synchronizes time with no concept of 
beat or tempo. 

Vision can also control devices that sup-
port MIDI Machine Control (MMC). For 
more information on this capability, see 
Chapter 39: The MMC Window.

All of Vision’s sync settings are config-
ured from the Sync Options dialog. See 
Sync Options (pg. 433) for details.
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SYNCING TO BEAT CLOCK 

MIDI Beat Clock with Song Pointer pro-
vides Start, Stop and Continue functions, 
and location information (which allows 
you to start playback in the middle of a 
sequence). 

To slave Vision to an external MIDI 
device:

a Open the sequence that will 
sync to the external MIDI device.

b Choose Options>Sync Options.

The Sync Options dialog opens.

c In the Receive Sync line, set the 
sync format to External Beat 
Clock.

In addition set the source of the Beat 
Clock to the desired device. 

Click the OK button to close the Sync 
Options dialog.

NOTE: The Beat Clock sync source 
device must be defined as such in the 
current OMS Studio Setup. If not, it will 
not appear in the Sync Source pop-up.
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d In the Control Bar, click the Play 
button, or press the Spacebar.

The Play button flashes, indicating it is 
waiting for sync information from the 
external device.

e Initiate playback of the external 
device.

Vision locates the sequence to the 
requested start time and begins playing.

NOTE: Make sure the external MIDI 
device is configured to send MIDI Beat 
Clock.

SYNCING TO TIME CODE

Synchronizing with SMPTE requires an 
external SMPTE to MIDI Time Code con-
verter (such as Opcode’s Studio 64 XTC 
or Studio 5). 

To slave Vision to MIDI Time Code:

a Open the sequence that will 
sync to tape.

b Choose Options>Sync Options.

The Sync Options dialog opens.

c In the Receive Sync line, set the 
sync format to MIDI Time Code.

In addition set the sync source to the 
desired device (usually your MIDI 
interface). 
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If you would like Vision to begin playing 
and recording automatically when 
receiving time code, check the Remote 
Start option.

d Choose the desired frame rate 
from the SMPTE Format pop-up.

Click the OK button to close the Sync 
Options dialog.

e Click the Play button in the 
Control Bar, or press the 
Spacebar.

The Play button flashes, indicating it is 
waiting for sync information from the 
tape.

f Start the tape.

Make sure the tape is striped with 
SMPTE and allow some leader time 
before the sequence is supposed to 
start. Also, make sure the sequenceÕs 
SMPTE offset matches whatÕs on tape. 
See SMPTE Offset (pg. 150) for more 
details.

Vision determines if the received time 
code is before or after the beginning of 
the sequence:

• If before, the Counter displays nega-
tive bar numbers and counts towards 
bar 1.

• If after, Vision locates the sequence 
to the correct start time and begins 
playing. 
Opcode Systems, Inc.



CHAPTER 18: Synchronization
NOTE: If the tape is played while Vision is 
stopped, Vision still displays the scrolling 
SMPTE numbers in the Counter.

RECORDING WITH EXTERNAL 
SYNCHRONIZATION

You can record into Vision while synchro-
nized with an external source, using 
either MIDI Beat Clock or MIDI Time 
Code. Make sure Punch mode is enabled 
or Vision is in Overdub mode. To begin to 
recording, click the Record button (or 
type the Tab key). The Record button 
flashes. 

Wait For Note

In Wait for Note mode, when you start the 
external device, Vision begins playing the 
sequence and the Record button will not 
be highlighted. Vision will punch in when 
you play a note or press the Spacebar—at 
which time the Record button becomes 
highlighted.

Auto Punch

A Countoff can’t be guaranteed because 
Vision cannot control the sequence start-
ing point, so Countoff automatically 
becomes Auto Punch when you select an 
external sync mode. In Auto Punch mode, 
the Record button does not become high-
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lighted if you start before the Punch In 
point (or after the Punch Out point). 
Vision will automatically punch in when 
you reach the Punch In point and will 
automatically punch out when you reach 
the Punch Out point. If you start the 
sequence in-between the two points, 
Vision punches in and the Record button 
becomes highlighted. 

When finished recording, click the Stop 
button or press the Return key (or just 
stop the tape). Whenever Vision loses the 
sync signal, it stops recording. 

NOTE: A bad sync signal from the 
SMPTE/MIDI converter can interrupt 
recording. Don’t try to keep recording! 
Restripe the tape with a fresh SMPTE 
signal.

The number of bars of Countoff set in 
Internal mode controls the metronome. If 
a 2 bar Countoff is set and the tape starts 5 
bars before the Punch In point, the metro-
nome doesn’t play until 2 bars before the 
Punch In point.

AUTOMATICALLY CHANGING 
SYNC MODES

When using external sync, Vision auto-
matically (and temporarily) enters 
Internal mode when you perform the fol-
lowing actions:

• Start a sequence by typing its key;
• Choose Do>Play Selection;
• Choose a specific Counter location 

when Vision is not already playing the 
active sequence in sync.
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Once the function is completed, Vision 
automatically returns to External sync.

SMPTE TIME CODE RATES

Vision supports five SMPTE frame rates:

• 24 Frame
This is the rate used by feature films.

• 25 Frame
This rate is used by EBU (European) 
television.

• 29.97 Drop Frame
This rate is used by NTSC (Ameri-
can) color television

• 29.97 Non-Drop Frame
This rate is used to sync to NTSC 
color television without dropping 
frames. SMPTE time does not match 
real time, but playback pitch is unaf-
fected. Video decks run at 29.97 
frames per second.

• 30 Non-Drop Frame
This was the original NTSC black and 
white television standard. This is 
often used in audio-only situations 
since there are no dropped frames 
and the SMPTE time is equal to a real 
clock.
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The difference between 29.97 
Non-Drop and 30 Non-Drop

These formats are actually the same but 
played at different speeds. Vision can’t dif-
ferentiate between 29.97 non-drop on a 
video machine and 30 non-drop on a 
slightly slow audio machine.

If 29.97 non-drop is specified, Vision 
skews the tempos so that if the tape plays 
at exactly 29.97 frames per second (as all 
video decks do), and the tempo is 120, 
then Vision plays 1200 beats in 10 minutes 
of “real time.” This is faster than the 
SMPTE time.

If 30 non-drop is specified, the deck plays 
at 30 frames per second, and the tempo is 
120, then Vision plays 1200 beats in 10 
minutes of SMPTE time and “real time.” 

If 30 non-drop is specified, but the deck 
plays at 29.97 frames per second, and the 
tempo is 120, then Vision plays 1200 beats 
in 10 minutes of SMPTE time. This is 
slower than “real time.”

SMPTE Offset

The SMPTE Offset time points to a loca-
tion on tape that corresponds to the 
beginning of a sequence. Each Vision 
sequence has its own SMPTE Offset set-
ting. When syncing to time code, the 
sequence begins playing after Vision 
receives the offset time code location. 

For information on setting a sequence’s 
SMPTE Offset, see Information Toggle 
(pg. 212).
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SLAVING EXTERNAL DEVICES 
TO VISION

Vision can also send sync signals to a 
“slaved” external device:

a Choose Options>Sync Options.

The Sync Options dialog opens.

b In the Send Sync pop-up, 
specify the type of sync sent 
(MIDI Time Code or Beat Clock).

In addition set the sync destination to the 
desired device. 

NOTE: In order to appear as a Send 
Sync device, a device must be defined 
as such in the current OMS Studio 
Setup.

c Click OK to close the Sync 
Options dialog.

d Make sure Options>Send Sync 
Enabled is checked.

e Click the Play button in the 
Control Bar.

Visions initiates playback and sends the 
sync to the slaved device.

Make sure the device is configured to 
sync to an external clock source, and is 
set to begin playing.

Figure 18.1: 
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 19: What’s Saved Where
In addition to saving your basic sequence 
files, Vision can also save a wide range of 
configuration settings, preferences, and 
templates. Following is a description of 
what’s saved where: 

Vision Files 

Each Vision file saves sequences and seg-
ments, Instruments, patch subscriptions, 
and edit window information (location and 
size). Optionally, Vision files can also 
include MIDIKeys, Input Map settings, 
Fader and Console assignments, and 
Fader and Console values. See Vision 
Files (pg. 156) for specifics.

Vision Setup 

Vision Setup is automatically updated to 
save any changes to your MIDIKeys, 
Commands Window settings, and 
Sequence Templates. Optionally, you can 
use Save As Setup to save a snapshot of 
Instruments, patch subscriptions, Input 
Map settings, Fader and Console assign-
ments, and Fader and Console values. For 
more details, see Vision Setup (pg. 157).
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Vision 4.5 Prefs

This file (which resides in the Prefer-
ences folder, inside your System Folder) 
stores information from Vision’s Settings 
Window, as well as many other items. See 
Vision 4.5 Prefs (pg. 158) for details.

Vision Editing Templates

This file stores saved templates for Select 
& Modify, Quantize, and Transpose. For 
tips on creating and saving templates, see 
Chapter 20: Templates.

Vision Effects Templates

This file saves all EQ templates, VST plug-
in Program Templates, VST plug-in Bank 
Templates, and TDM plug-in templates. 
For more information, see your Audio Ref-
erence Manual.

Console Layout Templates

This folder stores all console layout tem-
plates (each of which is its own file). Each 
Console Layout Template file contains 
information about the Console display set-
tings. For more information about these 
files and a complete list of what is stored 
in them, see page 366.
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Vision Grooves

This Vision file contains the source 
sequences and tracks for Groove Quan-
tize. It must be named as such and reside 
in the same folder as your Vision applica-
tion. See Creating Your Own Grooves 
(pg. 167) for more information.

OMS Studio Setup

In addition to containing a description of 
your MIDI studio, this file also stores the 
Current Thru Instrument, current 
patches, metronome channels, receive 
sync device, send sync device(s), enabled 
input devices, and Auto Remappings.

VISION FILES

Each Vision file can store the following 
objects:

• Sequences
Saves all sequences and segments 
listed in the Sequences Window.

• Instruments
Saves all Instrument definitions, 
including any assigned transpose 
maps and patch subscriptions.

• Input Map
Saves the routings in the Input Map 
Window.

• MIDIKeys
Saves the MIDIKey assignments.

• Fader Assignments
Saves all Instrument assignments for 
Faders and Consoles.
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• Fader Values
Saves all Fader and Console values.

• Audio Preferences
Saved in their current state when the 
file is saved.

• Sync Options
If Remember these settings in 
sequence files is checked, all set-
tings are saved.

• DSP Preferences
If Save with Sequence Files is 
checked, these settings are saved.

• Audio Recording Preferences
If Save with Sequence Files is 
checked, these settings are saved.

You can specify which objects are saved 
with a Vision file by clicking the What to 
Save button in the Save dialog (see 
Figure 19.1).

Figure 19.1: What to Save dialog
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When saving a Vision file, sequences and 
Instruments must always be included, but 
the other items are optional. Fader 
Assignments and Fader Values are 
enabled by default, though you can 
uncheck them if desired.

In addition, you can specify which objects 
are opened when opening a Vision file 
(click the What to Open button in the 
Open dialog). This lets you, for instance, 
open a set of Instruments or Fader 
Assignments without closing your current 
set of sequences. By default, all objects 
found in a file are opened.

VISION SETUP

The Vision Setup file is just like a regular 
Vision file except that the sequences it 
contains are used for Sequence Tem-
plates. The Vision setup file, which must 
reside in the same folder as your Vision 
application, lets you recall commonly 
used setup items (like Fader and Console 
configurations, Instrument definitions, 
Input Maps, etc.) for each newly opened 
Vision file.

Below is a complete list of the items saved 
in the Vision Setup file:

• Sequence Templates (automatic)
• Instruments
• Input Map
• MIDIKeys (automatic)
• Commands (automatic)
• Fader and Console Assignments
• Fader and Console Values
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Sequence Templates, MIDIKeys, and 
Commands are saved automatically when-
ever there are changes made to them. 
This ensures that any changes made to 
these items will not be lost.

NOTE: Even if you have not yet chosen 
File>Save As Setup, making changes to 
Sequence Templates, MIDIKeys, or Com-
mands will automatically create a new 
Vision Setup file.

To save the other Vision Setup items 
(Instruments, Input Map, and Fader and 
Console information), you must choose 
File>Save As Setup. If changes are 
made to any of these items and you have 
not saved them, you will be prompted 
before closing Vision.

When opening a Vision file, any objects 
unchecked in the What to Open dialog 
are not loaded—and as a result, the corre-
sponding Setup items are instead used.

You can also click the Use Setup Instru-
ments option in the Open dialog to use 
the Setup Instruments for any existing 
file. This would be handy for opening 
someone else’s file (with a different set of 
Instruments) at your studio—thereby let-
ting you use your Instruments saved in 
the Setup file.
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.

Figure 19.2: Use Setup Instruments option in 
Vision’s Open dialog

The Vision Setup file is saved in the same 
folder as the Vision application. It must 
remain in this folder, with its name intact, 
for Vision to access it. 

Vision Setup files are very much like regu-
lar Vision files—they can even be opened 
as such. This lets you rename and save as 
many different “Vision Setup” files as you 
like, opening them as necessary to return 
to those particular configuration settings.

VISION 4.5 PREFS

The Vision Prefs file stores a large 
number of configuration settings. This file 
is automatically written each time Vision 
is closed. It resides in the Preferences 
folder inside the System Folder. If you 
ever need to return Vision to its default 
state, remove this file from the Prefer-
ences folder and the Vision Setup file 
from the Vision folder before launching 
the program.
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NOTE: It can take quite a while to actually 
configure Vision with all of your favorite 
settings. Once this is done, it is a good idea 
to make a backup copy of the Vision Prefs 
file.

NOTE: For Studio Vision Pro users, the 
name of the preferences file is “Studio 
Vision Prefs.”

While not an exhaustive list, following is a 
compilation of some of the items saved in 
the Vision Prefs file:

• File Menu: Open (what to open), 
Save (what to save), Export as MIDI 
File (Multitrack option), Export As 
QuickTime Movie (movie settings), 
Export Audio Mix (file format), 
Export Audio Events (file format)

• Setups Menu: Keyboard Thru, Thru 
in Background, Input Effect Enabled, 
Input Map Enabled, MIDIKeys 
Enabled, Fader Remotes Enabled, 
Record Quantize Enabled, Record 
Filter settings, Colors 

• Options Menu: Sync Options set-
tings, Send Sync Enabled, Click in 
Record, Click in Play, Click in Count-
off Only, Metronome Sound settings, 
Countoff in Play, Stop at Punch Out, 
Real Time Capture, Local Sequence 
Times

• Audio Menu: Audio System, Wave-
form Height, Waveform Display, 
Display Names, Mix Audio on Cap-
ture, Audio Preferences

• DSP Menu: DSP Preferences
• Control Bar: Record Mode, Count-

off/ Wait Note, Punch toggle, Loop 
toggle
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• Sequences Window: Set Default 
Location

• Tracks and Pulse Window: Auto 
Scroll, Time Display (Bar/Beat/Unit, 
Absolute SMPTE, or Relative 
SMPTE), Set Default Location, Show 
Offset Info, Detailed Track Overview, 
Show Vertical Line, Cursor Quantize 
toggle, Cursor Quantize value

• Graphic Window: Auto Scroll, Time 
Display (Bar/Beat/Unit, Absolute 
SMPTE, or Relative SMPTE), Set 
Default Location, Play Edited Note, 
Show Bouncing Ball, Show Vertical 
Line, Show Piano Keyboard, Cursor 
Quantize toggle, Cursor Quantize 
value

• Notation Window: Auto Scroll, Time 
Display (Bar/Beat/Unit, Absolute 
SMPTE, or Relative SMPTE), Set 
Default Location, Play Edited Note, 
Show Bouncing Ball, Show Vertical 
Line, Cursor Quantize toggle, Cursor 
Quantize value, Notation Resolution

• List Window: Auto Scroll, Time Dis-
play (No SMPTE, Absolute SMPTE, 
or Relative SMPTE), Set Default 
Location, View settings, Play Edited 
Note, Show Event End Times, Show 
Event Durations

• Counter Window: Bar/Beat/Unit, 
Absolute SMPTE, Relative SMPTE, 
Font

• Record Monitor: Thru Mode, Stereo 
on/off, Auto Compact on/off, Sample 
Size, Record File Preferences

• Step Window: Spacing value, Tuplet, 
Duration, Velocity

• Players & Queue Window: Queue 
toggle
Vision & Studio Vision Pro — MIDI Reference M
• Input Effect Window: Arpeggiate/
Repeat, Latch toggle, Sync to Counter 
toggle, Octaves, Order, Spacing, 
Duration

• Faders Window: Tempo Fader 
assignment and range

• Select & Modify Window: All 
settings

• Settings Window: All settings, 
which include Insert Note, Strip 
Chart & Nudge, Editing, Real-Time, 
Controllers, and Appearance

• Audio Preferences: All settings
• DSP Preferences: All settings as 

they are when the program quits
• Audio Recording Preferences: All 

settings as they are when the pro-
gram quits
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CHAPTER 20: Templates
This chapter explores saving templates in 
Vision. The types of templates supported 
include:

• Sequence
• Transpose
• Quantize
• Select & Modify

This chapter also discusses how to save 
your own tracks as custom Groove 
sources for Quantizing.

For information about Console templates, 
please see Chapter 38: The Console 
Windows.

For information about EQ templates, 
please see your Audio Reference Manual.

SEQUENCE TEMPLATES

Sequence Templates are starting points 
for opening new sequences. If, for 
instance, you have a sequence (or seg-
ment) with useful track assignments, 
appropriate meter and tempo settings, 
patch and controller configurations, or 
anything else, you can save it as a 
Sequence Template. Then whenever you 
wish to open a new sequence based on 
that template, simply double-click it from 
the Sequences Window.
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Sequence Templates are stored in the 
Vision Setup file.

Saving a Sequence Template for 
Orchestral Music

The following example shows how to con-
figure and save a Sequence Template for 
orchestral music:

a Open a new sequence and assign an 
Instrument and patch for each of the 
desired orchestral tracks.

This example uses a GM device as its 
sound source.

b If desired, set volume and pan levels 
for each of the assigned Instruments.

For details, see Saving a Mixer Snap-
shot (pg. 89).
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c Set the sequenceÕs Meter and 
Tempo. Use values that make the 
most sense for your type of music.

These sequence settings neednÕt be 
exact, they can always be changed later 
when re-opening the template.

d Choose Save As Template from the 
menu in the Sequences Window.

e When prompted, enter a name for the 
template, then click OK.

The new Sequence Template is added 
to the Templates section of the 
Sequences Window.

Sequence Templates are stored in the 
Vision Setup file. Each time you save a 
Sequence Template, it is automatically 
written to the Setup file, thereby making it 
available each time you launch Vision.
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Opening a Sequence Template

To open a new sequence based on a 
Sequence Template:

a Open the Templates section of the 
Sequences Window, so you can view 
the current set of templates.

Use the open/close triangle to open the 
different sections in the Sequences 
Window.

b Locate the desired Sequence 
Template and double-click it, or 
simply type its key equivalent.

A new sequence is created, using the 
material from the specified template, and 
is placed in the Sequences section of the 
Sequence Window. A Tracks Window for 
the new sequence opens.

The new sequence is not named after 
the template source; it instead uses 
VisionÕs naming scheme when creating 
new sequences (Sequence A, 
Sequence B, etc.).
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EDITING TEMPLATES

Vision can save templates for Transpose, 
Quantize, and Select & Modify, which 
enables you to store and recall your favor-
ite parameter settings for these 
commands. These templates are written 
to the file Vision Editing Templates, which 
resides in the same folder as your Vision 
application. In order for the templates to 
be available this file must not be moved or 
renamed.

Quantize and Transpose 
Templates

Quantize and Transpose Templates are 
stored and recalled with a similar set of 
pop-up menus. 

Figure 20.1: Quantize (Grid) parameters

The Quantize parameters are found in the 
following locations:

• Info area of the Tracks and Pulse 
Windows when viewing a track’s Play 
Quantize settings;

• Select & Modify Window when its 
modify type is set to Quantize;

• Input Effect Window (for its Spacing 
settings).
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Figure 20.2: Transpose (Diatonic) parameters

The Transpose parameters are found in 
the following locations:

• Select & Modify Window when its 
modify type is set to Transpose;

• Transpose Map dialog for an 
Instrument.

To recall a template, simply choose it 
from the Template pop-up. This pop-up 
menu lists all templates stored in the cur-
rent Vision Editing Templates file.

Figure 20.3: Template pop-up for Quantize

The Template Functions pop-up is used 
save and copy parameter settings, and to 
delete existing templates. 

Figure 20.4: Template Functions pop-up 
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Following is a description of each item in 
the Template Functions pop-up menu:

• Save Settings: Stores the current 
parameter settings to the currently 
selected template.

• Save Settings As: Stores the current 
parameter settings to a new Quantize 
or Transpose Template.
With this command you are 
prompted to enter a name for the new 
template.

• Delete Template: Deletes the cur-
rently selected template.

• Load From: Lets you load a set of 
templates from a Vision Editing Tem-
plates file that is not current. The 
loaded templates are merged with the 
current set.

• Copy Settings: Copies the current 
set of parameters to the Clipboard.
This is handy for copying Play Quan-
tize settings between tracks, or to and 
from the Select & Modify Window.

• Paste Settings: Pastes a set of Quan-
tize or Transpose parameters from 
the Clipboard to the current location.

• Save As Default: This command is 
only available for track Play Quantize 
settings. Once you have a set of Play 
Quantize parameters that you like, 
use this command to make them the 
“default” for each new track.
164
Saving a Transpose Template

The following example shows how to save 
a set of Transpose parameters to a 
template:

a Choose Do>Transpose.

The Select & Modify Window opens, 
automatically configured for the Trans-
pose command.

b Choose the desired Transpose Type 
and make the necessary changes to 
the Transpose parameters.

For information on the different Trans-
pose types, see Transpose Types 
(pg. 134).

c Choose Save Settings As from the 
Template Functions pop-up.
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d When prompted, enter a name for the 
new template and click OK.

The new Transpose Template is saved 
to the Vision Editing Templates file.

Select & Modify Templates

Any configuration of the Select & Modify 
Window can be saved as a template. 
These Select & Modify Templates store 
both the “select” and the “modify” set-
tings of the window, and can be used to 
recall your most commonly used edit 
operations.

Figure 20.5: Components saved with the Select & 
Modify Templates

Modify parameters

Select attributes

Modify type

Events type
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Like Quantize and Transpose Templates, 
Select & Modify Templates are stored in 
the Vision Editing Templates file.

Select & Modify Templates are recalled 
from the menu in the Select & Modify 
Window. Simply select the desired tem-
plate, and the window is automatically 
reconfigured with the stored settings in 
the template. See Figure 20.6.

Figure 20.6: Choosing a Select & Modify Template

The lower portion of this menu lists all 
Select & Modify Templates stored in the 
Vision Editing Templates file. The top 
portion has commands for saving, load-
ing, and deleting templates. For details on 
each of these commands, see Select & 
Modify Menu (pg. 125).
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Saving a Select & Modify Template

The following example shows how to save 
a Select & Modify Template for quantiz-
ing just the snare hits with “swing”:

a Highlight the sequence or tracks you 
wish to edit and then choose 
Do>Quantize.

The Select & Modify Window opens, 
automatically configured for the Quan-
tize command.

b Open the Select area of the Select & 
Modify Window by clicking the open/
close triangle.

c Add a Select attribute for only 
selecting the pitch range containing 
the snare notes (D1).
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d Set the Quantize Type to Grid with a 
Quantize value of 8th notes. Also, 
enter a value of 70% in the Swing 
field.

Also, enter a value of 70% in the Swing 
field.

e Choose Save Settings As from the 
menu in the Select & Modify Window.

f When prompted, enter a name for the 
new template and click OK.

The new Select & Modify Template is 
saved to the Vision Editing Templates 
file.
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CREATING YOUR OWN 
GROOVES

With Groove Quantize, Vision uses a 
custom alignment grid based on the 
Groove Source track. Vision maps the 
start times, velocities, and durations (or 
any combination thereof) from the 
Groove Source onto the selected track. 

Groove Source tracks reside in the Vision 
Grooves file, which resides in the same 
folder as the Vision application. In order 
to access the Groove sources, the Vision 
Grooves file must not be moved or 
renamed.

To create your own custom groove, all 
you need to do is save the desired track to 
the Vision Grooves file. Then you can use 
it as a Groove Source track with Quantize.

You can save a Groove Source track by 
directly editing the Vision Grooves file:

a Record a track you would like to use 
as a Groove source.

b Select the track in the Tracks Window 
and choose Edit>Copy Track.

c Next, open the file ÒVision Grooves.Ó

d Make the Sequences Window active 
and then choose Edit>Paste 
Sequence.

Before pasting, make sure no 
sequences are selected in the 
Sequences Window.

e Rename the sequence as desired and 
choose File>Save.

The new sequence along with the 
Groove Source track is saved.
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You can also paste into the Vision 
Grooves file remotely, when it’s not even 
open:

a Record a track you would like to use 
as a Groove source.

b Select the track in the Tracks Window 
and choose Edit>Copy Track.

c Choose Do>Quantize to open the 
Quantize Window.

d Set the Grid Type to Groove.

e From the Seq pop-up, select a 
sequence source into which you will 
paste. Then choose Paste as New 
Groove Track from the Track 
Functions pop-up.

f When prompted, enter a name for the 
new Groove Source track and click 
OK.

The new Groove Source track is saved 
to the Vision Grooves file.
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THE COMMANDS WINDOW

The Commands Windows lets you assign 
key equivalents and MIDI events to prac-
tically any function or menu item in 
Vision. Changes in the Commands 
Window are automatically saved to the 
Vision Setup file.

To open the Commands Window, choose 
Setups>Commands.

Figure 21.1: Commands Window

The Commands Window is comprised of 
two sections: Digits, in the upper portion 
of the window, and Commands, in the 
lower portion.
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The Digits section determines how 
Vision responds to typed numbers. For 
example, Figure 21.2 illustrates that to 
clear a Locator button you must hold 
down the Command and Option keys (the 
Modifier) while typing the Locator’s 
number; in addition, the digit can be 
typed from the row of number keys at the 
top of the Keyboard, or from the numeric 
Keypad (since both columns are 
checked).

Figure 21.2: Digits section, Commands Window

To edit the modifier for a digit, click in 
that Modifier column and type in the 
desired keys. To change the Keyboard 
and Keypad status of a digit, click in the 
column to check or uncheck as desired.

The Commands section lists categories 
of commands, along with their assigned 
key equivalents and MIDIKeys. 
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To change a command’s keyboard equiva-
lent, click in the Keyboard column for the 
desired command and type the new key 
(or key combination). See Figure 21.3.

Figure 21.3: Keyboard column, Commands 
Window

To assign a MIDIKey, click in the column 
for the desired command and play the 
MIDI event on your controller. The event, 
device, and channel automatically appear 
in the column when received. See 
Figure 21.4.

Figure 21.4: MIDI Event column, Commands 
Window

NOTE: The column for MIDI Event, 
Device and Channel is grayed out if MID-
IKeys are not enabled.

To clear a key equivalent or MIDIKey in 
the Commands Window, click in the 
desired column and type the Delete key.

Highlighting the Edit Out Field

It is now possible to highlight the Edit 
Out field by typing back slash (\), or what-
ever key equivalent is assigned to “Select 
End Time” in the Commands Window.
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Previously, this key equivalent would 
always highlight the Punch Out field. 
Now, as long as an edit window is the top 
window, it will select the Edit Out field. 

To highlight the Punch Out field, type “=” 
(which will highlight the Counter, making 
the Control Bar the top window) followed 
by back slash.

Commands Window Menu

The Commands Window has a menu with 
the following items:

Figure 21.5: Commands Window Menu

Load From

Choose this menu item to load a set of 
Commands from a Vision Setup file.

Restore Factory Defaults

This command restores the settings in 
the Commands Window to their original 
“factory” state.

Assigning Key Commands

Following is a short example of assigning 
a key equivalent and MIDIKey for the 
Record command:
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a Choose Setups>Commands to 
open the Commands Window.

Figure 21.6: Commands Window

b Locate and click in the Keyboard field 
for the Record command.

c Type Shift-Space on your computer 
keyboard.

The new key equivalent appears in the 
Keyboard column for the Record 
command.

NOTE: If the new key equivalent is in 
use by another command or function, 
you are informed.
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d Next click in the MIDI Event field for 
the Record command.

If this column is grayed out, select Set-
ups>MIDIKeys Enabled to enable 
MIDIKeys.

e Play a note on your MIDI keyboard 
controller.

The note, and the device that played it, 
appears in the MIDI Event column for the 
Record command.

Any changes made in the Commands 
Window are automatically saved to the 
Vision Setup file. To return to the factory 
Commands set, choose Restore Factory 
Defaults from the menu in the Com-
mands Window.

THE MIDIKEYS WINDOW

MIDIKeys let you assign events from a 
MIDI controller to trigger nearly any key 
or key combination. This is particularly 
useful for controlling Vision remotely 
from your MIDI devices (without using 
your computer keyboard). There are also 
four special MIDIKeys with functions 
designed to facilitate interactive and loop 
recording.
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Choose Windows>MIDIKeys to open 
the MIDIKeys Window, or type Option-K.

Figure 21.7: MIDIKeys Window

The four “special” MIDIKeys occupy the 
top section of the MIDIKeys Window 
while the user-defined MIDIKeys are 
assigned and displayed in the lower 
section.

NOTE: Any MIDIKeys assigned in the 
Commands or Sequences Window automat-
ically appear as user-defined lines in the 
MIDIKeys Window.

Each MIDIKey assignment has four 
attributes: Function, MIDI Event, Device, 
and Channel.

Function is the key equivalent, or special 
MIDIKeys function, to which the MIDI 
Event, occurring on the selected Device 
and Channel, is assigned.

To assign MIDIKeys (special MIDIKeys 
or user-defined), simply click in the MIDI 
Event column for the desired line and play 
the MIDI event on your controller. The 
event, device, and channel automatically 
appear in the column when received. New 
lines are added by choosing Add Line 
from the menu in the MIDIKeys Window.
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You can also manually assign or edit 
MIDI events with the mouse. Following is 
a description of the items that define the 
MIDI event:

A Shift: Click in this column to toggle 
MIDIShift for a user-defined 
MIDIKey.

B Event Type: Choose from this pop-up 
an event type of either note, control-
ler, or program change.

C Event Value: Click in this column to 
specify a value for the event type.

D Input Device: This pop-up sets the 
input device.

E Input Channel: Click in this column 
to set the channel for the input 
device.

Special MIDIKeys

The four special MIDIKey functions allow 
you to perform different actions when 
MIDIKeys are enabled. You can assign 
each one of these functions to a different 
MIDI event.

12 3 4 5
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MIDIShift

The MIDIShift function allows a MIDI 
event assigned as a MIDIKey to trigger 
its function only when the MIDI event 
assigned as the MIDIShift function is 
active at the same time. Vision must 
receive both MIDI events for the corre-
sponding function to be performed.

For example, suppose you’d like to use 
the MIDI note G3 to trigger recording by 
assigning it to the Tab key. The G3 note 
can be insulated from triggering record-
ing every time it is played by using the 
sustain pedal as a MIDIShift function.

NOTE: Redefining the MIDI event associ-
ated with the MIDIShift function causes 
any MIDIKeys using MIDIShift to respond 
to the new event.

Erase

The Erase MIDIKey allows notes to be 
erased in the record-enabled track during 
playback or recording. Pressing the Erase 
MIDIKey and playing some notes on the 
MIDI controller erases all matching notes 
in the track. This is similar to the erase 
feature found on many drum machines.

See Drum Machine Style Loop Recording 
(pg. 45) for more information on using 
the Erase MIDIKey.
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Input Effect

The Input Effect MIDIKey, when invoked, 
enables Vision’s Input Effect. The Input 
Effect processes MIDI input. Depending 
on the settings in the Input Effect Win-
dow, the processed notes are either 
repeated or arpeggiated (see Input Effect 
Window (pg. 115) for details).

Vision’s Input Effect can be turned on and 
off from the Input Effect Window, or by 
choosing Setups>Input Effect Enabled. 

The Input Effect MIDIKey, on the other 
hand, offers a way to temporarily turn on 
the Input Effect in real time, on-the-fly.

Extend

This Extend MIDIKey performs a similar 
function as a sustain pedal, but without 
the hazards associated with sustain pedal 
events. Typically, you map your sustain 
pedal to the Extend MIDIKey.

The advantage of using the Extend 
MIDIKey to sustain notes is that note 
durations are actually lengthened, 
whereas sustain pedals work by combin-
ing short notes with pedal controller 
information. It is much easier to view and 
edit only the note durations, rather than 
the sustain pedal and note data.
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MIDIKeys Window Menu

Figure 21.8: MIDIKeys Window Menu

MIDIKeys Enabled

When checked, this menu item activates 
the current set of MIDIKeys. 

Add Line (Option-=)

Choose this command to add a new 
MIDIKey.

Remove Line (Option-—)

Choose this command to remove the 
selected MIDIKey. Although the four spe-
cial MIDIKeys cannot be removed, you 
can clear their MIDI event definition. To 
do this, click in the MIDI event field for 
the special MIDIKey and type Delete.

Load From

Choose this command to merge a set of 
MIDIKeys (from a Vision file) with the 
current set.

Clear All

This command removes all user MID-
IKeys, and clears all MIDI definitions for 
the four special functions.
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Defining MIDIKeys

The following example shows how to 
define a MIDIKey:

a Choose Windows>MIDIKeys.

The MIDIKeys Window opens.

b Choose Add Line from the menu in 
the MIDIKeys Window.

A new line is added to the MIDIKeys 
Window.

c Click in one of the MIDI event fields 
for the new line and play the desired 
MIDI event on your controller.

The MIDI event, device, and channel 
automatically appear when played.

d Click in the Function field and type 
the desired key equivalent to be 
triggered.

Click here and play a MIDI event

Click here and type key
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MIDIKeys can trigger any Vision function 
that uses a key combination. They can 
also trigger sequence playback by using 
the same key as the sequence’s key equiv-
alent from the Sequences Window (see 
page 197).

For a list of Vision’s default keyboard 
equivalents, consult the Quick Reference 
card in your Vision package. These keys 
can, however, be reassigned in the Com-
mands Window—so always check there 
for the current key assignments.

Any changes made in the MIDIKeys 
Window are automatically saved to the 
Vision Setup file. Also, MIDIKeys can 
optionally be saved with regular Vision 
files (see Chapter 19: What’s Saved 
Where).

NOTE: MIDIKeys only work in Vision. You 
cannot assign a MIDIKey to work in 
another application. However, MIDIKeys 
can still control Vision when it’s running in 
the background (as long as “Run MIDI in 
background” is checked in the OMS MIDI 
Setup dialog).

Deleting MIDI Keys

To remove a user-defined MIDIKey, click 
in either the function or MIDI event field 
and select Remove Line from the menu 
in the MIDIKeys Window.

Although the four special MIDIKeys 
cannot be deleted, you can clear their 
MIDI event definition. To do this, click in 
the MIDI event field for the special MID-
IKey and type the Delete key.
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SAVING MIDIKEYS AND 
COMMANDS

As mentioned previously, any changes in 
the MIDIKeys Window are automatically 
saved to the Vision Setup file. This lets 
you have a default set of MIDIKey defini-
tions that are used when opening new 
files.

MIDIKeys can optionally be stored with 
regular Vision files, creating an automatic 
association between the sequence and the 
MIDIKeys. To do this you’ll need to spec-
ify “what to save” in Vision’s Save dialog, 
see Figure 21.9.

Figure 21.9: Saving MIDIKeys with Vision file

To load a set of MIDIKeys from a Vision 
file, choose the Load From command in 
the MIDIKeys Window menu. The MID-
IKeys from the specified Vision file are 
merged into the existing set of 
MIDIKeys. 
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The settings in the Commands Window 
are also saved to the Vision Setup file 
automatically. Unlike MIDIKeys, Com-
mands cannot be saved with regular 
Vision files.

You can, however, backup and rename 
your Vision Setup files to create a library 
of Commands files. To restore a particular 
set of Commands, chose Load From in 
the Commands Window menu.
176
 Opcode Systems, Inc.



CHAPTER 22: Custom Instruments
Vision’s MIDI Instruments are defined by 
a number of parameters, including name, 
color, device and channel assignment, 
velocity scaling, transposition, key range, 
and voice allocation. Custom Instruments 
can be created by editing any of these 
parameters. 

Since Instruments can be comprised of 
several layers (lines), specialized Instru-
ments functioning as splits and layers can 
be created. This chapter discusses how to 
create some of these custom Instruments.

NOTE: Instruments are remembered with 
saved Vision files. They also can be saved in 
the Vision Setup file.

For a detailed discussion of the Instru-
ments Window, see Chapter 32: The 
Instruments Window.
Figure 22.1: 
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CREATING A LAYERED 
INSTRUMENT WITH OCTAVES

This example shows how to create a lay-
ered Instrument with one of the layers 
transposed up an octave.

a Choose Windows>Instruments to 
open the Instruments Window.

b Highlight an existing Instrument and 
choose New Instrument from the 
menu in the Instruments Window.

A new Instrument, based on the previ-
ously selected Instrument, is added at 
the bottom of the Instruments Window

c Highlight the name of the new 
Instrument and type in an appropriate 
name.

For this example, the name ÒLayered 
OctavesÓ is used.
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d Highlight the Layered Octaves 
Instrument and choose Add Line to 
Instrument from the menu in the 
Instruments Window.

A new line is added to the Instrument.

Make sure that the Instrument is set to 
Layered, if not, click on the word 
ÒOverflowÓ to toggle the mode.

e In the Output column, specify a 
Device and Channel for both 
Instrument lines. 

For an interesting effect, you can choose 
separate devices and channels that are 
set to vastly different patches.

f In the Transpose column, set the 
Octave for one of the layers to +1.

CREATING A SPLIT 
INSTRUMENT

This section explains how to create an 
Instrument “split” using two layers set to 
different key ranges.

a Choose Windows>Instruments to 
open the Instruments Window.
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b Highlight an existing Instrument and 
choose New Instrument from the 
menu in the Instruments Window.

A new Instrument, based on the previ-
ously selected Instrument, is added at 
the bottom of the Instruments Window

c Highlight the name of the new 
Instrument and type in an appropriate 
name.

For this example, the name ÒMiddle-C 
SplitÓ is used.

d Highlight the Middle-C Split 
Instrument and choose Add Line to 
Instrument from the menu in the 
Instruments Window.

A new layer is added to the Instrument.

e In the Output column, specify a 
device and channel for each 
Instrument line. 

You might want to assign a piano in one 
line and a bass in the other.

f In the Range column, set the Lo value 
to ÒC3Ó for the top line; then set the 
Hi value to ÒB2Ó for the other line.

For an easy way of entering values into 
the Lo and Hi fields, highlight the field 
and play the desired note(s) from your 
controller keyboard.
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CREATING VOICE-ALLOCATED 
INSTRUMENTS

This section discusses how to create a 
voice-allocated Instrument. Suppose, for 
example, you have two MIDI devices 
each with small polyphony capabilities.

You can use an Instrument in “overflow” 
mode to automatically allocate notes to 
different Instrument lines, based on their 
individual voice definitions.

a Choose Windows>Instruments to 
open the Instruments Window.

b Highlight an existing Instrument and 
choose New Instrument from the 
menu in the Instruments Window.

A new Instrument, based on the previ-
ously selected Instrument, is added at 
the bottom of the Instruments Window

c Highlight the new Instrument and 
choose Add Line to Instrument 
from the menu in the Instruments 
Window.

A new line is added to the Instrument.

d Set the mode of the Instrument to 
Overflow.

e In the Output column, specify a 
device and channel for each 
Instrument line.
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f In the Voices column, enter the 
number of voices for each Instrument 
line.

These values should equal the number 
of simultaneous notes each device 
(assigned to the line) is capable of 
playing.

Whenever Vision sends data to such an 
Instrument, it routes to the correct Instru-
ment line based on their Voice 
allocations.
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Figure 23.1: Control Bar

The Control Bar contains the major con-
trols for Vision. It’s normally located just 
below the Macintosh menu bar, but it can 
be moved by either dragging the drag 
strip (at the left edge), or by Option-drag-
ging any blank area in the Control Bar 
itself.

Unlike most Macintosh windows, the but-
tons in the Control Bar are always active. 
Clicking one will not move the Control 
Bar in front of another active window—
this lets you access Control Bar functions 
without de-activating another window.

The Control Bar cannot be closed.

RECORD MODE

The Record Mode determines how Vision 
records tracks. The four available record 
modes, chosen from the Record Mode 
pop-up, include:
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• Replace: Records in real time, replac-
ing existing track data.

• Overdub: Records in real time, 
adding to existing track data.

• Step Replace: Records in step time, 
replacing existing track data.
Step recording is a process where 
MIDI events are recorded individu-
ally, one step at a time. For more 
information, see Step Recording 
(pg. 42).

• Step Overdub: Records in step time, 
adding to existing track data.

Figure 23.2: Record Mode pop-up

Record Indicator

The Record Indicator button( ), located 
next to the Record Mode pop-up, blinks 
when Vision receives MIDI. It also indi-
cates if digital audio recording and 
Record Quantize are enabled.

Clicking on the Record Indicator button 
opens the Record Monitor Window, 
which is used for recording digital audio.
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CURRENT SEQUENCE

The Current Sequence is the sequence to 
which recording takes place. Whenever a 
Tracks Window for a different sequence is 
brought to the front, the Current 
Sequence pop-up changes to show that 
sequence’s name (except if you’re actively 
recording into another sequence).

Figure 23.3: Current Sequence pop-up

Choosing a sequence from this pop-up 
menu activates a Tracks Window for that 
sequence.

Seq Button

Click on the “Seq” button ( ) to bring 
the Tracks Window for the current 
sequence to the front.

CURRENT TRACK

Whenever a track is record-enabled, that 
track’s name is displayed in the Current 
Track pop-up menu.
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Figure 23.4: Current Track pop-up

Choose any existing track (or “new 
track”) from this pop-up menu to 
record-enable it.

Trk Button

To open an edit window for the current 
track, click on the “Trk” button ( ).

THRU INSTRUMENT

The Thru Instrument pop-up displays the 
MIDI Instrument to which your controller 
sends MIDI. This Instrument is always 
assigned to recorded data.

The Thru Instrument sounds when you 
play your controller keyboard (provided 
Options>Keyboard Thru is enabled). 
When you record-enable a different track 
from the Tracks Window, or from one of 
the other edit windows, this pop-up auto-
matically displays the Instrument 
assigned to that track. In addition, if you 
change the Instrument used by the cur-
rent track, the Thru Instrument pop-up 
changes as well.
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Figure 23.5: The Thru Instrument pop-up

KEY EQUIVALENTS: You can use your 
computer keyboard to set the Thru Instru-
ment. Hold down the Option key while 
clicking the Thru Instrument pop-up for a 
list of key equivalents. Also, you can use the 
Asterisk (*) key on the numeric keypad to 
highlight the Thru Instrument.

Trigger and Transpose Items

The Thru Instrument pop-up also lists 
Vision’s four Trigger modes: Transpose, 
Trigger, Cont Trig, and Gated. These 
items, which are not MIDI Instruments, 
are performance modes used in trigger-
ing sequences in real time.

NOTE: These Trigger modes work indepen-
dently of similar items in the Input Map 
Window, which are described in Trigger 
and Transpose Modes (pg. 326).
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• Transpose
Choosing this item temporarily puts 
Vision in transpose mode, which auto-
matically transposes the currently 
playing sequence when you play a 
note on your MIDI keyboard.

• Trigger
In trigger mode, every note you play 
restarts the currently playing 
sequence. Sequences playing are 
stopped when you strike a new key. 
You can play more than one note in 
this mode to produce automatic 
harmonies.
If the Thru Instrument pop-up in the 
Control Bar is set to Trigger, typing a 
sequence key does not initiate play-
back—instead, this makes that 
sequence “triggerable.” Play any note 
on your MIDI controller to start all 
triggerable sequences 
simultaneously.

• Cont Trig
Continuous Trigger Mode is the 
same as Trigger Mode, except that 
sequences are not stopped when trig-
gering a new sequence.

• Gated
Gated is the same as Trigger mode, 
except that each sequence plays for 
the length of time you hold down the 
key. When you lift your finger, the 
sequence stops.
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Instruments Button

Click on the Instruments button ( ) to 
open the MIDI Instruments Window. For 
information on the Instruments Window, 
see Chapter 32: The Instruments Window.

Global Instrument Solo Indicator

Instead of the Instruments button, the 
Control Bar displays a Global Instrument 
Solo Indicator whenever any Instrument 
(Audio or MIDI) is soloed.

Figure 23.6: Global Instrument Solo Indicator

Click the Solo Indicator to open any win-
dows that contain soloed Instruments. 
Option-click the Solo Indicator to auto-
matically unsolo all soloed instruments. 
For more details, see Global Instrument 
Solo Indicator (pg. 302).

Global Instrument Solo Indicator
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CURRENT PATCH

The Current Patch pop-up shows the 
patch used by the Thru Instrument. It is 
automatically updated when sending 
patch changes to the Thru Instrument, 
either when editing or playing.

Vision remembers the last patch change 
sent to each Instrument. When a new 
Instrument is chosen from the Thru 
Instrument pop-up, the Current Patch 
pop-up changes to display the patch last 
sent to that Instrument. This setting is 
remembered even when you quit Vision.

Figure 23.7: Current Patch pop-up displaying 
names

If the Thru Instrument is subscribed to a 
Patch Name document (see 
Chapter 33: The Names Window), the Cur-
rent Patch pop-up displays actual patch 
names. Otherwise, patch and bank num-
bers are used.
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Choose an item from the Current Patch 
pop-up to send a patch event to the Thru 
Instrument. This does not, however, add a 
patch event to the current track unless 
you are recording. For information on 
saving patch events, see Saving Patch 
Selections (pg. 88).

Patch Button

Click on the Patch button ( ) to open 
the Names Browser for auditioning 
patches, see Names Browser (pg. 321).

TRANSPORT CONTROLS

Figure 23.8: Transport Controls

The transport controls, located in the 
middle of the Control Bar, give you con-
trol over the playback and recording of 
sequences.

Fast Forward to
Next Marker

Shuttle Bar

Previous Marker
Rewind to

Record

Play from Start
Stop

Play from Counter

Pause
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Record

KEY EQUIVALENT: Type the Tab key to 
begin recording.

Click the Record button to initiate 
recording. During playback or recording, 
you can click the record button to punch 
in or out at any time (on-the-fly). If the 
button is highlighted, you are recording. 
If the button is flashing, this means that 
recording will occur when the Counter 
reaches the In Point. If the record button 
is disabled (grayed out), you cannot 
record—this usually means there is no 
track record-enabled.

Play from Start

KEY EQUIVALENT: Type the Spacebar to 
initiate playback from the beginning.

Click the Play from Start button to start 
playback from the beginning of a 
sequence, or from the In Point in the 
punch area of the Control Bar. If the 
sequence is paused, clicking this button 
continues playing from the pause point.
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Stop

KEY EQUIVALENT: Type the Return key 
to stop playback or recording.

Click the Stop button to stop playback or 
recording.

Play from Counter

KEY EQUIVALENT: Type the Semicolon 
key to initiate playback from the Counter’s 
current location.

Click the Play from Counter button to 
start playing from the current Counter 
location. If the sequence is paused, click-
ing this button continues playing from the 
pause point.

Pause

KEY EQUIVALENT: Type the Spacebar or 
Semicolon key to pause playback or 
recording.

Click Pause to pause recording or play-
back. This button highlights when 
playback is paused.
188
Shuttle Bar

KEY EQUIVALENT: Type the Comma key 
to shuttle left, type the Period key to shuttle 
right.

The Shuttle bar moves the Counter at 
variable speeds. Drag the Shuttle bar to 
the left to rewind the Counter; drag the 
Shuttle bar to the right to fast forward. 
The further you move the Shuttle bar 
from the center, the faster the Counter 
scrolls. You can also click anywhere on 
the bar itself and the button will jump to 
the mouse location.

The Shuttle bar can be used during play-
back, or when a sequence is stopped.

If the sequence is stopped and an edit 
window is active, the track displayed in 
the window will play back as the Shuttle 
bar moves (this is similar to “scrubbing,” 
see Auditioning with the Scrub Command 
(pg. 26)).

Previous and Next Marker 
Buttons

KEY EQUIVALENT: Type Shift-Comma 
(<) and Shift-Period (>) to move between 
the previous and next markers.

These buttons step back and forward 
through the marker locations listed in the 
Marker pop-up.
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LOCATORS

The Locator buttons store Counter loca-
tions. After setting a Locator, clicking it 
causes the Counter to jump to the stored 
location. Each sequence stores its own set 
of eight Locators.

KEY EQUIVALENTS: Type the number of 
the desired Locator to recall that location. 
You can Option-type a number to set a 
Locator, and you can Option-Shift-type a 
number to clear it.

Setting a Locator

Undefined Locator buttons are grayed. 
You can set Locators to the current 
Counter location while the Counter is 
moving, or while it is stopped. 

To set a Locator:

a Move the Counter to the desired 
location.

If you donÕt know the exact location, you 
can instead listen for the desired location 
during playback, adding Locators 
on-the-fly.

b Option-click the Locator button you 
wish to set.

You can also hold down the Option key 
and type the number of the desired 
Locator.
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Clearing a Locator

To clear a Locator button:

a Option-Shift-click the desired Locator 
button.

The button turns gray, indicating it is 
undefined.

You can also hold down the Option and 
Shift keys and type the number of the 
desired Locator.

SYNC POP-UP

KEY EQUIVALENT: Type ~ to toggle 
between Internal and the most recently 
selected “External” mode.

The Sync pop-up displays the source of 
Vision’s sync.

Figure 23.9: Sync pop-up

The available sync sources include:

• Internal: Uses the internal clock of 
the Macintosh. In this mode, 
sequences play at their own tempo.

• External Beat Clock: Syncs to an 
external source, usually from a hard-
ware-based sequencer or drum 
machine. In this mode, sequences 
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play at the tempo of the external sync 
device, and locate and play as deter-
mined by MIDI Song Pointer 
messages.

• MIDI Time Code: Uses time code 
from a SMPTE or MTC source. The 
sync source is usually a tape track but 
could be from another application or 
MIDI device that sends MTC. In this 
mode, Vision reads the incoming time 
code and begins playback when the 
sequence’s SMPTE offset is encoun-
tered; the sequence uses it’s own 
tempo.

• MTC/Machine Control: Syncs 
Vision to an MMC compatible device. 
In this mode, Vision automatically 
sends MMC commands to control the 
sync device. For more details, see 
Chapter 39: The MMC Window.

F Remote Start: Check this option to 
automatically start or stop Vision 
from an external device or program.
With Remote Start enabled, Vision’s 
Play button flashes in the Control 
Bar, indicating that it is waiting for 
sync or a start command from an 
external device (or other application).
When unchecked, you must always 
hit Play in Vision to initiate playback, 
even after receiving external sync.

For more information on sync settings, 
see Chapter 18: Synchronization.
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BEGIN RECORD TOGGLE

The Begin Record toggle determines how 
Vision begins recording. There are two 
modes:

Wait for Note

Figure 23.10: Begin Record toggle in Wait for 
Note mode

When using Wait for Note, recording 
does not begin until the first MIDI note is 
received. This method ensures you begin 
playing when you’re ready to record, and 
that the first note is recorded at the pre-
cise beginning of the section. 

NOTE: The metronome does start when 
clicking the Record button so you can get a 
feel for the tempo.

Countoff

Figure 23.11: Begin Record toggle in Countoff 
mode
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When using Countoff, Vision plays a spec-
ified number of measures before entering 
record mode.

You can change the number of bars in the 
Countoff field by using the mouse or Mac-
intosh keyboard. If Punch recording, 
playback begins this number of bars 
before the In Point. 

Figure 23.12: Changing the Countoff

THE COUNTER

The Control Bar’s Counter displays the 
current location for the current sequence. 
The Counter displays location information 
in two ways:

• Bars/beats/units
• SMPTE 

(Hours:Minutes:Seconds:Frames)

By default, the bars/beats/units are in 
large text and the SMPTE frames are in 
small text, see Figure 23.13.

Figure 23.13: The Counter
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You can switch the positions of the two 
displays (making SMPTE the large dis-
play) by clicking the Counter Display 
toggle ( ). Click it again to return the 
display to its default.

Figure 23.14: Switching between the Counter 
Displays

The Counter scrolls automatically during 
playback. When Vision is stopped, the 
Counter is updated whenever the Edit In 
Point changes—such as when clicking in 
an edit window.

You can change a Counter value by click-
ing on it and typing a number, or by 
clicking and dragging with the mouse.

Figure 23.15: Setting Counter location

NOTE: You can also open a larger version 
of the Control Bar’s Counter by choosing 
Windows>Counter. Because the Counter 
Window is resizable you can make it as big 
as you want—and you can switch its dis-
play font. See Counter (pg. 444) for details.
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About Units

Vision uses a 480 pulses-per-quarter note 
(ppq) resolution. This means that there 
are 480 units in each quarter note, and 
that there are 480 possible locations 
within each quarter note for a MIDI event 
to occur.

About Frames and Bits

Frames and bits are part of the SMPTE 
time code specification. The number of 
frames in one second depends on the type 
of time code used—see SMPTE Time 
Code Rates (pg. 150) for a description of 
the different frame rates. There are 80 
bits in a frame. Bits are shown in a 
sequence’s SMPTE offset, and in edit win-
dows for event locations.

Vision rounds each SMPTE location to 
the nearest 480th of a beat. When typing 
in a SMPTE number (for an event loca-
tion, for example), you may notice that 
Vision rounds the entered number to the 
nearest bar/beat/unit—which in the pro-
cess may alter slightly the SMPTE 
location.

TEMPO DISPLAY

The Control Bar’s Tempo Display usually 
shows the tempo of the current sequence. 
It is updated automatically if the tempo of 
the current sequence changes, or if you 
are syncing to External Beat Clock.
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Normally, you cannot change the Tempo 
Display. However, by muting the current 
sequence’s Tempo track, you can tempo-
rarily adjust the tempo in the Control Bar: 

a Open the Tracks Window for the 
current sequence.

b Click the Mute column for the Tempo 
track.

The Control BarÕs Tempo Display 
becomes editable.

c Click in the Tempo Display field and 
type in the desired tempo, or click and 
drag with the mouse.

NOTE: Changing the Display Tempo while 
recording, records these changes to the cur-
rent sequence’s Tempo track.

There are actually many ways to change 
or adjust a sequence’s tempo track. See 
Virtual Conducting—Recording Tempo 
Changes (pg. 137) for more details. 

To open a List Window for the current 
sequence’s Tempo track, click the Metro-
nome button ( ).
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MEMORY DISPLAY

The Memory Display indicates the avail-
able memory in Vision. For a more 
detailed look, click on the Memory Dis-
play for a pop-up.

Figure 23.16: Memory Pop-up

The “Largest free block” shows the larg-
est contiguous amount of available 
memory.

If the “Total free space” is substantially 
larger than the “Largest free block,” you 
may have fragmented memory. You can 
sometimes correct this by quitting and re-
launching Vision.

To increase the available memory for 
Vision, Get Info on the application from 
the Finder and increase the “Preferred 
Size.” This must be done while Vision is 
not launched.

IMPORTANT: Before allocating more 
memory to Vision, make sure your com-
puter has enough installed RAM. See your 
Macintosh operating manuals for more 
information.
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MARKER POP-UP

The Marker pop-up lists any markers con-
tained in the current sequence’s Meter 
track. Selecting a marker from this pop-up 
moves the Counter to that marker’s 
location.

Figure 23.17: The Marker Pop-up

Before creating any markers, the Marker 
pop-up contains items for beginning, in 
point, and end of sequence. These 
items, shown in parentheses, are not user-
defined and do not appear in the Marker 
Display.

When the Counter reaches a marker’s 
location, the Marker pop-up automati-
cally displays the name of that marker.

To open a List Window for the current 
sequence’s Meter track, click the Marker 
button ( ). 

To add new markers, choose either 
Do>Insert Bar Marker or Do>Insert 
SMPTE Marker (see page 422), or use 
the Insert pop-up in the List Window to 
insert a marker (see page 271).
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PUNCH AND LOOP CONTROLS

Figure 23.18: The Punch Controls in the Control 
Bar

Use these controls to enable and disable 
Punch and Loop modes, and to specify a 
range for playing, recording, and looping.

Punch Toggle

KEY EQUIVALENT: Type Shift-6 to toggle 
Punch mode.

Click the Punch toggle to enable or dis-
able Punch mode. Punch mode allows 
you to record or play a precise portion of a 
sequence (based on the In Point and Out 
Point fields).

When Punch mode is enabled:

• The Play From Start button initiates 
playback from the In Point.

• Recording only occurs within the 
range specified by the In and Out 
Points—Vision disables recording 
before the Counter reaches the 
In Point, and after the Counter 
reaches the Out Point.

Set In Point

Set Out Point

Punch Toggle
(disabled)

In Point

Out Point

Loop Toggle
(enabled)
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• You can manually enter record mode, 
during playback, by typing the Tab 
key or by clicking the Record button.

• If Options>Stop at Punch Out is 
checked, Vision automatically stops 
playback at the Out Point.

When Punch mode is disabled:

• The Play From Start and Record 
buttons always start playback from 
the beginning of the sequence.

• Recording with one of the “replace” 
modes replaces the entire track, 
regardless of how much recording 
was done.

Loop Toggle

KEY EQUIVALENT: Type Shift-7 to toggle 
Loop mode.

Click the Loop toggle to enable or disable 
Loop mode. When enabled, Vision contin-
uously repeats the portion of the 
sequence determined by the In and Out 
Points (for both playback and recording).

During playback, Loop mode lets you take 
full advantage of Vision’s real-time editing 
capabilities. You can listen to specific sec-
tions of a track, perform edits, and then 
immediately listen to the results— with-
out stopping and restarting the sequence.

With overdub recording, you can use 
looping to build track data, without exit-
ing record mode. This is effective when 
working with drum tracks, repeating 
musical patterns, and multi-timbral takes.
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Following are some helpful features rele-
vant to recording in Loop mode:

• Type the Enter key when satisfied 
with a performance—the material is 
saved to the track and Vision contin-
ues loop recording.

• If you make a mistake, type the 
Delete key to erase anything 
recorded since the last time Enter 
was typed.

• Type Command-Shift-¯ to record-
enable the next track; use Command-
Shift-­ to record-enable the previous 
track.

For more information on Loop recording, 
see Loop Recording (pg. 35).

In Point and Out Point Fields

KEY EQUIVALENT: You can set the In 
Point and Out Points by typing = and 
then / on your computer’s numeric 
keypad.

The In and Out Points determine the 
range played or recorded when Punch 
and Loop modes are enabled.

These fields, which are always displayed 
as bars/beats/units, can be set by manu-
ally typing in the desired fields; or you can 
use the Set In and Set Out Point buttons 
to automatically set them.
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When both Punch and Loop are disabled, 
the In Point and Out Point fields are 
grayed out.

Figure 23.19: In/Out Point fields, disabled 

NOTE: When the Punch Points follow 
Edit Points option is enabled in the Set-
tings Window, any changes made to the 
Edit In/Out points (when playback is 
stopped) are automatically entered into the 
In Point and Out Point fields.

Set In Point Button

KEY EQUIVALENT: Type [ to set the 
In Point.

Click this button during playback to set 
the In Point to the Counter location. 
When playback is stopped or paused, this 
button sets the In Point to that of the 
Edit In location.

Set Out Point Button

KEY EQUIVALENT: Type ] to set the 
Out Point.

Click this button during playback to set 
the Out Point to the Counter location. 
When playback is stopped or paused, this 
button sets the Out Point to that of the 
Edit Out location.
anual 195



PART 6: Windows
WINDOW BUTTONS

Figure 23.20: Control Bar Window buttons

Click one of Control Bar’s Window but-
tons to open the Sequences, Tracks, 
Pulse, List, Graphic, or Notation Win-
dows. If the window is already open, it is 
brought to the front. 

Clicking any of the Window buttons is the 
same as choosing the corresponding com-
mand from the Windows menu.

Sequences

Tracks List

Graphic

Notation
Pulse
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The Sequences Window lists all 
sequences and segments contained in the 
current Vision file. Also listed are the 
sequence templates stored in the Vision 
Setup file. These three items are listed in 
separate sections of the Sequences 
Window.

Figure 24.1: Sequences Window

Although sequences, segments, and tem-
plates share some common 
characteristics, there are important differ-
ences between the three:

• Sequences are groups of up to 99 
tracks. At their most basic, sequences 
can be viewed as single songs; how-
ever, with the use of sequence events, 
they can also be used as song sec-
tions or even music layers within a 
parent sequence.
Unlike segments, sequences can be 
triggered by a key equivalent or MIDI 
event.
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• Segments are just like sequences 
except they are usually made from 
existing track material (by choosing 
Edit>Make Segment/Loop). Unlike 
sequences, segments cannot be 
assigned a key or MIDI trigger. 
Also, segments have the option of 
being automatically deleted when no 
longer referenced by a parent 
sequence.
Segments can be turned into 
sequences by dragging them into the 
Sequences section.

• Templates are starting points for 
opening new sequences. If, for 
instance, you have a sequence (or 
segment) with useful track assign-
ments, appropriate meter and tempo 
settings, or anything else, you can 
save it as a sequence template.
Templates cannot be opened directly 
for editing or playback. Instead, they 
are copied to a new sequence when 
double-clicked, or when invoked by 
their key or MIDI trigger.
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SELECTING, MOVING, AND 
COPYING SEQUENCES

You can hide or view the items contained 
in each section of the Sequences Window 
by clicking the open/close triangle.

Figure 24.2: Templates section, closed and open

As discussed in Selector Dots and Move 
Cursor (pg. 22), sequences and segments 
can be selected and highlighted with their 
selector dots. Once a sequence or seg-
ment is selected, it can be deleted, copied 
and pasted to another Vision file, copied 
and pasted as a sequence event into the 
Tracks or List Window, or modified with 
any of Vision’s edit commands. In addi-
tion, they can be moved to another 
position within their section with the 
move cursor ( ).

NOTE: Drag a segment into the Sequences 
section of the Sequences Window to turn it 
into a sequence. Sequences, in turn, can be 
dragged into the Segments section.
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SEQUENCES WINDOW 
COLUMNS

The columns in the Sequences Window 
include Name, Key, MIDI, References, 
and Comments. As discussed in Moving 
and Resizing Columns (pg. 23), these col-
umns can be moved or resized as 
desired—allowing you to best utilize 
screen space.

Following is a description of each 
Sequences Window column:

Name

Although sequences are named automati-
cally when created (segments can be 
named when they are made with the 
Make Segment/Loop command), they 
can be easily renamed from this column.

To enter or change a name, simply click 
in the field and type the new name; then 
type Enter, or click anywhere else in the 
window, to enter the new name.

Key

Use the Key column to assign a key equiv-
alent to the sequence. Click in the field 
and type the key or key combination; keys 
in use by the program cannot be entered 
and you’ll be prompted if you try to use a 
key already assigned to another 
sequence. If necessary, you can enter key 
combinations that use the Shift and Con-
trol keys.
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Use the key trigger to initiate playback of 
the sequence, or to record it as a 
sequence event.

NOTE: Key and MIDI triggers cannot be 
assigned to segments. If you must assign a 
trigger to a segment, turn it into a sequence 
by dragging it to the Sequences section.

MIDI

Just like key equivalents, MIDI events can 
also trigger a sequence’s playback. To 
assign a MIDI trigger, click in the column 
and send the desired event from your 
MIDI controller. If the MIDI column is 
resized large enough, you will see the 
event type and the device that sent it. To 
clear an assigned MIDI event, click in the 
column and type Delete. 

The MIDI column lets you create and edit 
MIDIKeys for your sequences without 
opening the MIDIKeys Window (dis-
cussed on page 171).

You can also use the MIDIKeys Window 
to manually enter a MIDI event and 
device, or to edit an existing assignment. 
For details on using the MIDIKeys Win-
dow, see The MIDIKeys Window 
(pg. 171).

NOTE: The MIDI triggers for sequences are 
only available if Setups>MIDIKeys 
Enabled is checked.

NOTE: Key and MIDI triggers cannot be 
assigned to segments. If you must assign a 
trigger to a segment, turn it into a sequence 
by dragging it to the Sequences section.
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References

When a sequence or segment is refer-
enced by a parent sequence, information 
about the sequence event is displayed in 
the Reference column. The column lists 
the name of the parent sequence and 
track, and the measure location of the 
sequence event (see Figure 24.3).

NOTE: Sequence events describe how to 
play a sequence or segment from a parent 
sequence.

Figure 24.3: Pop-up of sequence event references

Although the column normally displays 
just the first reference, you can click in it 
for a complete pop-up listing of each track 
containing a reference (with the first bar 
shown), see Figure 24.3.

Comments

Use the Comments column to enter 
descriptive text about the sequence or 
segment. Resize the column, as neces-
sary, to display more of the sequence’s 
comments.
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SEQUENCES WINDOW MENU

The following commands are available 
from the menu in the Sequences Window:

Figure 24.4: Sequences Window menu

NOTE: These commands are also available 
from the Do menu when the Sequences 
Window is the active window.

New Sequence (Command-N)

Creates a new sequence and automati-
cally opens its Tracks Window. The new 
sequence is automatically named and 
assigned a key trigger.

New Generated Sequence

Creates a new generated sequence and 
opens its Tracks Window. These special 
sequences generate new and interesting 
music from existing notes and rhythms. 

For more information, see 
Chapter 14: Generated Sequences.
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Duplicate (Command-D)

Makes a copy of the selected sequence or 
segment. The new sequence is automati-
cally named (based on the original) and 
assigned a key trigger.

NOTE: Segments are always duplicated as 
sequences and placed in the Sequences 
section.

Save as Template

Use this command to save the selected 
sequence or segment as a template. When 
saving a template, you are prompted to 
name the new template.

IMPORTANT: Sequences containing 
sequence events or digital audio events 
cannot be saved as sequence templates.

Remove Unused Segments

When chosen, all segments without refer-
ences are deleted. This command is only 
available if the Automatically Remove 
Unused Segments item is unchecked.

Automatically Remove Unused 
Segments

Check this option if you want segments 
automatically deleted when no longer ref-
erenced by any parent sequences.
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Set Default Location

Saves the location, size, and column con-
figuration of the Sequences Window as 
default. These settings are then used for 
any new Vision files.
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CHAPTER 25: The Tracks Window
Figure 25.1: Tracks Window

The Tracks Window lists all tracks in a 
given sequence. In addition to having a 
variety of sequence and track controls, 
the Tracks Window also contains a “Track 
Overview” and Strip Chart for displaying 
and editing individual track data.

For information on edit tools and edit 
functions common to all of Vision’s edit 
windows, see Chapter 9: Basic Editing 
Procedures. For information on navigating 
Vision’s windows, see 
Chapter 4: Navigating in Vision.
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TWO WINDOWS IN ONE

The Tracks Window is divided into two 
basic areas: the Track Columns and the 
Track Overview section. Vision responds 
differently depending on which area you 
are working in. This distinction is subtle, 
but crucial to working with Vision.

Figure 25.2: The Two areas of the Tracks Window

When selecting items in the track col-
umns, or selecting tracks using the 
selector dots (left side of the window), 
Vision is in “Tracks” mode, indicated by 
the entire track line (Name, Length, 
Instrument, and Comments) becoming 
highlighted, as shown in Figure 25.2. In 
this mode, edit operations affect the 
selected track or tracks and their entire 
contents.

Track Columns Track Overview
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When selecting tracks or portions of 
tracks in the Track Overview (right side 
of the window), Vision is in “Events” 
mode, indicated by highlighted track 
blocks (not highlighted track lines). In 
this mode, edit operations affect only the 
events in the selected track regions.

Figure 25.3: Events mode selection

Track Overview Toggle

Click the Track Overview toggle to show 
or hide the Track Overview section.

Figure 25.4: Tracks Window, Track Overview 
hidden

Track
Overview
toggle
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Window Divider

Use this divider to specify how the Tracks 
Window divides its space between the 
Track columns and Track Overview area. 
When the mouse is positioned over the 
divider, the cursor changes into a resize 
cursor ( ). The divider can be dragged, 
changing the size of both areas, which 
could cause the Track Overview area to 
cover Comments and other columns.

Figure 25.5: Resizing the Track Overview section

NOTE: You can also double-click the 
Window Divider to move it all the way to 
the left or right.
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Expanded Info Area and Strip 
Chart

The lower portion of the Tracks Window 
can be expanded by clicking the open/
close triangle. The lower-left area, when 
opened, displays expanded Play Quantize 
settings for selected tracks, or sequence 
event info for selected sequence event 
blocks. The lower-right area displays the 
Strip Chart.

Figure 25.6: Tracks Window with expanded info 
area and Strip Chart

For information on the info area’s Play 
Quantize controls, see Play Quantize 
(pg. 72). For information about the Opts 
menu, see Opts Menu (pg. 262). For infor-
mation on sequence event controls, see 
Sequence Event Parameters (pg. 96). And, 
for details on using the Strip Chart, see 
Chapter 28: The Strip Chart.

Expanded Info Area Strip Chart
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TRACK COLUMNS

Figure 25.7: Track columns in Tracks Window

As mentioned in Moving and Resizing Col-
umns (pg. 23), each of the track columns 
can be moved (and some resized) as 
desired—allowing you to best utilize 
screen space.

Each of the track columns are discussed 
in the following sections.

Select and Move

As discussed in Selector Dots and Move 
Cursor (pg. 22), tracks can be selected 
and highlighted with their selector dots. 
Once a track is selected, it can be deleted, 
copied and pasted to another sequence, or 
modified with any of Vision’s edit com-
mands. In addition, they can be moved to 
another position within the Tracks 
Window with the move cursor ( ).

Record

Click in this column to record-enable the 
track. Only one track can be record-
enabled at a time. An “R” appears in the 
track’s column when record-enabled. 
Clicking again disables the track for 
recording.

Type Command-Shift-­ to enable record-
ing on the previous track, or Command-
Shift-¯ to enable recording on the next 
track.
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Mute

Click in this column to mute playback for 
a track (or group of tracks). This lets you 
listen to and focus on other tracks within 
the sequence. An “M” appears in the 
track’s column when it is muted.

Click on the M in the column head to 
toggle the mutes for all selected tracks. 
Command-click the M in the column head 
to unmute all tracks in the sequence.

Solo

Click in this column to hear only that 
track, or group of tracks. An “S” appears 
in this column when the track is soloed.

Click on the S in the column head to 
toggle the solos for all selected tracks. 
Command-click the S in the column head 
to unsolo all tracks in the sequence.

Track Name

To enter or change the name of a track, 
highlight this field and type the desired 
name, then type Enter or click anywhere 
else on the screen to enter the new name. 

Length and Looping

These fields display the length of the 
sequence and tracks. Option-click to lock 
or unlock a length. To loop a track or 
sequence, click on either edge of this 
field.
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Figure 25.8: Track and sequence lengths

Vision automatically sets the sequence 
length to that of the greatest track length. 
If all tracks are looped, the sequence 
length becomes infinity (¥). If this field 
displays a “>” or “<” symbol, the sequence 
doesn’t end cleanly on the barline.

Locking a Track or Sequence Length

Option-click a track or sequence length to 
lock or unlock it. When a length is locked, 
a small padlock icon ( ) appears, indicat-
ing that Vision cannot automatically 
change it—although you can do so manu-
ally by typing a new value into the field, or 
by clicking and dragging with the mouse.

Normally, track lengths are automatically 
updated, if necessary, after recording. 
And if you record a track that is longer 
than the sequence length, Vision length-
ens the sequence automatically.

Length header 
(click to toggle 
looping of 
selected tracks)

Sequence

Track lengths
Looped track

Locked track

length
Opco
de Systems, Inc.
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Looping a Track or Sequence

Set the loop option to play a track or 
sequence indefinitely by clicking either 
edge of the length field.

Figure 25.9: Setting a sequence to loop

Figure 25.10: Setting a track to loop

When a track loops, Vision plays the 
track’s contents (beginning at the 
sequence start point) repeatedly, regard-
less of what the other tracks are playing. 
All tracks loop independently of each 
other. For example, if one track is set to 
loop every 2 bars, and another every 3 
bars, the tracks coincide every 6 bars.

When a sequence loops, Vision restarts all 
tracks at the sequence Start Point, after it 
reaches the end of the sequence. This 
includes the Tempo and Meter tracks.
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To loop or unloop several tracks 
simultaneously:

a Select the desired tracks.

b Click in the Length column heading.

The loop mode for each selected track is 
toggled.

Drum ( )

Click in this column to specify that the 
track is a drum track, which allows it to be 
viewed and edited in the Pulse Window.

Drum Instruments do not allow a note to 
be retriggered until that note is finished 
playing. Also, notes on Drum Instruments 
don’t play if playback begins after the 
note’s onset. This is useful when working 
with drum loops on samplers, where it 
doesn’t make sense to trigger the note 
anywhere except at the start. For exam-
ple, a note beginning on beat 1 and ending 

Click here...

... to toggle the loop setting
for each selected track
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on beat 4 won’t play if playback begins on 
beat 2. This concept applies to mutes and 
solos as well; if a drum instrument or 
track is soloed or unmuted on beat 2, a 
note beginning on beat 1 and ending on 
beat 4 won’t play.

For more information about drum tracks, 
please see Drum Tracks (pg. 223).

Instrument

The Instrument column displays the 
assigned Instrument for each track.

When recording a track, the current Thru 
Instrument (shown in the Control Bar) is 
automatically assigned to the track.

To change a track’s Instrument assign-
ment, choose a new Instrument from the 
pop-up that appears when clicking in the 
Instrument column for that track.

Multi Instruments

Although each track is usually assigned to 
a single Instrument for playback, tracks 
can contain events to be played on several 
Instruments (up to 16). “Multi” tracks can 
be created from one or more selected 
tracks by choosing Edit>Combine 
Tracks (see page 413).

Multi-tracks can also be created by 
recording on multiple channels into a 
single track via the Input Map. For 
details, see Multi-Channel Recording 
(pg. 46).
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To reassign Instruments within a multi-
track:

a Click in the Instrument column for 
the multi-track.

Vision displays a list of Instruments used 
by the track, plus a ÒRemap InstrumentsÓ 
option.

b Choose the Remap Instruments 
option to open the following dialog.

c Click on an Instrument pop-up to 
reassign its data to a different 
Instrument.
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Multi-tracks can be split into separate 
tracks by choosing Edit>Separate Multi 
Track. See page 413 for details.

Patch

The Patch column shows the name or 
number of the patch associated with the 
Instrument. For details on how Vision 
uses names, see Chapter 33: The Names 
Window.

NOTE: For multi-tracks, the patch column 
is blank.

The Patch column displays its contents in 
five different ways:

• Patch name in normal type
There is a patch event residing in one 
of the sequence’s tracks.

• Patch name in italics
The patch isn’t currently loaded in 
the Instrument, but there is a patch 
event specifying it in one of the 
sequence’s tracks.

• Patch name in parentheses
There is no patch event for this 
Instrument anywhere in the 
sequence. The name shown in the 
Patch column is the last one sent to 
the Instrument (probably from the 
Control Bar’s Current Patch pop-up).

• “Various”
The word “Various” in the Patch 
column indicates that there is more 
than one patch event for that Instru-
ment in the sequence (muted tracks 
are ignored).
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• Number
Instruments that aren’t subscribed to 
a Patch Name document (see 
page 305) display a numerical repre-
sentation of the current or stored 
patch.

Patch events can be changed by clicking 
the Patch column and choosing from the 
pop-up menu of patches associated with 
the track’s Instrument. Option-clicking 
the column opens the Name Browser—
see Names Browser (pg. 321) for a com-
plete description. A patch can also be 
selected by typing the first few letters of 
its name, and typing Enter.

Clicking on a patch name in parentheses 
and selecting a patch from the pop-up 
inserts a patch event at the beginning of 
that track (and removes the parentheses). 
When selecting a patch, the Patch column 
changes even if the original patch event is 
located in another track.

The Patch column can reference a multi-
track containing only patch events for 
multiple Instruments, such as that created 
by the Copy Patches command (see 
page 421). Each patch from the multi-
track is displayed in the Patch column of 
tracks assigned to their corresponding 
Instruments. Changing patches in the 
Patch column simultaneously updates the 
multi-patches track.
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The Patch column also supports having a 
separate “setup” sequence that sends 
patches and perhaps sysex. After having 
played the setup sequence, the current 
patches displayed in the normal 
sequences will all be correct, though they 
are displayed in parentheses.

It is possible to make a window to monitor 
the current patches for several Instru-
ments just by creating an empty sequence 
containing tracks assigned to those 
Instruments. As various patch events are 
played, the new current patches are 
displayed.

Comments

Type any text into this field to make notes 
or comments about any of the tracks.

METER AND TEMPO TRACKS

The Meter Track

Every sequence has a Meter track that 
can contain three types of information: 
meter changes, key signature changes, 
and markers.
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If a sequence has a constant meter, it is 
displayed in the Tracks Window, where it 
can be edited by clicking the top or 
bottom number and entering a new value. 
See Figure 25.11.

Figure 25.11: Setting the meter from the Tracks 
Window

Meter Changes

If a sequence contains more than one 
meter event, the Tracks Window displays 
“Meter Track” in the Meter field. In this 
case, editing the Meter track must occur 
from a List or Notation Window. To open 
a List Window of meter events, double-
click the selector dot.

Figure 25.12: Meter Track in the Tracks Window

See also Changing the Meter in Notation 
Windows (pg. 279) and Inserting Meter 
Changes in a List Window (pg. 270). To 
automatically add meter changes, see 
Reclocking to a Click Track (pg. 144).

Key Signature Changes

Key changes must be viewed and edited 
from within a List or Notation Window. 
See Changing the Key in Notation Win-
dows (pg. 279) and Inserting Key Changes 
in a List Window (pg. 271) for details.
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Markers

Markers allow you to move quickly to dif-
ferent counter locations. For information 
on recalling markers, see Marker Pop-up 
(pg. 193). For information on inserting 
markers, see Insert Bar Marker (Com-
mand-’) (pg. 422) in Chapter 43: The Do 
Menu, and Inserting Markers in a List 
Window (pg. 271).

The Tempo Track

The Tempo field shows the tempo for the 
sequence. A sequence’s Tempo track con-
tains only tempo change events. For a 
new sequence, the tempo track contains 
one tempo change event at the beginning 
of the sequence.

If a sequence’s Tempo track contains just 
one tempo event, the value is editable 
from the Tracks Window. If the sequence 
contains more than one tempo event, 
“Tempo Track” is displayed in the Tempo 
field.

Figure 25.13: Tempo Track in Tracks Window

For sequences containing tempo changes, 
double-click the Tempo track’s selector 
dot to open a List Window of tempo 
events.

Other tempo related topics:

• To use the Change Tempo dialog, see 
Change Tempo (Option-’) (pg. 422).
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• To change the tempo in the Strip 
Chart, see Tempo (pg. 250).

• To insert tempo changes in a List 
Window, see Tempo Track List Win-
dows (pg. 271).

• To record tempo changes in real 
time, see Virtual Conducting—Record-
ing Tempo Changes (pg. 137).

• To make the sequence play at the 
Master tempo setting in the Control 
Bar, see Tempo Display (pg. 192).

• To allow simultaneously playing 
sequences to use their own Tempo 
tracks, see Sync Mode (pg. 212).

• To add tempo changes automatically 
while scaling time, see Editing a 
Rubato Performance (pg. 144).

• To display the Tempo field with more 
resolution (4 decimal places), see 
Clean Tempo Display (pg. 334).
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SEQUENCE INFORMATION

Information Toggle

The Sync and Offset settings, if used at 
all, are usually set once and not used 
again. Choose Show Info from the 
Tracks Window menu to show and hide 
this information—or click the Information 
toggle.

Figure 25.14: Click the Information toggle to 
show and hide sequence information

SMPTE Offset

The SMPTE Offset sets the SMPTE start 
time of a sequence and is also used as the 
basis for computing SMPTE times dis-
played in List Windows.

SHORTCUT: Click the Offset button to 
grab the current SMPTE location from the 
Counter in the Control Bar. The SMPTE 
Offset field is updated automatically with 
the new location.

Information toggle

SMPTE Offset Sequence Start

Sync Mode

Grab SMPTE
Offset button
212
Sequence Start

Use the sequence Start Point to create a 
pickup for the sequence. Each sequence’s 
Start Point can only be defined as 1•1•0 
or earlier (anywhere in Bar 0). 

For example, to set an eighth note pickup 
for the sequence:

a Set the sequence Start Point to 
0¥4¥240.

Opening an edit Window shows the 
sequence starting at 0¥4¥240, an eighth 
note earlier than bar 1. 

NOTE: Setting a sequenceÕs Start Point 
to somewhere in bar 0, shifts all existing 
events back by one measure. Events 
residing before the Start Point are played 
at the Start Point.

Sync Mode

Figure 25.15: Sync Mode pop-up

Sequence Start Point
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Each sequence has its own Tempo track 
that usually determines its playback 
tempo. However, Vision also allows play-
back of several sequences simultaneously 
(see Players (pg. 113)). In these cases, 
you can specify whether the sequence 
uses the Master Tempo (and plays in sync 
with the other sequences), or whether it 
uses its own Tempo track.

The Sync mode pop-up allows selection of 
one of the following choices:

• Off
The sequence plays independently of 
the Master Tempo (except when 
synced to MIDI Beat Clock). In this 
mode, Vision is substantially bur-
dened with real-time computations; 
you should therefore only use this 
mode when you need to play simulta-
neous sequences with independent 
tempos.

• Speed (default)
The sequence uses the Master 
Tempo. If a new sequence is trig-
gered when other sequences are 
already playing, the new sequence 
starts playing immediately.

• Start
The sequence uses the Master 
Tempo. When a sequence is already 
playing, triggering a new sequence 
causes a delay in playback until the 
Counter returns to the playing 
sequence’s Start Point, thereby keep-
ing both sequences in sync.

You cannot change the Sync mode while 
playing or recording.
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TRACK OVERVIEW—VIEWING 
AND EDITING BLOCKS

Figure 25.16: Track Overview area of Tracks 
Window

If Detailed Track Overview is enabled 
in the Tracks Window menu, Vision dis-
plays actual MIDI data in the Track 
Overview area, using either a miniature 
piano roll or Strip Chart. The Strip Chart 
events are visible only if there are no note 
events occurring at the same time.

If a track contains both sequence events 
and MIDI data, the sequence event blocks 
will hide the MIDI data in the Track 
Overview.

NOTE: The Track Overview can display 
any part of the sequence at any horizontal 
zoom level, and with one of four vertical 
zoom levels. See Vertical Zooming 
(pg. 217).

Display Mode

Cursor Display

Arrow Tool

Marquee Tool
I- Beam Tool

Cursor
Quantize

Ruler Track Overview

Exact
Mode

Block Size
or Phrases
Silence
Size
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Display Modes

The Track Overview has three display 
modes: Phrases, Blocks, and Tracks. In 
addition, there is an option for Markers 
Break Blocks.

Figure 25.17: Display Mode pop-up

NOTE: In all Display modes, a sequence 
event is displayed as its own block.

Phrases

Phrases mode groups MIDI events into 
blocks created from MIDI events occur-
ring closely together in time, but 
separated from other MIDI events by 
silence longer than the value selected in 
the Silence pop-up (see page 215).

Blocks

Blocks mode displays blocks of equal 
size. The Block size is set using the Block 
Size pop-up (see page 215).
214
Tracks

In Tracks mode, the entire track is a 
single block. This allows the entire track 
to be selected with a single mouse click in 
the Track Overview. 

Markers Break Blocks

Check this option and Vision will break 
the material in the Track Overview into 
blocks wherever it encounters a marker.

For example, when using Tracks mode 
with Markers Break Blocks checked, 
Vision breaks your Track Overview into 
blocks that correspond exactly with every 
marker.

Figure 25.18: Track Display Mode with Markers 
Break Blocks enabled

Markers shown here...

... break Track Overview into separate blocks
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This has numerous uses. For example:

• Figure 25.18 shows a case where an 
EDL (Edit Decision List) was made 
using markers—the Markers Break 
Blocks option lets you quickly locate 
your individual musical passages 
visually in the Track Overview.

• If you record your entire song in a 
single sequence and use markers to 
define the sections (intro, verse, cho-
rus, bridge), then by using the 
Markers Break Blocks option, you 
can easily locate to various portions of 
your song using only the visual feed-
back in the Track Overview.

If you display either Phrases or Blocks 
and check the Markers Break Blocks 
option, Vision continues to break up the 
Track Overview using the options set in 
either the Silence or Size selectors, but it 
further breaks the Track Overview at 
every marker.

NOTE: Markers are set, stored, and edited 
in the Meter track as described in Inserting 
Markers in a List Window (pg. 271).

You can also insert markers by selecting 
either Do>Insert Bar Marker or 
Do>Insert SMPTE Marker.

Cursor Display

The Cursor Display constantly reflects 
the placement of your cursor in the track 
overview.
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This is useful when you prefer more spe-
cific numeric feedback to graphical 
feedback about your cursor’s position. 
For example, when making selections, 
dragging, etc., it is often helpful to know 
exactly where your cursor is.

Clicking on the I-beam icon in the Cursor 
display (as shown in Figure 25.19) tog-
gles a SMPTE display on and off.

Figure 25.19: Cursor display

The SMPTE display is especially useful 
when scoring to film or video; for 
instance, if you need to insert a sound 
effect at a specific SMPTE location, use 
the SMPTE cursor display to ensure that 
the data is entered accurately.

Block Size/Phrase Silence Size 
Pop-Up
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When viewing tracks in Phrases or 
Blocks mode, the display resolution is 
specified in this pop-up. In Phrases mode, 
the value defines the amount of time that 
a track must be silent in order for Vision 
to break it into separate blocks. In Blocks 
mode, the value defines the size of the 
block.

Using the Arrow Tool in Track 
Overview

With the Arrow tool selected, clicking on 
blocks selects them. Shift-clicking addi-
tional blocks allows multiple, possibly 
discontiguous, blocks to be selected.

Using the Arrow tool selects all types of 
MIDI data in addition to notes.

Figure 25.20: Selected track blocks

Dragging a selection rectangle with the 
Arrow tool selects any block touched by 
the rectangle.

Figure 25.21: A selection rectangle with the 
Arrow tool
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Using the Marquee Tool in Track 
Overview

Use the Marquee tool to select a time 
range of blocks in the Track Overview by 
dragging a rectangle around the block(s).

This selects all types of MIDI data in the 
tracks in addition to notes.

Figure 25.22: A selection rectangle with the 
Marquee tool

Using the I-Beam Tool in Track 
Overview

Use the I-Beam tool to select a time range 
in all tracks in a sequence, including the 
Tempo track.

This selects all types of MIDI data in the 
tracks in addition to notes.

Figure 25.23: Selecting all tracks with the I-Beam 
tool
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Selecting in the Track Overview 
Ruler

When the cursor is moved into the Ruler 
(regardless of the selected tool), it turns 
into the I-beam tool. Dragging the cursor 
in the Ruler selects a time range in all 
tracks in the Track Overview. Clicking in 
the Ruler sets the Edit In point, but 
doesn’t select all the tracks. This allows 
copying a selection, clicking in the Ruler 
to set a destination time, then pasting the 
data at the selected point. This method 
can considerably ease the task of locating 
the same data in other windows.

Dragging Blocks in Track 
Overview

Use the Arrow tool to drag blocks in the 
Track Overview. Dragging a block from 
one track to another merges the contents 
of the block with the contents of the desti-
nation track. The information is assigned 
to the Instrument of the destination track.

Dragging a block to a multi-track main-
tains the block’s original Instrument 
assignment.

Figure 25.24: Dragging a block to a different track
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Dragging a block horizontally changes its 
start time.

Figure 25.25: Changing the start time of a block

NOTE: When dragging blocks, Cursor 
Quantize helps position the block precisely 
on bar and beat lines. See Cursor Quantize 
(pg. 58) for more information.

Option--dragging blocks keeps the origi-
nal block untouched while copying it to a 
new location.

Figure 25.26: Option-drag to make a copy while 
moving a block.

Vertical Zooming

Zooming vertically in the Tracks Window 
works a little differently than Vision’s 
other edit windows.
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Figure 25.27: Zoom buttons in Tracks Window

NOTE: With the Strip Chart open, the 
Tracks Window has an extra set of vertical 
Zoom buttons (located below those of the 
Track Overview).

To increase the display height for all 
tracks in the Track Overview, click the 
Zoom In vertical (+) button. This lets you 
see more track detail in each track block, 
but decreases the number of tracks visi-
ble in the Tracks Window.

SHORTCUT: Option-click the Zoom In 
button to zoom the Track Overview to its 
maximum height.

Click the Zoom Out vertical (-) button to 
decrease the display height for all tracks 
in the Track Overview. This lets you see 
more tracks in the Tracks Window, but 
decreases the amount of visible detail 
within each track block.

SHORTCUT: Option-click the Zoom Out 
button to zoom the Track Overview to its 
minimum height.

Vertical Zoom buttons
for Track Overview

Vertical Zoom buttons
for Strip Chart

Horizontal Zoom buttons
for both Track Overview
and Strip Chart

Vertical scroll bar
for Strip Chart
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The Tracks Window supports four vertical 
zoom levels, shown in Figure 25.28. 
Select a zoom level that gives you the opti-
mum trade-off between track detail and 
number of visible tracks.

Figure 25.28: Four vertical zoom levels for Track 
Overview in the Tracks Window

NOTE: When zooming vertically in the 
Tracks Window, Vision recalculates the 
window size, if necessary, so that partial 
tracks are not displayed.

MIDI

Audio

MIDI

Audio

MIDI

Audio

MIDI

Audio

Zoomed Out

Zoomed In
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TRACKS WINDOW MENU

Following is an explanation of the items in 
the Tracks Window menu:

Auto Scroll (Shift-4)

When checked, Vision follows the 
Counter and automatically scrolls the con-
tents of the Track Overview section.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.

Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the Track Overview 
to the Edit In point.
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Zoom to Fit (Option-Z)

Choose this command to view the con-
tents of the entire sequence in the Track 
Overview section.

Zoom Back (Option-B)

Choose this command to return to the 
previous zoom level (acts to “undo” the 
last zoom).

Tools

This item chooses from the Arrow, Mar-
quee, and I-beam tools. Only one can be 
selected (checked) at a time. Selecting 
one deselects the others.

Choosing one of these items is identical to 
selecting the corresponding tool in the 
actual Tracks Window. For a description 
of the different tool types, see Cursor 
Tools (pg. 57).

Bar/Beat/Unit

Specifies that bars/beats/units are dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.

Absolute SMPTE

Specifies that absolute SMPTE is dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.
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Absolute time values are derived from 
adding the sequence’s offset time to the 
actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.

Relative SMPTE

Specifies that relative SMPTE is displayed 
for the Edit In/Out points, and for the 
event times in the Cursor Display.

Relative time values represent the actual 
elapsed time from the beginning of the 
sequence—without adding the 
sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the Tracks Window. Any newly 
opened Tracks Windows use these 
defaults.

Show Offset Info

This option opens and closes the Informa-
tion area of the Tracks Window. Checking 
this item is the same as clicking the Infor-
mation toggle in the upper-left corner of 
the Tracks Window (see Information 
Toggle (pg. 212)).
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Detailed Track Overview

When checked, Vision displays detailed 
MIDI information in the Track Overview 
area of the Tracks Window. You will be 
able to see the data in a piano roll or Strip 
Chart format (or audio where applicable).

When unchecked, Vision instead displays 
patterned blocks where data is present—
which speeds screen redraws.

Show Vertical Line

When checked, Vision displays a scrolling 
vertical line in the Track Overview area, 
indicating the location of the Counter as 
the sequence advances.
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PULSE WINDOW

Vision’s Pulse Window provides a visual 
and intuitive environment for creating and 
editing drum tracks. To open the Pulse 
Window choose Windows>Pulse, or 
click the Pulse Window button in the Con-
trol Bar.

Figure 26.1: Pulse Window

As can be seen in Figure 26.1, the Pulse 
Window is in many ways very similar to 
the Tracks Window. For instance, the 
sequence’s Tempo, Meter, and Length 
fields are included and displayed in the 
same place; in addition, Track columns 
are listed on the left with corresponding 
track data displayed on the right in the 
Note Grid area.

One important difference between the 
Tracks and Pulse Window is that only 
drum tracks (which are comprised of indi-
vidual note lines) can be viewed in the 
Pulse Window. For an explanation of 
drum tracks, see Drum Tracks (pg. 223).
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Features common to both the Tracks and 
Pulse Windows are discussed in 
Chapter 25: The Tracks Window. If neces-
sary, go back and read that chapter for 
information on the following topics:

• Track column descriptions, page 205;
• Sequence Length and Looping, 

page 206;
• Meter and Tempo tracks, page 210;
• Sequence Information (Offset, Start 

Point, and Sync mode), page 212;
• Info area and Strip Chart, page 222.

Note Grid Toggle

You can show or hide the Note Grid area 
by clicking the Note Grid toggle, see 
Figure 26.2.

Figure 26.2: Pulse Window, Note Grid hidden

Note
Grid
toggle
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Window Divider

Use this divider to specify how the Pulse 
Window divides its space between the 
Track columns and Note Grid. When the 
mouse is positioned over the divider, the 
cursor changes into a resize cursor ( ). 
The divider can be dragged, changing the 
size of both areas, which could cause the 
Note Grid to cover some of the track and 
note line columns.

Figure 26.3: Resizing the Note Grid area

NOTE: You can also double-click the 
Window Divider to automatically move it 
all the way to the left or right.
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Expanded Info Area and Strip 
Chart

The lower portion of the Pulse Window 
can be expanded by clicking the open/
close triangle. The lower-left area, when 
opened, displays expanded Play Quantize 
settings for selected drum tracks. The 
lower-right area displays the Strip Chart.

Figure 26.4: Pulse Window with expanded info 
area and Strip Chart

For information on the info area’s Play 
Quantize controls, see Play Quantize 
(pg. 72). See Opts Menu (pg. 262) to 
learn about the Opts menu. And, for 
details on using the Strip Chart, see 
Chapter 28: The Strip Chart.

Expanded Info Area Strip Chart
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DRUM TRACKS

Figure 26.5: Drum tracks in Pulse Window

The Pulse Window displays all drum 
tracks contained in the sequence. To 
create a new drum track, choose New 
Drum Track from the menu in the Pulse 
Window. In addition, any existing track 
can be turned into a drum track by click-
ing in the Drum column from the Tracks 
Window (see Figure 26.6).

Figure 26.6: Enabling a drum track from the 
Tracks Window

NOTE: When opening older Vision files, 
some tracks (those containing Drum 
Instruments or Instruments with note 
names) are automatically designated as 
drum tracks.

Drum tracks, like regular tracks, can be 
selected and highlighted with their selec-
tor dots, and moved to another position 
within the window with the move cursor 
( ). See Selector Dots and Move Cursor 
(pg. 22) for details.

As in the Tracks Window, the Pulse 
Window has track columns for Record, 
Mute, Solo, Length and Loop, and Com-
ments, which are discussed in Track 
Columns (pg. 205). 
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NOTE: Instrument and Patch columns are 
part of the note line description.

Each of the track columns can be moved 
(and some even resized) as desired—
allowing you to best utilize screen space. 
For details, see Moving and Resizing Col-
umns (pg. 23).

Playback

In most cases, making a track a drum 
track will have no impact on the way the 
track sounds during playback.

However, there is one exception to this 
rule. If playback of a drum track begins 
during a note, or if the track is unmuted 
or soloed during a note, that note will not 
sound. Only notes whose note on events 
occur after playback begins (or after the 
track is soloed or unmuted) will sound. 
Soloing or unmuting the Instrument that 
the track is assigned to does not demon-
strate the same effect; it works just as if 
the track is not a drum track.

This feature can be useful in live playback 
situations where a user might want to 
mute and solo tracks but only trigger note 
events that occur after the time that the 
solo button is enabled or mute is disabled. 
For example, if the triggered note is a 
sample loop, you would probably want to 
hear only full instantiations of the loop.
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Quantize settings

Unlike the Tracks Window, the Pulse 
Window has a Play Quantize column 
containing a Quantize Value pop-up and 
Play Quantize toggle. This column lets 
you easily view the Play Quantize status of 
each drum track. To enable Play Quan-
tize, simply check or uncheck the toggle.

Figure 26.7: Play Quantize toggle (enabled)

The function of the Quantize Value pop-
up changes depending on whether the 
track is using Grid or Groove for its Play 
Quantize:

• Command-click the pop-up to toggle 
between Grid and Groove Quantize;

• When in Grid mode, choose a note 
duration for the Quantize value;

• When in Groove mode, specify the 
source track for the Groove;

• When in Groove Mode, Shift-click on 
the pop-up to specify the source 
sequence for the Groove.

To access the complete list of Play Quan-
tize parameters, select the desired track 
and click the open/close triangle in the 
info area (see Expanded Info Area and 
Strip Chart (pg. 222)).
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Drum Note Lines

When creating a new drum track, it con-
tains just one note line. Additional note 
lines are added by clicking the Add 
button in the Select & Move column.

Figure 26.8: Adding drum note lines

Each drum track can contain multiple 
drum note lines. Each note line corre-
sponds to a single drum or percussion 
sound, which is defined with columns for 
Note, Instrument, and Patch.

Figure 26.9: Assigning a sound in the Note column

Click in the Note column to assign a 
sound to the note line. If the assigned 
Instrument is subscribed to a Patch Name 
document that contains note names, the 
Note column displays those names—as 
opposed to MIDI note numbers. 

Click Add button to add note lines

Click in 
Note column
to assign sound
Opcode Systems, Inc.



CHAPTER 26: The Pulse Window
Drum tracks containing note lines 
assigned to different Instruments are 
“multi” tracks and are displayed as such 
in other Vision windows.

NOTE: When recording or inserting notes 
into a drum track from another window, 
drum note lines, corresponding to the new 
data, are automatically added.

Individual drum note lines can be selected 
for editing by clicking on their respective 
selector dots. When selected, all notes in 
the note line become highlighted, and can 
be modified with any of Vision’s edit 
commands.

Figure 26.10: Selecting a drum note line

Selected note lines can also be dragged to 
a different position within a drum track, or 
to another track—drag beyond all current 
drum tracks to add a new track 
automatically. 

To remove a drum note line, select it and 
choose Edit>Clear Selection.

NOTE: You can use Separate Multi 
Track to unmerge all note lines in a drum 
track to separate tracks.

NOTE: A drum track’s Play Quantize set-
tings affect all note lines contained in that 
track. If individual settings for Play Quan-
tize and Play Shift are desired for a 
particular note line, simply drag it to a new 
drum track where it can have its own 
settings.
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Using Separate Multi Track with 
Drum Tracks

If a drum track is selected, the Separate 
Multi Track command can be used to 
separate each note line on the track into 
its own track. Select the track in the 
Tracks window and choose Edit>Separate 
Multi Track to create an individual track 
for each note line.

NOTE GRID

Figure 26.11: Note Grid area

The Note Grid displays data for each of 
the note lines in each drum track. In addi-
tion to the normal methods of recording 
and inserting MIDI data, notes can be 
inserted and deleted in the Note Grid with 
the Magic Drumstick or Pencil tools. Data 
displayed in the Note Grid is restricted to 
notes.

The Note Grid is viewed in one of two 
modes as specified by the Display pop-up.

Display Mode
Note Grid Size

Magic Drumstick tool

Velocity toggles Note Grid

Nudge
Settings
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Figure 26.12: Display Mode and Grid Size pop-ups

Both display modes provide vertical grid 
lines that help illustrate the “beat” bound-
aries in the Note Grid. The number of 
grid lines, and their spacing, is based on 
the setting in the Grid Size pop-up (just to 
the right of the Display Mode pop-up).

Matrix Display Mode

The Matrix display mode is optimized to 
provide an evenly spaced grid for insert-
ing and deleting notes.

Figure 26.13: Display mode set to Matrix with 
16th note grid lines

In this mode, inserted notes are seen as 
small squares centered cleanly within 
each grid space. Although note durations 
are not displayed, and note start times are 
not always clearly represented, Matrix 
mode provides a good environment for 
building and editing rhythms and 
patterns.
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You can zoom horizontally while in 
Matrix mode—with the Zoom buttons in 
the scroll bar, or by Option-clicking with 
the mouse. Changing the zoom levels, 
however, automatically adjusts the Grid 
Size pop-up to the appropriate corre-
sponding resolution. 

NOTE: When zooming out, groups of indi-
vidual notes are displayed as single blocks 
equal to the Display mode’s Grid Size.

Graphic Display Mode

Unlike Matrix, the Graphic display mode 
accurately displays where each note 
begins and ends (with relation to bar and 
beat lines). In this mode, the notes dis-
played are just like those used in the 
Graphic Window.

Figure 26.14: Display mode set to Graphic

This mode provides better horizontal 
zooming than Matrix mode—zooming in 
and out does not adjust the Grid Size and 
individual notes are almost always visible. 
Hence, the Graphic display mode pro-
vides an excellent environment for 
adjusting note durations and start times 
within the context of the Note Grid’s verti-
cal lines.

NOTE: When zooming out past a certain 
point while in Graphic display mode, the 
vertical grid lines disappear.
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Inserting Notes with Magic 
Drumstick

To insert a note in the Note Grid, simply 
select the Magic Drumstick and click in 
the desired grid location. The Drumstick 
works as a toggle for inserting and delet-
ing notes. To remove a note, just click on 
it with the Drumstick.

The Drumstick points in a different direc-
tion depending on its mode of operation 
(inserting or deleting).

Figure 26.15: Drag-entering with Magic Drumstick 

A series of notes can be entered, or 
removed, by clicking and dragging with 
the Drumstick. The spacing, duration and 
velocity for the entered notes is taken 
from the settings in the Insert Note sec-
tion of the Settings Window, see 
Figure 26.16.

Click in empty space
to insert note

Click on an existing note
to delete it
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Figure 26.16: Insert Note settings from Settings 
Window

The Spacing size can also be set from the 
note pop-up directly to the right of the 
Drumstick tool in the Pulse Window. And, 
if Duration is set to “Percent of Spacing” 
with 100% (in the Settings Window), 
adjusting the Spacing pop-up also sets the 
Duration value.

Notes can also be entered in the Note 
Grid area with the Pencil tool. It cannot, 
however, erase notes or click and drag a 
range of notes like the Magic Drumstick.

For a short tutorial on using the Magic 
Drumstick tool, see Building a Drum 
Track (pg. 40).

NOTE: If a drum note line is set to display 
note velocities, the vertical placement of the 
mouse determines the velocity for the 
entered note. See Note Velocities (pg. 228) 
for details.
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Note Velocities

In the Note Grid area, individual note 
lines can be displayed with or without 
velocities. A Velocity button, located just 
to the left of the Note Grid, toggles the 
display of velocities on and off for each 
line. Option-click on any one Velocity 
toggle to set all note lines to that velocity 
view.

Figure 26.17: Click Velocity toggle show and hide 
velocities for any drum note line

When enabling the Velocity toggle, the 
height of the display for that particular 
note line gets taller, thereby allowing the 
velocity range of its notes to be seen. In 
this mode, notes entered with the Drum-
stick or Pencil tools will have velocities 
based on the vertical placement of the 
mouse.

Click to view velocities
228
Adjusting Notes in the Note Grid

Figure 26.18: Dragging notes with Note Grid set 
to Matrix

With the Note Grid set to Matrix, you can 
drag notes to another grid space—for-
ward or back in time, or up and down to 
another note line. Select the Pencil or 
Marquee tool, place your cursor near the 
desired note, and one of the following 
note edit cursors will appear:

•  Click and drag left or right with 
this cursor to change the note’s loca-
tion. Any other selected notes are 
dragged as well. You can only move 
notes horizontally with this cursor.
Dragging notes in this fashion (while 
set to Matrix) always moves them in 
increments of the note value defined 
in the Spacing pop-up—regardless of 
the Cursor Quantize setting.

•  Click and drag up or down with 
this cursor to move the note to a dif-
ferent note line. Any other selected 
notes are dragged as well. You can 
only moves notes vertically with this 
cursor.

Dragging

Dragging to

forward in time

another note line
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With the Note Grid set to Graphic, the 
note edit cursors work just like they do in 
the Graphic Window. See Modifying Notes 
in the Graphic Window (pg. 236) for 
details.

NOTE: You must choose either the Mar-
quee or Pencil tool in order for the note edit 
cursors to show up in the Note Grid.

Editing Velocities in the Note Grid

If velocities are displayed for a note line, 
you can use the Marquee or Pencil tool to 
edit their values. 

Figure 26.19: Changing velocities with Note Grid 
set to Matrix mode

With the Note Grid set to Matrix, place 
your cursor near the top of the note for 
the Change Velocity cursor to appear. 
Then click and drag up or down to set the 
new velocity value, see Figure 26.19.

Figure 26.20: Changing velocities with Note Grid 
set to Graphic Mode
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If the Note Grid is set to Graphic, place 
your cursor near the center of the note. 
Once the Change Velocity cursor 
appears, click and drag up or down to set 
the new velocity value (see Figure 26.20).

NOTE: When viewing velocities for a note 
line, it is not possible to drag those notes to 
another drum note line.

TIP: You can adjust the velocities of entered 
notes on-the-fly with the Drumstick or 
Pencil tools. While viewing velocities, click 
a note into a grid space and hold down the 
mouse button; then drag up or down until 
the desired velocity is achieved—release the 
mouse button to enter the note.

Nudge

Figure 26.21: Nudge settings in the Pulse Window

Data contained in any drum track or note 
line can easily be nudged back or forward 
in time. This nudging capability provides 
an easy way to tweak the subtle timing of 
tracks or notes.
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To nudge a drum track or note line, 
simply select it and type Command® (for-
ward) or Command¬ (back). To see the 
notes actually move, you’ll need to set the 
Display mode to Graphic.

The nudge amount, set from either the 
Pulse Window or the Settings Window, is 
defined by a number of bars, beats, units, 
seconds, frames, or bits.

NOTE: Unlike settings for Play Quantize or 
Play Shift, nudging tracks and notes perma-
nently alters the data.

MULTIPLE PULSE WINDOWS

It is possible to have multiple Pulse Win-
dows open for the same sequence, which 
is desirable if you'd like them set to differ-
ent Matrix values. 

With a Pulse Window active (in front), 
simply choose Windows>Pulse, or click 
on the Pulse button in the Control Bar, to 
open an additional Pulse Window.

With a Pulse Window in the background, 
you can also open additional Pulse Win-
dows by Shift-double-clicking a drum 
track's selector dot or track block, or by 
Shift-clicking the Pulse button in the Con-
trol Bar.
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PULSE WINDOW MENU

Following is an explanation of the items in 
the Pulse Window menu:

New Drum Track (Command-Shift-N)

Choose this command to add a new drum 
track to the current sequence.

NOTE: Only drum tracks can be viewed 
and edited in the Pulse Window.
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Auto Scroll (Shift-4)

When checked, Vision follows the 
Counter and automatically scrolls the con-
tents of the Note Grid.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.

Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the Note Grid to the 
Edit In point.

Zoom to Fit (Option-Z)

Choose this command to set the size of 
the Note Grid to whole notes, which is the 
widest zoom level.

Zoom Back (Option-B)

Choose this command to return to the 
previous zoom level (acts to “undo” the 
last zoom).

Tools

This item chooses from the Marquee, 
Pencil, and Magic Drumstick tools. Only 
one can be selected (checked) at a time. 
Selecting one deselects the others.

Choosing one of these items is identical to 
selecting the corresponding tool in the 
Pulse Window’s tool palette. For a 
description of the different tool types, see 
Cursor Tools (pg. 57).
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Bar/Beat/Unit

Specifies that bars/beats/units are dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.

Absolute SMPTE

Specifies that absolute SMPTE is dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.

Absolute time values are derived from 
adding the sequence’s offset time to the 
actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.

Relative SMPTE

Specifies that relative SMPTE is displayed 
for the Edit In/Out points, and for the 
event times in the Cursor Display.

Relative time values represent the actual 
elapsed time from the beginning of the 
sequence—without adding the 
sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the Pulse Window. Any newly 
opened Pulse Windows use these 
defaults.
anual 231



PART 6: Windows
Show Offset Info

This option opens and closes the Informa-
tion area of the Pulse Window. Checking 
this item is the same as clicking the Infor-
mation toggle in the upper-left corner of 
the Pulse Window (see Information 
Toggle (pg. 212)).

Play Edited Note

When checked, Vision plays any note 
clicked. Notes inserted with the Pencil 
and Magic Drumstick are also audible. 
When unchecked, note editing does not 
trigger any sound.

Show Vertical Line

When checked, Vision displays a scrolling 
vertical line in the Note Grid area, indicat-
ing the location of the Counter as the 
sequence advances.
232
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The Graphic Window displays and edits 
MIDI data in a “Piano Roll” format. The 
“piano keys,” or pitches, are oriented at 
the left edge of the screen, descending in 
pitch from top to bottom. The display may 
be scrolled to display all 127 MIDI 
pitches. The horizontal direction, repre-
senting time flowing from left to right, is 
denoted by bars and beats. Although only 
one track can be displayed in a Graphic 
Window, many Graphic Windows can be 
open simultaneously.

Figure 27.1: Graphic Window

In Graphic Windows, notes are displayed 
graphically as rectangles (very short 
notes are displayed as X’s). The vertical 
position of each rectangle denotes the 
pitch while the horizontal location of the 
left edge of the note marks the time at 
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which the note occurs. The duration is 
represented by the length of the rectan-
gle. If the track contains multiple 
Instruments, the note color indicates the 
assigned Instrument.

Figure 27.2: Piano Roll area

For information on edit tools and edit 
functions common to each of Vision’s edit 
windows, see Chapter 9: Basic Editing 
Procedures. For information on navigating 
Vision’s windows, see 
Chapter 4: Navigating in Vision.

Pitch (note names)

Ruler Time (Bars/Beats)

Notes
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SELECTING NOTES IN THE 
GRAPHIC WINDOW

Click a note to select a it. Shift-click to 
select additional notes. Selected notes are 
hollow instead of solid. Shift-click to de-
select a selected note. 

NOTE: Once a note is selected, you can 
automatically select the previous or next 
note by typing the appropriate Arrow key 
(left or right) on your Macintosh keyboard. 
Hold down the Shift key and the previously 
selected notes remain selected.

In addition to selecting notes individually, 
they can also be selected in groups, as dis-
cussed in the following sections.

Using the Marquee Tool

Us the Marquee tool to select notes in a 
rectangular area. Choose the Marquee 
tool, click in one corner of the rectangle 
and drag to the other corner. All notes 
beginning within the drawn rectangle are 
selected. 

Figure 27.3: Selecting notes with the Marquee 
tool
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Make sure the cursor is a “cross” when 
beginning to drag the rectangle rather 
than a note edit cursor (indicated with 
small arrows, discussed at the end of this 
chapter). The note edit cursors appear 
when the cursor is located over a note, 
indicating that the note will either be 
dragged to a new pitch or location, 
depending on which part of the note the 
cursor is above.

Using the I-Beam Tool to Select a 
Time Range

Notes in a time range are selected with 
the I-beam tool by dragging across the 
time area within the Piano Roll. Unlike the 
Marquee tool, which allows a vertical 
component to the selection, using the 
I-beam tool in this manner selects all 
pitches in the selected time range (see 
Using the I-Beam Tool to Select a Pitch 
Range (pg. 235)).

Figure 27.4: Defining a time range in the Piano 
Roll
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This method does not select pitch bend, 
modulation or controller events. To select 
these type of MIDI data, see Selecting all 
Types of MIDI Data in a Time Range 
(pg. 235).

Using the I-Beam Tool to Select a 
Pitch Range

By moving your mouse into the left 
margin of the Graphic Window, where the 
pitches are displayed, the cursor changes 
to a horizontal I-beam. This tool allows 
selection of all notes in a specified pitch 
range over the entire track length.

Figure 27.5: Defining a pitch range in the Piano 
Roll

Click and drag in left margin
to select pitch range
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Selecting all Types of MIDI Data 
in a Time Range

To select all MIDI data, position the 
cursor within the Ruler and drag horizon-
tally. All MIDI data contained within the 
time range is selected (including notes, 
patch changes, pitch bend, etc.).

Figure 27.6: Click and drag in Ruler to select all 
data

The I-beam tool is available in the Ruler at 
all times, even if the Marquee tool is cur-
rently selected.

Click and drag in the
Ruler to select all data
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MODIFYING NOTES IN THE 
GRAPHIC WINDOW

There are three note edit cursors to 
modify notes in the Graphic Window. As 
the cursor moves over different portions 
of the note, the cursor changes to reflect 
the operation that occurs when the note is 
dragged. The following sections discuss 
these note edit cursors.

NOTE: Use the Cursor Display area (see 
page 58) to monitor changes to the note 
properties.

NOTE: When you are moving or transpos-
ing notes, you can hold down the Option key 
on your computer keyboard to copy the note 
before modifying it. This leaves the original 
data intact.

Moving Notes

Position the cursor over the left section of 
a note to get the Move cursor, which 
allows modification of the note’s start 
point by clicking and dragging left or 
right. Any other selected notes are also 
dragged. The Move cursor changes only 
the start time of the note, not it’s pitch or 
duration.

Figure 27.7: Moving a note with the Move cursor
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Transposing Notes

Position the cursor in the middle of a note 
to get the Transpose cursor, which 
allows modification of the note’s pitch by 
dragging up or down. The start time and 
duration of the note are not changed.

Figure 27.8: Transposing with the Transpose 
cursor 

Changing a Note’s Duration

Position the cursor over the right section 
of a note to get the Duration cursor, 
which allows modification of the note’s 
duration. Dragging to the left shortens 
the note and dragging to the right length-
ens it.

Figure 27.9: Changing duration with the Duration 
cursor
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GRAPHIC WINDOW MENU

Following is an explanation of the items in 
the Graphic Window menu:

Auto Scroll

When checked, Vision follows the 
Counter and scrolls the contents of the 
Graphic Window.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.
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Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the Graphic Window 
to the Edit In point.

Zoom to Fit (Option-Z)

Choose this command to view the con-
tents of the entire track in the Graphic 
Window.

Zoom Back (Option-B)

Choose this command to return to the 
previous zoom level (acts to “undo” the 
last zoom).

Tools

This item chooses from the Marquee, 
I-beam, and Pencil tools. Only one can be 
checked at a time. Selecting one deselects 
the others.

Choosing one of these items is identical to 
selecting the corresponding tool in the 
actual Graphic Window. For a description 
of the different tool types, see Cursor 
Tools (pg. 57).

Bar/Beat/Unit

Specifies that bars/beats/units are dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.
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Absolute SMPTE

Specifies that absolute SMPTE is dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.

Absolute time values are derived from 
adding the sequence’s offset time to 
actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.

Relative SMPTE

Specifies that relative SMPTE is displayed 
for the Edit In/Out points, and for the 
event times in the Cursor Display.

Relative time values represent the actual 
elapsed time from the beginning of the 
sequence—without adding the 
sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the Graphic Window. Any newly 
opened Graphic Windows use these 
defaults.
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View (Option-V)

Choose this menu item to open the View 
dialog. It specifies which Instrument 
events are displayed for the selected track 
in the Graphic Window.

Figure 27.10: Graphic Window’s View dialog

Choose from the following radio buttons:

• all
Displays all Instruments.

• only
Displays only the selected 
Instruments.

• all except
Displays only the Instruments not 
selected.

The View dialog not only determines 
which data is displayed, but also which 
data is editable. Data not displayed, there-
fore, cannot be selected, edited, or 
modified.
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Play Edited Note

When checked, Vision plays any note 
clicked. If transposing a note, the different 
transposition values are audible as the 
note is dragged. Notes inserted with the 
Pencil tool are also audible. When 
unchecked, note editing does not trigger 
any sound.

Show Vertical Line

When checked, Vision displays a scrolling 
vertical line in the Graphic Window, indi-
cating the location of the Counter as the 
sequence advances.

Both the bouncing ball and vertical line 
may be displayed simultaneously.

Show Piano Keyboard

Check this option to display a graphic 
keyboard in the left margin of the Graphic 
Window (instead of pitch and note 
names).
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 28: The Strip Chart
WHAT IS THE STRIP CHART?

The Strip Chart is a powerful editing tool 
found in the Tracks, Pulse, Graphic, and 
Notation Windows. It provides graphic 
viewing and editing of a variety MIDI 
data. The Strip Chart can also be used to 
insert events, and in the process, create 
many interesting musical effects like 
decrescendo, accelerando, or vibrato.

The following event types can be viewed 
and edited in the Strip Chart:

• velocity
• release velocity
• duration
• tempo
• markers (view only)
• patches
• text events (view only) including 

lyrics and copyrights
• aftertouch and poly aftertouch
• pitch bend
• MIDI Controllers (volume, pan, sus-

tain, mod wheel, etc.)
• automation events (including volume, 

pan, mute/solo, send levels, EQ 
enable, and phase inversion)

• EQ band parameter events
• Plug-in parameter events
Vision & Studio Vision Pro — MIDI Reference M
Each event in the Strip Chart is displayed 
as a rectangle. The height of the rectangle 
determines the value, the left edge signi-
fies the start time, and the width 
determines the duration of the event.

Figure 28.1: The Strip Chart

The Strip Chart consists of the following 
items:

A I-beam tool
B Pencil tool
C Variable pop-up
D Edit Shapes pop-up
E Strip Chart toggle (shown enabled)
F Strip Chart contents
G Density setting
H Exact toggle (shown disabled)

123 4 5 6 7 8
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Opening the Strip Chart

To open the Strip Chart in the Graphic 
Window, click the Strip Chart toggle at 
the bottom of the Window (see 
Figure 28.2). In addition, choosing an 
event type from the Strip Chart Contents 
pop-up will automatically open the Strip 
Chart.

Figure 28.2: Clicking the Strip Chart toggle

To open the Strip Chart in the Tracks and 
Pulse Windows, click the open/close tri-
angle in the lower-left corner of the 
Window (see Figure 28.3).

Figure 28.3: Opening Strip Chart in Tracks Window

KEYBOARD EQUIVALENT: Type Shift-3 
on your computer keyboard to toggle the 
Strip Chart between open and closed.
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Defining the Strip Chart Contents

To choose the event type displayed in the 
Strip Chart:

a Click on the Contents pop-up and 
select the desired event type.

Figure 28.4: Defining the Strip Chart 
Contents

Event types contained within the track are 
displayed in bold text in the Contents 
pop-up. This provides immediate feed-
back on which types of data are contained 
in the track. If a track contains only note 
data, the Contents pop-up displays only 
three event types in bold: Velocity, 
Release Velocity, and Duration.

NOTE: Choosing No Strip Chart from the 
Contents pop-up closes the Strip Chart.
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STRIP CHART CONTENTS

Modifying Events in the Strip 
Chart

In the Graphic and Notation Windows, 
the Strip Chart displays information only 
for the track in that window. In this case, 
inserting new events in the Strip Chart 
places the data in the displayed track 
(even if other tracks are selected in the 
Tracks or Pulse Window).

In the Tracks and Pulse Windows, the 
Strip Chart displays information for all 
selected tracks. In this case, inserting 
new events in the Strip Chart places the 
data in each selected track.

However, modifying existing events in the 
Strip Chart modifies all events of that type 
in all selected tracks for the selected time 
range. This is the case for the Strip Chart 
in each edit window (despite the absence 
of these track events in the Graphic and 
Notation Windows).

THE STRIP CHART TOOLS

Figure 28.5: Strip Chart tools

Edit Shapes pop-up

Variable pop-up

Pencil tool (selected)

Strip Chart I-beam tool

Strip Chart toggle (enabled)
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The I-Beam Tool (Select)

Use this tool to click and drag over a 
selected time range in the Strip Chart. 
The I-beam tool in the main window’s tool 
palette works similarly, but each tool 
operates independently. 

The Strip Chart I-beam tool is also inde-
pendent from the Marquee tool in the 
main window’s tool palette.

The Pencil Tool

The Pencil tool allows drawing a new set 
of values for a selected event or group of 
events. It works with the Shapes defined 
in the Edit Shapes pop-up (see page 246).

The Variable pop-up

Figure 28.6: Variable pop-up in the Strip Chart

The Variable pop-up, providing access to 
several types of tools with special func-
tions, works in conjunction with the Edit 
Shapes pop-up.
anual 243



PART 6: Windows
Scale

• Using the Scale tool, Strip Chart data 
can be modified by a factor ranging 
from 25% to 400%, labelled in the left 
margin. Vision multiplies the value of 
each event by the Scale factor. The 
resulting value is confined to limits 
imposed by the event type.

Figure 28.7: Scale Tool with Straight shape

Add Amount

The Add Amount tool causes values to be 
added to or subtracted from the values of 
the event according to the points on the 
line drawn. 

For example, drawing a sloping line from 
10 to 20 in the time range of notes having 
a velocity of 64, increases the values from 
74 to 84.
244
Max/Min Limit

The range of values created by Strip 
Chart edit operations can be limited by 
setting the Variable pop-up to either Max 
or Min Limit. 

For example, values greater than 48 can 
be reduced to 48 by selecting Max Limit 
and drawing a line at 48 across the 
desired time range, leaving all values less 
than 48 unchanged.

Figure 28.8: Max Limit with Flat shape

Legato

In Legato mode, the ending times of 
selected notes are changed with respect 
to their proximity to the next note. The 
duration is changed but not their start 
times.

For example, using Legato on durations 
with a value of 100%, extends each note 
until the beginning of the next note.
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NOTE: Legato is grayed out when the Strip 
Chart displays anything other than note 
durations.

NOTE: The Legato tool in the Strip Chart 
uses the setting in the Select & Modify 
Window (for Change Duration, Set Legato 
to) when deciding the gap size over which 
notes are not affected. For details, see 
Change Methods (pg. 126).

Thin

Using Thin eliminates some controller 
data to require fewer events to achieve a 
similar effect. This saves memory and 
speeds up operations. Aftertouch, pitch 
bend, and volume controllers are notori-
ous for clogging up MIDI transmissions 
with high data densities.

For example, if a sequence is mixed and a 
track contains too much volume control-
ler data:

a Choose the Thin tool from the 
Variable pop-up.

b Set the Density to a small amount 
(perhaps 3%).

The Density field is located to the left of 
the Exact mode toggle.

c Drag across the control data to thin.

NOTE: By using Undo, different Density 
settings can be auditioned to find the small-
est setting that produces the desired effect.
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The Density setting can also be increased 
from the current setting, creating interpo-
lated values to “smooth out” overly 
noticeable controller changes.

Compress

The Compress tool compresses and 
expands Strip Chart data while keeping 
the relationships between existing events 
proportional.

For instance, Figure 28.9 shows the Com-
press tool expanding a range of key 
velocities. Notice that the basic shape of 
the data remains similar, but its range is 
expanded to fit the height of the drawn 
rectangle.

Figure 28.9: Expanding data range in Strip Chart 
with Compress tool

To compress the data, draw a rectangle 
around the events with a narrow range—
the events increase or decrease as neces-
sary to fit within the new data range.
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The Compress tool affects all events in 
the time region of the dragged rectangle, 
even if they are above or below it. Events 
at the bottom of the data range are 
assigned a new value corresponding to 
the bottom of the rectangle, events at the 
top of the range are assigned a new value 
corresponding to the top— all others get 
proportional new values somewhere in-
between.

The Edit Shapes Pop-up

Figure 28.10: Edit Shapes pop-up 

Straight

The Straight shape draws a line in any 
direction, making linear changes to Strip 
Chart events.

Free

The Free shape draws a freehand line and 
is especially helpful when using the Pencil 
tool, Min Limit, or Max Limit.
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Parabola

The Parabola shape draws a parabolic 
curve from left to right (steeper at right) 
or from right to left (steeper at left).

The shape and size of the parabola is 
defined by the direction and amount 
dragged:

Figure 28.11: Four parabolas drawn differently, 
arrows indicating the mouse direction 

The Parabola is especially useful when 
creating fade outs:

a With the Strip Chart open, choose 
Volume from the Contents pop-up.

b Select the Pencil tool.

c Choose Parabola from the Edit 
Shapes pop-up.

d Drag a parabola from the top of the 
Strip Chart to the bottom, starting at 
the time to begin fading, and stopping 
at the end of the track.
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Flat

The Flat shape draws straight, horizontal 
lines. All affected data either assumes the 
value drawn, has a constant amount 
added, or is scaled by a constant amount, 
depending on the modification tool 
selected from the Variable pop-up. 

This is especially useful with the Percent 
tool to scale all events by the same 
percentage. 

Random

The Random option drags a rectangular 
selection around the events to randomize. 
Vision randomly chooses values falling 
within the range of the rectangle and 
applies the changes to the selected 
events. When the Variable pop-up is set to 
Add Amount, Vision adds a random 
amount between values outlined. When 
using Scale, Vision chooses random 
values for scaling the selection.
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Figure 28.12: Using Random on key velocities

The Random option is useful in “humaniz-
ing” notes step-recorded with constant 
velocities.

Oscillator Shapes

Use the Oscillator shapes to insert or 
shape data with periodic waveforms. The 
available waveshapes include Sine, 
Square, Triangle, and Sawtooth. These 
shapes can be used to draw in expression 
data for filter sweeps, or volume data for 
tremolo effects—and they can be in per-
fect sync with your sequences.

Figure 28.13 shows controller events 
inserted with the Sawtooth waveshape.
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Figure 28.13: Drawing events with Sawtooth 
waveshape

The height of the drawn events is deter-
mined by how far up or down you drag 
the mouse after the initial click. The direc-
tion of the waveform is determined by 
whether the mouse was dragged up or 
down.

The Waveform Period is set in the Strip 
Chart & Nudge section of the Settings 
Window, see Figure 28.14, and deter-
mines the length of each cycle for the 
Oscillator shape. The period can be speci-
fied as a number of bars, beats, units, 
seconds, frames, or bits.

Figure 28.14: Strip Chart & Nudge settings
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The Waveform Period pop-up also has an 
option called Use Meter. Check this item 
when using “bars” as the period; this 
ensures that the bar’s size is based on the 
Meter for the affected track region. Use 
Meter is checked by default.

Use the Waveform Period along with 
Cursor Quantize to ensure that the wave-
shapes are drawn cleanly on the desired 
beats.

NOTE: When using an Oscillator Shape in 
the Strip Chart with the Pencil tool selected, 
you can click the Pencil tool to automati-
cally open the Settings Window —where the 
Waveform Period may be specified.

NON-CONTINUOUS EVENTS IN 
THE STRIP CHART

The Strip Chart can display many non-
continuous types of events, including 
Mute, Solo, Plug-In Bypass, EQ Enable, 
etc. In these cases, events drawn in the 
top half of the Strip Chart result in an 
“On” event and events drawn in the 
bottom half of the Strip Chart result in an 
“Off” event.

Regardless of where you position the 
pencil tool when inserting these events, 
On events will be drawn at the very top of 
the window and Off events will be drawn 
Opcode Systems, Inc.



CHAPTER 28: The Strip Chart
at the very bottom of the window. This 
results in a situation where Off events 
themselves cannot be seen in the Strip 
Chart, except as the “end” of an on event.

As a rule of thumb, if you see a colored 
rectangle in the Strip Chart, the parame-
ter selected in the Strip Chart contents 
pop-up is On. If you do not see a colored 
rectangle, the parameter is Off.

USING THE STRIP CHART

This section describes how to use the 
Strip Chart to view and change various 
event types.

NOTE: When editing data in the Strip 
Chart, holding down the Shift-key affects 
only previously selected events.

NOTE: During operations that add to or 
subtract from Strip Chart data, Vision 
automatically limits the resulting values to 
their legal minimum or maximum bounds.

Solo Off event Solo On event
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Velocity and Release Velocity

The Strip Chart displays two types of 
velocity:

• velocity (key velocity)
• release velocity

Since Velocity is not displayed in the 
Graphic or Notation Windows, the Strip 
Chart provides viewing and editing for 
these important events.

When either type of velocity is selected 
from the Strip Chart’s Contents menu, the 
Strip Chart displays a vertical bar for each 
note’s velocity value. The values are 
shown on the left side of the Strip Chart.

An audio event’s velocity setting affects 
the playback volume of the audio event; 
the higher the number is, the louder the 
event will be.

NOTE: While most keyboards and MIDI 
devices send and respond to key velocity, 
few send or respond to release velocity. 
Vision’s default release velocity value is 64; 
if Vision does not receive a release velocity 
setting while recording from a MIDI con-
troller, it sets the release velocity parameter 
to 64.

Duration

Note Durations can be viewed and modi-
fied in the Strip Chart.
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When viewing durations in the Strip 
Chart, vertical bars are displayed denot-
ing the duration for each note. The value 
of the bar is shown on the left side of the 
Strip Chart. The scale maximum is a 
whole note except when Add Amount is 
the selected tool. The scale is then 
denoted by -B to B indicating that a maxi-
mum value of B may be added to or 
subtracted from a note duration.

Figure 28.15: Viewing Durations in the Strip Chart

Tempo

Although tempo events are stored in the 
Tempo track of each sequence, the 
Tempo track is directly editable from the 
Strip Chart—simply choose Tempo from 
the Contents pop-up.
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Editing or inserting tempo events in the 
Strip Chart automatically updates the 
sequence’s Tempo track.

Figure 28.16: Viewing tempo events in the Strip 
Chart

NOTE: When using the Straight tool to 
draw an accelerando or ritardando in the 
Strip Chart, Vision draws a curve instead. 
Linear changes to tempo are not perceived 
as linear, or smooth.

Markers

Markers are stored in the Meter track, 
but can be viewed in any track’s (MIDI or 
Audio) Strip Chart. For example:

If the Markers in your Meter track look like this...

...the Markers would look like this when displayed in the 
Strip Chart.
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Patches

Insert a Patch Change in the Strip Chart 
by using the Pencil tool to click at the 
desired time for the Patch Change. A pop-
up menu appears listing the patches avail-
able for the track’s Instrument.

Figure 28.17: Patch Events in the Strip Chart

If the Instrument doesn’t have names 
assigned in the Names Window, a dialog 
appears allowing numeric entry for bank 
select and program change values:
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Text-type submenu

Figure 28.18: Text-type submenu

Text-type events allow storage of text 
comments, copyright information, 
descriptions of Instruments, lyrics, or cue 
points in tracks, along with MIDI 
information.

The Strip Chart displays each text event 
on its own horizontal text line. When 
enough text events have been displayed 
to fill the entire strip chart (vertically), 
display begins again at the top of the win-
dow. The Strip Chart can only display the 
first 62 characters of any text-type event. 
Text-type events may actually occupy sev-
eral lines in the Text Edit dialog but only 
the information that fits is displayed in the 
Strip Chart.

Text-type events include:

• Text
Can be used for any text including 
comments, reminders etc.

• Copyright
Provides a place to store a copyright 
notice.

• Instruments
Verbal descriptions of Instruments 
can enable subsequent orchestration 
in a different MIDI environment.

• Lyrics
Words may be exported to notation 
programs supporting this feature.
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• Cue Points
Typically describes action taking 
place on film or video occurring at a 
specific SMPTE time.

Inserting a new text-type event opens the 
Text Edit dialog allowing display and edit-
ing for the entire event. Any text can be 
typed in, and cut, copy, and paste opera-
tions can be performed by typing 
Command-X, Command-C, and Com-
mand-Y, respectively (these commands 
are not available from the Edit menu). 
When finished, type the Enter key to 
insert the text into the track.
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MIDI submenu

Figure 28.19: MIDI submenu

MIDI events include:

• Pitch Bend
Pitch Bend events can have values 
from -8192 to +8191. They are dis-
played as events above and below a 
horizontal line. Events above the line 
have positive values, and events 
below the line have negative values.

Figure 28.20: Pitch bend events in the Strip 
Chart
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• Aftertouch
Aftertouch events can have values 
between 0 and 127.

• Poly Aftertouch
When using the Strip Chart to display 
and edit Poly Aftertouch, a note 
number appears in the second pop-up 
next to the Strip Chart’s Contents 
pop-up. The Strip Chart displays and 
edits Poly Aftertouch events for one 
note at a time. To select a different 
note, click the Note pop-up and 
change it using either the mouse or a 
MIDI controller.

Figure 28.21: Viewing Poly Aftertouch in the Strip 
Chart

• Velocity Scale
Velocity Scale events can have values 
between 0 and 127. For more informa-
tion about Velocity Scale, see Velocity 
Scale (pg. 297).

Note Affected by Poly Aftertouch
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• MIDI Controllers
A general Controller option and all 
eight Favorite Controllers are avail-
able from the MIDI submenu. To 
define your Favorite Controllers, see 
Favorite Controllers (pg. 336).
Choosing any of these items gives 
you a second pop-up containing all 
controller types.
When one of the eight favorite con-
trollers is selected, the name and 
number of the controller appears in 
the second pop-up (to the right of the 
Strip Chart’s Contents pop-up). When 
“Controller” is selected, the second 
pop-up displays Controller 7 (Vol-
ume) by default.
In both cases, any new controller may 
be selected from the second pop-up.

Figure 28.22: Controller pop-up in the Strip 
Chart

Press here...
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• Fine Controls
Vision allows controllers numbered 0-
63 to be in Fine or Coarse mode. In 
Coarse mode, Vision displays and 
edits values in a range of 0-127. In 
Fine mode, controllers 32-63 are 
interpreted as “fine tuning” for con-
trollers 0-31. In this case, the 
combined value limits are 0 to 16383. 
Fine Controls are enabled from the 
Settings Window (see page 331 for 
details).
NOTE: Most MIDI devices don’t use 
Fine controls. Consult your device 
manual to find out if this feature is 
available. 

Automation submenu

Figure 28.23: Automation submenu

• Audio Volume
Values can range from negative infin-
ity to +24 dB. For details, see your 
Audio Reference Manual.

• Audio Pan
Values range from <100.00 (left) to 
100.00>(right).
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• Mute
Events drawn in the top half of the 
strip chart will result in a “Mute On” 
event, and events drawn in the 
bottom half will produce a “Mute Off” 
event.
Unlike most of the other commands 
in this menu, Mute can affect Audio 
or MIDI Instruments. Keep in mind 
that these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Solo
Events drawn in the top half of the 
strip chart will result in a “Solo On” 
event, and events drawn in the 
bottom half will produce a “Solo Off” 
event.
Unlike most of the other commands 
in this menu, Solo can affect Audio or 
MIDI Instruments. Keep in mind that 
these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Send (1-4) Level
These options can write Send Level 
events for each specific send. Values 
range from negative infinity to 
+24 dB.
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• Plug-in (1-4) Bypass
Plug-in Bypass events can have Off 
and On values. When set to Off, the 
plug-in will be applied to the audio 
signal. When set to On, the plug-in 
will be bypassed.
Events drawn in the top half of the 
strip chart will result in a “Plug-in 
Bypass On” event, and events drawn 
in the bottom half will produce a 
“Plug-in Bypass Off” event.

• Phase Invert
Events drawn in the top half of the 
strip chart will result in a “Phase 
Invert On” event, and events drawn in 
the bottom half will produce a “Phase 
Invert Off” event.

• EQ Enable
Events drawn in the top half of the 
strip chart will result in an “EQ 
Enable On” event, and events drawn 
in the bottom half will produce an 
“EQ Enable Off” event.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

EQ Band Parameter submenu

Figure 28.24: EQ Band Parameter submenu

• Frequency
Controls the frequency of the speci-
fied EQ band. Values can range from 
20.00 Hz to 20000.00 Hz.
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• Gain
Controls the gain of the specified EQ 
band. Values can range from -
18.00 dB to +18.00 dB.

• Width
Controls the width of the specified 
EQ band. Values can range from 0 to 
4.00 octaves.

• Type
Allows you to change the EQ type for 
the specified band.

• Enable
Events drawn in the top half of the 
strip chart will result in a “EQ Band 
Enable On” event, and events drawn 
in the bottom half will produce a “EQ 
Band Enable Off” event for the speci-
fied band.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.
anual 255



PART 6: Windows
Plug-in Parameter submenu

The Plug-in Parameter submenu lists 
the plug-ins that are assigned to the 
selected track’s Audio Instrument. For 
example:

Figure 28.25: Plug-in Parameter submenu

After you select a plug-in, another pop-up 
menu appears to the right. This menu dis-
plays the selected plug-in’s parameters. 
For example, if you select opECHO, you 
will see the following:

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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Open the plug-in edit window for 
opECHO, and you will see that the param-
eters listed in the pop-up menu 
correspond to the parameters of the 
opECHO plug-in.

Vision can automate up to 1024 parame-
ters per VST plug-in.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

Using the Density Setting

When choosing the Pencil or Thin tools to 
edit continuous automation data, the Den-
sity setting appears next to the second 
Strip Chart pop-up.

Figure 28.26: Density setting in the Strip Chart

Plug-in parameters

Density Setting
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NOTE: The Density setting can also be set 
from the Settings Window. See Strip Chart 
Settings (pg. 332) for details.

MIDI is capable of communicating 
approximately 1000 events per second. If 
pitch bend was entered at this maximum 
speed, MIDI wouldn’t have time to trans-
mit anything but pitch bend. The Density 
setting, scaled from the maximum MIDI 
transmission rate, allows restriction of 
this data to levels that are musically mean-
ingful. The minimum density is 0.1% of 
MIDI capacity.

The goal is to achieve a musical effect 
with controller data, without hearing indi-
vidual steps, while using a minimum 
Density setting. 

Use Undo to audition different Density 
settings to find the smallest setting that 
provides a satisfying musical effect.

When entering pitch bend for a patch 
whose pitch bend range is a whole step, a 
Density of 1% is adequate. If the pitch 
bend range is two or three octaves, a Den-
sity of 20% is appropriate. 

MULTIPLE TRACKS AND 
CHANNELS IN THE STRIP 
CHART

The Strip Chart in the Tracks and Pulse 
Windows can simultaneously display and 
edit data for more than one track. This is 
helpful for scaling or thinning data on sev-
eral tracks at the same time, or for 
inserting identical volume and pan events 
across several tracks.
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Figure 28.27 shows pan data from two 
separate tracks being displayed in the 
Strip Chart. Viewing related data from 
separate tracks is useful for checking 
their relationship.

Figure 28.27: Pan data from two separate tracks

Inserting data in the Strip Chart for the 
Tracks and Pulse Windows places the 
data in all selected tracks. If a track is a 
“multi” and contains several channels, a 
copy of the data is inserted for each 
channel.

Although the Strip Chart in the Graphic 
Window cannot display data for multiple 
tracks, it can display data for multiple 
channels if the displayed track is a “multi” 
track. However, it can only insert data on 
one channel at a time (see Figure 28.28). 
Edits, on the other hand, affect all dis-
played channels.

Figure 28.28: Specifying Instrument for inserted 
Strip Chart events
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RESIZING AND ZOOMING THE 
STRIP CHART

The Strip Chart in the Tracks and Pulse 
Windows can be resized and vertically 
zoomed for greater detail and data 
resolution.

Resizing the Strip Chart

To resize the Strip Chart in the Tracks 
and Pulse Windows:

a Open the Strip Chart by clicking the 
open/close triangle in the lower-left 
corner of the Tracks or Pulse 
Window.

b Place your cursor at the top of the 
Strip Chart area so the resize cursor 
( ) appears.
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c Click and drag up to resize the Strip 
Chart area. 

Once the desired size is reached, 
release the mouse button to resize the 
area.

The contents in the Strip Chart are 
redrawn to take advantage of the larger 
edit area.

d If necessary, resize the entire Tracks 
(or Pulse) Window to make room for 
the larger Strip Chart.

Zooming Vertically in the Strip 
Chart

Normally, the entire value range for 
events fits into the height of the Strip 
Chart. You can, however, zoom vertically 
for greater resolution, which can be 
important for inserting and editing data.
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To zoom vertically in the Strip Chart, click 
the Zoom buttons in the lower-right 
corner of the Tracks (or Pulse) Window. 
Make sure not to confuse the vertical 
Zoom buttons for the Strip Chart with 
those of the Track Overview, see 
Figure 28.29.

Figure 28.29: Vertical Zoom buttons and scroll bar 
for Strip Chart

When viewing zoomed data in the Strip 
Chart, use the vertical scroll bar to navi-
gate up or down.

Vertical Zoom buttons
for Track Overview

Vertical Zoom buttons
for Strip Chart

Horizontal Zoom buttons
for both Track Overview
and Strip Chart

Vertical scroll bar
for Strip Chart
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Figure 28.30 illustrates the Strip Chart at 
three different zoom levels. The more you 
zoom vertically, the smaller the displayed 
data range becomes. View the left margin 
of the Strip Chart for the actual range of 
the displayed data.

Figure 28.30: Strip Chart data, zoomed vertically

Displayed value range, 0-127

Displayed value range, 48-79

Displayed value range, 60-68
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The List Window displays a chronological 
list of all events in a track as text and num-
bers. List Windows are used for the 
following track types:

• Performance track (normal track)
• Tempo track
• Meter track

List Windows for normal tracks may con-
tain events for notes, patch changes, 
digital audio, text-type, pitch bend, con-
trollers, aftertouch, poly aftertouch, 
automation (plug-in and EQ parameters, 
etc.), system exclusive, and sequence 
events.

Figure 29.1: List Window 
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List Windows for Meter tracks contain 
events for meter changes, markers, and 
key signatures.

Figure 29.2: Meter track List Window

List Windows for Tempo tracks contain 
events for tempo changes.

Figure 29.3: Tempo track List Window
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OPTS MENU

In previous versions of Vision, a Seqs 
menu appeared in the List window and 
Tracks/Pulse window expanded info area 
for tracks with sequence events in them. 
The menu is now called Opts, and it con-
tains an additional command that can 
apply to any track, regardless of whether 
or not the track contains sequence events. 
For that reason, the menu appears in the 
List window (and Tracks/Pulse Window 
expanded info area) for all performance 
tracks.

Song Track

Song Track is available only when the 
List window displays a performance track 
containing sequence events.

Check this option to copy the tempo infor-
mation from the referenced sequences (in 
that track) to the parent sequence. This 
lets the parent sequence play back with 
the tempo of the referenced material. 

The parent sequence’s Meter and Tempo 
tracks are updated automatically if any 
changes are made to the sequence events 
contained in the Song Track.
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Each sequence can only have one Song 
Track. If you already have Song Track 
enabled for one track, enabling it for 
another track disables the option for the 
previous track.

Keep Sequences End-to-End

Keep Sequences End-to-End is avail-
able only when the List window displays a 
performance track containing sequence 
events.

When both Song Track and Keep 
Sequences End-to-End are checked, 
Vision keeps sequence event blocks 
neatly together, one after another (the 
end point of one sequence event is the 
start point of the following sequence 
event). This is a handy option when chain-
ing together sequences to make songs.

Dragging, resizing, or changing the 
number of repeats for any sequence event 
block (as well as inserting or deleting 
sequence events), causes existing 
sequence events to move accordingly.

Also, the Meter and Tempo tracks of the 
parent sequence automatically change to 
match those of the sequence events resid-
ing in the Song Track. All meter, tempo, 
key, and marker events in the referenced 
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sequences therefore end up in the parent 
sequence. In addition, a marker is auto-
matically inserted at the beginning of 
each sequence event with the name of the 
referenced sequence or segment.

IMPORTANT: In order for a parent 
sequence to use both the Meter and Tempo 
tracks of the sequence events in the Song 
Track, both options in the Sequence Event 
pop-up must be checked.

Figure 29.4: Sequence Event pop-up in List 
Window

Lock Event SMPTE Times

Lock Event SMPTE Times is available 
for all performance tracks.

When checked, this option locks the 
SMPTE time of each event in the track so 
that even if you change the tempo of the 
sequence, each event in the track will play 
at the appropriate SMPTE time.

This is especially useful if you are scoring 
a film and want to set up a “sound effects” 
track. Simply check Lock Event SMPTE 
Times in the Opts menu for that track, 
and you can freely change the tempi of 
the music in the sequence without affect-
ing the sound effects.

You can check Lock Event SMPTE 
Times for any number of performance 
tracks.
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INSERTING EVENTS

Choose an item from the Insert Events 
pop-up to insert it into the track at the Edit 
In point. The available event types depend 
on the type of List Window currently 
active.

After inserting a particular event type into 
the List Window, you can click the Insert 
Events icon like a button (without high-
lighting the event type in the pop-up) to 
insert the same event type again.

Performance Track List Windows

Figure 29.5: Insert Event pop-up for performance 
Track

Notes

Note events display the pitch (note num-
ber), duration, velocity, and (optionally) 
release velocity.
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Durations are displayed as quarter notes 
and units. Durations, pitch and velocity 
are editable using the mouse or computer 
keyboard. Pitch and velocity are also edit-
able by selecting the item and playing a 
MIDI controller.

Audio Event

Choosing Audio Event automatically 
opens the Import Audio dialog box. The 
audio event(s) inserted will be placed at 
the current insertion point.

For more information about Import 
Audio, see your MIDI Reference Manual.

Patch

Patch events can be displayed as numbers 
or names. After being inserted with the 
Insert Events pop-up, they can be 
changed by clicking them and selecting a 
new patch from the Patch pop-up that 
appears.

Unless you use the Names Window to 
assign a Patch Name document to a 
device, it will display its patch changes as 
numbers. For more information, see 
Chapter 33: The Names Window. 

The rightmost part of the patch line con-
tains a pop-up menu.
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NOTE FOR MIDI NOVICES: The maxi-
mum number that can be sent in a MIDI 
program change message is 127. However, 
double program change and bank select 
messages can be used to access patches 
beyond the “127” limit.

Using this menu accesses the five differ-
ent types of patch change messages. The 
different types allow patch changes on 
synths that have more than 128 patches 
via bank select messages, or multiple pro-
gram change messages. In all cases, there 
will be numericals next to the boxed icons 
that can be set to the appropriate values. If 
you are using the OMS Name Manager to 
provide patch names, you won’t need to 
set the numericals manually; they will be 
filled in automatically whenever a patch is 
selected.

Following is a description of the five types 
of patch change messages:

• PC: Sends a program change mes-
sage only.

• PC PC: Sends two program changes 
in rapid succession. Some synths use 
the first message to set the hundreds 
digits and the second message to set 
the tens and ones digit. For example, 
PC 105 PC 38 would set the channel 
to program 538.

• B0 PC: Sends a bank select 0 mes-
sage followed by a program change.

• B32 PC: Sends a bank select 32 mes-
sage followed by a program change.

• B0 B32 PC: Sends a bank select 0 
message, a bank select 32 message, 
and a program change.
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Check your synthesizer’s documentation 
to find out which patch change messages 
it supports.

Text-type

Text-type events allow storage of text 
comments, copyright information, 
descriptions of Instruments, lyrics, or cue 
points in tracks, along with MIDI informa-
tion. The List Window displays as much of 
the text event as fits on one line. Text-type 
events may actually occupy several lines 
in the Text Edit dialog but only the infor-
mation that fits is displayed on one line in 
the List Window.

Text-type events include:

• Cue Points
Typically describes action taking 
place on film or video occurring at a 
specific SMPTE time.

• Lyrics
Words may be exported to notation 
programs supporting this feature.

• Instruments
Verbal descriptions of Instruments 
can enable subsequent orchestration 
in a different MIDI environment.

• Copyright
Provides a place to store a copyright 
notice.
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•  Text
Can be used for any text including 
comments, reminders etc.

Inserting a new text-type event, or click-
ing on an existing one, opens the Text 
Edit dialog allowing display and editing 
for the entire event. Any text can be typed 
in, and cut, copy, and paste operations can 
be performed by typing Command-X, 
Command-C, and Command-Y, respec-
tively (these commands are not available 
from the Edit menu). When finished, type 
the Enter key to insert the text into the 
track.

Pasting markers from the Meter track 
into a normal track converts bar markers 
to text-type events, and SMPTE markers 
to cue point events. This process may also 
occur in reverse with cue points and text-
type events pasted into the Meter track.

MIDI

Figure 29.6: MIDI Submenu

• Pitch Bend

Pitch Bend events display the bend 
amount as a number from -8192 to 
+8191.
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• Aftertouch

Aftertouch events are displayed as an 
editable number between 0 and 127.

• Poly Aftertouch

Polyphonic Aftertouch events display 
the pitch and controller amount (0–
127). The pitch is edited by selecting 
it and either playing a new note on a 
MIDI controller, or by using the 
mouse or computer keyboard.

• Velocity Scale

Velocity Scale events are displayed as 
a number from 0 to 127. For more 
information about Velocity Scale, 
please see page 297.

• Controllers

Controller events display the control-
ler name, number and value (in that 
order). The eight Favorite Control-
lers (as defined in Favorite Controllers 
(pg. 336)) and a generic “Controller” 
item are available in the MIDI pop-up 
menu. When “Controller” is selected, 
a Volume event (MIDI Controller #7) 
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is inserted by default. You can then 
click on “Volume” and select a new 
controller from the pop-up that 
appears.
Controller events previously inserted 
are also changed by clicking them 
and selecting a new controller from 
the pop-up that appears.
If Fine Controls is checked in the Set-
tings Window, values for pairs of 
controllers are shown as numbers 
from 0 to 16383.

Automation submenu

Figure 29.7: Automation submenu

• Audio Volume

Values can range from -¥ to +24 dB. 
For details, see your Audio Reference 
Manual.

• Audio Pan

Values range from <100.000 (left) to 
100.000>(right).
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• Mute

Mute events can have values of Off 
and On. The value is toggled by click-
ing on the word “Off” (or “On”).
Unlike most of the other commands 
in this menu, Mute can affect Audio 
or MIDI Instruments. Keep in mind 
that these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Solo

Solo events can have values of Off 
and On. The value is toggled by click-
ing on the word “Off” (or “On”).
Unlike most of the other commands 
in this menu, Solo can affect Audio or 
MIDI Instruments. Keep in mind that 
these events affect Instruments 
rather than tracks.
For details, see your Audio Reference 
Manual.

• Send (1-4) Level

These options can write Send Level 
events for each specific send. The 
number of the Send that will be 
effected is displayed in the left col-
umn. Values range from negative 
infinity to +24 dB.
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• Plug-in (1-4) Bypass

Plug-in Bypass events can have Off 
and On values. When set to Off, the 
plug-in will be applied to the audio 
signal. When set to On, the plug-in 
will be bypassed. The value is toggled 
by clicking on the word “Off” (or 
“On”).
In the List window, these events 
appear with the name of the effected 
plug-in on the left, followed by the 
word “Bypass”, followed by the On/
Off status.

• Phase Invert

Phase Invert events can have values 
of Off and On. The value is toggled by 
clicking on the word “Off” (or “On”).

• EQ Enable

EQ Enable events can have values of 
Off and On. The value is toggled by 
clicking on the word “Off” (or “On”).

For more information about these auto-
mation events, please see your Audio 
Reference Manual.
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EQ Band Parameter submenu

Figure 29.8: EQ Band Parameter submenu

• Frequency

Controls the frequency of the speci-
fied EQ band. Values can range from 
20.00 Hz to 20000.00 Hz.

• Gain

Controls the gain of the specified EQ 
band. Values can range from -
18.00 dB to +18.00 dB.

• Width

Controls the width of the specified 
EQ band. Values can range from 0 to 
4.00 octaves.

• Type

Allows you to change the EQ type for 
the specified band. Clicking on the 
EQ Type setting opens a pop-up 
menu with all five EQ types.
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• Enable

EQ Band Enable events can have 
values of Off and On. The value is tog-
gled by clicking on the word “Off” (or 
“On”).

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

Plug-in Parameter submenu

The Plug-in Parameter submenu lists 
the plug-ins that are assigned to the 
selected track’s Audio Instrument. For 
example:

Figure 29.9: Plug-in Parameter submenu

After you select a plug-in, another pop-up 
menu appears to the right. This menu dis-
plays the selected plug-in’s parameters. 

...then the Plug-in Parameter
submenu looks like this.

If the Console looks like this...
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For example, if you select opECHO, you 
might see the following:

“Dry/Wet” is the default parameter 
because it is the first parameter of the 
selected plug-in. Clicking on “Dry/Wet” 
will produce a pop-up menu that contains 
the selected plug-in’s parameters.

If you open the plug-in edit window for 
opECHO, you will see that the parameters 
listed in the pop-up menu correspond to 
the parameters of the opECHO plug-in.

Vision can automate up to 1024 parame-
ters per VST plug-in.

All plug-in parameters, regardless of their 
ranges in the plug-in edit window, will 
have values between 0.0000 and 100.0000 
in the list window. The plug-in’s range of 
possible parameters in the plug-in edit 

Plug-in
parameters
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window is mapped onto this scale. When 
the events are played back, they are 
mapped the opposite way; plug-in automa-
tion will still have appropriate values in 
the plug-in edit windows.

For more information about these auto-
mation events, please see your Audio 
Reference Manual.

System Exclusive

The number in parenthesis indicates the 
length of the event, in bytes. To edit the 
system exclusive data, click on the actual 
event.

When inserting a System Exclusive event, 
the Sysex Edit dialog appears, allowing 
viewing and editing of the sysex data.

Figure 29.10: System Exclusive dialog

In this dialog, entry is limited to valid 
hexadecimal characters. Each byte (2 hex 
characters) is separated by spaces. 
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NOTE: There are 16 possible hex digits: 
0-9, and A–F (corresponding to 10–15). 
Consult a MIDI reference text to learn more 
about hex numbers and their use in MIDI 
applications

You can cut, copy, and paste within the 
Sysex Edit dialog by typing Command-X, 
Command-C, and Command-Y, respec-
tively (these commands are not available 
from the Edit menu). When pasting into 
the Sysex Edit dialog, all non-hexadeci-
mal characters are removed. Click OK to 
exit the dialog box. The computer beeps 
to indicate invalid entries and highlights 
them for correction. Of course, clicking 
Cancel exits without changing any 
events.

Sequence Events submenu

There are five different types of sequence 
and transpose events. See Sequence 
Events in the List Window (pg. 103) for 
more information.
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Meter Track List Windows

When the List Window of a Meter track is 
active, there are three event types avail-
able from the Insert Events pop-up menu. 
see Figure 29.11. Changes to meter and 
key signature affect every track in the 
sequence.

Figure 29.11: Insert Event pop-up in Meter track 
List Window

Inserting Meter Changes in a List 
Window

Meter change events can be located only 
at the beginning of a measure. Both the 
top and bottom numbers of the meter are 
editable. The metronome click rate and 
the number of measures the meter will be 
active are also editable.

Figure 29.12: Meter Change Event

Meter Metronome click # of Bars
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Inserting Key Changes in a List Window

After inserting a key change event by 
choosing Key Signature from the Insert 
Events pop-up, the key can be edited by 
clicking the key and selecting from a pop-
up of available keys. Clicking the word 
“major” or “minor” toggles the value back 
and forth.

Figure 29.13: Key Change Event

Inserting Markers in a List Window

There are two types of markers—SMPTE 
markers and bar markers. When you 
insert a marker, the default type is bar 
marker. You can change this to a SMPTE 
marker by clicking the icon. Click in the 
name field and type a new name.

Figure 29.14: Two Different types of Markers

NOTE: SMPTE Markers retain their 
SMPTE times, even if you change the 
tempo or SMPTE offset of the sequence 
using any method. However, they will move 
if you use Move Events—they are not 
“locked.”

Markers are displayed in the Marker pop-
up in the Control Bar (see page 193), and 
in the Tracks Window ruler.

Name fields

Marker Type Icons
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Tempo Track List Windows

Figure 29.15: Insert Event pop-up in Tempo track 
List Window

Inserting a tempo change affects the 
tempo for all tracks in the sequence. The 
Insert Event pop-up for the Tempo track 
contains Tempo as its sole entry.

Figure 29.16: Tempo Change Event

LIST WINDOW MENU

Following is an explanation of the items in 
the List Window menu:
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Auto Scroll (Shift-4)

When checked, Vision follows the 
Counter and scrolls the contents of the 
List Window.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.

Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the List Window to 
the Edit In point.

No SMPTE

Turns on and off SMPTE display for event 
times, Edit In/Out points, and track 
length. Bar/beat/unit times are always 
displayed in the List Window.

Absolute SMPTE

This item specifies that absolute SMPTE 
times are displayed. Absolute time values 
are derived from adding the sequence’s 
offset time to actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.
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Relative SMPTE

This item specifies that relative SMPTE 
times are displayed. Relative time values 
represent the actual elapsed time from 
the beginning of the sequence—without 
adding the sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the List Window. Any newly 
opened List Windows use these defaults.

View (Option-V)

Choose this menu item to open the View 
dialog. It specifies which events are dis-
played in the List Window. And, if the 
track is a “multi,” containing events 
assigned to more than one Instrument, 
you can use this dialog to choose which 
Instruments are displayed.

Figure 29.17: List Window’s View dialog

Instrument
Choices

Event Choices
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For each type of criteria, choose the radio 
button that makes the most sense:

• all
Displays all events or Instruments.

• only
Displays only the selected events or 
Instruments.

• all except
Displays only the events or Instru-
ments not selected.

The View dialog not only determines 
which data is displayed, but also which 
data is editable. Data not displayed, there-
fore, cannot be selected, edited, or 
modified.

There are two checkbox options at the 
bottom of the View dialog. Checking 
either option lets you apply changes in the 
dialog to:

• all open List Windows
• all new List Windows

Play Edited Note

When checked, notes are sounded when 
clicked, or when changing their pitch.

Show Event End Times

When checked, end times for note and 
audio events are displayed, instead of 
event durations.
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Show Event Durations

When checked, durations for note and 
audio events are displayed, instead of end 
times.

Show Release Velocities

Turns on and off the display of release 
velocities for note events. Most MIDI 
devices don’t respond to release veloci-
ties, so you may wish to suppress viewing 
them.

EDITING EVENTS IN THE LIST 
WINDOW

To select events for modification in a List 
Window, click on the event’s selector dot 
at the far left. The selector dot becomes 
an open triangle, signifying that the item 
is selected. The entire event description is 
also highlighted. 

When changing the bar of an event in the 
List Window, the beat and unit are set to 
the beginning of the bar. This makes it 
easy to enter events at bar or beat loca-
tions. To change one of the bar/beat/unit 
numbers without affecting the others, 
Command-click the number.

To select a group of adjacent events, click 
on the first event’s selector dot and drag 
up or down across the events. 

To select many events, click on the first 
event, scroll to the last one, and 
Shift-click. All events between them are 
selected.
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To select several non-adjacent events, 
hold down the Command-key while click-
ing on each of the events. 

Clicking on the time or description of an 
event deselects all currently selected 
events and selects the new event.

NOTE: Use the Select submenu commands 
in the Do menu to utilize rules that aid spe-
cific selection. For a complete description of 
these commands, see The Select Submenu 
(pg. 423).

Event Times and Moving Events

After moving any event in the List Win-
dow, the window scrolls to display the 
event.

Edit the event time to move an individual 
event. Click the bar/beat/unit fields and 
type the desired values (or use the 
mouse).

After entering event times, click else-
where or type the Enter key. The event 
moves to its new location, scrolling the 
window if necessary.

Re-ordering Simultaneous Events

Due to MIDI transmission rates (and pos-
sibly computer processor speed), large 
numbers of simultaneous events can’t all 
be sent at once. If some notes (i.e. drums) 
require more rhythmic precision than 
other notes, move the less important 
notes a unit or two later in time. Since it 
usually takes MIDI about one unit of time 
to send a MIDI event, several simulta-
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neous events are already being 
transmitted over a period of several units. 
Changing some events by a few units 
changes their “priority,” but generally 
doesn’t delay them by a musically signifi-
cant amount. 

Several events occurring at the same time 
can be re-ordered to be transmitted 
sequentially by changing the units field of 
the events. Typing the Enter key displays 
the event in the new order. Use the play-
back quality as a guide indicating whether 
this process is necessary.
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Vision Notation Windows display MIDI 
information using standard music nota-
tion. The displayed track’s note range 
determines which clefs are used. Multiple 
tracks can be viewed in a Notation Win-
dow, and several Notation Windows may 
be open simultaneously. The contents of 
the Notation Window determine which 
tracks are printed.

For information on edit tools and edit 
functions common to all of Vision’s edit 
windows, see Chapter 9: Basic Editing 
Procedures. For information on navigating 
Vision’s windows, see 
Chapter 4: Navigating in Vision.

SELECTING NOTES IN THE 
NOTATION WINDOW

Notes can be selected individually or in 
groups (note heads are hollow):

• To select a single note, click on the 
note head.

• Use Shift-click to select additional 
notes.

• Shift-click to de-select selected notes.

When selected, note heads are hollow 
instead of solid.
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NOTE: Select notes connected by ties by 
clicking on the first note of the group. The 
note edit cursors appear over the first note-
head, not for the subsequent note-heads.

Selecting Tracks in a Notation 
Window

When selecting notes in one or more 
tracks in the Notation Window, the 
Tracks Window updates to show cur-
rently selected tracks.

Although the Notation Window shows 
multiple tracks, only one can be the 
“current track,” indicated by a small trian-
gle, as shown in Figure 30.1. 

Figure 30.1: Current Track Indicator

For more information on showing multi-
ple tracks in a Notation Window, see 
Showing and Hiding Tracks in the Nota-
tion Window (pg. 21).

Current Track Indicator
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Using the Marquee Tool

Select notes using the Marquee tool by 
clicking and dragging a rectangular area. 
The area highlights signifying that all 
notes beginning within the highlighted 
rectangle are selected.

NOTE: The first note in Figure 30.2 is not 
selected because the beginning of the note 
does not occur within the selection 
rectangle.

Pitch bend, modulation, or controller 
events are not selected with the Marquee 
tool (see Selecting all Types of MIDI Data 
in a Time Range (pg. 277)).
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Figure 30.2: Selecting notes in the Notation 
Window using the marquee tool

NOTE: When using the Marquee tool, note 
that the cursor is a cross when starting to 
drag the rectangle. If its one of the note edit 
cursors, the note will instead be modified.
Notation Window

Notation Resolution

Notation Display

Track Name

Instrument

Key Signature

Quantize Value

Time Signature

Clef

Fit to Window Marquee
I-beam

Pencil

Cursor Quantize

Edit Points
Cursor Display

Change octave area

Current Track Indicator
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Using the I-Beam Tool to Select a 
Time Range

Select notes in a time range using the 
I-beam tool by dragging across the rele-
vant time area. All notes in displayed 
tracks, beginning within the highlighted 
area, are selected.

Figure 30.3: Selecting notes within a specified 
time range in the Notation Window

Using the I-Beam Tool to Select a 
Pitch Range

Select a specific pitch range, for the entire 
track length, using the I-beam tool. The 
horizontal I-beam is available at the left of 
the Notation Window.

Figure 30.4: Defining a pitch range in the Notation 
Window

Drag in this 
area to deÞne 
a pitch range
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Selecting all Types of MIDI Data 
in a Time Range

Select all MIDI data by positioning the 
cursor within the Ruler and dragging a 
selection. This selects all MIDI data con-
tained within the highlighted time range.

This I-beam tool appears whenever the 
cursor is moved into the Ruler, even if 
another tool is selected.

Figure 30.5: Dragging in the Ruler select all MIDI 
data

MODIFYING NOTES IN THE 
NOTATION WINDOW

By positioning the cursor over different 
parts of the note head, three note edit cur-
sors appear—indicating that the pitch, 
start time, or duration will change if the 
note is dragged.

Dragging in 
the Ruler
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Figure 30.6: The Transpose, Move, and Duration 
cursors

When you are moving or transposing 
notes, you can hold down the Option key 
on your computer keyboard to copy the 
note before modifying it. This will leave 
the original data intact.

Transposing Notes

The Transpose cursor appears over the 
center of a note-head. Clicking and drag-
ging a note up or down changes the pitch 
without changing the duration or start 
time. All selected notes are transposed 
the same amount.

Figure 30.7: Transposing a note in the Notation 
Window

Move Duration
CursorCursor

Transpose
Cursor
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Moving Notes

The Move cursor appears over the left 
side of the note head. Clicking and drag-
ging a note to a different location alters 
the start time without changing the pitch 
or duration. All selected notes are moved 
the same amount. 

Figure 30.8: Moving a note in the Notation 
Window

Changing a Note’s Duration

The Duration cursor appears over the 
right side of the note head. Clicking the 
mouse opens the duration pop-up, allow-
ing selection of a new duration. The pitch 
and start time are unchanged.

1. Click here with Move cursor.

2. Drag to change start
time of note
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Figure 30.9: Changing duration in the Notation 
Window

NOTE: When moving or transposing, 
Option-clicking the note copies the note 
before modifying it, leaving the original 
data unchanged.

Rests are automatically inserted by Vision 
in the absence of notes and cannot be 
explicitly modified using the techniques 
discussed in the previous sections. To 
change or eliminate a rest, modify the 
notes around the rest.

For example, lengthening a note the dura-
tion of a neighboring rest eliminates the 
rest. Setting a larger Notation Resolution 
can also decrease the number of rests. 

For information on reducing rests see 
Notation Resolution (pg. 280). For other 
tips on improving score appearance, see 
Tips for Good-Looking Scores (pg. 289).
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CHANGING KEY AND METER

Changing the Meter in Notation 
Windows

To change the meter in a Notation Win-
dow, click on the upper or lower element 
of the time signature. To change the top 
number, select it and enter a new number. 
To change the bottom number, click on it 
and select a new value from the pop-up 
that appears (see Figure 30.10). Vision 
automatically changes the meter in the 
Meter track, affecting all subsequent 
bars. New meter changes are inserted in 
the List Window.

Figure 30.10: Changing the meter in a Notation 
Window

Changing the Key in Notation 
Windows

To change the key in a Notation Window, 
choose a new key signature from the Key 
Signature pop-up. Vision automatically 
changes the key in the Meter track, affect-
ing all subsequent bars. To insert a new 
key change, use the List Window.

Selecting a Numerator

Selecting a
Denominator
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When positioning the mouse over the key 
signature, the cursor changes into a sharp 
( ), indicating that the key signature can 
be changed.

CHANGING APPEARANCE 
WITHOUT CHANGING DATA

Notation Resolution

The Notation Resolution pop-up allows 
changing the quantization level for nota-
tion displayed in the Notation Window, 
without affecting playback or the stored 
MIDI data. This technique is very helpful 
for creating clear scores because there 
are often subtle differences between the 
way music is played and how it should 
appear in a written score.
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To set the Notation Resolution, select a 
note value from the Notation Resolution 
pop-up.

Figure 30.11: Music with Notation Resolution set 
to 16th notes

The same music with Notation Resolution set to 
eighth notes

Octave Display Area

The octave for tracks displayed in a Nota-
tion Window is set by positioning the 
cursor under the staff. When the cursor 
changes into an “8,” clicking causes a pop-
up to appear containing the options for 
octave display. See Shifting the Music by 
Octaves (pg. 290) for more information.
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NOTATION WINDOW MENU

Following is an explanation of the items in 
the Notation Window menu:

Auto Scroll

When checked, Vision follows the 
Counter and scrolls the contents of the 
Notation Window.

NOTE: If Auto Scroll Top Window 
Only is checked in the Editing section of the 
Settings Window, Vision only scrolls the top 
window.

Jump to Selection (Command-J)

Choose this command to automatically 
scroll the contents of the Notation 
Window to the Edit In point.
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Zoom to Fit (Option-Z)

Choose this command to view the con-
tents of the entire track (or tracks) in the 
Notation Window.

Zoom Back (Option-B)

Choose this command to return to the 
previous zoom level (acts to “undo” the 
last zoom).

Tools

This item chooses from the Marquee, 
I-beam, and Pencil tools. Only one can be 
checked at a time. Selecting one deselects 
the others.

Choosing one of these items is identical to 
selecting the corresponding tool in the 
actual Notation Window. For a description 
of the different tool types, see Cursor 
Tools (pg. 57).

Bar/Beat/Unit

Specifies that bars/beats/units are dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.
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Absolute SMPTE

Specifies that absolute SMPTE is dis-
played for the Edit In/Out points, and for 
the event times in the Cursor Display.

Absolute time values are derived from 
adding the sequence’s offset time to 
actual event times.

NOTE: The offset time for a sequence refer-
ences a SMPTE time (location) on tape, 
usually corresponding to the beginning of a 
song or musical passage.

Relative SMPTE

Specifies that relative SMPTE is displayed 
for the Edit In/Out points, and for the 
event times in the Cursor Display.

Relative time values represent the actual 
elapsed time from the beginning of the 
sequence—without adding the 
sequence’s offset.

Set Default Location

Saves as default the current position and 
size of the Notation Window. Any newly 
opened Notation Windows use these 
defaults.
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View (Option-V)

Choose this menu item to open the View 
dialog. It specifies which Instrument 
events are displayed for the selected track 
in the Notation Window.

Figure 30.12: Notation Window’s View dialog

Choose from the following radio buttons:

• all
Displays all Instruments.

• only
Displays only the selected 
Instruments.

• all except
Displays only the Instruments not 
selected.

The View dialog not only determines 
which data is displayed, but also which 
data is editable. Data not displayed, there-
fore, cannot be selected, edited, or 
modified.
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Play Edited Note

When checked, Vision plays any note 
clicked. If transposing a note, the different 
transposition values are audible as the 
note is dragged. Notes inserted with the 
Pencil tool are also audible. When 
unchecked, note editing does not trigger 
any sound.

Show Vertical Line

When checked, Vision displays a scrolling 
vertical line in the Notation Window, indi-
cating the location of the Counter as the 
sequence advances.

Both the bouncing ball and vertical line 
may be displayed simultaneously.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 31: The Print Preview Window
Vision can print any number of tracks in 
standard music notation. Printing com-
mands are available only when a Notation 
Window is active. The contents of the 
active Notation Window determine which 
tracks will print.

THE PRINT PREVIEW WINDOW

Open the Print Preview Window by 
choosing File>Print Preview. Print Pre-
view allows the addition of a title, 
comments, author name, as well as 
changes to basic page layout. The score 
prints exactly as depicted in the Print Pre-
view Window.

Figure 31.1: Print Preview Window

Layout Properties

Text

Page

Blocks

Area
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The tracks in the current Notation 
Window determine which tracks appear 
in the Print Preview Window. Showing or 
hiding tracks in the Notation Window 
automatically updates the Print Preview 
Window. See Showing and Hiding Tracks 
in the Notation Window (pg. 21) for 
details.

Page Properties

The top of the Print Preview Window con-
tains fields that determine how Vision 
prints your music.

Title Space

This field determines the amount of space 
between the top of the page margin and 
the top of the first staff.

Figure 31.2: Title Space

Title Space
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System Spacing

Use this field to specify the amount of 
space between systems for each page.

Figure 31.3: 2-Staff System and System Spacing

Staff Spacing

Use this field to specify the distance 
between staves within the same system.

Figure 31.4: Staff Spacing

System

System
Spacing

Staff
Spacing
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Staff Indentation

This field specifies the amount of space 
each staff is indented from the left and 
right page margins.

Figure 31.5: Staff Indentation

Bars per Line

This field sets the number of measures 
displayed and printed per system.

Figure 31.6: Two bars per line

Figure 31.7: Three bars per line

Staff Indentation
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Systems per Page

This is the number of systems displayed, 
and printed, per page. You cannot change 
this number directly—it is determined by 
the numbers you chose for the Title 
Space, System Spacing, and Staff Spacing.

Number of Pages

This field displays the number of pages 
that comprise the current score. You 
cannot change this number directly—use 
it to see how changing other properties 
affects the number of printed pages.

Current Page

Use this field to specify the currently dis-
played page. 

Show Bar Numbers

Check this option to display and print bar 
numbers. Bar numbers are displayed 
every measure, and are placed directly 
above the barlines.

Barline thru System

When checked, the barline extends 
between each staff in the system. If 
unchecked, the barline stops at each staff. 
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Extending a barline through a system can 
make an instrument grouping more 
apparent. 

Figure 31.8: Barline thru System on

Figure 31.9: Barline thru System off

Show Page Numbers

When checked, page numbers are dis-
played and printed in the lower right 
corner of each page.

Title Font

This field displays the selected font for 
the three text blocks.

Units of Measurements

All measurements can be viewed in either 
inches or centimeters. Click on the unit to 
toggle between inches and centimeters.

Figure 31.10: Changing inches to centimeters
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Adding Text to a Page

Three text blocks can be used to add text 
to the top of the first page. To add text, 
click in one of the text blocks and type 
whatever you wish. The text blocks 
appear only on the first page.

Figure 31.11: The three text blocks

Changing the Font of the Text

You can change the font of all three text 
blocks by selecting a font from the Font 
menu.

PAGE SETUP

Choose File>Page Setup to open the 
Page Setup dialog box, which is used to 
change the orientation or percentage size 
of the printed pages.

The Page Setup dialog looks different 
depending on the type of printer being 
used. Consult your printer’s documenta-
tion for details.
288
A BRIEF DISCUSSION OF 
NOTATION TERMS

The following sections define terms that 
are necessary to understand Vision’s nota-
tion features as they apply to printing.

Grand Staff

When a track containing low notes is dis-
played in a Notation Window, Vision uses 
a bass clef. When a track contains high 
notes, Vision uses a treble clef. If the 
track contains both high and low notes, 
Vision uses a grand staff, consisting of 
both treble and bass clefs.

Vision uses a grand staff if the track con-
tains notes higher than F above middle-C 
and notes lower than G below middle-C. 
Figure 31.12 illustrates the criteria for 
grand staff usage.

Figure 31.12: The Grand Staff

The track must
contain notes 
above and 
below this 
area for Vision
to notate the 
track with a 
grand staff.
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Part

Each Vision track normally constitutes 
one part. Printing music for musicians to 
read and play usually requires separate 
parts.

To accommodate piano players and any 
other instruments capable of playing mul-
tiple parts, multiple tracks can be 
combined to create a single part. For 
example, a bass and melody track can be 
combined into a single piano part, and dis-
played on a grand staff. 

System

A system consists of all tracks displayed 
in the active Notation Window. A system 
can consist of one staff or it can include 
many staves if multiple tracks were 
selected when the Notation Window was 
opened.

Voice

When notating a track, Vision analyzes 
the notes to detect different rhythmic pat-
terns occurring simultaneously. These 
independent rhythms are called voices. 
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Vision attempts to separate voices and 
notate them with stems pointing in oppo-
site directions to avoid collisions and 
enhance readability. Figure 31.13 shows a 
2 voice staff created from one track and 
displayed in one part.

Figure 31.13: Two-voices in one track

TIPS FOR GOOD-LOOKING 
SCORES

Vision contains powerful mechanisms to 
enhance the appearance of printed music. 
This section explains these features and 
concludes with Notation Troubleshooting 
(pg. 291), answering common questions 
about notational problems.

Changing the Order of Notation 
Tracks

Tracks print in the same order as they 
appear in the Tracks Window. To change 
the order that tracks print, change their 
order in the Tracks Window. The Print 
Preview and Notation Windows automati-
cally update to reflect the new order.
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Figure 31.14: The relationship between track 
order and printing

Shifting the Music by Octaves

Notated tracks containing very high or 
low notes can be hard to read due to an 
excess of ledger lines. The octave shift 
feature changes the octave used to notate 
the music without changing the actual 
MIDI data.

a Position the cursor underneath the 
clef of the staff to shift. 

The cursor changes into an Ò8.Ó

b Click the mouse. 

The Octave Shift pop-up menu appears.

To change the order of

.

printed tracks, change their
order in the Tracks Window
290
c Select one of the five Octave 
selections in the pop-up.

Figure 31.15: The Octave Shift pop-up menu.

Different octaves can be used for each 
track. Each octave shift option is 
explained below:

• 15ma
The music is notated two octaves 
lower than it actually sounds.

• 8va
The music is notated one octave 
lower than it actually sounds.

• loco
The music is notated in the same 
octave it is played.

• 8va bassa
The music is notated one octave 
higher than it actually sounds.

• 15ma bassa
The music is notated two octaves 
higher than it actually sounds.
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Notation Troubleshooting

Problems with Vision Notation

“I have too many extra voices.”

Use the Graphic Window to find where 
extra voices have been generated. If the 
track doesn’t require a second voice to 
play correctly, then realign the note loca-
tions to become either sequential notes or 
chords. Lowering the notation resolution 
sometimes helps alleviate extra voices. By 
elongating notes to the beginning of the 
next note, the Legato tool in the Strip 
Chart (page 244) can also help clear up 
ambiguous note overlaps that sometimes 
yield extra voices.

“I’m playing swing, and all my eighth 
notes are showing up as triplets.”

If swung eighth notes turn out as triplets 
and you want straight eighths, try moving 
the second note of each group a little to 
the left in the Graphic Window, or try 
quantizing the music to eighth notes.

“Notes are printing off the page.”

Before printing, check the Print Preview 
Window for notes appearing outside the 
margin or covering the page number.

“When trying to print, I get a dialog 
box telling me there’s a printing 
problem”

Check to make sure that the printer port 
isn’t being used for MIDI communication.
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Also, if your printer requires AppleTalk, 
check to see if AppleTalk is on or off. If it’s 
off, use the Chooser to turn it back on 
(you can turn it back off when you’re fin-
ished printing and need to resume using 
MIDI).

“It’s barely more than a page. Can’t I 
make it fit?”

Use the Bars per Line, Title Space, 
System Spacing, and Staff Spacing 
fields in the Print Preview Window to fit 
the music on one page. This may cause 
adverse effects such as note collisions.

If you can’t fit the desired number of bars 
to the line without collisions, try the set-
tings in the Page Setup dialog box to print 
either landscaped or scaled.

“There’s a rest between every note!”

You may need to adjust the Notation Res-
olution (see page 280). Use the minimum 
resolution necessary to accurately notate 
the track. If a track contains primarily D 

and E but has one F then the notation res-
olution should be set to E.

The Legato tool in the Strip Chart elon-
gate notes to the beginning of the 
following note, erasing rests between 
notes (see page 244). Quantize Durations 
(pg. 132) can also change the way rests 
and notes are notated, which usually 
improves the notation.

“Why are there so many ledger 
lines?”

If notes are generally way above or below 
a staff, try using 8Va (see page 290).
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“If my music looks good it sounds 
terrible, and vice-versa.”

There are some cases where a good 
sounding piece cannot be accurately 
notated without considerable editing. A 
reasonable solution involves using two 
copies, one for printing, the other for 
playing: 

a Optimize one copy for notation using 
quantization and other techniques 
discussed in this section to simplify 
the notation.

b Edit the second copy to fix only minor 
playback errors. Leave the timing and 
duration of notes as raw as possible 
to preserve the original performance.

Problems with Other Notation 
Applications

NOTE: Each notation application has its 
own rules for converting real-time created 
performance data to notation. Opcode does 
not take any responsibility for how other 
music notation programs implement this 
very complex process. Vision exports the 
data correctly! 

Following are some techniques that can 
help clean up tracks in Vision prior to 
exporting them to another application.

“There are many small notes and 
tuplets tied together.”

Use a larger quantize setting before 
exporting. Also consider using Quantize 
Durations (pg. 132).
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“Large sections appear to be missing 
from the score.”

Sequences must be captured before being 
exported. Vision ignores sequence events 
that aren’t captured during export, and 
this could cause large sections to “disap-
pear” from the score. Use File>Export 
to Clipboard, paste to a sequence, then 
export that sequence to automatically cap-
ture the tracks.

“I have chords covering many octaves 
in a single staff.”

Use Do>Split Notes to split the MIDI 
information into different tracks before 
exporting it. See page 424 for more infor-
mation on splitting notes.
Opcode Systems, Inc.
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Vision tracks are not directly assigned to 
specific MIDI channels. Instead, they are 
assigned to Instruments, which, in turn, 
are assigned to MIDI channels of devices 
contained in the current OMS Studio 
Setup.

Figure 32.1: MIDI Instruments Window

This scheme of assigning tracks to Instru-
ments, and Instruments to devices offers 
several advantages:

• Tracks can be assigned to Instru-
ments with descriptive names, 
instead of just channels.

• Several MIDI channels can be 
assigned to a single Instrument to 
create layers and splits.

• Velocities can be scaled and notes 
transposed on a per Instrument basis.

• Individual Instruments can be muted 
and soloed instead of tracks.
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The Instruments Window is extremely 
useful when working with sequences that 
contain lots of sequence events. Rather 
than making changes to tracks contained 
within the referenced sequences and seg-
ments, you can instead make global 
changes with the controls in the Instru-
ments Window.

INSTRUMENTS WINDOW

Choose Windows>Instruments (or type 
option-I) to open or activate the Instru-
ments Window.

The following sections discuss each 
column found in the Instruments 
Window.

Select and Move

As discussed in Selector Dots and Move 
Cursor (pg. 22), Instruments or groups of 
Instruments can be selected and high-
lighted with the selector dots. Once 
selected, an Instrument can be deleted, 
copied and pasted to another Instrument, 
or even moved to another position within 
the window.
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Instrument

The Instrument column shows the name 
and color assignment for each 
Instrument.

Instrument Names

Instruments are automatically named 
according to the devices and channels in 
your OMS Studio Setup. You can, how-
ever, enter your own custom names for 
each Instrument; to do so, simply click in 
this field and type in the new name. To 
revert back to the default name, highlight 
the custom name and delete it.

Instrument names are displayed wher-
ever an Instrument is referred to, such as 
in the Thru Instrument pop-up, each of 
the edit windows, the Faders and Con-
soles windows, the Input Map Window, 
and many other locations.

Instrument Colors

An Instrument’s color is used when dis-
playing track data in the various edit 
windows. To change an Instrument’s 
assigned color, click on the color square 
and choose from the pop-up menu of 
colors.
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Vision’s available colors can be custom-
ized by choosing Setups>Colors. The 
colors can also be reinitialized to their 
default values by choosing Initialize 
Colors from the Instruments Window 
menu.

Mute and Solo

Click in the Mute column to mute one or 
more MIDI Instruments, thereby ceasing 
MIDI transmission to those Instruments.

Click in the Solo column to “solo” one or 
more MIDI Instruments, thereby restrict-
ing MIDI transmission to only those 
Instruments.

NOTE: Muting and soloing of Instruments 
affects not only track playback, but also 
MIDI routing to the Thru Instrument and 
Input Maps.

NOTE: Instruments can also be muted and 
soloed from a Console Window (and, in 
Acadia mode, the EQ and Plug-in Edit 
windows).
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Muting and Soloing Tracks vs. Muting 
and Soloing Instruments

Muting or soloing an instrument is not 
the same as muting or soloing a track, 
although in many cases it produces the 
same audible effect. Muting or soloing an 
instrument will mute or solo all note 
events assigned to that instrument (in all 
tracks). Muting or soloing a track will 
mute or solo all events (of any kind) in 
that track.

Muting an instrument does not mute all 
events assigned to the instrument; specifi-
cally, all automation events assigned to a 
particular instrument will play even if the 
instrument is muted (or unsoloed).

Muting instruments and tracks is cumula-
tive. If you mute both an instrument and a 
track assigned to a different instrument, 
the track and all note events assigned to 
that instrument will be muted.

Solo events are also cumulative, but the 
effect is different. If you solo both an 
instrument and a track assigned to a dif-
ferent instrument, you will hear nothing. 
This is because the instrument solo mutes 
all events that aren’t assigned to that 
instrument, and the track solo mutes all 
events that aren’t on that track. Since 
there are no events assigned to the instru-
ment and on the track, no events will 
sound.
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Transpose Maps and Drum 
Instruments

There are several transpose options for 
Instruments. The easiest is a simple 
octave or chromatic transposition. Since 
this can be done separately for each line 
of an Instrument, these settings are 
located in the right half of the Instru-
ments Window (see Transpose (pg. 298).

In addition to these simple transpositions, 
each Instrument can use a Transpose 
Map, allowing more complex transposi-
tions. When clicking in this column, the 
Transpose Map dialog appears, allowing 
arbitrary transpositions. For details, see 
Transposing with Vision Instruments 
(pg. 83).

Drum Instruments

The Drum Instrument setting ( ) pre-
vents notes assigned to that Instrument 
from being changed with Vision’s Trans-
pose command. Transposing most drum 
tracks usually results in a somewhat 
random reassignment of drum sounds—
something that most users will wish to 
avoid.

To turn an Instrument into a Drum Instru-
ment, move the cursor over the column 
and click the mouse button—a small pic-
ture of a snare drum appears in the 
column. Click again to make it a normal 
transposing Instrument (the snare drum 
disappears).
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Figure 32.2: Defining a Drum Instrument

Even when an Instrument is assigned as a 
Drum Instrument, Vision still uses the 
Transpose Map. This lets you use a Trans-
pose Map to map drum sounds from one 
device to another.

Drum Instruments do not allow a note to 
be retriggered until that note is finished 
playing. Also, notes assigned to Drum 
Instruments don’t sound if playback 
begins after the note’s onset. This is 
useful when working with drum loops on 
samplers, where it doesn’t make sense to 
trigger the note anywhere except at the 
start. For example, a note beginning on 
beat 1 and ending on beat 4 won’t play if 
playback begins on beat 2. This concept 
applies to mutes and solos as well; if a 
drum instrument or track is soloed or 
unmuted on beat 2, a note beginning on 
beat 1 and ending on beat 4 won’t play.

Instrument Line Settings

The Columns to the right of Transpose 
Map pertain to each line (or layer) within 
an Instrument and are called Instrument 
Line settings. To add a line to an Instru-
ment, see page 300.
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Mode

Figure 32.3: A multi-line Instrument set to 
Overflow

If an Instrument has more than one line, 
its mode is shown on the second line, just 
below the name. The mode can be either 
Layered or Overflow. Click the word to 
toggle between them.

Layered

A Layered Instrument transmits data to 
each device in each of its lines simulta-
neously. Each layer can play on a different 
channel, allowing the creation of a large 
“stacked” sound using different patches. 
Another useful option involves playing 
layered Instruments on the same channel 
but transposed an octave higher or lower.

Overflow

An Overflow Instrument can link several 
synthesizers with limited voices to func-
tion as a single synthesizer. For each line 
of an Overflow Instrument, set the MIDI 
device, channel, and the number of voices 
that the synthesizer can produce. Voices 
are entered in the far right column of the 
Instruments Window and are only active 
when Overflow mode is selected.
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You can use an Overflow Instrument to 
simulate a monophonic patch. This is 
useful if you have a track that should only 
play as if it were on a mono patch, but you 
want to hear it on some patches that may 
be polyphonic.

a Set the desired device and channel 
for the first line and set its number of 
Voices to 1.

b Add a second line and set its number 
of Voices to 0.

Vision limits itself to sending only one 
voice to the first line, and when it tries to 
overflow onto the second, it cuts itself 
off.

Output (Device and Channel)

The Output column specifies the Device 
and Channel for each line in the 
Instrument.

The Device determines which OMS 
device is used to transmit events for this 
Instrument or line. Devices shown in ital-
ics are not defined in the current OMS 
Studio Setup document, and will not play. 
Click the italic text and choose a defined 
device from the pop-up menu.

The Chan determines which MIDI chan-
nel is used to transmit events for the 
Instrument or line. The available channels 
are those defined in the current Studio 
Setup for the selected device. If the chan-
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nel is shown in italics, it is not defined in 
the current Studio Setup and nothing will 
play on that channel. Click the italic text 
and choose a defined channel from the 
pop-up menu.

Reassigning undefined devices and chan-
nels affects only the current Vision file. 
The process must be repeated for any 
other Vision files referencing the same 
undefined devices and channels. 

Instead of manually reassigning unde-
fined devices and channels, you can 
choose Setups>Undefined Channels. 
This opens the Undefined Channels dia-
log, which controls remappings for all 
Vision file objects that use device and 
channel assignments (such as MIDIKeys, 
Input Maps, faders and consoles, etc.). 
The remappings can then be applied to 
any Vision file opened in the future. See 
Undefined Channels (pg. 431) for details.

Velocity Scale 

The Velocity Scale checkbox allows 
enabling and disabling of velocity scaling 
for a particular instrument. If the box is 
checked, velocity scale events assigned to 
the selected instrument will be followed. 
If the box is unchecked, those events will 
be ignored.
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This box is particularly useful if you’ve 
been working with velocity scale and sud-
denly find that you can’t hear an 
instrument. A very low velocity scale set-
ting could cause that scenario. You can 
simply uncheck the Velocity Scale check-
box in the Instruments window to 
determine whether this is the cause of the 
problem.

The Velocity Scale % number ranges 
from 1% to 250% and controls the scaling 
of velocities for the Instrument or line.

The default value is 100% and does not 
change note velocities during playback. 
Numbers less than 100% reduce outgoing 
velocities and numbers greater than 100% 
increase them. This still affects the veloci-
ties even if a fader is controlling them, so 
several lines can be controlled by the 
same fader, each with different scalings.

Faders from the Faders and Consoles 
Windows can be used to control velocity 
for the Instrument. A fader value of 127 
equals the full scaled velocity level. For 
example, a note recorded at a velocity 
level of 64, with Velocity Scale % set to 
50, results in a velocity level of 32 (50% of 
64) with the fader at 127. Changing the 
percentage to 150, but keeping the fader 
at 127, outputs the same note with a veloc-
ity level of 96 (150% of 64). See Using 
Faders to Control Instrument Velocities 
(pg. 346) for further information.
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Transpose 

The Oct column shows the number of 
octaves transposed for the Instrument or 
line. It may be set to any value from -5 to 
+5. 

The column on the right sets the number 
of semitones the Instrument or line is 
transposed. This may only be between -5 
(down a fourth) and +6 (up a tritone). 
Changes outside this range spill over into 
the Octave transpose column.

Range (key)

The Range column specifies the range of 
notes played by the Instrument or line. 
Notes outside this range are not played. 
Valid ranges are between C-2 and G8 (the 
full 127 note MIDI range) and are 
expressed by the note name followed by 
the octave number. 
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AVAILABLE INSTRUMENTS

Vision can store up to 512 Instruments for 
use at any one time. The following sec-
tions discuss various methods for 
Instrument assignment and storage.

OMS Studio Setup Document 
Instruments

Each Vision Instrument is associated with 
a particular device channel. When Vision 
is first started, it creates one Instrument 
for each receiving MIDI channel in your 
OMS Studio Setup. These Instruments 
have the same names as the devices in 
the current OMS Studio Setup. For exam-
ple, if the only device in your OMS Studio 
Setup is named “Synth” and is receiving 
on MIDI channels 1-4, Vision creates four 
Instruments named “Synth-1” through 
“Synth-4”.

You can change an Instrument’s name, 
and other parameters as well. Renamed 
Instruments are called “custom” 
Instruments. 

Vision Setup File Instruments

Custom Instruments can be saved in the 
Vision Setup file and, like other file 
objects, are applied to any newly opened 
Vision files. New Instruments can be cre-
ated and unused Instruments can be 
deleted.
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Custom Instruments saved in the Vision 
Setup file take precedence over the auto-
matically generated Instruments made 
from the OMS Studio Setup document. 

For more information, see Vision Setup 
(pg. 157).

INSTRUMENTS WINDOW MENU

Figure 32.4: Instruments Window menu

Following is a description of the items in 
the Instruments Window menu:

New Instrument

To create a new Instrument:

a Click an existing InstrumentÕs 
selector dot.

b Choose New Instrument from the 
menu in the Instruments Window.

A duplicate of the selected Instrument 
appears at the bottom of the Instruments 
Window (you may have to scroll in order 
to see it). 
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c Rename the duplicate by clicking its 
name and typing in a new, custom 
name that distinguishes it from the 
other Instrument on the same device 
and channel.

Add Line to Instrument (Option-=)

Adding lines to an Instrument allows it to 
either play on more than one channel 
(Layered mode), or to overflow to another 
device when the first device’s maximum 
polyphony is exceeded (Overflow mode).

NOTE: Click the desired Instrument’s selec-
tor dot before choosing Add Line to 
Instrument.

Most Instruments have only one line, indi-
cating that they play through one MIDI 
channel. You can add lines, each line play-
ing through a different MIDI channel to 
create “stacked” Instruments.

See Chapter 22: Custom Instruments for 
details on creating multi-line Instruments.

Remove Line from Instrument

To remove an Instrument line, click on 
any parameter of the desired Instrument 
line and choose Remove Line from 
Instrument (from the menu in the Instru-
ments Window).
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Make from Studio Setup

Choosing Make from Studio Setup 
opens the following dialog:

Figure 32.5: Make from Studio Setup dialog

Clicking Make creates one Instrument 
for each device’s channel in the current 
OMS Studio Setup. Instruments are 
retained only if they’re being used by the 
sequence. All non-custom Instruments 
that are not in used by sequence are 
removed if they don’t correspond to 
defined devices.

Since unused custom Instruments are not 
deleted by Make from Studio Setup, 
naming an Instrument ensures that it will 
remain in the sequence.

Vision automatically makes Instruments 
from the current OMS Studio Setup docu-
ment the first time the program is 
launched. Thereafter, whenever the cur-
rent Studio Setup changes (and if the 
Always Make from Studio Setup option 
is checked), Vision prompts you to update 
the Instruments to match those in the 
OMS Studio Setup. 
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Making Instruments from your Studio 
Setup has the disadvantage of losing all 
non-custom Instruments not used by the 
current sequence, or not associated with a 
device in the current Studio Setup. 
Regardless of where an Instrument comes 
from, unused, undefined Instruments are 
removed from the Instruments Window 
after using Make from Studio Setup. 

If Instruments are not made from the 
OMS Studio Setup document and the 
Vision Setup file contains Instruments 
that don’t match Instruments created 
from the Studio Setup, then the device 
channels need to be remapped. See Unde-
fined Channels (pg. 431) for more 
information on remapping undefined 
channels.

NOTE: Working with Instruments is usu-
ally less complicated by saving them with 
each sequence file, rather than using the 
Vision Setup file for this purpose.

Always Make from Studio Setup is 
checked by default.

Select Unused Instruments 
(Command-A)

Choose this command to quickly delete 
unused Instruments. If an Instrument is in 
use by the current sequence, it can not be 
deleted. You can use the Show Use of 
Selected Instruments command to find 
out where it’s being used so you can go to 
the source and clear or change it.
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Show Use of Selected 
Instruments

Choose Show Use of Selected Instru-
ments to reveal where the selected 
Instruments are used.

Instruments can be used by tracks, the 
Thru Instrument, the metronome sound, 
Input Maps, faders, the Clipboard, or the 
Undo buffer. 

Clear Clip & Undo

Choosing Clear Clip & Undo clears the 
Vision Clipboard and the Undo buffer. 
This is helpful to remove an Instrument 
that Vision considers “in use” by the 
sequence only because it is stored in the 
Clipboard following an edit procedure.

NOTE: You cannot undo this command.

Initialize Colors

This sets the Instrument colors to the 
Vision defaults.
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GLOBAL INSTRUMENT SOLO 
INDICATOR

The Control Bar displays a Global Instru-
ment Solo Indicator whenever any 
Instrument (Audio or MIDI) is soloed.

Figure 32.6: Global Instrument Solo Indicator

If no Instruments are soloed, then the 
Control Bar displays the standard Instru-
ment button ( ).

Why have a Global Solo 
Indicator?

Numerous Vision windows let you solo an 
Instrument, including:

• MIDI Instruments Window
• Audio Instruments Window
• Console Windows
• EQ and Plug-In Edit Windows
• Graphic Window (Audio Instruments 

only)

Global Instrument Solo Indicator
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With so many windows letting you control 
Instrument soloing, it’s easy to acciden-
tally leave an Instrument soloed, resulting 
in unexpected playback problems. The 
Global Instrument Solo Indicator reminds 
you that an Instrument is soloed some-
where in Vision.

NOTE: The Solo column in the Tracks 
Window solos entire tracks, not individual 
Instruments, so it does not turn on the 
Global Instrument Solo Indicator.

Using the Solo Indicator

The Solo Indicator lights whenever any 
MIDI Instrument or Audio Instrument is 
soloed in any window.

Once lit, the Solo Indicator blinks when-
ever a sequence plays, or whenever 
Vision transmits MIDI data, such as 
when...

• you play an external MIDI controller 
and Vision is in Keyboard Thru mode 
(Setups>Keyboard Thru is 
checked).

• you edit MIDI notes and the Do>Edit 
Window>Play Edited Note option 
is checked.

• you scrub across MIDI data.

Finally, you can click the Solo Indicator to 
open any windows that contain soloed 
Instruments (as discussed in the next 
section).
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Automatically Unsoloing Soloed 
Instruments

All soloed instruments (MIDI and Audio) 
can be automatically unsoloed by option-
clicking on the Global Instrument Solo 
Indicator.

Finding Soloed Instruments

The Global Instrument Solo Indicator 
goes beyond reminding you that an 
Instrument is soloed—it helps you find 
the soloed Instrument(s).

a In the Control Bar, click the Global 
Instrument Solo Indicator.

Vision opens any window that contains a 
soloed Instrument.

Specifically:

• If a MIDI Instrument is soloed, click-
ing the Solo Indicator automatically 
opens the MIDI Instruments Win-
dow, so you can turn off any soloed 
Instruments.

• If an Audio Instrument is soloed, 
clicking the Solo Indicator automati-
cally opens the Audio Instruments 
Window, so you can turn off any 
soloed Instruments.

• If both MIDI Instruments and Audio 
Instruments are soloed, clicking the 
Solo Indicator automatically opens 
both the MIDI Instruments Window 
and the Audio Instruments Window.
Vision & Studio Vision Pro — MIDI Reference M
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Choose Windows>Names to open the 
Names Window, which is a component of 
the OMS Name Manager.

The Name Manager integrates patch doc-
uments from a variety of sources:

• Galaxy Bundles
• Typed-in Patch Name documents
• Documents from other OMS-2 com-

patible librarians

Once you set up the Name Manager, 
Vision displays patches, notes and con-
trollers by name, as opposed to just 
numbers. The Name Manager also takes 
care of the housekeeping involved when 
you open a file that uses a different set of 
patch names.

TERMINOLOGY

Every MIDI device manufacturer seems 
to use different terminology to describe 
similar features in their devices. For 
example, different synthesizer manufac-
turers use the terms “patch,” “voice,” 
“part,” “program,” or “sound” to mean the 
same thing—a collection of programma-
ble parameters that work together to 
create a unique sound.
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Because Opcode has no way of knowing 
which MIDI devices you own, we must 
describe certain Name Manager functions 
generically. The following mini-glossary 
lists the terms we’ll use in describing the 
Name Manager.

Patch

A collection of parameters in a device that 
define the sound played when recalled. 
For example, one patch might create a 
trumpet sound and another might create a 
guitar sound.

Bank

A collection of patches stored in a MIDI 
device. Most modern MIDI devices have 
storage for hundreds (or even thousands) 
of different patches. However, the MIDI 
specification only provides program 
change messages for 128 patches. In 
order to access more than 128 patches, a 
device must store them in banks, which 
are accessed via bank select messages. 
The actual bank select messages vary 
from device to device.
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Mode

The state of a device that determines how 
MIDI program changes are interpreted. 

Imagine a synthesizer with three different 
modes:

• Patch Mode: Individual sounds, 
such as “Electric Piano,” “Acoustic 
Guitar,” or “Flute.”

• Effect Mode: Effects programs such 
as “Hall Reverb,” “Slap Delay,” or 
“Flange.”

• Performance Mode: A combination 
of several individual sounds with an 
effects patch, such as an “Electric 
Piano” patch layered with a “Flute” 
patch and assigned to a “Hall Reverb” 
effect.

Usually devices access the different 
modes by interpreting patch change mes-
sages differently for different channels. 
For instance, General MIDI devices have 
“patch” channels and “drum” channels. 
Sending program change #1 to a channel 
in “patch mode” calls up a piano, whereas 
sending program change #1 to a channel 
in “drum mode” calls up a standard drum 
kit.

By using different device modes, OMS 
applications can display and select any 
patch type contained in your MIDI device.

Do not confuse modes with banks; a bank 
of patches for one mode might contain an 
entirely different number of patches than 
a bank for a different mode.
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Patch Name Document

A document that stores and provides 
patch names and device modes for one or 
more devices. There are subtle differ-
ences in the way the Name Manager 
handles different types of documents; 
these will be noted throughout the rest of 
this chapter.

Current Patch Name Document

If a Patch Name document is current, 
OMS thinks that the patches in the docu-
ment are loaded into the device. You can 
manually make a document current, or a 
librarian program like Galaxy might auto-
matically do it for you when sending 
sounds to a device.

Patch Name Provider

An application that can create a Patch 
Name document readable by the OMS 
Name Manager.

Name Setup

A mapping that associates each MIDI 
device in your current OMS Studio Setup 
document with a specified Patch Name 
document. There is only one Name Setup 
active at a time, and it “lives” inside OMS, 
not the application.

Since the Name Setup is handled by 
OMS, changes made to the Name Setup 
in Vision affect the names seen in other 
OMS 2.0-compatible applications.
Opcode Systems, Inc.
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When you save a Vision file, the current 
Name Setup is saved along with it.

NAMES WINDOW

To open the Names Window, choose 
Windows>Names.

Figure 33.1: Anatomy of the Names Window

Names Window Anatomy

As you can see in Figure 33.1, the Names 
Window contains numerous elements:

A Device column: This column shows 
the name of each MIDI device con-
tained in your current OMS Studio 
Setup document. You cannot edit the 
contents of this column. Its contents 
change whenever the current Studio 
Setup document changes.
Devices stored in a Name Setup but 
not defined in the current Studio 
Setup appear in italics.

A B C D

E
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B Patch Name Document column: 
This column shows the Patch Name 
document referred to by each of the 
devices. For more information, see 
Patch Name Document Column 
(pg. 308).

C MIDI Channel column: Some MIDI 
devices let you select different modes 
on different MIDI channels. This 
column shows which MIDI channel 
uses the mode shown in the Device 
Mode column. For more information, 
see Channel and Device Mode Col-
umns (pg. 310).

D Device Mode column: If a device 
supports multiple modes, then this 
column shows which mode it is using. 
You can change the mode directly in 
this column’s pop-up menu.

E Name Setup control: Use this pop-
up menu to determine how changes 
made in other applications affect the 
Name Setup. For more information, 
see Name Setup Control (pg. 309).

The information contained in this window 
is saved with the Vision file when using 
the File>Save or File>Save As 
commands.

The following sections discuss the Names 
Window in greater detail.
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Patch Name Document Column

Use this column to select which Patch 
Name document or Galaxy bundle is ref-
erenced by each MIDI device. This is 
called subscribing to a document. To sub-
scribe to a Patch Name document or 
Galaxy bundle:

a Click in the Patch Name Document 
column next to a MIDI device.

b Choose Names>Subscribe.

A standard Open dialog box appears.

c In the following dialog, navigate to 
and select the desired Patch Name 
document or Galaxy bundle. Then 
click OK.

The column now shows the Patch Name 
document or Galaxy bundle to which you 
subscribed.

NOTE: If you don’t know where to find 
Patch Name documents, read the following 
section.
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Where To Find Patch Name Documents

There are three sources for Patch Name 
documents:

• The Name Manager recognizes Bun-
dles created by Galaxy and other 
OMS-2.0 compatible librarians as 
Patch Name documents.

• You can create your own “typed-in” 
Patch Name documents directly from 
the Name Manager.
To do so, double-click in the Patch 
Name column to open the Patch 
Name Editor. Use the Patch Name 
Editor to create or edit a Patch Name 
document as described in Patch 
Name Editing (pg. 313).

Figure 33.2: Blank Patch Name Editor 
Window

• Opcode supplies a collection of “fac-
tory” Patch Name documents for 
many popular synthesizers. If there is 
a factory Patch Name document for 
your device, choosing Names>Use 
Factory/GM Names enables it. See 
Use Factory/General MIDI Names 
(pg. 311).
Opcode Systems, Inc.



CHAPTER 33: The Names Window
Current and Missing Documents

Figure 33.3: Name Setup showing current and 
missing documents

The Patch Name Document column dis-
plays additional information about 
subscribed documents by using italicized 
text and the small diamond icon:

• A small diamond appears before the 
name of each current Patch Name 
document. A current Patch Name 
document is the document that the 
Name Manager uses to supply names 
to all OMS 2.0-compatible applica-
tions. For more information, see 
Name Setup Control (pg. 309). 
In Figure 33.3, the MU80’s Patch 
Name document is not current. This 
means that the patches actually resi-
dent in the MU80 don’t match those 
currently subscribed.

• The Patch Name document is itali-
cized if the Name Manager can’t 
locate the document. In Figure 33.3, 
the document for the Wavestation SR 
is missing.
Vision & Studio Vision Pro — MIDI Reference M
Name Setup Control

Since the OMS Name Manager only refer-
ences one Name Setup at a time, changes 
made to the Name Setup in other applica-
tions can affect Vision. Use the Name 
Setup control to determine what happens 
when changes are made to the Name 
Setup:

• Always use current patches: 
Making Patch Name documents cur-
rent in another application changes 
the Name Setup in Vision to match.

• Keep using these patches: “Locks 
in” the current Name Setup. Subscrip-
tions can’t be changed in Vision by 
changing them in another OMS 2.0-
compatible application.

This setting is not remembered between 
sessions. Whenever you open Vision, the 
control is reset to Always use current 
patches.

Name Setup control
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Channel and Device Mode 
Columns

The Channel and Device Mode func-
tions are interrelated and are described 
here together.

If a device supports multiple device 
modes, then the Device Mode column 
contains a pop-up menu listing all possible 
modes.

Since each MIDI channel can access a dif-
ferent device mode, the Ch (Channel) 
column displays which MIDI channels 
access which device modes. You can view 
every enabled MIDI channel or just a sum-
mary of all MIDI channels by clicking the 
desired device’s selector icon, then choos-
ing Names>Show Channels.

Device mode pop-up list
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Show Channels is a toggle whose value 
is changed by choosing it repeatedly.

• When Show Channels is checked 
(on), the Names Window displays a 
separate row for every MIDI channel 
in that device (as defined in the OMS 
Studio Setup document). You can 
then select a device mode for each 
MIDI channel.

• When Show Channels is not 
checked (off), the Names Window 
displays a single row for that MIDI 
device and the Ch column is labeled 
all. Changing the device mode affects 
all channels simultaneously.

Figure 33.4: Channel mode indicators

The word various in the 
Device Mode column indi-
cates that not all channels 
are in the same mode.
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Editing Device Modes when Show 
Channels is Off

If Show Channels is off and every MIDI 
channel is set to the same device mode, 
then that mode appears in the Device 
Mode column.

If Show Channels if off and different 
MIDI channels use different device 
modes, then the device mode column dis-
plays various, indicating more than one 
device mode is active for this device (see 
Figure 33.4).

Editing Patch Name Documents for 
Multi-Mode Devices

If different MIDI channels reference dif-
ferent device modes, there is only one 
way to edit each mode’s Patch Name 
document:

a Double-click a number in the Ch 
column.

A Patch Name Editor opens for that MIDI 
channelÕs mode. Patch Name Editing is 
discussed in Patch Name Editor Anat-
omy (pg. 314).

IMPORTANT: This is the only way to edit 
the patch names for a device with multiple 
modes.

Same device mode used by 
all MIDI channels
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NAMES MENU

The Names Menu is available whenever 
a Names Window is active.

Figure 33.5: Names Window menu

The following sections describe each 
command in the Names Menu.

Subscribe

This command selects a Patch Name doc-
ument to which all selected devices are 
subscribed.

Use Factory/General MIDI Names

If you’re using a General MIDI synth, 
choose this command to subscribe to the 
General MIDI Patch Name document 
located in the Factory Names folder (in 
the OMS Folder inside the System 
Folder).
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OMS also provides Factory Name docu-
ments for many popular instruments. If 
your device is supported, this command 
subscribes to these names.

If the device doesn’t have an associated 
Factory Name file, the General MIDI 
patch names are used instead.

Copy Subscription

This command copies the subscription for 
the selected device(s) to the Clipboard.

Paste Subscription

This command pastes subscriptions from 
the Clipboard onto the selected device(s). 
Any previous subscription is replaced and 
the new Patch Name document becomes 
current.

Clear Subscription

Removes the subscription information 
from selected device(s).

Make Current

When choosing this command, the follow-
ing alert appears:
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Clicking Don’t Make Current retains 
the previous subscription.

If the Send the patches option is avail-
able and checked, the Name Manager 
attempts to transmit the patches to the 
device when you click the Make Current 
button. The application that created the 
Patch Name document must be capable of 
this operation. For example, names 
obtained from a Galaxy Bundle can be 
sent (if Galaxy is available on your sys-
tem), but typed-in Patch Name 
documents cannot and the Send the 
patches option won’t appear in the alert.

Use Current Instead

Use Current Instead replaces the 
selected device(s)’ non-current subscrip-
tions with subscriptions to the current 
Patch Name document(s).

New Patch Document

Creates a blank, untitled Patch Name doc-
ument for the selected device(s).

View/Edit Patch Names

Selecting a device and choosing this com-
mand is equivalent to double-clicking a 
device’s Patch Name document column.
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Tell Patch Provider

This menu item contains a sub-menu list-
ing the commands that can be sent to the 
Patch Name provider.

If the Patch Name Provider understands 
the selected message, it performs that 
action. For example, if patch names come 
from a Galaxy Bundle and Send Patches 
to Device is the selected command, 
Galaxy sends the bundled patches to the 
selected device.

Show Channels

Show Channels controls whether the 
Names Window displays one row per 
MIDI channel or a single row represent-
ing all MIDI channels. To assign different 
device modes to different MIDI channels, 
this option must be enabled (checked). 
For more information, see Channel and 
Device Mode Columns (pg. 310).
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PATCH NAME EDITING

Use the Patch Name Editor to display or 
edit Patch Name documents. 

To open the Patch Name Editor:

a In the Names Window, double-click in 
the Patch Name Document column 
next to a device.

Figure 33.6: Double-click to open the Patch 
Name Editor

The Patch Name Editor opens for that 
Patch Name document. The Editor 
shows all the Patch Names for that 
device.

Figure 33.7: Typical Patch Name Editor

If you open a Patch Name Editor for an 
unsubscribed device, a blank Patch 
Name Editor opens, which you may use 

A B C D

E F

G
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to create a Patch Name document. Doc-
uments created this way are called 
Òtyped-inÓ Patch Name documents.

NOTE: If a Patch Name document con-
tains multiple device modes, the Patch 
Name Editor displays names only for the 
selected channel’s current device mode. For 
more information, see Channel and Device 
Mode Columns (pg. 310).

Patch Name Editor Anatomy

Figure 33.7 shows the various elements in 
the Patch Name Editor. These are:

A MIDI Program Number: The MIDI 
column in the Patch Name Editor dis-
plays MIDI representations of 
patches in the form bank0/bank32/
patch number (0-127). For example, if 
the current bank requires a bank32 
message with value “1” to be sent to 
access the patches, each patch will 
have “1/x” as its program number, 
where x is the number within the 
bank.
Bank0 and bank32 are each omitted 
when not used, which is the case for 
the default first bank. Consult your 
synthesizer’s documentation to deter-
mine how bank0 and bank32 
messages affect patch selection.
These numbers can’t be changed 
directly, and if the Patch Name docu-
ment comes from an external 
librarian, they can’t be changed at all. 
If the document in question is a 
typed-in Patch Name document, the 
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numbers are affected by settings in 
the Bank Select/Numbering dialog 
box. See Bank Select/Numbering 
(pg. 319).

B Device Program Number: This 
column shows how the MIDI device’s 
internal program numbering corre-
sponds to the actual MIDI program 
number.
For example, some devices number 
their internal programs 1-128, which 
corresponds to MIDI programs 0-127. 
This results in the pattern shown in 
Figure 33.8 in the MIDI and Num-
bers column.
The device shown in this example, 
organizes its programs in banks of 50, 
which are numbered 0-49.

Figure 33.8: MIDI and device numbering

C Patch Name: This column shows the 
name of each patch. New patch 
names can be typed directly into this 
column if this Patch Name document 
was created in the Name Manager 
(Galaxy and other librarian docu-
ments can’t be edited from here). 
These names appear wherever patch 
names are seen in any OMS 2.0-com-
patible application.

This column numbers patches as they 
appear in the actual device.
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D GM Equivalent: If this patch corre-
sponds to a General MIDI patch, 
choose the relevant GM patch from 
the pop-up menu in this column. The 
Name Manager applies all attributes 
and benefits of General MIDI group-
ings to that patch.
For example, assume you have a 
piano sound in your Patch Name doc-
ument, and you assign “GrandPno1” 
as its GM Equivalent. Then, if you 
choose to display patch names by 
General MIDI Groups, this piano 
sound appears whenever you ask to 
see all the piano sounds in your MIDI 
device. For more information about 
selecting patches by General MIDI 
Groups, see Using Patch Groupings 
(pg. 321).

E Note Name Indicator: The OMS 
Name Manager can store custom 
MIDI note names along with patch 
names. Custom note names have 
many uses. For example, names can 
be assigned to the notes in a drum kit 
patch, causing edit windows to dis-
play notes named “kick” and “snare,” 
instead of “C3” and “D3.”
This column uses a small note icon to 
indicate that a patch has custom note 
names. The Note Name Editor can be 
opened by double-clicking in this col-
umn. For more information, see Note 
and Control Names (pg. 320).

F Control Name Indicator: The OMS 
Name Manager allows storage of 
custom MIDI control names along 
with the name of the patch. Custom 
control names have many uses. For 
example, a MIDI effects device might 
use MIDI control numbers to edit its 
Vision & Studio Vision Pro — MIDI Reference M
internal parameters. By entering 
custom control names, edit windows 
display controls named “Reverb 
Time” and “Pre-Delay,” instead of 
“Control 48” and “Control 37,” 
making it easier to edit these devices 
within OMS 2.0-compatible 
applications.
This column indicates that a patch 
has custom control names if it con-
tains a small knob icon. The Control 
Name Editor can be opened by 
double-clicking in this column. For 
more information, see Note and Con-
trol Names (pg. 320).

G Program Selector Dot: If you are 
pasting names into a typed-in Patch 
Name document, you can select the 
range where the names will be pasted 
by Shift-clicking or dragging over the 
Program Selector dots. If no dots are 
selected, names are pasted starting at 
the top and working down until the 
names on the Clipboard are 
exhausted. See Paste Name List 
(pg. 317) for more information.
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Patches Menu

The Patches menu is available whenever 
a Patch Name Editor is active.

Figure 33.9: Patches menu

NOTE: Most of these menu items apply only 
to typed-in Patch Name documents; they’re 
disabled for Patch Name documents that 
come from other applications, such as 
Galaxy.

Save

Choose this command to save any 
changes you’ve made to the current Patch 
Name document. If you’ve previously 
saved a document, then the Save com-
mand replaces the old document with the 
new version. If you haven’t yet saved the 
active document, choosing Save opens 
the Save As dialog box, in which you can 
name the document and select a location 
in which to store it.
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This command behaves differently 
depending on where the document comes 
from:

• Typed-in Patch Name documents are 
saved normally.

• Documents from Galaxy or other 
OMS-compatible Patch Name provid-
ers are converted to typed-in Patch 
Name documents. For this reason, 
the Save command is not available 
when you are in a librarian’s docu-
ment. In this situation, only the Save 
As command is available.

Save As

Use this command to save a copy of the 
active document using a different name. 
Choosing Save As opens the Save As 
dialog box, in which you can name the 
document and select a location in which 
to store it.

Saving Note/Control Names

If Note or Control Names have been 
added to a document created by another 
application, the Save Note/Control 
Names command becomes available. 
This command adds the note and control 
name information to the saved Patch 
Name document.

Copy Name List

Choose Copy Name List to copy the list 
of patch names from a Patch Name docu-
ment onto the Clipboard.
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Names are copied to the Clipboard as 
text, and can be pasted into other applica-
tions. For example, you can paste names 
into a word processor or database to for-
mat, search, or print name lists. Each line 
is copied as:

Patch Number <tab> Patch Name

Paste Name List

Choose Paste Name List to copy text 
from the Clipboard into the Patch Name 
Editor. If the lines of text contain tabs, 
they are interpreted as:

Patch Number <tab> Patch Name

Otherwise, each line of text becomes a 
patch name. If you have access to a scan-
ner and OCR (optical character 
recognition) software, you can scan patch 
name lists for your synthesizers, convert 
them to word processing files, then paste 
them into the Patch Name Editor.

If any patches in the Patch Name Editor 
are selected (that is, their selector dots 
are black), then pasting names overwrites 
only the selected patches. For example, if 
you have ten patch names on the Clip-
board, but select only three patches, only 
the first three names on the Clipboard are 
used (see Figure 33.10).
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Figure 33.10: Only patches 1-3 will be pasted, 
regardless of the Clipboard’s contents

Clear Name List

This command erases the currently 
selected name list, should you wish to 
start with a “clean slate.”

Add Mode

Choose Add Mode to create an entirely 
new device mode for the document, and 
open a new window to display it.

Remove Mode

Choose Remove Mode to delete the 
device mode displayed in the active 
window.
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Mode Name

Choose Mode Name to name (or 
rename) the device mode displayed in the 
active window. The mode name appears 
on the top line of the window.

Default Modes

Choose Default Modes to open a 
window in which you select a default 
mode for each channel. Whenever this 
Patch Name document is subscribed, the 
channels are set to the modes designated 
in this window.

For example: General MIDI devices have 
two modes: standard and drums. Chan-
nel 10 is always in drums mode, and all 
other channels are in standard mode. 
Figure 33.11 shows the default mode 
screen setup for a General MIDI device.

Mode name
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Figure 33.11: Default Mode Window

Add Bank

Choose Add Bank to create a new bank 
of 128 patches following the bank contain-
ing the currently selected patch, or at the 
end of the document if there is no 
selected patch. When you choose this 
command, the Bank Select/Numbering 
dialog box opens as discussed in Bank 
Select/Numbering (pg. 319).

Remove Bank

Choose Remove Bank to delete the bank 
in which the selected patch resides.

NOTE: If the device has less than 128 
patches in a bank, leave the unused patches 
blank—blank patches won’t be displayed in 
patch selection menus and dialog boxes.
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Bank Select/Numbering

Adding a bank or choosing the Bank 
Select/Numbering command opens the 
Bank Select/Numbering dialog box:

Figure 33.12: Bank Select/Numbering dialog box

Figure 33.12 displays the various ele-
ments in the Bank Select/Numbering 
dialog box. Specifically:

A A Bank Select message may be speci-
fied by checking one or both of the 
Bank Select checkboxes, and by 
entering a bank select value in the 
box to the right. Consult your synthe-
sizer’s documentation to determine 
the appropriate values for these 
boxes.
IMPORTANT: Each bank must have a 
unique combination of bank select mes-
sages. A warning message appears if 
two banks have the same bank select 
combination.

1

2
3

4
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B If the Automatically number 
patches in bank option is checked, 
the patches are automatically num-
bered according to the selected 
numbering convention:
0-127: Used for synthesizers with a 
“0 based” numbering convention.
1-128: Used for synthesizers with a 
“1 based” numbering convention.
A11-B88: Used for synthesizers 
with a “bank based” numbering con-
vention (most Roland devices use this 
scheme).

C Patch prefixes can be entered in the 
Prefix box. For example, a synth may 
use banks with names such as 
“RAM1.” The patches could be num-
bered “RAM1-0” thru “RAM1-127” by 
entering “RAM1-” in the Prefix box 
and selecting 0-127.

Figure 33.13: Using the Prefix feature

D If the Assign GM equivalents to all 
patches option is checked, each 
patch is assigned a General MIDI 
patch equivalent. This sets each 
patches’ number equal to the GM 
equivalent. This is useful to configure 
a bank to match the GM defaults 
without changing the names.

End of first bank

Beginning of second bank
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Note and Control Names

Double-click the Cntls column in the 
Patch Name Editor to open a Control 
Names Window. Similarly, double-click 
the Notes column to open a Note Names 
Window.

Figure 33.14: Note Names Window

Saving note names or control names adds 
them to the Patch Name document, 
regardless of whether it is typed-in or 
from another application.

Note names are useful for drum machines 
or samplers. For example, it’s easier to 
edit MIDI data for a drum machine if 
notes appear named “Kick” and “Snare” 
rather than “C2” and “D2.” Similarly, if 
you’re using a sampler to trigger sound 
effects, notes named “Crash” and “Gun-
shot” are more useful than notes named 
“G3” and “D5.”
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Control names are useful if you perform 
real-time edits to synthesizer or effects 
patches. For example, it’s easier to edit 
controllers named “RevTime” and 
“HPFiltr” than controllers named “Con-
trol 41” and “Control 73.”

Default Note and Control Names

At the top of every Patch Name document 
is a line marked Default. You can add a 
set of default note and controller names to 
a Patch Name document by double click-
ing in the appropriate column and typing 
names into the Note Names or Control 
Names Window. These default Names are 
used for every patch that doesn’t specifi-
cally override them.

Figure 33.15: Default Note and Control Names

In Figure 33.15, there is a set of default 
Note Names. All the patches in this bank 
use these note names. However, the note 
icon in the row for patch number 2 indi-
cates that it has its own set of Note Names 
that override the defaults.

Default Note and Control Names row
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SELECTING NAMES

Once the Name Setup is configured prop-
erly, Vision displays names in all 
appropriate places (such as in the Current 
Patch pop-up in the Control Bar, or in the 
Patch column of the Tracks Window).

There are two ways to choose names:

• A simple pop-up menu of choices, 
either sorted alphabetically or numer-
ically. This appears when you click on 
a name field.

• The Names Browser is a more 
sophisticated window where you can 
view names numerically or alphabeti-
cally—or even group them by 
keyword or patch type. The Names 
Browser Window appears when you 
Command or Option-click a name 
field.

Figure 33.16 shows the pop-up menu that 
appears when you click on a patch name 
field.

Figure 33.16: Pop-up Patch Name menu
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Names Browser

If you Option or Shift-click on a name 
field, the Browser Window opens:

Figure 33.17: Patch Name Browser

The Name Manager sends the necessary 
commands (program change/bank 
select) each time a patch is selected. The 
By number/By name radio buttons sort 
the list by number or name; this is global 
and applies to pop-up menus as well.

Using Patch Groupings 

The Grouping pop-up menu allows you to 
choose a grouping assignment for the cur-
rent Patch Name document. For example, 
the General MIDI patch names contains 
the groupings None, General MIDI 
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Groups and General MIDI Patches. If 
you select General MIDI Groups from the 
Grouping pop-up menu, you will be pre-
sented with this list of groupings in the 
Browser Window:

Figure 33.18: General MIDI Groups

Selecting an item from this list narrows 
the list of available patches to show only 
those patches that belong to the selected 
group. For example, patches in the Piano 
group include Grand Piano, Brite Piano, 
and so forth.

An additional advantage to using group-
ings is that patch selection menus display 
their contents hierarchically; that is, 
arranged by group (as shown in 
Figure 33.19).
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Figure 33.19: Hierarchical Patch Selection

You can create your own groupings with 
Galaxy, Opcode’s patch librarian applica-
tion. Also, Galaxy automatically provides 
groupings for certain synthesizers. You 
cannot create groupings with typed-in 
Patch Name documents.

Browser Menu

Figure 33.20: Browser menu

When you use the Names Browser, the 
menu shown in Figure 33.20 becomes 
available.
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Sort by Number/Sort By Name

These commands duplicate the function 
of the “By Name/By Number” buttons in 
the Browser Window.

Show Patches In Any/All Selected 
Group(s)

With “any selected group” selected, Shift-
clicking multiple groupings in the 
Browser displays patches that belong to 
any of the selected groups (if you have 
programming experience, think of this as 
the “or” condition).

With “all selected groups” selected, Shift-
clicking multiple groupings in the 
Browser only displays patches that 
belong to all of the groups (programmers 
can think of this as the “and” condition).

As an example, imagine you have a group-
ing for “bright” and a grouping for 
“piano.” With “all selected groups” cho-
sen, you would see only bright pianos 
listed, whereas with “any selected group,” 
you would see all bright patches and all 
piano patches listed together.

Edit Selected Patch

Tells the patch provider to open an edit 
window for the selected patch, if the appli-
cation supports the command.
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OPENING FILES WITH 
DIFFERENT NAME SETUPS

Vision saves Name Setups in its sequence 
files. When you open a file that references 
a different Name Setup, you have to 
answer some questions to let the Name 
Manager know how you want to handle 
the different assignments. This section 
discusses the possible options.

First, you see the following dialog box:

Figure 33.21: Different Name Setups, first dialog 
box

You have two choices at this point. The 
following sections describe these choices.

Make Current

This choice overrides all current Name 
Setup information with the information in 
the file being opened.
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Usually if you want to change subscrip-
tions, you also want to send the new 
patches to your synthesizers, and the 
Name Manager assumes that this is what 
you want to do. You will see a dialog box 
similar to the following, letting you know 
that transmission is going to start:

Figure 33.22: “Getting Ready To Send” dialog box

Typed-in patch documents have an aster-
isk (*) next to their name, letting you 
know that they can’t be sent automati-
cally. You should load up your devices 
with these patches in whatever manner is 
appropriate.

Documents that can’t be found are dis-
played in italics.

When you are ready, you can click...

• Send: to send the bundles to the 
devices.

• Don’t Send: to proceed without 
sending any data.

• Go Back: to return to the previous 
dialog box.
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Don’t Make

Clicking Don’t Make leaves the current 
patches current. However, you still have a 
choice to make: do you want to change 
the document being opened to use the 
current Name Manager subscriptions, or 
do you want to leave the file alone?

Figure 33.23: “Don’t Make Current” dialog box

If you click...

• Keep: the document is unchanged.
• Change: the document is updated to 

use the current Name Manager sub-
scriptions. If you save the file without 
changing its name, any record of the 
old subscriptions is lost.

• Go Back: returns to the previous 
dialog box.
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The Input Map Window allows reassign-
ment of MIDI events received from an 
Instrument, defined by a device and chan-
nel, to a different Instrument. Reassigned 
events can also trigger and transpose 
sequence playback.

Figure 34.1: The Input Map Window

INPUT MAP DISPLAY

Each line in the Input Map controls the 
mapping for a range of notes on a MIDI 
device and channel to an Instrument or a 
trigger mode. Vision compares each 
incoming MIDI event to each line in the 
Input Map, beginning with the top line. If 
the event is in the specified range of notes 
and it’s on the specified device and chan-
nel, then the MIDI event is reassigned. If 
more than one line matches, the first one 
is used. If no line matches, the event is 
routed to the Thru Instrument set in the 
Control Bar.
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Input Device and Channel

Selecting a MIDI device and channel 
defines the source for incoming events. 
Vision intercepts MIDI signals from this 
device and channel, and remaps them to 
the Instrument or trigger defined in the 
Thru/Trigger field.

The available devices are determined by 
the Input Devices defined in the current 
OMS Studio Setup document.

Range

These columns allow specification of the 
note range, on the selected device and 
channel, that will be remapped. Notes out-
side this range are not affected by the 
Input Map. MIDI note numbers can be 
entered from the numeric keypad or by 
selecting the field and playing a note on a 
MIDI controller.

NOTE: Notes assigned in MIDIKeys have 
precedence over the Input Map. For exam-
ple, a note falling within the note Range in 
the Input Map, but having an assignment 
in MIDIKeys, will not be processed by the 
Input Map. 
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Base

The Base is the note that acts as middle C 
for the remapped keyboard zone. This is 
useful when splitting a keyboard into two 
or more zones. For example, assuming C3 
is middle C, setting the Base to C2 trans-
poses each note up an octave before being 
remapped or routed to the Thru 
Instrument. 

The Base also acts as a reference point for 
the transpose and trigger modes.

NOTE: Middle C can be either C3 or C4, 
depending upon what has been specified in 
the Settings Window.

Thru/Trigger

Clicking here gives you the same Instru-
ment pop-up as the Thru Instrument pop-
up in the Control Bar. You can choose 
either an Instrument to assign to this 
line’s zone, or you can choose a trigger or 
transpose mode.

If you want to assign a trigger mode, you 
can then set the sequence and Player 
number. This is discussed below and in 
Trigger and Transpose Modes (pg. 326).

Sequence and Player

When selecting a trigger mode for a line, 
these fields allow specification for both 
the sequence played and the Player it’s 
played on. 
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Unlike the Thru Instrument setting, 
where the trigger mode requires you to 
hit a letter key to make a sequence trig-
gerable, Vision will start a sequence when 
it receives a MIDI signal from the device 
and channel in this line. 

Figure 34.2: Choosing a Sequence to trigger

For more information, see 
Chapter 15: Players and Input Effect.

TRIGGER AND TRANSPOSE 
MODES

Although the trigger and transpose 
modes can also be set using the Thru 
Instrument pop-up menu, the operation is 
effective only until sequence playback 
stops. The Input Map settings remain 
active between playback sessions. 

Transpose Mode

Transpose mode remaps valid incoming 
MIDI notes to transpose sequences cur-
rently playing, without playing the 
incoming notes. Transpose mode doesn’t 
affect sequences being recorded. 
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Notes played within the selected note 
Range transpose playing sequences rela-
tive to the Base note. For example, if the 
Base note is C3 and a D3 is played (and 
D3 falls within the note Range), all play-
ing sequences are transposed up a whole 
step. The D3 is not played but acts only as 
a transposition value and signal.

If two keys are played simultaneously, 
and both fall within the note Range, both 
notes affect their own transpositions rela-
tive to the Base note. 

Trigger Modes

The trigger modes allow notes falling 
within the note Range to trigger sequence 
playback for the sequence specified in the 
Sequence field. Each valid note starts 
playback for one copy of the sequence. 
The sequence is also transposed accord-
ing to the rules discussed in the previous 
section. Multiple valid notes, played 
simultaneously, transpose and play sepa-
rate copies of the sequence.

Trigger Mode

Trigger mode stops and restarts the 
selected sequence, using the relative 
transposition, upon receiving valid trigger 
notes. Notes played simultaneously start 
and transpose separate copies of the 
sequence.
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Continuous Trigger Mode

Continuous Trigger mode does not stop 
currently playing sequences when valid 
notes are directed to that sequence. After 
the sequence finishes playing, it is 
restarted and transposed according to the 
note previously received.

Gated Mode

Gated mode plays and transposes the 
sequence, when receiving notes within 
the note Range, only while notes are held 
down. This can provide an interesting 
interactive environment for creating inter-
woven lines.

INPUT MAP WINDOW MENU

Figure 34.3: Input Map Window menu

Input Map Enabled

When this toggle is enabled, Vision 
routes incoming MIDI signals to the Input 
Map. If the MIDI note doesn’t apply to 
any line in the Input Map, the signal is 
routed to the Thru Instrument. When the 
toggle is disabled, Vision routes incoming 
MIDI signals directly to the Thru Instru-
ment, bypassing the Input Map.
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Add Line (Option-=)

Choosing this item creates a new line in 
the Input Map. Selecting an item on an 
existing line, before choosing Add Line, 
duplicates that line below the line contain-
ing the selected item.

Remove Line (Option-—)

Selecting any parameter in a line and 
choosing Remove Line, removes that 
line from the Input Map.

Make One Line per Channel

Choosing this command sets up one 
Thru/Trigger Instrument for each device 
enabled for MIDI Input in the Studio 
Setup document. Instruments appear in 
the same order as in the Instruments 
Window. 

To quickly add one line per channel for a 
specific device, choose Setups>Enable 
Input Devices and disable all input 
devices except the specific device being 
added to the Input Map. Then choose 
Make One Line per Channel. Disabled 
devices may then be enabled without dis-
turbing the Input Map.

Load From

This opens a standard open dialog box 
allowing the Input Map from another 
Vision file to become the active Input Map 
for the current file.
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The Load From command loads only the 
Input Map from the Vision file. This 
mechanism allows the creation of tem-
plates for commonly used Input Maps.

Clear All

The Clear All command deletes all lines 
from the Input Map and cannot be 
undone. If your use of Vision doesn’t 
require an Input Map (see When to Use an 
Input Map (pg. 328)), you should keep 
the Input Map clear. This allows your con-
troller keyboard to use the Thru 
Instrument setting, which can be changed 
more easily than the Input Map.

WHEN TO USE AN INPUT MAP

For those using Vision with a single con-
troller keyboard, Input Maps are not 
essential and their inadvertent use can 
create confusing routing problems. 
Choosing Clear All from the Input Map 
Window pop-up clears all lines from the 
Input Map and disables all assignments 
(page 328). 

The following examples suggest several 
common uses for the Input Map:

• The OMS Studio Setup has more than 
one MIDI controller;

• Permanent assignment of MIDI notes 
to trigger certain sequences (see 
Trigger and Transpose Modes 
(pg. 326));

• Enable recording from another 
sequencer;

• Split the controller keyboard.
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Multi-Channel Recording

Several MIDI channels can be recorded 
simultaneously from a separate 
sequencer into Vision by using the Input 
Map to assign each incoming MIDI chan-
nel to a different Vision Instrument. See 
Multi-Channel Recording (pg. 46) for 
details.

Multiple Keyboards and Keyboard 
Splits

To set up a split controller keyboard, clear 
the Input Map by choosing Clear All 
from the menu in the Input Map Window. 
Then, for each zone on the keyboard:

a Choose Add Line from the Input 
MapÕs Window menu.

b Make sure the Input MapÕs device and 
channel assignments match the 
controllerÕs output assignments.

c Click in the low Range note field in 
the new line, and play the low note of 
the range on your keyboard 
controller.

d Click on the high Range note field and 
play the high note of the range on 
your keyboard controller.

e Set the Base note for the zone to the 
note that will function as C3.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 35: The Settings Window
The Settings Window contains preference 
settings for a number of different edit and 
display options. The Settings Window dis-
plays a different set of preference items 
based on the selection in its pop-up menu, 
see Figure 35.1.

Figure 35.1: Settings Window pop-up menu

Changes in the Settings Window take 
effect immediately. In fact, you can keep 
this window open, making changes as 
needed, while continuing to use Vision.

Any changes made in the Settings 
Window are remembered when relaunch-
ing Vision. Information from the Settings 
Window is saved to the Vision Prefs file 
(located in the Preferences folder inside 
your System Folder).

The following sections discuss each of the 
preference groups accessed from the Set-
tings Window.
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INSERT NOTE

Figure 35.2: Insert Note settings

The Note Settings allow precise control 
over the duration, spacing, and velocity of 
notes entered with the Pencil and Magic 
Drumstick. You can use standard note 
durations, tuplets, or construct arbitrary 
durations. 

The Note Settings can be opened auto-
matically by double-clicking the Pencil or 
Magic Drumstick tools.

Spacing

Specifies the spacing of notes inserted 
when dragging with the Magic Drum-
stick. For details on using the Spacing 
pop-up and Tuplet option, see Spacing 
(pg. 337).
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Duration

Specifies the duration of notes inserted 
with the Pencil and Magic Drumstick. For 
details on the Duration parameters, see 
Duration (pg. 339).

Velocity

Specifies the velocity of notes inserted 
with the Pencil and Magic Drumstick.

STRIP CHART & NUDGE

Figure 35.3: Strip Chart & Nudge settings

Strip Chart Settings

Density

Sets the density of continuous controller 
events inserted in the Strip Chart. This 
value can also be changed in the Strip 
Chart area. For more details, see Using 
the Density Setting (pg. 256).
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Waveform Period

Sets the period length for the Strip 
Chart’s Oscillator Shapes. This length can 
be based on a number of bars, beats, 
units, seconds, SMPTE frames, or 
SMPTE bits. For more details, see Oscil-
lator Shapes (pg. 247).

The Waveform Period also has an option 
called Use Meter. Check this item when 
using “bars” as the period; this ensures 
that the bar’s size is based on the Meter 
for the affected track region.

Nudge Settings

Move Amount ( )

Determines how far events are nudged 
left or right. This amount can be based on 
a number of bars, beats, units, seconds, 
SMPTE frames, or SMPTE bits.

The Move Amount also has an option 
called Use Meter. Check this item when 
using “bars” as the nudged amount; this 
ensures that the bar’s size is based on the 
Meter for the edited track region.

Transpose Amount ( )

Determines the type of transpose used 
when nudging notes up or down. This 
value can be based on a number of semi-
tones, octaves, or scale degrees.
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The Transpose Amount also has an option 
called Use Key Signature. Check this 
item when using “degrees of scale,” 
which ensures that the transposition is in 
the Key Signature used by the edited 
track region.

EDITING

Figure 35.4: Editing settings

Auto Scroll Top Window Only

Check this option to restrict Auto Scroll-
ing to the top window. This can free up 
processing power for slower computers. If 
unchecked, all windows for the current 
sequence scroll.
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Set Insertion Point to End of 
Paste Region

When checked, the Insertion Point is 
automatically moved to the end of a 
pasted region—which makes it easier to 
cleanly paste another copy. This option is 
also used with Insert Blank Time, Insert 
Clipboard, Merge, and Repeat Paste.

When unchecked, pasted events remain 
selected (so they can be modified, if 
desired).

Clear Beat/Unit when Entering 
Bar

If checked, typing into a field for bar, beat, 
hours, minutes, or seconds clears all 
fields to the right.

If unchecked, typing into any of these 
fields leaves fields to the right unaf-
fected— typing the Period key, however, 
moves the cursor to the next field and 
clears it.

Punch Points follow Edit Points

When checked, any changes made to the 
Edit In/Out points (while playback is 
stopped or paused) are automatically 
echoed to the Punch In/Out Points.
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Clean Tempo Display

When checked, tempos are displayed 
with 2 decimal points. Uncheck this 
option to display tempos with four deci-
mal points.

NOTE: Not all four digit tempos are possi-
ble, but you will be able to access Vision’s 
full tempo accuracy.

Define Middle C

This pop-up menu specifies whether “mid-
dle C” (MIDI note number 60) is 
displayed as C3 or C4. Most instruments 
define “middle C” as C4. Yamaha instru-
ments, on the other hand, use C3.

Default Edit Window

This pop-up specifies the edit window 
opened when double-clicking a track from 
the Tracks and Pulse Windows (regard-
less of the type of data contained in the 
track). 

If Graphic or Notation is specified, 
Option-double-clicking a track opens the 
List Window. If List is chosen, Option-
double-clicking opens the Graphic 
Window.

In all cases, double-clicking a drum track 
from the Tracks Window opens the Pulse 
Window.
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Modify Window Option

This pop-up specifies what happens to the 
Select and Modify Window after an action 
is performed. You can specify that the 
window: stay in front, go behind the 
target editing window, go behind all win-
dows, or close after invoking the Select & 
Modify command (by either clicking the 
Modify button or typing Return).

REAL-TIME

Figure 35.5: Real-Time settings

Silent when Paused

When checked, all notes are turned off 
when playback is paused. If unchecked, 
all notes are sustained when paused, 
which can be used as a “fermata” effect.

Sustain Notes across Segments

When checked, notes playing back from a 
sequence event play for their full dura-
tion, even if the referenced segment or 
sequence stops playing.
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Sustain Audio Across Segments

When checked, audio events played from 
a sequence event last for their full dura-
tion—even if the referenced segment or 
sequence stops playing.

If you uncheck this option, the audio will 
stop playing when the sequence event 
ends, or when it reaches the loop end 
point (if it is set to repeat).

Aftertouch Sets Effect Velocity

When checked, aftertouch affects the 
velocities of notes played with the Input 
Effect (Repeat or Arpeggiate).

System Exclusive Thru

When checked, Vision routes system 
exclusive messages from your MIDI con-
troller to the Current Thru Instrument (or 
with the Input Map, if enabled).

If unchecked, Vision receives the informa-
tion but does not route it.

Solo Audio and MIDI 
independently

When checked, soloing of one or more 
Audio Instruments will not mute MIDI 
Instruments, and soloing of one or more 
MIDI Instruments will not mute Audio 
Instruments. Instruments can be soloed 
from the Instruments or Audio Instru-
ments window, Consoles, Plug-in edit 
windows, and EQ edit windows.
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This does not apply to audio or MIDI 
tracks, however. Soloing tracks still 
behaves as it always has; if one or more 
tracks are soloed, only the soloed tracks 
can be heard (regardless of whether they 
are MIDI, audio, or multi tracks).

If unchecked, soloing an Instrument 
(Audio or MIDI) will mute all remaining 
instruments (Audio or MIDI).

Audio edits occur...

Select “immediately” from this pop-up 
menu to have audio edits reflected almost 
instantaneously for playback. Choosing 
this option does, however, cause audio 
edits to interrupt audio playback briefly.

If you instead select “smoothly,” edits are 
reflected more slowly, but with no disrup-
tion in audio playback.

Record Quantize Source

The settings used for Record Quantize 
can be the Quantize settings residing in 
the Select & Modify Window or Input 
Effect Windows or the Play Quantize set-
tings of the record-enabled track

The default choice for this pop-up is 
“track,” which (when selected) represents 
no change in the way Record Quantize in 
previous versions of Vision.

From the Real-Time section of the Set-
tings Window, choose either “track,” 
“Modify,” or “Input Effect” from the 
Record Quantize source pop-up to specify 
the Record Quantize source.
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Maximum Playable Tracks

This is the maximum number of tracks 
(parent sequences and sequence events 
included) that Vision can play at any one 
time. 

Decreasing this number frees up more 
memory for recording and editing.

CONTROLLERS

Figure 35.6: Controllers settings

Favorite Controllers

These pop-ups specify the eight continu-
ous controllers you use most often. These 
controllers appear in many of Vision’s dia-
logs and windows, wherever you must 
make a controller selection.

Fine Controller Values

When checked, continuous controllers 
0-31 use a finer range of controller values 
(0-16383, as opposed to 0-127). Also, the 
Strip Chart generates “fine” controller 
data for any inserted values.
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If unchecked, all MIDI controllers are 
treated equally as having a range of 0-127. 
Consult your user manual to see if your 
devices support “fine” mode.

APPEARANCE

Figure 35.7: Appearance settings

Window Background

This pop-up menu determines the graphic 
background patterns used in Vision’s win-
dows and dialogs.

Fader Slots in Instrument Color

Check this option to display Instrument 
colors in the fader and console slots.
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The Step Window specifies how notes are 
step recorded. It opens automatically 
when entering step record mode. For 
details on step recording, see Step Record-
ing (pg. 42).

Figure 36.1: Step Window

The Step Window is divided into three 
sections: Spacing, Duration, and Velocity. 
The following sections discuss these 
three components of the Step Window.
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SPACING

Spacing determines the amount of time 
the Counter advances each time you play 
a note. The value is displayed as both a 
note duration and number of units (there 
are 480 units per quarter note). It also can 
affect the duration of the note.

One of the easiest ways to set the Spacing 
value is to choose a note value from the 
note pop-up. The units field is automati-
cally updated with the selected note value.
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You can also click in the units field and 
type a new value, or click and drag with 
the mouse.

If you enter a value in the units field that 
is not an equal subdivision of the beat, the 
note pop-up shows a “>” or “<” symbol 
along with the current note size, which 
indicates the approximate value.

Figure 36.2: Approximate note sizes

Figure 36.3: Exact note sizes

Tuplet Checkbox

If using complex timing divisions, use the 
Tuplet checkbox to define the Spacing. 
With it you can specify, for instance, 5 
notes in the space of 1 for quintuplets.

To enable the Tuplet, click its checkbox 
and enter the values for each of its fields. 
Vision calculates the Spacing size and the 
units field is updated automatically.
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Figure 36.4: Tuplet enabled for Spacing

In Figure 36.4, the Spacing specifies three 
notes within the space of an 8th note. In 
this instance, the Counter advances a 
third of an 8th note (80 units) for each 
step.

Using Keystrokes to set the 
Spacing

Perhaps the fastest way to change the 
Spacing size is by typing keys on your 
computer keyboard. This only works if 
the Step Window is open.

The following table summarizes the 
keystrokes: 

Key Function

1 A

2 B

4 C

8 D

6 E

5 F

3 Toggle triplet setting on or off

. (period) Toggle dot on or off

+ (plus) Add the next value to the cur-
rent value

- (minus) Subtract the next value from 
the current value
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The following mnemonics may be useful 
in remembering the keystroke for each 
note duration:

• 1: One whole note per measure.
• 2: Bottom number of 1/2 note.
• 4: Bottom number of 1/4 note.
• 6: “6”teenth note.
• 5: 25 = 32 for 32nd note.
• 3: triplet has 3 notes.

Adding and Subtracting Durations

The “+” and “-” keys can help calculate the 
Spacing value, for example:

a With the Spacing value set to 8th 
notes (240 units), type +.

Make sure the note is not highlighted. 
Click on any inactive window area or on 
another field to de-select the Size 
pop-up.

b Next type 6 to add a 16th note (120 
units) to the 8th note.

The SpacingÕs note pop-up switches to a 
dotted 8th note (360 units).

You can also use the “+” key for long 
notes— type “1 + .4” to create a whole 
note tied to a dotted quarter note. As you 
can imagine, with one hand on the com-
puter keyboard, and one on your MIDI 
controller, you can step record music very 
efficiently.
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DURATION

The Duration section of the Step Window 
determine the lengths of step recorded 
notes. The Duration pop-up menu offers 
the following four options:

Independent

Independent sets the note durations to a 
length independent of the Spacing size. 
To set the Independent duration, choose a 
value from the note pop-up or change the 
value in the units field; changing either of 
these items updates the other 
automatically.

Independent ensures all recorded notes 
are of uniform length, even if the Spacing 
size changes. Figure 36.5, for example, 
illustrates the Spacing size varying while 
the Duration stays constant with Indepen-
dent set to 16th notes.

Figure 36.5: Independent set to 16th notes
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Spacing Minus Gap

Spacing Minus Gap specifies the size of 
the “gap” (rest) between each step 
recorded note. As a result, the actual 
length of the recorded notes is equal to 
the Spacing size minus this Duration size. 
In this mode, the gap between the 
recorded notes is constant, even if the 
Spacing size changes.

Figure 36.6: Spacing Minus Gap, 8th notes

Figure 36.6 illustrates step recorded notes 
with Spacing Minus Gap set to 8th notes. 
Even though the Spacing size changes, 
the gaps between the notes remain 
constant.

Constant gap size 
between entered notes
340
Percent of Spacing

Percent of Spacing calculates the dura-
tions based on a percentage of the 
Spacing size. To enter staccato notes, use 
smaller percentage values such as 50%. To 
enter legato notes, use percentage values 
near 100% or even larger.

Figure 36.7: Spacing set to quarter notes, Percent 
of Spacing set to 60%

As Played (Duration)

As Played step records durations as you 
actually play them, with respect to the 
current tempo setting of the sequence—
even though the metronome doesn’t 
sound while step recording.

The Counter still advances based on the 
Spacing setting but the actual duration 
entered can be arbitrarily long or short.

is 60% of
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VELOCITY

The Velocity section of the Step Window 
determines the velocities of step recorded 
notes. The following two options are 
available:

Constant

Constant specifies that all step recorded 
notes are entered with a specified value. 
To change the Constant velocity, high-
light the field and use the mouse or 
keyboard to change the value.

As Played (Velocity)

As Played step records velocities as you 
actually play them on your MIDI control-
ler. This method ensures more natural 
sounding velocities than with Constant.
Vision & Studio Vision Pro — MIDI Reference M
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Figure 37.1: The Faders Window

ABOUT FADERS

Vision supports up to 800 faders that are 
divided into two categories:

• Faders 1-32 are controlled from the 
Faders Window, as shown in 
Figure 37.1.

• The sixteen Console Windows, each 
represented as a mixing board, con-
trol the other 768 faders.

NOTE: Each Console Window can contain 
up to 24 channels, and each channel con-
tains 2 faders. The fader that appears to be 
a pan control is, in fact, fully assignable, as 
is the main fader.
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Each fader can be set to send any MIDI 
controller (except pitch bend and after-
touch) or volume or pan for any audio 
Instrument, Bus, Input, or Output. Each 
fader can be controlled directly with the 
mouse or by an external MIDI controller. 
Faders can also be grouped and con-
trolled from the same external MIDI 
controller. One fader can control tempo.

When a fader’s movements are recorded 
and its window is open, the results are 
audibly and visually represented during 
playback. These movements are recorded 
as automation events in the record-
enabled track. These events can be 
viewed and edited in either the List 
Window (see page 261) or the Strip Chart 
(see page 241). Specific events can be 
selected for editing or remapping using 
the Select & Modify Window (see 
page 119).

Vision handles automation events identi-
cally whether they originate from the 
Faders or Console Windows. Although 
this chapter discusses the Faders Win-
dow, feel free to consult Chapter 38: The 
Console Windows and the Automation 
chapter of your Audio Reference Manual 
to correlate ideas between these related 
features.
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THE FADERS WINDOW

The Faders Window can be displayed in a 
single column consisting of 16 faders, 
beginning with either Fader 1 or 
Fader 17; or in two columns, showing all 
32 faders. This display option is controlled 
in the bottom right of the window.

To the left of the display options, at the 
bottom of the Faders Window, is a toggle 
that controls what the window displays:

• Send: The controllers the faders are 
sending data to
or

• Rcv: The external controllers the 
faders are controlled from

Fader Values

The field to the right of the fader name 
(F1, F2 etc.) shows the numerical value 
for that fader. Clicking and dragging up or 
down in the fader value numerical allows 
the value to be precisely set. Values may 
also be typed in from the computer key-
board. The range of values is 0-127.

Although Console faders assigned to cer-
tain parameters may have different value 
ranges, faders in the Faders window will 
always have a range of 0-127. These 
values are automatically remapped to 
appropriate values when recording, and 
vice versa. For example, if you set the 
Maximum Fader Position value to 
+6 dB, record a fade from 127 to 0 on a 
fader assigned to Audio Volume, and then 
view those events in the List window, the 
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values for the events will be between 
+6 dB and -¥. Playing those events (with 
+6 dB to -¥ values) will still result in the 
fader numerical displaying values 
between 0 and 127.

Fader Sliders

The fader’s slider may be dragged to 
change the value in the numerical field. 
Faders that are controlled by external 
devices move automatically in response to 
their assigned controller. Dragging the 
slider sets the fader to even-numbered 
values (and 127). 

If the Fader Slots in Instrument Color 
option is checked in the Settings Window, 
the fader slots are displayed in the color 
of the assigned Send Instrument. 

Instrument, Device, Channel 
Number and Controller

When the Faders Window is showing the 
Send settings, the Instrument and Con-
troller pop-ups determine where the fader 
sends its data.

When the Receive settings are shown, the 
Device, Channel and Controller pop-ups 
determine the source of the fader’s 
control.

Tempo Fader Assign

One fader can be set to control the tempo. 
See Using a Fader to Record Tempo 
Changes (pg. 138) for more information.
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Tempo Fader Range

These numericals determine the range 
available to the Tempo fader.

Send/Receive Settings Display

Clicking this field toggles the Faders 
Window display between the Send and 
Rcv settings.

Send Settings

Each fader can be used to send an auto-
mation event to a selected Instrument, 
Bus, Input, or Output:

a Set the Send/Receive toggle to Send.

b Activate the desired fader by clicking 
on its selector dot.

The selector dot changes into a hollow 
triangle.

c Select an Instrument, Input, Output, 
or Bus from the Instrument pop-up 
menu. 

d Select a controller from the Controller 
pop-up menu.

Volume (7) is the default that is initially 
displayed. Pitch bend and aftertouch are 
not available.

If an Audio Instrument, Input, Output, or 
Bus is selected, the only available send 
destinations are Volume and Pan. Click-
ing on the setting alternates between the 
two options.
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Whenever the fader is moved, the 
assigned automation events are sent to 
the selected Instrument. Moving a fader 
while recording causes Vision to record 
the automation events for the record-
enabled track.

One fader can control the volume of sev-
eral MIDI channels by setting up an 
Instrument with several layers, each layer 
set to one of the desired MIDI channels, 
and then selecting that Instrument to 
receive the fader’s volume information.

Receive Settings

To control a fader using an external MIDI 
controller such as a modulation wheel, 
MIDI fader unit, or continuous pedal:

a Select Fader Remotes Enabled 
from the menu in the Faders Window.

This allows the information from remote 
MIDI controllers to reach the faders.

b Set the Send/Receive toggle to Rcv.

c Enable the fader by clicking its 
selector dot. 

The device, channel and controller 
number are displayed that currently pro-
vide external control for that fader.

d Each numerical can be individually 
set using any of VisionÕs standard 
procedures.

An easier method is to click on each field 
and then move the external MIDI control-
ler that controls that fader. The 
information is automatically transmitted 
to the selected field.
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This process results in the external MIDI 
controller moving the fader to which it is 
assigned. The fader, in turn, sends the 
automation information assigned in the 
Send mode to the assigned Instrument, 
Input, Output, or Bus. Multiple faders can 
be controlled from a single external MIDI 
controller.

Fader Display Mode

Three different display modes are avail-
able for the Faders Window by clicking 
the 1, 17 or 32 fields in the bottom right 
corner of the window: 

• 1: The Faders Window consists of 16 
faders in one column beginning with 
Fader 1.

• 17: The Faders Window consists of 
16 faders in one column beginning 
with Fader 17. 

• 32: The Faders Window consists of 
32 faders in two columns beginning 
with Fader 1. 

FADER FUNCTIONS

Using Faders to Remap MIDI 
Controllers

Faders can remap a MIDI controller’s 
function by selecting one controller type 
to control the fader (with the Rcv setting) 
while assigning a different controller type 
to be sent by the fader (with the Send 
setting). 
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Using Faders to Control 
Instrument Velocities

Most MIDI synthesizers respond to MIDI 
Volume (control #7) but certain older syn-
thesizers do not. Vision allows a pseudo-
volume mix by using faders to control 
Instrument velocities instead of volume. 
Since velocity normally corresponds to 
note amplitude on most synthesizers, 
varying a note’s velocity is similar to vary-
ing channel volume. 

NOTE: Although velocity usually corre-
sponds to note volume, it may also affect the 
timbral aspects of the sound as well. Check 
the synthesizer manual for details.

Each Instrument layer can modify the 
velocities of the notes it plays. Two col-
umns in the Instruments Window control 
this action: 

• Velocity Scale checkbox: Any of 
Vision’s 800 faders can be assigned to 
control Velocity Scale for any instru-
ment. This checkbox enables the 
instrument to respond to Velocity 
Scale messages. Unchecking this box 
will cause the instrument to ignore 
Velocity Scale information assigned 
to it.

• Velocity Scale %: The amount can 
range from 1% to 250%. 

At the fader’s maximum level (127), the 
velocity output is the recorded velocity 
multiplied by the scaling factor. These 
settings affect all note velocities played by 
that Instrument layer.
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For example, if a note is recorded at a 
velocity level of 64 and the Velocity Fade 
Amount is set to 50%, then a fader level of 
127 equals a velocity of 32 (50% of 64).

Moving the fader while the sequence is 
playing changes the velocity of notes 
assigned to that Instrument. Fader move-
ments can now be recorded and used as 
pseudo-volume controllers for MIDI 
devices that don’t respond to Volume 
(control #7).

For more details, please see Velocity Scale 
(pg. 297).

Copying Fader Settings

When the Fader Window is active, choos-
ing Edit>Copy Faders places an 
automation event for each defined fader’s 
current value onto the Clipboard. The 
fader events can then be pasted into a 
track, creating a “snapshot” of the current 
fader values.

This is particularly useful for creating a 
mix at the beginning of a sequence. To 
ensure that your sequence begins with 
the correct mix, it is a good idea to place a 
fader snapshot at the beginning of the 
sequence. This process is very important, 
but it is often overlooked.
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For example, you might use volume 
faders to create a “fade out” at the end of a 
song, with each instrument’s volume set-
ting ending at 0. The first time the 
sequence is played, it sounds correct. 
After the sequence ends, you press play 
again, but can’t hear anything. If you let 
the sequence play long enough, you’ll 
hear only the fade out.

This happens because, at the end of the 
song, each instrument receives a volume 
setting of 0. If there’s no volume data at 
the beginning of the sequence, the instru-
ment doesn’t know to change its volume 
until the first volume event of the fade out. 
Creating a set of initial volume settings (a 
“snapshot” of the Console and Faders 
windows) will alleviate this problem.

Copy Faders now automatically inserts 
Mute and Solo automation events for 
MIDI Instruments in addition to any other 
MIDI controller events that are assigned 
in the Faders or Console windows.

For more information about the Copy 
Faders command, please see Saving a 
Mixer Snapshot (pg. 89).

CHANGES IN THE WAY VISION 
HANDLES FADERS

Removal of “fader events”

In previous versions of Vision, faders 
were a type of interface between you and 
your MIDI controller data.
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Figure 37.2: The old way

Faders still act as an interface, but now 
they generate data directly. Instead of cre-
ating a fader event assigned to another 
parameter (such as a controller), faders 
now create controller (or automation) 
events.

Figure 37.3: The new way

In short, we’ve “eliminated the middle-
man” by completely removing “fader 
events”.

Visual and Audible Effect

In most cases, the visual and audible 
effects of recorded fader movements will 
not change. In fact, faders themselves 
have become much more flexible. For 
example:

A fader set up like this...

...used to generate an event like this
(in the List Window).

A fader set up like this...

...will now generate an event like this
(in the List Window).
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a Open the Faders window and assign 
the first fader to control pan for a MIDI 
instrument.

This example uses JD-800-1.

b Record enable a track.

c Press the Record button.

d Click on the fader and drag it back 
and forth to record pan information.

e Press the Stop button and open the 
List window.

You can see the pan events in the list 
window.
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Notice that these are not fader events 
assigned to pan; they are pan events.

f Press Play

Watch the first fader move just as you 
recorded it.

g Disable the first fader by clicking on 
its selector dot.

h Enable a different fader and set it to 
JD-800-1 Pan.

i Press Play.

Now the new fader moves to the 
recorded pan events.

You could also assign a Console channel 
to JD-800-1 and the pan fader in that con-
sole would move in unison as well.
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Notes About Audio Volume and 
Pan

As in previous versions of Vision, audio 
volume and pan can be displayed in the 
Faders window and controlled by its 
sliders.

Audio pan now has a range of -100.00 to 
100.00, and audio volume now has a range 
of -¥ to the Maximum Fader Position (as 
set in the Audio Preferences dialog box). 
However, displayed fader values in the 
Faders window are still 0-127.

These values are mapped to the appropri-
ate range of values (for the selected 
parameter). In the case of audio pan, 0 
corresponds to -100.00 (left) and 127 cor-
responds to 100.00 (right). For audio 
volume, 0 corresponds to -¥ and 127 cor-
responds to the Maximum Fader 
Position.

If you wish to see the correct numeric 
values for these parameters, use the 
Consoles rather than the Faders window.

For more information, see your Audio Ref-
erence Manual.

Changes in Copy Faders

The Copy Faders command is most 
often used to create a “snapshot” of fader 
values for several different instruments.
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Since fader values are now mapped 
directly to controller values (as described 
on page 347) which are in turn assigned 
to instruments, pasting the information 
gathered during Copy Faders into a 
track will now result in a multi track.

For instance, if you invoke the Copy 
Faders command when you have a Con-
sole set up like the one above, the events 
inserted into a track will look like this in 
the List window.
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The track’s instrument is now set to multi, 
and automation events have been inserted 
for each instrument’s faders and mute and 
solo buttons.

If desired, you can use the Separate 
Multi Track command to put each instru-
ment’s events onto separate tracks. See 
page 49 for details.

Copy Faders and Audio Channels

When using the Copy Faders command 
with audio channels defined in the Con-
sole, you may end up with more data than 
you were expecting. For instance, EQ 
Enable, EQ Band Enable and EQ Band 
Parameters, Plug-in Bypass, and Send 
Levels are some of the event types that 
can be copied. See your Audio Reference 
Manual for more information about Copy 
Faders and audio channels.
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Vision offers sixteen separate Console 
Windows, each of which contains 24 chan-
nels. Console Windows can be configured 
as desired to perform a number of differ-
ent functions:

• Record dynamic MIDI and Audio 
Instrument mixes (or create static 
mix “snapshots”);

• Create real-time controllers for impor-
tant synthesizer and effects 
parameters, and record those param-
eter changes as part of the sequence;

• Assign EQs and VST plug-ins to 
Audio Instruments, busses, inputs, 
and outputs and edit them (in Acadia 
audio mode). See your Audio Refer-
ence Manual for details.

• Assign TDM plug-ins to Audio Instru-
ments and edit them (only if you own 
Studio Vision Pro and a Digidesign 
TDM-equipped digital audio system). 
See your Audio Reference Manual for 
details.

ABOUT CONSOLES

Console Windows are similar to the 
Faders Window, but offer more control. 
You should understand the Faders 
Window before using Consoles.
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Like the Faders Window, the Console 
Windows control Vision’s automation 
events. The Faders Window is discussed 
in the previous chapter and automation 
events are discussed in the Automation 
chapter of your Audio Reference Manual.

In the current version of Vision, each 
fader directly controls an automation 
parameter, such as volume, pan, velocity 
scale, or any MIDI controller.

Vision can automate up to 800 different 
faders—each assigned to a different 
Instrument, channel, or MIDI control. 
Faders 1-32 are controlled from the 
Faders Window. The others are con-
trolled from the Console Windows.

OPENING A CONSOLE WINDOW

To open a Console Window:

a Press and hold the mouse over the 
Windows>Console command.

Vision produces a submenu of console 
choices.
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b Select one of the sixteen consoles 
from the submenu.

Vision opens that Console Window.

Figure 37.4: Typical Wide Console Window

BASIC CONSOLE WINDOW 
ANATOMY

Vision offers numerous display choices 
for each console, including:

• Channel width (narrow or wide)
• Fader assignment displays
• Remote devices display
• Masking Tape display

Figure 37.4 shows a console with all dis-
play options disabled. It contains three 
major elements:

A Console Name
This area always displays the name of 
your console (as assigned in the Con-
sole Window Menu).

B Console Window Menu
Use this pop-up menu to set numer-
ous display options, as discussed in 
The Console Window Menu (pg. 355).

AB C
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C Individual Console Channels
The Console Window contains one 
vertical strip for each console chan-
nel. The next section details the 
elements in a channel.

The Basic Console Channel

Figure 37.5: Single, Basic Console Channel

As you can see in Figure 37.5, a basic con-
sole channel contains the following 
elements:

A Channel Number
Displays the number for each console 
channel. This area is highlighted for 
the channel that contains the active 
control.

A

B

C

5

6

7

8

9

J K

4
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B Instrument Selector
Use this pop-up menu to select the 
Instrument that’s controlled by this 
channel. Faders can control either 
MIDI Instruments, Audio Instru-
ments, Buses, Inputs, or Outputs.

C Volume Fader
By default, this fader controls volume 
(MIDI control #7), but you can reas-
sign it to any MIDI control number as 
discussed in Show Selected Fader Info 
(pg. 357) or Show All Fader Info 
(pg. 359).
The active fader always appears 
highlighted.

TIP: You don’t have to drag faders to 
change them—simply click where 
you want the fader to be and it jumps 
to the new value immediately.
NOTE: If the fader is assigned to an 
Audio Instrument, it can only control 
the audio’s volume.
NOTE: If the Fader Slots in Instru-
ment Color option is checked in the 
Settings Window, the fader slots are 
displayed in the color of the assigned 
Send Instrument. 

Click here...

...and the fader 
jumps to that value.
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D Volume Thumb
Click and drag the Volume Thumbs 
to adjust the fader value. Each thumb 
is color-coded as follows:
MIDI channels are teal.
Audio channels are blue.
Busses are pink. 
Inputs are purple. 
Outputs are red.
TDM SampleCell inputs are orange. 
NOTE: The Bus, Input, and Output 
colors are only applicable to Acadia 
users or Studio Vision Pro users with 
TDM-compatible hardware. Sample-
Cell colors are only available to Studio 
Vision Pro users with SampleCell 
TDM. ReWire channels are available 
only to Acadia users with ReWire com-
patible soft synths. For more 
information, see your Audio Reference 
Manual.
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E Volume Fader Value
Displays the numerical value set by 
the Volume Fader. You can change 
this numerical directly and the 
Volume Fader will move to reflect the 
new value.
Any time you reassign a channel to a 
different Instrument (either manually 
or with one of the Build Console 
From commands), the faders change 
to display the current fader value of 
the new Instrument.
Audio volumes are now displayed in 
decibels. The value can range from 
negative infinity to the Maximum 
Fader Position setting (see your 
Audio Reference Manual for details).
If you reassign a channel to a MIDI 
Instrument that does not currently 
have a volume value, Vision sets the 
fader level to 127. If you reassign a 
channel to an Audio Instrument that 
does not currently have a volume 
value, Vision sets the fader level to 
0 dB.

F Volume LEDs
Displays MIDI or audio volume levels 
graphically.
If your audio hardware does not sup-
port output level metering, then the 
channel hides the level LEDs.

G Clipping Indicator
In Acadia audio mode, this indicator 
works only with audio Outputs—it 
indicates a clipped digital audio sig-
nal. In Acadia mode, Audio 
Instruments, Busses, and Inputs 
never clip. This is because Acadia 
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uses floating point in its computa-
tions, and with floating point there is 
practically no limit to the dynamic 
range for these audio signals.
In all other modes, this indicator 
works only with Audio Instruments; it 
indicates a clipped digital audio 
signal.

H Pan Fader
By default, this fader controls pan 
(MIDI control #10), but you can reas-
sign it to any MIDI control number 
when working with MIDI Instru-
ments. This fader can only control 
pan when working with Audio Instru-
ments, Busses, Inputs, and Outputs.

I Pan Fader Value
Displays the numerical value set by 
the Pan Fader. You can change this 
numerical directly and the Pan Fader 
will move to reflect the new value.
For MIDI Instruments, this value can 
range from <64 (left) to 63> (right).
For Audio Instruments, Busses, 
Inputs, and Outputs, this value can 
range from -100.00 to 100.00.

J Mute Button
Click this button to mute playback of 
the Instrument, Bus, Input, or Output 
controlled by this channel.
Opcode Systems, Inc.



CHAPTER 38: The Console Windows
K Solo Button
Click this button to solo playback of 
the Instrument, Bus, Input, or Output 
controlled by this channel. Soloing a 
channel automatically mutes play-
back of any non-soloed channels.
Soloing an audio bus automatically 
results in all pre sends routed to that 
bus being heard (post sends are 
muted).

CREATING A CONSOLE 
“SNAPSHOT”

You can use the Copy Faders command 
to create a snapshot of fader values 
(including all Console faders). This is par-
ticularly useful for setting the mix at the 
beginning of a sequence.

For information about Copy Faders, see 
Copying Fader Settings (pg. 347) and 
Saving a Mixer Snapshot (pg. 89).
Vision & Studio Vision Pro — MIDI Reference M
THE CONSOLE WINDOW MENU

Figure 37.6: The Console Window Menu

The following sections discuss each item 
in the Console Window Menu:

Channel Width

Use the Channel Width command to 
specify one of two channel widths:

• Narrow
• Wide

The following sections discuss these two 
options in detail.
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Narrow

Select this option to reduce the display 
width of each console channel.

Figure 37.7: Channel Width set to Narrow

This option has pros & cons:

PRO: You can view more channels at a 
time on your computer screen.

CON: You lose some channel display 
capabilities. Specifically, if you select the 
Narrow option, channels won’t display:

• Volume bargraph (LED’s)
• Optional detailed channel information 

(such as Pan Fader Info, Fader Con-
trol selectors, and Remote Devices). 
These options are described later in 
this chapter.

Additionally, Instrument names in the 
Instrument Selector pop-up menu contain 
very few characters.
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Wide

Select this option to display each console 
channel at its maximum width.

Figure 37.8: Channel Width set to Wide

This option has pros & cons:

PRO: You can view all of the detailed 
information for each channel in the 
console.

CON: Each channel, since it’s wider, 
requires more screen space. Therefore, 
your computer screen can display fewer 
console channels at one time.

Audio Sends

The Audio Sends menu item (disabled 
for unsupported audio systems) allows 
you to create advanced routings using 
Acadia or Digidesign’s DAE with TDM-
equipped hardware. This feature is dis-
cussed in your Audio Reference Manual.
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Plug-Ins

The Plug-Ins menu item (disabled for 
unsupported audio systems) lets you 
apply VST or TDM plug-ins. This menu 
item is enabled only if you:

• are in Acadia mode
• own Studio Vision Pro and are using 

it to control TDM-equipped Digide-
sign audio hardware.

See your Audio Reference Manual for 
details.

EQs

The EQs menu item (disabled for unsup-
ported audio systems) lets you apply 
Vision’s realtime EQs to audio channels. 
This menu item is enabled only when you 
are in Acadia audio mode. This feature is 
discussed in your Audio Reference 
Manual.
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Show Selected Fader Info

Select this option if you want the top of 
the Console Window to display detailed 
information about the selected (high-
lighted) fader.

Figure 37.9: Console with Show Selected Fader 
Info enabled

You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and the fader info 
appears at the top of the Console Window. 
When the option is unchecked, it’s dis-
abled and the fader info does not appear 
at the top of the Console Window.

Selected fader information appears 
here, at top of window, when Show 
Selected Fader Info is checked.
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Figure 37.10 illustrates the different ele-
ments displayed by the Show Selected 
Fader Info option.

Figure 37.10: Anatomy of the Selected Fader Info 
Area

These are:

A Instrument Selector
This is the same as the Instrument 
Selector pop-up menu in the channel, 
but is wide enough to show the full 
Instrument name.

B MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the selected 
fader. It’s the same as the MIDI Con-
trol Selector displayed in each 
channel when Show All Fader Info 
is enabled as discussed in Show All 
Fader Info (pg. 359).
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

C Fader Value
This numerical displays the current 
value of the selected fader.

A B C D
E

F
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D Remote Device Selector
Use this pop-up menu to assign an 
external MIDI device to control the 
selected fader. This is particularly 
useful if you own a MIDI fader unit 
and wish to use it to control Vision’s 
faders.

E Remote Device Channel
Use this numerical to designate 
which MIDI channel is used by the 
Remote Device.

F Remote Controller Selector
Use this pop-up menu to select which 
MIDI controller on the external 
device will control the selected fader.

NOTE: Remote control of faders will not 
work until you check the Fader Remotes 
Enabled option in the Console Window 
Menu (or the Setups menu) as discussed on 
page 362.
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Show All Fader Info

Select this option if you want Vision to dis-
play detailed Instrument and MIDI 
controller assignments for each fader in 
each channel.

Figure 37.11: Wide Console with Show All Fader 
Info enabled

You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and all fader infor-
mation appears in each channel. When 
the option is unchecked, it’s disabled and 
the fader information does not appear in 
the channel.

NOTE: There is not enough room to show 
all fader information if the console’s Chan-
nel Width is set to Narrow. Therefore, the 
option is disabled when narrow channels 
are displayed.
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Figure 37.12 illustrates all the elements 
that are added to a single channel when 
you enable this option.

Figure 37.12: Anatomy of a console channel with 
Show All Fader Info selected

These are:

A Pan Instrument Selector
Use this pop-up menu to select the 
Instrument that’s controlled by the 
pan fader in this channel. Faders can 
control either MIDI Instruments or 
Audio Instruments.

B Pan MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the pan fader 
for this channel.
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

C Volume MIDI Control Selector
Use this pop-up menu to assign a 
MIDI control number to the volume 
fader for this channel.
IMPORTANT: If the fader is assigned 
to an Audio Instrument, it can only 
control the audio’s volume or pan.

A

B

C
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Show Remote Devices

Select this option if you want Vision to dis-
play the remote control assignments for 
the volume fader in each channel.

IMPORTANT: If you want to see remote 
device assignments for the pan faders, you’ll 
need to check the Show Selected Fader 
Info option as discussed in Show Selected 
Fader Info (pg. 357).

NOTE: Remote control of faders will not 
work until you check the Fader Remotes 
Enabled option in the Console Window 
Menu as discussed in Fader Remotes 
Enabled (pg. 362).

Figure 37.13: Wide console with Show Remote 
Devices enabled
360
You can turn this option on and off by 
selecting it repeatedly—when the option 
is checked, it’s enabled and the remote 
devices appear in each channel. When the 
option is unchecked, it’s disabled and the 
remote devices do not appear in the 
channel.

NOTE: There is not enough room to show 
remote devices if the console’s Channel 
Width is set to Narrow. Therefore, the 
option is disabled when narrow channels 
are displayed.

Figure 37.14 illustrates the elements that 
are added to a single channel when you 
enable this option.

Figure 37.14: Anatomy of a console channel with 
Show Remote Devices enabled

A
B

C
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These are:

A Remote Device Selector
Use this pop-up menu to assign an 
external MIDI device to control the 
volume fader.

B Remote Device Channel
Use this numerical to designate 
which MIDI channel transmits the 
remote data.

C Remote Controller Selector
Use this pop-up menu to select which 
MIDI controller on the external 
device will control the volume fader.

Show Masking Tape

This option adds a blank “masking tape” 
region to the bottom of each console 
channel. The Masking Tape area can be 
used to label each channel. After choos-
ing Show Masking Tape from the 
Console Window Menu, simply click in 
the Masking Tape area and type in the 
name you want to display (see 
Figure 37.15, below).

Figure 37.15: Console Channel with Masking Tape

Click here and type the
channelÕs name.
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You can type anything you wish into this 
field; Masking Tape doesn’t necessarily 
correspond to the name of a specific 
track. For example, even though you may 
use the same Instrument for several 
tracks, this Instrument has only one Con-
sole channel. In this case, you could label 
the Console channel “Synths” to refer to 
all of the tracks that it controls.

Naming an Instrument vs. using 
Masking Tape

Many users find that they wish for a quick 
way to add names to a console’s channels. 
Vision’s consoles are designed to mimic a 
physical mixing console, so the Masking 
Tape region was added to give users 
more flexibility. You can use it to quickly 
label your console channels.

Vision also has the capability to rename 
Instruments (MIDI and Audio), Busses, 
Inputs, and Outputs. For instructions, 
please see Instrument Names (pg. 294). 
Renaming an instrument is actually a 
more thorough labeling method. The 
instrument’s name appears throughout 
the program, including the Thru Instru-
ment popup, all edit windows (including 
the Tracks window), and the Record Mon-
itor, but the Masking Tape field only 
appears in the console.

In general, it’s best to use Masking Tape 
as a “scratch pad” while you’re working 
on the fly and then rename your instru-
ments when you’re ready for serious 
editing.
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Fader Remotes Enabled

Select this option if you want to remote 
control Vision’s software faders with hard-
ware MIDI controllers.

TIP: Fader remotes are particularly useful 
if you own a MIDI fader unit. You can 
assign each hardware fader to remotely 
control one of Vision’s software faders.

You can assign a different MIDI device, 
channel, and controller number to each 
fader in each console channel. For more 
information, see Show Selected Fader Info 
(pg. 357) and Show All Fader Info 
(pg. 359). This command is also in the 
Setups menu.

Master Instrument

Use this option to determine how faders 
are assigned in each channel. Specifically:

• Enabled (checked)
If the Master Instrument option is 
enabled (checked), Vision assigns 
both faders in a channel to the same 
Instrument.
This is the default console because, in 
most instances, you’ll use the vertical 
fader to control volume and the hori-
zontal fader to control the same 
Instrument’s pan.
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Figure 37.16: Master Instrument mode 
enabled

For example, look at Figure 37.16. 
Console channels 1-4 control the 
volume and pan of K2000 MIDI chan-
nels 1-4.

• Disabled (unchecked)
If the Master Instrument option is 
disabled (unchecked), Vision lets you 
assign each fader in a channel to a dif-
ferent Instrument.
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Figure 37.17: Master Instrument mode 
disabled

For example, look at Figure 37.17. 
Console channels 1-4 use their 8 
faders to control the volume on 8 
K2000 MIDI channels.

Console Name

Use this command to rename the active 
console. To do so:

a Choose Console Name.

Vision opens a renaming dialog box.

b Type a new name.

c Click the OK button.

Vision renames the console.
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Build Console From

Select the Build Console From com-
mand to produce a submenu of building 
options.

Figure 37.18: Build Console From submenu

Vision gives you the following options, 
each of which automates the console-
building process:

• Selected Tracks’ Instruments
• All Instruments In Use
• MIDI Instruments In Use
• Audio Instruments In Use
• Audio Instruments
• Enabled ReWire Channels

There are, however, several important 
points to consider when you ask Vision to 
build a console for you:

• When Vision builds a console, Vision 
automatically enables Master 
Instruments mode, ensuring that 
the two faders in each channel con-
trol the volume and pan of the same 
Instrument.

• When Vision builds a console, it 
“wipes out” any fader assignments 
you may have already made in that 
console. Should you wish to keep the 
console assignments you’ve already 
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created, open a new console (by 
choosing Windows>Consoles> 
<Console Name>) before using the 
Build Console From command.

The following sections discuss in detail 
each option for building consoles.

Selected Tracks’ Instruments

Choose this option if you want Vision to 
automatically build a console using the 
Instruments in all the selected tracks:

a In the Tracks Window, select those 
tracks you want to use to build a 
console.

b Open a new Console Window and 
choose Build Console 
From>Selected TracksÕ 
Instruments from the Console 
Window Menu.
364
Vision creates a console that contains 
channels assigned to the Instruments in 
the selected tracks.

Notice that the console contains fader 
assignments for the four Instruments 
used by the selected tracks.

NOTE: This option creates console chan-
nels for both MIDI Instruments and Audio 
Instruments.

Build Console From All Instruments In 
Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every Instrument (Audio and MIDI) used 
in every sequence in the entire Vision file. 
It first assigns all the MIDI Instruments to 
console channels. It then assigns all the 
Audio Instruments to console channels.
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Build Console From MIDI Instruments In 
Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every MIDI Instrument used in every 
sequence in the entire Vision file. It 
ignores all Audio Instruments in the 
build.

Build Console From Audio Instruments 
In Use

If you choose this command, Vision cre-
ates one or more consoles containing 
every Audio Instrument used in every 
sequence in the entire Vision file. It 
ignores all MIDI Instruments in the build.

Build Console From Audio Instruments

If you choose this command, Vision auto-
matically builds one or more consoles 
containing all of Vision’s Audio Instru-
ments (whether they’re used in a Vision 
sequence or not).

Build Console From Enabled Rewire 
Channels

If you choose this command, Vision auto-
matically builds one or more consoles 
containing every enabled ReWire chan-
nel. ReWire channels are enabled in the 
Audio Instruments window. For more 
information, see your Audio Reference 
Manual.
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Clear Console

Choose this command to clear all Instru-
ment assignments in the Console 
Window. If one or more audio channels in 
the Console has plug-in, send, or EQ 
assignments, you will see the following 
dialog.

If Clear plug-ins, sends, and EQs as 
well is checked, all plug-in automation 
data will be cleared. EQ and send automa-
tion data will remain, but it won’t have any 
direct effect on the sequence unless EQs 
or sends are reassigned.

Fader values are not cleared.

Save Console Layout

Choose this command to save the infor-
mation in the Console to a template file. A 
“Console Layout Templates” folder is cre-
ated within the Vision folder the first time 
you choose this (or the Save Console 
Layout As...) command. Each Console 
Layout template is stored as a separate 
file within this folder. When you choose 
Save Console Layout, one of these files 
is created in the Console Layout Tem-
plates folder. The name of the file is the 
name of the current Console.
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Choosing this option multiple times 
within the same Console will simply 
update the previously saved file. However, 
if you change the name of the Console 
and then choose Save Console Layout 
again, a new file with the Console’s new 
name will be generated.

The following information is stored in a 
Console Layout template:

• Console name (stored as the name of 
the Console Layout Template file);

• Channel width;
• Enabled display options (“Show” 

options under the Console menu);
• Number of Sends displayed;
• Number of Plug-ins displayed;
• EQ display settings;
• Instrument assignments;
• Remote device assignments;

The following information is not stored in 
a Console Layout template:

• Fader values;
• Plug-in assignments or parameters;
• Send assignments or parameters;
• EQ parameters;
• Output assignments.

This feature is designed so that loading a 
Console Layout will NOT delete your cur-
rent fader values, output assignments, or 
plug-in, send, and EQ settings. Console 
layouts effect only the display of the con-
sole, not the information that is already 
saved elsewhere in the sequence.
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Save Console Layout As...

This option works exactly like Save Con-
sole Layout except that it gives you an 
opportunity to name the file you’re saving. 
After choosing Save Console Layout, 
this dialog box appears.

Type in a name for the Console Layout 
template file here. This will not change 
the name of the current Console. It will 
name the file within the Console Layout 
Templates folder.

Load Console Layout

Use this option to recall a Console Layout 
template you’ve already saved (using the 
Save Console Layout or Save Console 
Layout As... commands). Choosing this 
command will apply the Console Layout’s 
settings to the current Console.
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Select the Layout you want to load and 
press Open. The Layout settings stored 
in the selected Console Layout file are 
applied to the current console.

Again, loading a Console Layout will NOT 
delete your current fader values, output 
assignments, or plug-in, send, and EQ set-
tings. Console layouts effect only the 
display of the console, not the information 
that is already saved elsewhere in the 
sequence.

You may need to navigate (in the Load 
Console Layout dialog box) to the “Con-
sole Layout Templates” folder in your 
Studio Vision folder in order to see your 
available Console Layouts.

IMPORTANT NOTE: A Console Layout 
Template cannot be opened by double-click-
ing its icon. You must use the Load 
Console Layout Template command. 
Double-clicking a Console Layout Template 
will launch Vision, but it will not open (or 
load) the template itself.

FADER GROUPING

You can select multiple faders and move 
them as a group. Fader groupings are 
temporary and disappear once the selec-
tion is disabled.
Vision & Studio Vision Pro — MIDI Reference M
Selecting Multiple Faders

You can select multiple faders using one 
of two methods:

• contiguous selection—all faders in a 
group are physically next to each 
other in the console.

• discontiguous selection—selected 
faders can be anywhere in the con-
sole. They don’t have to be next to 
each other.

To create a contiguous selection:

a Click a fader to select it.

Vision highlights the fader to show itÕs 
selected.

b Shift-click a second fader some 
distance from the first.

Vision selects the second fader and 
every fader in between it and the first.

Figure 37.19: Contiguous Selection

This is a contiguous selection, and is a 
quick way to select a long block of faders 
with only two clicks.

All three faders are selected
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To create a discontiguous selection:

a Click a fader to select it.

Vision highlights the fader to show itÕs 
selected.

b Command-click a second fader some 
distance from the first.

Vision adds the second fader to the 
grouping.

Figure 37.20: Discontiguous Selection

Notice in this example that, unlike 
Figure 37.19, the middle fader isnÕt 
selected.

c Continue to Command-click 
additional faders until youÕve 
completed your grouping.

NOTE: To clear a fader grouping, click in 
any non-active area of the console.

Only these two faders are selected
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Moving Faders as a Group

Once you’ve created a group of faders, 
Vision offers you three different ways in 
which to move them:

• Absolute fading— all grouped 
faders move the same amount up or 
down.

• Proportional fading—all grouped 
faders move proportionally, so that 
they all reach their minimum or maxi-
mum positions simultaneously.

• Snap fading—all grouped faders 
move to a single level.

Each of these methods is discussed in the 
following sections.

Absolute Fading

Drag any one fader and all grouped faders 
move by the same amount. The following 
example illustrates how to perform abso-
lute fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 367).

Figure 37.21: Three grouped faders
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b Drag any fader up or down.

All grouped faders move the same 
amount.

In this example, notice that each fader 
value was reduced by 40.

c Continue dragging until the fader 
Òbottoms out.Ó

In this example, the dragged fader is the 
first to reach Ò0,Ó so no additional 
decrease can occur in the values of the 
other faders.
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If you dragged that same fader up, it 
would be the last to reach 127.

Proportional Fading

Option-drag any one fader and all grouped 
faders move proportionally, so that they 
all reach the bottom (or top) of their fade 
simultaneously. The following example 
illustrates how to perform proportional 
fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 367).

Since youÕre dragging the lowest-valued 
fader in the group, all the other faders 
reach 127 before it does.
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Figure 37.22: Three grouped faders

b Option-drag any fader up or down.

All grouped faders move proportionally.

In this example, notice that the dragged 
fader was reduced by 40, but that the 
other two grouped faders were reduced 
substantially more.

This is because, in proportional fading, 
all the faders move so that they reach 
the bottom (or top) of their fade 
simultaneously.
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c Continue Option-dragging until the 
fader Òbottoms out.Ó

With proportional fading, all faders reach 
their minimum or maximum values 
simultaneously.

Snap Fading

Control-click within any one fader and all 
grouped faders snap to that value. The fol-
lowing example illustrates how to perform 
snap fading with a group of faders:

a Create a group of faders.

This is discussed in Selecting Multiple 
Faders (pg. 367).

Figure 37.23: Three grouped faders
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b Control-click anywhere along a fader 
path.

All grouped faders snap to that value.

Control-click here
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REARRANGING CONSOLE 
STRIPS

Dragging Strips Horizontally

It is now possible to rearrange the order 
console strips by dragging them horizon-
tally. To do this:

a Set up your console.

In this example, console strip 1 will be 
moved. Its volume and pan have been 
set to make it easily recognizable.

b Click and hold on the number at the 
top of the strip youÕd like to move.
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c Drag the mouse to your destination 
(where you want the strip to be in the 
Console).

In this example, strip 1 will be moved 
between strips 3 and 4.

d Release the mouse button.

Strips 2 and 3 are moved to the left and 
strip 1 is inserted between strips 3 and 4.

Notice that the Console strips are always 
numbered from left to right. This does not 
(in any way) change their functionality.
372
Dragging Plug-Ins Vertically 
(Acadia only)

Just as Console strips can be dragged hor-
izontally, VST plug-ins can be dragged 
vertically within a Console strip. This pro-
vides a quick and easy way to change the 
order in which plug-ins affect your audio 
signal. Plug-ins are always applied to the 
audio signal in ascending numerical order 
(1, 2, 3, and then 4).

To vertically drag a plug-in:

a Click and hold in the Plug-In Type 
area of the plug-in you wish to move.
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b Drag to the plug-inÕs desired location.

In this example weÕre moving the third 
plug-in so that it will be first.

c Release the mouse.

The plug-ins are rearranged.

NOTE: It is not possible to drag plug-ins to 
incompatible locations. For example, you 
cannot drag a mono plug-in to occur after a 
stereo plug-in or a mono in/stereo out 
plug-in. For more information about mono 
and stereo plug-ins and audio plug-ins in 
general, see your Audio Reference Manual.

It is not possible to rearrange TDM plug-
ins by dragging.
Vision & Studio Vision Pro — MIDI Reference M
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Use the MMC Window to control devices 
compatible with MIDI Machine Control, 
such as hard disk recorders and digital 
multitracks.

In this chapter you will learn:

• how to set up your MMC devices
• the anatomy of the MMC Window
• how to control an external MMC 

device using Vision

SETTING UP YOUR MMC 
DEVICES

Before you begin using Vision with MMC 
devices, you must:

• Connect your MIDI Machine Con-
trolled hardware to your MIDI 
interface as specified by the manufac-
turer’s documentation.

• Add the MMC device to your OMS 
Studio Setup document—make sure 
it is set to send and receive MIDI 
Time Code and MMC.
IMPORTANT: Also make sure the 
Device ID in OMS Setup matches the 
Device ID of your MMC device.
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Once your MMC devices are connected 
to your MIDI interface and defined in 
your OMS Studio Setup document, you 
can control them from Vision’s MMC 
Window (discussed in the following 
section).

ANATOMY OF THE MMC 
WINDOW

To open the MMC Window:

a In Vision, choose Windows>MMC.

Vision opens the MMC Window.

Figure 38.1: Typical MMC Window

In general, you’ll use the MMC Window 
to control the transport and recording 
functions of an external MMC device 
from within Vision.

A

B

C

D

E
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Figure 38.1 shows the basic elements con-
tained in a typical MMC Window. These 
are:

A Transport Controls
Use these buttons to remotely control 
the start, stop, play, rewind, and fast-
forward controls on your external 
MMC device. For more information, 
see Transport Controls (pg. 376).

B MMC Device Information
Use these various parameters to fur-
ther define your MMC device, to set 
its communication options, and to 
record-enable various tracks. For 
more information, see MMC Device 
Information (pg. 377).

C Preroll Time
Use this numerical to enter the 
amount of preroll time required by 
your external MMC hardware. For 
more information, see PreRoll Time 
(pg. 378).

D Record Mode
Use this pop-up menu to select how 
your MMC device(s) will respond to 
Vision’s MMC recording controls. 
For more information, see Record 
Mode (pg. 379).

E MMC Window Menu
Use this pop-up menu to reset your 
MIDI Machine Control parameters. 
For more informations, see MMC 
Window Menu (pg. 380).

The following sections discuss each of 
these areas in detail.
376
Transport Controls

Use the transport controls to remotely 
control the operation of your MMC 
device.

Figure 38.2: Transport Controls

The MMC device transport controls 
include the buttons described in the fol-
lowing sections.

Stop Button

Click this button to stop the transport on 
your MMC device.

Play Button

Click this button to make your MMC 
device start playing from its current 
location.

NOTE: This works differently than the Play 
button in Vision’s Control Bar, which plays 
from the position shown in the Counter.

Record Button

Click this button to put your MMC device 
into Record mode (if the device is a 
recorder and has a record-enabled track).

Fast Forward button

Rewind button Record button Play button

Stop button
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Fast Forward Button

Click this button to start fast forwarding 
your MMC device.

Rewind Button

Click this button to start rewinding your 
MMC device.

MMC Device Information

This section displays an information line 
for each MMC device you use (as defined 
in your current OMS Studio Setup 
document).

Figure 38.3: MMC Device Information

MMC Device Information includes the 
areas discussed in the following sections.

Device Name

This is the name of your MMC device(s) 
as entered in your OMS Studio Setup doc-
ument. You’ll see a separate entry for 
every MMC device in your studio. This 
example contains two MMC devices, 
named “MMC Device #1” and “MMC 
Device #2.”

Device Name

Device Options

Number of Tracks

Track Enable buttons
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Device Options

Use this pop-up menu to select various 
MMC device options, as shown below:

Figure 38.4: MMC Device Options

The Device Options pop-up has the fol-
lowing three options:

• Test Device: Select this command to 
test communication with your MMC 
device and to check its status.
This command works only if you use 
“Closed Loop communications” (as 
set in the MMC Communications 
Setup, discussed below).

• MMC Communications Setup: 
Select this command to open the 
MMC Communications Setup dialog 
box for an MMC Device.

Figure 38.5: MMC Communications Setup
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The various communication options 
are described within the dialog box, 
itself.
NOTE: If your Studio Setup document 
contains more than one MMC device, 
use the “Suppress MMC Transport 
Commands” option to disable any 
devices that you don’t want to respond 
to MMC messages.

• Reset Debug Logs: Select this com-
mand to save the communications 
test log as a text file.

Number of Tracks

Set this numerical to the number of tracks 
contained in your MMC device. For 
example, if your MMC device is a 16-track 
tape recorder, set this numerical to “16”.

Track Enable Buttons

Click one or more of these buttons to 
record-enable the corresponding track on 
your MMC device.

The number of Track Enable buttons dis-
played for each MMC device is 
determined by the Number of Tracks 
numerical. For example, if you set that 
numerical to “16”, then you would see 16 
Track Enable buttons, as shown in 
Figure 38.6.
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Figure 38.6: MMC Window with a 16-track device 
and an 8-track device

PreRoll Time

Different devices take different amounts 
of time to shuttle back and forth to vari-
ous locations. Use the PreRoll numerical 
to set the amount of time your device 
needs to locate to an edit point.

For example:

• The original Alesis ADAT requires 
5 - 10 seconds to locate to a point on 
the tape. Therefore, you should set a 
PreRoll time of between 5 and 
10 seconds.

• A Tascam DA-88 requires about 
5 seconds to locate to a point on the 
tape, so set a PreRoll time of 
5 seconds.

• Most hard disk recorders (like the 
Akai DR-8) don’t require any PreRoll 
time since they use random access 
playback and recording and don’t 
require fast-forwarding or rewinding 
of tape.
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The PreRoll time works in conjunction 
with Vision’s Begin Record mode. 
Specifically:

• If Vision is in Wait for Note mode, it 
will actually count off for the amount 
of time specified in the PreRoll 
numerical.

• If Vision is in Countoff mode and if 
the PreRoll time exceeds the amount 
of time required by that countoff, 
then your MMC device begins to play 
after the period specified by the Pre-
Roll time.

• If Vision is in Countoff mode and if 
the PreRoll time is less than or equal 
to the amount of time required by 
that countoff, then your MMC device 
begins to play after Vision’s countoff 
is complete.

PreRoll Caveats

Keep the following points in mind when 
using PreRoll:

• In the Sync Options dialog box, you 
must set the Receive Sync mode to 
MTC/Machine Control in order for 
the PreRoll time to have any affect. 
Also, you must select your MMC 
device from the Receive Sync 
selector.

• If your MMC device uses tape, make 
sure to create about a minute of blank 
leader so that your first song has 
enough PreRoll time ahead of it.
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Record Mode

Use this pop-up menu to select the 
desired MMC record mode.

Figure 38.7: Record Modes

As you can see in Figure 38.7, there are 
three different record modes. These are:

Enabled

Select this option to completely slave the 
record operations of your machine to 
Vision. In this mode:

• your MMC device completely locks 
to all of Vision’s transport controls—
fast forward, rewind, stop, play, and 
record.

• your MMC device records on any 
record-enabled tracks. If you use 
punch points, your MMC device will 
begin recording at the punch-in point 
and stop recording at the punch-out 
point.
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Rehearse

This mode works very similarly to 
Enabled, except that the Record button 
never actually engages at the record 
points.

This lets you rehearse what you want to 
record before actually recording it. In this 
mode:

• your MMC device locks to Vision’s 
fast forward, rewind, stop, and play 
transport controls.

• your MMC device will not automati-
cally record on any record-enabled 
tracks. If you use punch points, your 
MMC device will shuttle between 
them as in Enabled mode, but will 
not actually engage the Record but-
ton. This lets you rehearse your audio 
overdub without actually recording it.

Safe

Recording is completely disabled in this 
mode. Specifically, clicking a Track 
Enable button in the MMC Window will 
not put your MMC device into record 
mode.
380
MMC Window Menu

To open the MMC Window Menu:

a Press and hold the mouse on the little 
down-pointing arrow to the left of the 
MMC WindowÕs Title Bar.

Figure 38.8: MMC Window Menu

The MMC Window Menu contains only 
one command:

• Reset MMC System: Choose this 
command to reset all MMC device 
parameters to their default condi-
tions, clearing any existing time code 
messages (which are constantly 
being sent by VITC devices).
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REAL-WORLD EXAMPLE—
TASCAM DA-88

This section provides a step-by-step tuto-
rial for controlling a Tascam DA-88 from 
Vision.

NOTE: Although this discussion is specific 
to the DA-88, anyone wishing to use MMC 
should read through this tutorial and use 
similar techniques with their own 
hardware.

First, set up your DA-88:

a Set dip switch #2 (located on the left 
side of the DA-88 SY-88 expansion 
board) to the UP position.

b Set dip switch #6 to the down 
position.

The DA-88 needs to be in ÒTimecode 
controlled mode,Ó and its timecode out 
must be set to ÒAbsolute.Ó

c Check the DA-88Õs Device ID number 
(see your DA-88 manual). Its default 
value is Ò1,Ó which is the value used 
in this example.

d After setting the dip switches and the 
Device ID, turn your DA-88 off, then 
back on again.

e Connect the DA-88Õs MIDI In and MIDI 
Out ports to your MIDI Interface.

Next, tell OMS Setup about the DA-88:

a Launch OMS Setup and open your 
current OMS Studio Setup document.
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b Create a new device in your OMS 
Studio Setup document for the DA-88, 
and connect it to your MIDI interface.

See your OMS Manual if you need 
assistance.

Your DA-88 MIDI Device Info dialog box 
should look like the one shown in 
Figure 38.9.

Figure 38.9: Typical Device Info for DA-88

The device defined as the DA-88 in OMS 
should be set to an ID of Ò0,Ó which is 
one less than the actual unit (unfortu-
nately, the ID numbering scheme on the 
DA-88 is off by one).

Figure 38.10: Also, make sure to set the 
device to receive and send both MIDI 
Time Code and MIDI Machine 
Control.

Type name here

Enter Device ID here.
The DA-88Õs default
Device ID = 1

Disable all MIDI channels
since you donÕt want to be
able to send any MIDI note
data to the DA-88

Check these Sync Boxes
as indicated here
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c Save your Studio Setup document, 
and make it current.

The concept of a current Studio Setup 
document is discussed in your OMS 
Manual.

Then, set up Vision to work with the 
DA-88:

a Launch Vision.

b If youÕre creating a new sequence, set 
its length to 999.

c Choose Options>Sync Options.

Vision opens the Sync Options dialog 
box.

d Set the Receive Sync Mode to 
ÒMTC/Machine ControlÓ and the 
Receive Sync Device to ÒTascam 
DA-88Ó (or whatever you name your 
MMC device).

This lets VisionÕs transport controls oper-
ate your DA-88.

e Select the desired SMPTE format, 
then click OK to close the Sync 
Options dialog box.

The DA-88Õs default SMPTE format is 
Ò30 fps, non-drop.Ó

f Choose Windows>MMC.

Vision opens the MMC Window.

g From the Device Options pop-up 
menu, select MMC 
Communications Setup.

h Click the Use Open Loop 
communications radio button, then 
click OK.

i Leave the PreRoll numerical set to 
5 seconds.
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j To test communication, press the 
Play button in the MMC Window and 
see if the DA-88 responds.

If not, check your Device ID settings and 
cables.

k At the top of the Tracks Window, click 
the Information Toggle (the little ÒiÓ).

The Tracks Window now displays 
SMPTE offset information at the top of 
the window.

l Set the SMPTE offset to match the 
DA-88Õs.

See your DA-88 manual to see how to 
view and set its SMPTE offset.

m In Vision, press the Play button.

The DA-88 will locate to the PreRoll or 
countoff timeÑas discussed in PreRoll 
Time (pg. 378)Ñand start to play. At the 
same time, Vision will lock to MTC 
coming from the DA-88.

n In Vision, press the Stop button.

This stops both Vision and the DA-88.

Finally, use Vision to control DA-88 
recording:

a In Vision, set a punch-in and 
punch-out point.

In this example, we set a punch-in at 
4 bars and a punch-out at 8 bars.

b Choose Windows>MMC and set the 
Record Mode to Rehearse.

c In the MMC Window, click a Record 
Enable button for any track.

In this example, we record-enabled 
track 1.

Note that the DA-88Õs record indicator 
light blinks for track 1.
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d In VisionÕs Control Bar, set the Begin 
Record Mode to Countoff with a 
countoff time of 3 measures.

This is completely arbitrary. You can use 
any value you desire.

e Press the Tab key.

The DA-88 locates to the PreRoll time or 
countoff number and starts to play.

Vision counts down and starts to play. 
When it reaches the punch-in point, its 
record button turns solid, but the DA-88Õs 
record enable light continues to blink. 
This is because the MMC WindowÕs 
Record Mode is set to ÒRehearse.Ó

f In Vision, press the Stop button.

g In the MMC Window, change the 
record mode to Enabled.

h Press the Tab key.

When Vision reaches the punch-in point, 
the DA-88Õs record indicator turns solid 
and stays solid until the punch-out point 
is reached. This indicates that the DA-88 
is recording between the punch-in and 
punch-out points.
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Use the QuickTime Movie Window to 
open and play QuickTime movies. You 
can even import the audio and MIDI from 
the movie into your Vision tracks, edit the 
imported tracks and add others—once 
you’re done scoring the movie, export the 
tracks back into the QuickTime movie.

REFERENCING A QUICKTIME 
MOVIE

Each Vision file can reference its own 
QuickTime movie. To establish this 
reference:

a Choose File>Open.

A standard Open dialog box appears.

Figure 39.1: Standard Open Dialog Box
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b Navigate to the folder containing the 
desired movie, select the movie, and 
click Open.

What happens next depends on what 
type of data is contained in the Quick-
Time movie. Specifically:

1) If the movie contains only video (no 
audio or MIDI), then Vision automatically 
opens the movie in the QuickTime Movie 
Window. Go to step h.

2) If the movie contains only audio and/
or MIDI (no video), then Vision imports 
the MIDI and/or audio into a new 
sequence. This procedure is discussed 
thoroughly in the Audio Reference 
Manual.

3) If the movie contains BOTH Video 
AND audio (and/or MIDI), youÕll see an 
alert box asking you what, exactly, to 
open.

Figure 39.2: Import/View Alert Box

Import causes Vision to import the 
movieÕs audio and/or MIDI tracks into 
Vision tracks, but does not establish a 
reference to the movie, nor does it open 
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the QuickTime Movie Window. This 
allows you to further edit and refine the 
movieÕs soundtrack.

View causes Vision to open the movie in 
the QuickTime Movie Window. The 
movieÕs audio and/or MIDI will play back 
using the standard QuickTime elements 
contained in the QuickTime Movie 
Window.

Import & View causes Vision to import 
audio and/or MIDI as described above, 
plus it opens the movie into the Quick-
Time Movie Window.

c If you saw an Import/View alert box, 
click either Import & View or View.

If you clicked View, go to step h.

If you clicked Import & View, Vision 
opens a Save As dialog box.

REASON: When you import audio from a 
QuickTime movie, you might want to 
save it in some format other than what 
was stored with the movie. For example, 
the QuickTime audio might be an 8-bit 
AIFF file, but you need to work with 
16-bit SDII files in your sequence.
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d Look at the bottom of the dialog box 
to see what format Vision will use to 
save the imported audio.

e If you want to change the format, click 
the Format button.

Vision opens a subset of the standard 
Audio Format dialog box.

Figure 39.3: Audio Format Dialog Box for 
Imported QuickTime Audio

f Define the type of audio file you want 
to work with, then click OK.

Consult your Audio Reference Manual 
for a detailed description of the Audio 
Format options.

g Click Save.

Vision imports the audio from the Quick-
Time movie, saves it to your hard disk in 
the selected audio format, and creates a 
new audio event in your sequence.

h Vision opens the selected QuickTime 
movie in its QuickTime Movie Window 
and establishes a reference to that 
movie.
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Once you’ve established a reference to a 
QuickTime movie, Vision remembers that 
reference. Whenever you open that Vision 
file, you need only choose Win-
dows>QuickTime movie to view the 
movie.

NOTE: If you move a referenced movie to a 
different folder, Vision is smart enough to 
find it. However, Vision will lose the refer-
ence if you move the movie to a different 
volume.

To change the QuickTime movie that 
Vision references, use the Open com-
mand to open a different QuickTime 
movie.

NOTE: Importing Audio and MIDI from a 
QuickTime movie is discussed further in 
the Audio Reference Manual.

OPENING THE QUICKTIME 
MOVIE WINDOW

You can open a QuickTime Movie 
Window for any Vision file that references 
a QuickTime movie. To do so:

a Choose Windows>QuickTime 
Movie.

A QuickTime Movie Window opens simi-
lar to the one shown in Figure 39.4.

NOTE: If the Windows>QuickTime 
Movie command is disabled, it’s because 
your Vision file does not yet reference a 
QuickTime movie. To establish a reference, 
see Referencing a QuickTime Movie 
(pg. 385).
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QUICKTIME MOVIE WINDOW 
ANATOMY

Figure 39.4: Typical QuickTime Movie Window with 
SMPTE times displayed

As seen in Figure 39.4, the basic Quick-
Time Movie Window contains the 
following elements:

A QuickTime Movie Title: This is the 
name of the QuickTime movie file.

B QuickTime Movie Window Menu: 
This menu contains numerous 
options to control the window’s opera-
tion and its integration with Vision. 
For more information, see QuickTime 
Movie Window Menu (pg. 389).

C Movie Screen: This is the movie 
playback area.

AB

C D

E

F
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D Standard Movie Controller: This is 
a standard QuickTime movie 
controller.

E SMPTE Offset: This field displays 
the movie’s SMPTE start time. For 
example, if you set the Offset to 
01:05:10:00, then the movie won’t 
start playing until Vision’s counter 
reaches a SMPTE time of 1 hour: 5 
minutes: 10 seconds: and 0 frames.

Play/Pause

Slider Play bar

Step Forward 1-frame

Step Backward 1-frame

Volume Control
button (if needed)

button

button

button
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F SMPTE Counter: This area displays 
the movie’s absolute SMPTE time 
(defined below). When the movie is 
playing, it shows a running SMPTE 
time stream. When the movie is 
stopped, it shows the current cursor 
location.

The SMPTE counter always shows 
absolute SMPTE time, which 
includes the SMPTE offset. For 
example:
IF the offset is set to 01:00:00:00,
AND the movie plays for five 
seconds,
THEN the SMPTE counter shows 
01:00:00:05.

Figure 39.5: Counter Shows Absolute SMPTE

Hours

Minutes

Seconds

Frames

Offset time + Actual time = Absolute SMPTE time
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QUICKTIME MOVIE WINDOW 
MENU

Figure 39.6: QuickTime Movie Window Menu

The following sections discuss the com-
mands included in the QuickTime Movie 
Window menu.

Lock to Timing

Selecting this option repeatedly will 
toggle it between checked and 
unchecked.

• Checked (enabled): The movie plays 
back in sync with Vision. When Lock 
to Timing is enabled, Vision trans-
port controls are used to start, stop, 
locate, or scrub the QuickTime 
movie.
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• Unchecked (disabled): The movie 
does not respond to Vision’s transport 
controls, but you can still use the 
QuickTime Movie Window’s controls 
to start, stop, fast forward, and rewind 
through the movie.

Mute QuickTime Audio

Selecting this option repeatedly will 
toggle it between checked and 
unchecked.

• Checked (enabled): The audio play-
back from within the QuickTime 
Movie Window is muted.
This option is checked by default 
because QuickTime and a Vision 
sequence might “compete” for the 
rights to play a movie’s sound.
In general, when you open a Quick-
Time movie, you should import the 
audio into Vision, check the Mute 
QuickTime Audio option, and use 
Vision to play back the movie’s audio.

• Unchecked (disabled): The movie’s 
audio can play back from the Quick-
Time Movie Window. This is the best 
option only if your movie’s 
soundtrack has not been imported 
into a Vision sequence.
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Show SMPTE Offset

Selecting this option repeatedly will 
toggle it between checked and 
unchecked.

• Checked (enabled): Displays a 
numerical with which you can see or 
set the movie’s SMPTE offset (start 
time).

• Unchecked (disabled): Hides the 
SMPTE offset display.

Figure 39.7: Showing/Hiding SMPTE Offset
390
Show SMPTE Counter

Selecting this option repeatedly will 
toggle it between checked and 
unchecked.

• Checked (enabled): Displays a 
SMPTE counter at the bottom of the 
QuickTime Movie Window.

• Unchecked (disabled): Hides the 
SMPTE counter.

Figure 39.8: Showing/Hiding SMPTE Counter
Opcode Systems, Inc.



CHAPTER 40: The QuickTime Movie Window
Window Size

Select any of these options to scale the 
movie’s size by the indicated amount.

Figure 39.9: Window Size Options

The window can never shrink so much 
that you can’t view your SMPTE times. 
For example:

IF your movie shows either the 
SMPTE Offset or the SMPTE 
Counter
AND your movie is smaller than the 
width of either of the time fields
THEN Vision shrinks the movie to 
the selected size, but leaves the 
window size large enough to display 
the SMPTE times.

The movie is quarter size, but the 
window shrunk only enough to still 
display the SMPTE times.
Vision & Studio Vision Pro — MIDI Reference M
SETTING SMPTE FRAME RATES 
FOR MULTIMEDIA MOVIES

If you’re scoring for multimedia, your 
QuickTime movies will probably have a 
slower frame rate than any of the standard 
SMPTE frame rates.

Opcode recommends that, if possible, you 
set Vision’s SMPTE frame rate to a whole 
number multiple of your QuickTime 
movie’s frame rate.

NOTE: Set SMPTE frame rates in the new 
Sync Options dialog box, as described in 
Sync Options (pg. 433).

For example:

• If your QuickTime movie plays at 
10 fps, set Vision to 30 fps (10 fps x 3 
= 30 fps).

• If your QuickTime movie plays at 
12 fps, set Vision to 24 fps (12 fps x 2 
= 24 fps).

• If your QuickTime movie plays at 
6 fps, set Vision to either 24 fps (6 fps 
x 4) or 30 fps (6 fps x 5).

This practice will result in a linear correla-
tion between the SMPTE frame rate and 
the QuickTime frame rate. For example, if 
Vision is set to count at 30 fps and your 
QuickTime movie plays at 10 fps, then the 
movie advances 1 frame for every 
3 frames of SMPTE time (see 
Figure 39.10).
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Figure 39.10: SMPTE vs. QuickTime frame rates

Counters advance 
1 frame...

but movie frame 
does not advance.

Counters advance 
1 more frame...

but movie frame still 
does not advance.

Counters advance 
1 more frame...

and movie advances 
(because youÕve 
counted off 3 SMPTE 
frames).

Starting Point.
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WORKING WITH SMPTE 
OFFSETS

If you’re using Vision to control the 
movie’s playback (that is, Lock to 
Timing is checked), keep in mind that 
Vision sequences can have their own 
SMPTE offsets, which may or may not be 
the same as the movie’s SMPTE offset.

Specifically:

• if movie offset = sequence offset
When you click Vision’s Play button, 
both the sequence and the movie 
start playing simultaneously, from 
their beginnings.

• if movie offset > sequence offset
When you click Vision’s Play button, 
the sequence begins to play, but the 
movie does not. When Vision reaches 
the time specified by the movie’s off-
set, the movie begins to play.

Sequence Offset (in Tracks Window)

Movie Offset (in QuickTime Movie Window)
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• if movie offset < sequence offset
When you click Vision’s Play button, 
the sequence begins to play and the 
movie begins playing from the 
sequence’s offset point.

USING THE MOVIE PLAYER 
WINDOW

The following tutorial details one of many 
ways to score a QuickTime video using 
Vision.

a Choose File>Open.

A standard Open dialog box appears.

b Use the dialog box to select a 
QuickTime movie to open, then click 
Open.

If the movie contains both video and 
audio, select either View or Import & 
View from the subsequent dialog box 
depending on your needs.

Vision opens the selected QuickTime 
movie in its QuickTime Movie Window.

c Choose Options>Sync Options.

Vision opens the Sync Options dialog 
box.

d Set the SMPTE Format pop-up to a 
whole number multiple of your 
movieÕs frame rate.

If you donÕt know your movieÕs frame 
rate, there are numerous applications 
(such as Adobe Premiereª) that provide 
that information.

e Click OK.

f In the menu for the QuickTime Movie 
Window, check the options for Lock 
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to Timing, Show SMPTE Offset 
and Show SMPTE Counter.

g In the QuickTime Movie WindowÕs 
Offset field, set the SMPTE start time 
of the movie, if necessary.

h Use VisionÕs scrub control to shuttle 
through the movie.

i Each time you spot a point where you 
want to create a musical cue, choose 
Do>Insert SMPTE Marker.

Vision opens the Meter Track Window 
and inserts a SMPTE marker at the 
selected time.

j Name each marker.

k From the Meter Track Window Menu, 
select Absolute SMPTE.
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Vision now displays Absolute SMPTE 
times in the Meter Track Window.

The Meter List Window basically acts as 
your Edit Decision List (EDL).

l Jump to any point in the movie by 
selecting an Edit Point from the 
Control BarÕs Marker pop-up.

Using Vision to create the EDL and to 
control the movieÕs playback, you can 
now go about the business of creating a 
musical score.

Use a General MIDI Module for 
MIDI Scoring

IMPORTANT: When you compose a MIDI 
score that you plan to export as a Quick-
Time movie, Opcode recommends that you 
always score the movie using a General 
MIDI Module rather than Apple’s Quick-
Time Musical Instruments extension.
394
QuickTime Musical Instruments has a 
built-in delay that, if used for creating a 
movie, could cause synchronization prob-
lems when exported.

So...

IF you use a General MIDI module to 
create a score
AND you export the MIDI data as a 
QuickTime movie
THEN end-users will be able to play-
back your movie using either 
QuickTime Musical Instruments or 
their own General MIDI Module—
the soundtrack will be in sync with 
the video.
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Figure 40.1: File menu
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NEW

New closes the current project (you are 
first prompted to save any changes) and 
opens a new Sequences Window with one 
empty sequence. This is similar to quit-
ting Vision then immediately re-launching 
it—a new file appears that has all of your 
default settings.

If you have a file called “Vision Setup” in 
the same folder that the Vision application 
is in, all setup objects (including Instru-
ments, Input Maps, MIDIKeys, and Fader 
and Console information) are read in from 
that file.

If you do not have a file called “Vision 
Setup” in the same folder as Vision, the 
Instruments are made from your current 
Studio Setup. See Vision Setup (pg. 157) 
for more information.

New does not affect the contents of the 
Clipboard. Its contents are preserved, 
enabling you to copy and paste between 
different Vision files.
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OPEN (COMMAND-O)

Choose File>Open to open an existing 
Vision file, or to import a MIDI file into a 
new sequence. The Vision Open dialog 
appears:

Figure 40.2: Open dialog

When you have located and selected the 
file you wish to open, click Open to open 
the file. 
398
What to Open

Click What to Open to specify which 
items are opened with the selected Vision 
file.

Figure 40.3: What to Open dialog

This dialog contains all the file objects 
that you can choose to open. Click the 
checkbox next to each object you wish to 
open, then click OK to return to the 
Vision Open dialog box. Generally, you 
will want to open everything in a file. The 
default setting has all items checked.
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Use Setup Instruments

Sometimes a Vision file contains Instru-
ments that are not the same as the ones in 
your current Vision Setup document. The 
Use Setup Instruments option allows 
you to determine what happens when you 
open such a file:

• If Use Setup Instruments is 
unchecked, the Instruments in the 
file that you are opening are used.
If other Instruments are currently in 
use by the metronome, faders and 
consoles, Input Map, etc., then Vision 
also adds those Instruments if they 
aren’t already present in the file being 
opened.

• If Use Setup Instruments is 
checked, Instruments contained in 
the opened file that differ from the 
Setup Instruments are added. This 
option gives you a more consistent 
set of Instruments from one file to the 
next, so that the same command key 
selects the same Instrument.

The file plays exactly the same regardless 
of the condition of this checkbox. This 
option only determines the number of 
Instruments used and their order.
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Possible Warnings

There are two situations that could inter-
rupt an Open operation:

• When opening a file that contains 
patch names that conflict with the 
current Name Manager subscrip-
tions, you are asked to resolve the 
conflict before the file can be opened. 
See Opening Files With Different 
Name Setups (pg. 323) for a descrip-
tion of this process.

• If the file refers to devices that aren’t 
defined in the current Studio Setup, 
the Remap Undefined Channels 
dialog appears. See Undefined Chan-
nels (pg. 431) for more information.

About MIDI Files

There are two types of MIDI files: single 
track (Type 0) and multitrack (Type 1). 
Both can be imported with Vision’s Open 
command.

Single-track (type 0) MIDI files, when 
opened, are unmerged so that each chan-
nel is assigned to a separate Vision track.

When importing a MIDI file, if a track 
doesn’t contain the name of a defined 
device, Vision creates a device called 
“MIDI File.” You can then remap this 
device so that future MIDI files automati-
cally associate themselves with the right 
devices. For more information on remap-
ping, see page 431.
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CLOSE WINDOW 
(COMMAND-W)

This command closes the active window.

If the active window is the Sequences 
Window, the current Vision file is closed. 
You will be asked to save changes before 
closing. You can choose to save or discard 
changes, or cancel the close.

You cannot close the Control Bar.

CLOSE ALL 
(COMMAND-OPTION-W)

Choose this command to close all win-
dows in Vision except the Sequences 
Window.

SAVE (COMMAND-S)

This command saves the current file to 
disk. If the Sequences Window is untitled, 
you will be asked to name the file and find 
a location for saving it.

Figure 40.4: Save Dialog
400
Once you have named your file, the 
Vision Save dialog no longer appears 
when choosing File>Save—your file 
simply overwrites the previous version.

If you are saving for the first time, you can 
choose the file objects that you wish to 
save:

Figure 40.5: What to Save Dialog

You must save sequences and Instru-
ments (that’s why their checkboxes are 
grayed out— you don’t have the option of 
unchecking them), but you may also save 
other items that differ from your Vision 
Setup file.

SAVE AS

Choosing File>Save As opens the Save 
dialog box (see Figure 40.4 on page 400). 
Use this command to save your file under 
another name, and keep an older version 
of your file untouched.
Opcode Systems, Inc.



CHAPTER 41: The File Menu
After finishing a Save As command, the 
current file has the name with which it 
was just saved. The original file is still in 
its original location. This is good for creat-
ing successive versions of the same 
project.

You can also see the current file objects 
by choosing this item.

SAVE A COPY AS

This command is very similar to Save As, 
but it lets you save any combination of file 
objects to any file at any time, without 
changing the current file. When you 
choose File>Save a Copy As, you are 
not required to save Sequences and 
Instruments, as you must do with normal 
Save operations.

However, if you use it to save either 
sequences, an Input Map, or fader assign-
ments, then you are strongly encouraged 
to save Instruments as well—sequences, 
Input Maps and fader assignments refer 
to Instruments by number.

Save a Copy As leaves the current file 
completely unchanged, enabling the cre-
ation of backup copies to other disks 
without returning to the Finder.
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SAVE AS SETUP

When you choose this command, Vision 
saves the following file objects in a file 
called “Vision Setup” to the same folder as 
the Vision application:

• Instruments
• Input Maps
• MIDIKeys
• Commands
• Fader and console assignments
• Fader and console values

If Vision Setup doesn’t exist, Vision cre-
ates it when you invoke this command. If 
it already exists, Vision updates it by 
saving the current state of the file objects.

If you would like to update only certain 
file objects in the Vision Setup file:

a Choose File>Open.

b Select the Vision Setup file.

c Click What to Open.

The What to Open dialog opens.

d Uncheck the file object(s) you wish to 
keep unchanged in Vision Setup. 

e Click OK to close the What to Open 
dialog.

f Click Open to open the Vision Setup 
file.

g Choose File>Save as Setup.
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REVERT

This command discards any changes you 
have made since the last Save operation. 
When you invoke this command, Vision 
re-reads the file from disk.

Figure 40.6: Before Reverting to a file, make sure 
you have saved a version you like.

If the Names Window is open when you 
choose Revert, the names are reverted 
and the sequences remain untouched.

Caution: Reverting a file causes all changes 
in the current document since the last Save 
operation to be lost.
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EXPORT AS MIDI FILE 
(OPTION-X)

Select a sequence before choosing 
Export. The Export dialog box is similar 
to the Save dialog box:

Figure 40.7: Export Dialog

Decide if you want to create a Type 0 
MIDI file (single track) or Type 1 (multi-
track). If you leave the Multitrack option 
unchecked, the sequence is written to a 
single track MIDI file. Loops are 
unlooped and played as if you had 
recorded it in real time.

If you check the Multitrack checkbox, 
each track remains separate. Loops are 
also expanded in this format.
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EXPORT TO CLIPBOARD

This command translates the current 
selection into standard MIDI data 
(Type 1—multitrack), and places it on the 
Clipboard. This is useful for transferring 
data between applications without saving 
and importing new files. If both applica-
tions are open, you can use this command 
to easily transfer data between them.

This command is slightly different from 
Edit>Copy (see page 407). Copying data 
places the information on the Clipboard in 
Vision’s native format, which cannot be 
understood by other MIDI applications. 
Using File>Export to Clipboard trans-
lates the data into a format (Type 1—
multitrack) that other applications 
can understand.

If the current selection contains loops or 
sequence events, they are expanded 
before being exported. Multiple tracks 
that have the same Instrument assign-
ments are not merged together into a 
single track, as Edit>Capture 
Seq->Track (see page 414) does.

The data from Export to Clipboard is also 
available on Vision’s Clipboard and can be 
pasted into sequences and tracks. This 
command is useful for preparing 
sequences to be notated.
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EXPORT AS QUICKTIME MOVIE

Choose this command to export selected 
MIDI or audio as a QuickTime movie. 
Consult the Audio Reference Manual for 
details.

IMPORT AUDIO (OPTION-H)

Choose this command to import audio 
into the selected track. Consult the Audio 
Reference Manual for details.

IMPORT AUDIO USING 
QUICKTIME

This command imports audio or MIDI 
from QuickTime movies, and audio from 
standard audio CDs. In addition, this com-
mand can be used to import various 
industry-standard audio formats that are 
not native to Vision (such as .AU 
and .wav). Consult the Audio Reference 
Manual for details.

EXPORT AUDIO MIX

Use this command to create stand-alone 
audio files for multimedia or web applica-
tions. Consult the Audio Reference 
Manual for details.
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EXPORT AUDIO EVENTS

Use this command to export each 
selected audio event into its own audio 
file. This is particularly useful for creating 
sounds or loops for triggering with a sam-
pler. Consult the Audio Reference Manual 
for details.

PAGE SETUP

Choosing File>Page Setup opens the 
standard Page Setup dialog box for your 
printer. Whenever you change printers, 
you should choose this menu item. This 
dialog box allows you to make printer-spe-
cific decisions about how your document 
will look. See your printer documentation 
for more information.

PRINT PREVIEW

Choosing Print Preview opens the Print 
Preview Window, where you can view 
your music as it appears on the printed 
page, and make some adjustments. A 
Notation Window must be active for this 
item to be available. 

See The Print Preview Window (pg. 285) 
for more information.
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PRINT (COMMAND-P)

When you choose this menu item, Vision 
prints your music as it appears in the Print 
Preview Window. A Print Preview or 
Notation Window must be active for this 
item to be available. 

QUIT (COMMAND-Q)

When you choose File>Quit and you 
haven’t saved your most recent changes, 
Vision presents a message box requesting 
you to either:

• Save and quit;
• Discard changes since your last save;
• Cancel the Quit command and con-

tinue working. 

Vision closes if either of the first two 
options are chosen.
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Figure 41.1: Edit menu
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UNDO (COMMAND-Z)

This command reverses the effect of the 
last command. The name of the Undo 
command changes depending on the 
action (e.g., Undo Clear, Undo Record, 
Undo Make Segment, etc.).

NOTE: Most, but not all, commands can be 
undone.

After you choose this command, it 
becomes Redo, allowing you to quickly 
audition the effect of any change or edit.

Generally, you can undo all changes to 
sequences, tracks, events, or text. You 
cannot undo the following actions:

• Save commands
• Copy commands
• changes to Instruments
• changes to Names
• changes to MIDIKeys
• changes to the Input Map
anual 405



PART 7: Menus
You cannot undo the Copy command. 
This has the distinct advantage of allow-
ing you to change a track then, if you like 
both the old and new versions, you can 
retain them both. To do so:

a Make a change to part of a sequence.

b Copy the new version.

Vision places a copy on the Clipboard.

c Choose Undo.

Vision reverts to the old version.

d Select a new location and choose 
Edit>Paste.

Since the new version is still on the 
Clipboard, Vision pastes it into the 
new location. Vision now contains 
both the old and new versions of the 
track.

Undo and Recording

It is important to understand how editing 
during recording affects the Undo com-
mand. After editing during recording, 
choosing File>Undo restores the file to 
the state it was in prior to the last edit.

Clicking the Stop button and choosing 
Undo undoes the entire recording, negat-
ing all edits made while recording.

If you are in replace mode, any edits made 
may be lost when recording stops and the 
recording replaces the track’s previous 
contents, including the edits.
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CUT (COMMAND-X)

This command removes the selected 
items from the active window and places 
them on the Clipboard.

Vision recognizes any MIDI events you 
cut as a sequence—this ensures that you 
can cut and paste between different types 
of windows. The name of this menu item 
changes depending upon which window 
is active and what you have selected (e.g., 
Cut Track, Cut Selection, Cut Instrument, 
etc.).

Cutting does not affect the length of a 
track or sequence. When the selected 
events are removed, the information 
around them does not change. To erase 
the time as well as the data, use 
Delete Selected Time (see page 412).

Figure 41.2: Cutting MIDI data leaves a space 
where the data was

Before Cut

After Cut
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COPY (COMMAND-C)

This command places the selected items 
on the Clipboard without changing the 
source MIDI data. The selected items 
remain unchanged.

Vision will recognize any MIDI events 
you copy as a sequence—this ensures 
that you can cut and paste between differ-
ent types of windows. The name of this 
menu item changes depending upon 
which window is active and what you have 
selected (e.g., Copy Track, Copy Selec-
tion, Copy Instrument, etc.).

Copy Faders

When the Faders Window or a Console 
Window is active, this command is Copy 
Faders, which will copy all the assigned 
fader parameters and values, mute and 
solo status, and other automation parame-
ter values (for audio instruments). You 
can take a “snapshot” of these fader val-
ues, then paste them into a single track. 
When Vision plays these fader events, the 
faders will be reset to their copied values.

For more information about Copy Faders 
and Audio instruments, Busses, Inputs, 
and Outputs, see your Audio Reference 
Manual.
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PASTE (COMMAND-V)

This command places a copy of the Clip-
board data into the active window. The 
name of this menu item changes depend-
ing upon the type of information 
contained in the Clipboard, which window 
is active, and what you have selected 
(e.g., Paste Track, Paste Instrument, 
Paste Sequence Event, etc.).

When pasting certain types of informa-
tion, you must make a selection first. For 
example, if you want to paste an Instru-
ment, you must select an Instrument (in 
the Instruments Window) before you can 
paste. The contents of the Clipboard will 
overwrite the current selection.

Vision will automatically number items 
that contain the same name. For example, 
if you have copied a track called “Bass” 
from the Tracks Window and paste it in 
the same window (or any Tracks Window 
with an identical name), the new track will 
be renamed “Bass #2.”

Pasting in the Sequences Window

When you paste a sequence in the 
Sequences Window, a new sequence will 
be added after the last one, unless you 
have already selected one or more 
sequences. If you would like to replace 
anual 407



PART 7: Menus
one or more sequences with the contents 
of the Clipboard, select the sequences 
and choose Paste.

If you want to paste the sequence into a 
new sequence location, be sure to de-
select all sequences in the active 
Sequences Window. You can easily do 
this by clicking in the selection column 
header, or click after the last sequence in 
the list.

Working with Multiple Sequences

If the Clipboard contains a different 
number of sequences than you have 
selected in the Sequences Window, 
Vision will confirm that you wish to 
replace the current selection with the con-
tents of the Clipboard.

For example, if you copied three 
sequences and then pasted them into one 
sequence, you would see the following 
alert:

You can also paste sequences into the 
Track Overview or List Window to create 
sequence events. See Sequence Events 
(pg. 96) for more information.
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Pasting in the Tracks Window

If you are pasting entire tracks in the 
Tracks Window (i.e. you’ve clicked on 
one or more track selector dots), all the 
tracks you’ve selected will be replaced by 
all the tracks on the Clipboard, regardless 
of their number. Tracks are inserted and 
deleted as necessary.

If you are pasting into an edit window 
(including the Track Overview) or doing a 
Merge Paste, track counting works differ-
ently. In these cases, if the Clipboard 
contains more tracks than you have 
selected, it will paste only the first Clip-
board tracks to the selected tracks. For 
example, if there are three tracks on the 
Clipboard and two tracks selected, only 
the first two tracks will be pasted.

Pasting MIDI Data

When pasting MIDI events into an edit 
window, the Clipboard will be placed at 
the Edit In point. If there are any events 
already present, they are replaced. If you 
don’t want this, use Merge or Insert 
Clipboard (explained later in this chap-
ter) instead.

CLEAR (COMMAND-B)

Clear is similar to Cut, but does not save 
the selection to the Clipboard. Clearing 
MIDI events does not affect the length of 
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a track or sequence. When the selected 
events are removed, the information 
around them does not change.

You can clear many types of data, and the 
name of the menu item will change 
depending upon which window is active 
and what you have selected (e.g., Clear 
Selection, Clear Sequence, Clear Instru-
ment, etc.).

MERGE (COMMAND-M)

This command merges the contents of 
the Clipboard with that of the destination 
track (at the Edit In point). It doesn’t 
change any data that is already in the 
track.

Merge is different than Paste because 
the previous track contents are 
not replaced.

Instrument Reassignment

When the Clipboard contains only one 
track with only one Instrument and you 
merge it into a track with a different 
Instrument, all of the merged data will use 
the Instrument of the destination track. It 
will not make a multi-track (containing 
several Instrument channels). To make a 
multi-track, paste to an empty track and 
then combine the tracks with the Com-
bine Tracks command.
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Merge Markers As Text

When you cut or copy a Meter track to 
the Clipboard and select a normal track, 
the Merge command becomes the Merge 
Markers As Text command. The only 
information in a Meter track that is com-
patible with a normal track are the 
markers. Choosing this command merges 
the marker events into the destination 
track as text events.

INSERT CLIPBOARD 
(COMMAND-N)

This command pastes the contents of the 
Clipboard at the Edit In point of the 
selected track. Any MIDI events that are 
already present will be shifted later in 
time to make room for the Clipboard data. 
This command changes the track length, 
because it retains all the previous infor-
mation and adds the length of the 
Clipboard.

Insert Clipboard is different than Paste 
because the previous track contents are 
moved, but not replaced.

Instrument Reassignment

When the Clipboard contains one track 
with one Instrument and you insert it into 
a track with a different Instrument, all of 
the inserted data uses the Instrument of 
the destination track. It does not make a 
multi-track (containing several Instru-
ment channels). To make a multi-track:

a Paste to an empty track.
anual 409



PART 7: Menus
b Insert an equivalent amount of blank 
time into the original track.

c Combine the tracks with the 
Combine Tracks command.

REPEAT PASTE (OPTION-;)

Choose this menu item to open the 
Repeat Paste dialog. Use this command 
to paste, merge, or insert the Clipboard 
information several times, beginning at 
the Edit In point of the destination track.

Figure 41.3: Repeat Paste dialog

You can specify the number of times to 
paste the Clipboard (in the Repeat field), 
or the number of bars/beats/units the 
pasted data should occupy. Changing 
either of these fields automatically 
updates the other.

TIP: By selecting a time region before 
choosing Edit>Repeat Paste, Vision com-
putes the necessary number of repetitions to 
fill the selected time.
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If the specified number of bars/beats/
units is not an exact multiple of the time 
on the Clipboard, the data is pasted the 
indicated number of Repeat times, along 
with any remainder needed to fill the 
specified time.

NOTE: Unless you are pasting into a 
sequence with a different time signature, 
you’ll seldom have to change the time signa-
ture fields.

With the Repeat Paste command, material 
can be pasted in one of three ways:

• Paste over track
Replaces the contents of the destina-
tion track with the contents of the 
Clipboard.

• Merge with track
Merges the contents of the Clipboard 
with the those of the destination 
track.

¥ Insert into track

Shifts the contents of the destination 
track to make room for the pasted 
material.
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CLONE (COMMAND-=)

The Clone command is only available 
when a sequence event is selected in the 
Track Overview or List Window. Choose 
this command to clone the sequence or 
segment referenced by the selected 
sequence event. 

The Clone command makes a copy of the 
referenced sequence or segment and puts 
it in the Segments section of the 
Sequences Window, the sequence event 
is updated to point to the clone. 

NOTE: If the previously referenced item is 
a segment and is no longer referenced by 
any other sequence events, it is deleted.

For more information on using segments 
and sequence events, see 
Chapter 13: Segments, Loops, and 
Sequence Events.

GET TIMES FROM CLIPBOARD 
(COMMAND-‘)

This command gets the Edit In/Out 
points from the Clipboard and pastes 
them into the edit points of the current 
edit window.

Suppose you copied a section of a track to 
the Clipboard. If you change the Edit In 
point of the destination track, you may not 
know where to paste the information. By 
choosing Get Times from Clipboard 
before pasting, you are assured that the 
information will be pasted to the correct 
location.
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INSERT (COMMAND-H)

The Insert command has different func-
tions, depending on the active window.

Insert Track(s)

When the Tracks Window is active and 
one or more tracks are selected (with the 
name, length, and Instrument for the 
tracks highlighted), choosing 
Insert Tracks will create the same 
number of new tracks that you have 
selected and place them above the top 
selected track.

Insert Blank Time

This command inserts an amount of blank 
time (empty time, no events) equal to the 
selection. All MIDI events after the Edit 
In point are shifted to the end of the Edit 
Out point.
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Figure 41.4: Insert Blank Time shifts events by the 
amount of the selection

DELETE (COMMAND-D)

The Delete command has different func-
tions, depending on the active window.

Delete Track(s)

When the Tracks Window is active and 
one or more tracks are selected (with the 
name, length, and Instrument for the 
tracks highlighted), choosing 
Delete Tracks erases the selected 
tracks, and shifts all remaining tracks to 
fill the empty space. This will not affect 
the Clipboard.

Before Insert Blank Time

After Insert Blank Time
412
Delete Selected Time

When you have defined a selection in an 
edit window, this command cuts the 
selected MIDI events to the Clipboard 
and shifts all remaining events after the 
Edit Out point to fill the empty space.

Figure 41.5: Delete Time erases the events and 
time in the selection

NOTE: If you select a time range in the 
Ruler of the Tracks Window, Delete 
Selected Time deletes the selection across 
the entire sequence for all tracks.

Delete Selected Time 
cuts the selected 
events...

...then shifts remaining events to 
Þll the area left by erasing.
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MOVE EVENTS (COMMAND-,)

Choose this menu item to open the Select 
& Modify Window automatically config-
ured for Move Events. This command 
moves selected events to a specific loca-
tion, or forward or back in time by any 
increment.

Figure 41.6: Move Events command

Choose one of the following options and 
click the Move button to move the events.

• Move earlier
Moves selected events back in time 
by the specified number of bars, 
beats, units, SMPTE frames, or 
SMPTE bits.

• Move later
Moves selected events forward in 
time by the specified number of bars, 
beats, units, SMPTE frames, or 
SMPTE bits.

• Move so selection starts at
Places the selected events at the spec-
ified bar/beat/unit location.

Values for the move can be in “bars & 
beats” or “SMPTE time,” as specified by 
the Move by pop-up.
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You can click the Double button to move 
a copy of the selected events, leaving the 
original data unchanged—which is useful 
for creating echo effects.

COMBINE/SEPARATE TRACKS 
(COMMAND-U)

This command is available only if you 
have tracks selected in the Tracks Win-
dow. If more than one track is selected, 
the Combine Tracks command col-
lapses them into a single track in the 
location of the first track. Other tracks in 
the sequence move up to fill the void.

If the tracks were using different Instru-
ments, the new track will be a multi-track.

This is especially useful if you are using 
more than one Instrument to create a 
sound that you think of as a single Instru-
ment. For example, if you are building a 
drum set, you may love the kick and snare 
sounds in one device, but prefer the hi-hat 
sound in another. After you have finalized 
the tracks, you may want to refer to all 
three tracks as one.

Vision automatically names the com-
bined track “Track n” where n = the next 
available track number. 
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If the selected track is already a multi-
track, this command becomes 
Separate Multi Track, which unmerges 
the channels into separate tracks (located 
next to each other). Other tracks in the 
sequence are shifted as necessary. Vision 
automatically names the tracks based on 
the original track name followed by num-
bers. For an example, see page 49

Separate Multi Track is also available if a 
drum track is selected. In this case, 
choosing Separate Multi Track will sepa-
rate each note of the track onto its own 
track. See page 225 for details.

CAPTURE SEQUENCE 
(COMMAND-K)

Capturing is a process that internally 
plays and records the selected sequence 
into a new track. Capturing creates a chro-
nological stream of events—all looped 
data is unlooped as if it were played in real 
time. Sequence events are also played 
into the new track as if you played them in 
real time.

You must copy a selection of MIDI events 
before you can use this command. When 
you copy any MIDI selection, Vision inter-
nally refers to it as a “sequence,” even if 
the original data was a specific selection 
within a track or sequence. There are two 
414
possible names for this command: 
Capture Seq->Track and Capture 
Seq->Seq.

To use Capture Sequence:

a From the Sequences or Tracks 
Window, or from one of the edit 
windows, make a selection.

b Choose Edit>Copy.

c Select a destination track or 
sequence, or have the Sequences 
Window active with no sequence 
selected.

d Choose Edit>Capture Seq->Track 
(or Edit>Capture Seq->Seq).

Capture Seq->Track

If you have a track selected in the Tracks 
Window, Vision will capture the Clipboard 
information into the selected track. All 
loops and sequence events are tran-
scribed into a continuous stream of MIDI 
data. If the Clipboard information con-
tains many tracks, Vision will create a 
multi-track so that all Instruments are 
retained. Only 16 Instruments can fit into 
a track—if your sequence has more than 
16 Instruments, capture to a sequence 
instead.

Capture Seq->Seq

If the Sequences Window is active, Vision 
captures the Clipboard information into a 
sequence. If a sequence is selected, the 
data on the Clipboard replaces the 
selected sequence. All loops and 
sequence events are transcribed into a 
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continuous stream of MIDI data. Each 
Instrument will be placed on a separate 
track, but information from separate 
tracks with the same Instrument will be 
merged into the same track.

MAKE SEGMENT/LOOP 
(OPTION-U)

Use this command to turn track regions 
into segments, which can be used as song 
sections, music layers, reoccurring 
phrases and riffs, or even nested track 
loops. 

The selected material is replaced by a 
sequence event block that references the 
new segment. The original material then 
resides in the newly created segment, 
which is listed in the Segments section of 
the Sequences Window.

Figure 41.7: Make Segment/Loop dialog

Following is a description of the various 
options in the Make Segment/Loop 
dialog:

1

2

3

4
5
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A Start/End
These fields specify the time range of 
data used for the segment. Check the 
“Round to nearest barline” option if 
you want the selection to fall cleanly 
on the beat.

B Loop
Check this option if you want the 
resulting sequence event to loop. 
Enter the number of repeat times in 
the accompanying field.

C Name
Specifies the name used for the new 
segment.

D Make one segment with multiple 
tracks
If several tracks are selected, this 
option places them into a single seg-
ment containing multiple tracks.

E Make single-track segments
If several tracks are selected, this 
option makes them into separate seg-
ments, each containing a single track.

For more information, please see Seg-
ments (pg. 93).

Unmake Sequence Event

When selecting a sequence event in the 
Track Overview or List Window, this com-
mand becomes Unmake Sequence 
Event. Invoking this command places the 
original tracks (from the referenced seg-
ment or sequence) into the parent 
sequence.

See Unmaking Sequence Events (pg. 102) 
for details.
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NEW RECORD TRACK

This command will record-enable the next 
empty track in the current sequence. If 
there are no sequences selected or open, 
Vision automatically selects the first 
sequence in the Sequences Window. This 
command is especially useful if you want 
to start recording immediately—it 
ensures that an empty track is placed in 
record mode.

The Tracks Window does not need to be 
open or active for this command to work, 
so you may not see the track you are 
recording into.

Record Enabling Neighboring 
Tracks

After choosing this menu item, you can 
type Command-­ to record-enable the 
previous track and Command-¯ the next 
track.
416
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Figure 42.1: Do menu

WINDOW SUBMENU

The Window submenu is the first item in 
the Do menu. The exact name of this 
menu item changes depending on which 
window is currently active.
Vision & Studio Vision Pro — MIDI Reference M
The Window submenu contains the same 
commands found in the Window menu of 
the active window.

Figure 42.2: Mirroring of Window menus

TIP: One reason the Window submenu is 
provided in the Do menu is so you can use 
a macro program to make keyboard equiva-
lents for any menu items that don’t already 
have one—which can automate many 
tasks.
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TRANSPOSE (COMMAND-T)

Choose this command to open the Select 
& Modify Window automatically config-
ured for Transpose. For information on 
the Transpose command, see the 
following:

• The Transpose Command (pg. 80);
• Transpose Types (pg. 134);
• Quantize and Transpose Templates 

(pg. 163).

QUANTIZE (OPTION-G)

Choose this command to open the Select 
& Modify Window automatically config-
ured for Quantize. For information on the 
Quantize command, see the following:

• The Quantize Command (pg. 74);
• Quantize Parameters (pg. 129);
• Quantize and Transpose Templates 

(pg. 163).

MODIFY (COMMAND-Y)

Choose this command to open the Select 
& Modify Window automatically config-
ured for Modifying notes. The following 
note properties can be modified:

• velocity
• release velocity
• durations

For details, see Modifying Note Properties 
and Automation Values (pg. 126).
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REASSIGN

Choose this command to open the Select 
& Modify Window automatically config-
ured for Reassign.

The Reassign command changes one con-
tinuous controller type (MIDI controllers, 
pitch bend, aftertouch, velocity scale, 
audio volume and pan, send levels, contin-
uous EQ parameters, and continuous 
plug-in parameters) to another. 

Selected events can be changed to any 
MIDI controller, pitch bend, aftertouch, 
velocity scale, audio volume and pan, 
send levels, continuous EQ parameter, or 
continuous plug-in parameter.

For more information, see Reassign 
(pg. 127).

SET INSTRUMENT 
(COMMAND-I)

Choose this command to open the Select 
& Modify Window automatically config-
ured for Set Instrument. 

Figure 42.3: Set Instrument

Instruments pop-up
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To reassign events to a new Instrument:

a Select the desired track or track 
region and choose Do>Set 
Instrument.

The Select & Modify Window opens, 
automatically configured for Set 
Instrument.

b Specify the new Instrument from the 
Instruments pop-up.

c Click the Set button to reassign the 
previous y selected events.

You can also click the Double button 
assign a copy of the data, leaving the 
original material assigned to the origi-
nal Instrument.

SUBSTITUTE

Choose this command to open the Select 
& Modify Window automatically config-
ured for Substitute. Substitute replaces 
selected events with the contents of the 
Clipboard.

Figure 42.4: Substitute command

1
2

3

4
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Following is a description of each option 
for Substitute:

A Replace each event with a single 
sequential event from the 
Clipboard
Vision replaces each event in the cur-
rent selection with a one-to-one 
correspondence to each event on the 
Clipboard. If the following notes rep-
resent the contents of the Clipboard:

...and the following notes represent 
the current selection:

Then clicking Substitute yields this 
result:
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B Replace each event with the entire 
contents of the Clipboard
Vision replaces each selected event 
with the entire contents of the Clip-
board. Notice that Vision does not 
transpose the Clipboard contents to 
match the selection it’s replacing.
If the following notes represent the 
contents of the Clipboard:

...and the following notes represent 
the current selection:

Then clicking Substitute yields this 
result:

C Controllers to notes
This option specifies what happens 
when substituting continuous events 
for notes events, and vice versa. The 
continuous event values can be used 
for the note’s pitch, velocity, or 
durations.
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D Preserve options
When using the Substitute com-
mand, three aspects in the current 
selection may be preserved: dura-
tions, velocities, and Instruments.
For each box checked, Vision retains 
the appropriate property for Substi-
tute operations on the current 
selection.

Substitute Ideas

Substitute may be used to replace the 
current selection with the contents of the 
Clipboard. Although it would be impossi-
ble to outline every possible use for this 
powerful feature, here are some sugges-
tions and possibilities:

• You can change the pitches of the 
current selection to the pitches on the 
Clipboard without changing the 
rhythmic content of the 
current selection.

• You can substitute every note in the 
selection with the contents of the 
Clipboard, creating “riffs” without 
using a trigger.

NOTE: If you have more than one track on 
the Clipboard, Substitute uses only the 
first track. All other tracks are ignored.
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SELECT/MODIFY TEMPLATES

This submenu lists all Select & Modify 
templates stored in the Vision Editing 
Templates file (see Editing Templates 
(pg. 163) for details). 

To recall a template, simply choose it 
from the submenu and the Select & 
Modify Window is automatically 
reconfigured.

QUANTIZE (COMMAND-G)

Choose this command to permanently 
Quantize the selected material. Unlike 
other Select & Modify commands, Quan-
tize is always available—regardless of the 
current state of the Select & Modify Win-
dow. The Quantize parameters used are 
those last specified in the Select & Modify 
Window.

The name of this command changes 
depending on the type of material 
selected (i.e. Quantize Sequences, Quan-
tize Track, Quantize Selection).

For information on the Quantize com-
mand, see the following:

• The Quantize Command (pg. 74);
• Quantize Parameters (pg. 129);
• Quantize and Transpose Templates 

(pg. 163).
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SELECT & MODIFY 
(COMMAND-R)

Choose this command to perform the 
function specified in the current configu-
ration of the Select & Modify Window. 

The name of this menu item changes 
depending on the command specified in 
the Select & Modify Window and the type 
of material selected (i.e. Transpose in 
Track, Change Duration in Selection). If a 
Select & Modify template has been 
selected, its name appears for this menu 
item.

For details on using the Select & Modify 
Window, see Chapter 16: Select & Modify.

COPY PATCHES (OPTION-C)

Choosing Copy Patches copies the last 
patch change event sent to each Instru-
ment in the current sequence to the 
Clipboard. If more than 16 Instruments 
are used by a sequence, the Clipboard will 
contain more than one track. This is help-
ful when making a “setup” track 
containing patch events for the sequence. 

To use Copy Patches:

a With the Tracks Window active, select 
an empty track.

You can also select an existing obsolete 
Òprogram changeÓ trackÑthis track will 
be replaced by patch events.
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b Choose Do>Copy  Patches, or type 
Option-C.

The current patches (for Instruments 
used in the current set of tracks) are 
copied to the Clipboard.

c Choose Edit>Paste Track, or type 
Command-V.

The current patches are pasted into the 
selected track.

REVERSE TIME

This command reverses the order of 
events in the current selection. This 
results in a “retrograde” effect, which can 
be a useful tool for composition. Notice 
that this is not the same as playing a 
sound recording backwards, because this 
command only affects the order of MIDI 
events, not the sound of the Instruments.

SCALE TIME

This command opens the Scale Time dia-
log. Scale Time compresses or expands 
existing events to fit a new time range. 
For details, see Scale Time (pg. 140).

Before using Reverse Time

After using Reverse Time
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CHANGE TEMPO (OPTION-’)

Choose this command to open the 
Change Tempo dialog, which lets you:

• Fit a range of measures into a precise 
time range;

• Create tempos that accelerate or 
ritard;

• Scale existing tempos.

For details, see Change Tempo (pg. 139).

RECLOCK

Choose this command to open the 
Reclock dialog. Reclock takes a 
sequence recorded without a metronome 
(or from an audio source) and aligns it to 
bars and beats. See Reclock (pg. 142) for 
details.

INSERT BAR MARKER 
(COMMAND-’)

This command opens the Meter track’s 
List Window and puts a bar marker at the 
current Counter location (not necessarily 
the Edit In point). In this window, you can 
name the marker.

The marker appears in the Marker pop-up 
in the Control Bar and in the Track Over-
view Ruler.

For more information on markers, see 
Marker Pop-up (pg. 193).
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INSERT SMPTE MARKER 
(COMMAND-;)

This command opens the Meter track’s 
List Window and puts a SMPTE marker at 
the current Counter location (not neces-
sarily the Edit In point). In this window, 
you can name the marker.

The marker appears in the Markers 
pop-up in the Control Bar and in the 
Track Overview Ruler.

SMPTE Markers retain their SMPTE 
times, even if you change the tempo or 
SMPTE Offset of the sequence using any 
method. However, they will move if you 
use Move Events—they are not “locked.”

PLAY FROM SELECTION 
(COMMAND-SPACE)

This command plays the current track or 
sequence starting with the current selec-
tion. This changes depending on what 
you have selected:

• If the current selection is a sequence, 
Vision plays from the sequence Start 
Point to the end of the sequence.

• If the current selection is a track, 
Vision plays from the track’s start 
time to the end of the track.

• If the current selection is a range of 
MIDI data, Vision plays from the Edit 
In point to the end of the track.

Of course, you can manually stop or pause 
playback at any time.
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PLAY SELECTION 
(OPTION-SPACE)

This command plays only the selected 
events in the current sequence from the 
Edit In to the Edit Out point, then stops.

THE SELECT SUBMENU

This submenu allows you to define the 
current selection according to rules 
you specify.

Select by Rule (Command-E)

Choose this command to open the Select 
& Modify Window automatically config-
ured for Select. Use this command to 
make precise and exacting selections for 
selected tracks or sequences.

Figure 42.5: Select & Modify Window configured 
for Select

For details on using the Select command, 
see Select Attributes (pg. 121).
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Select All (Command-A)

If the Sequences Window is active, choos-
ing Select All selects all sequences.

If the Graphic or Notation Window is 
active, Select All selects all events for the 
displayed track and sets the Edit In and 
Edit Out points to the length of the track.

If a Tracks Window in “Events” mode is 
active (cursor in Track Overview), Select 
All selects all events and sets the Edit In 
and Edit Out points accordingly.

If a Tracks Window in “Tracks” mode is 
active (one or more tracks selected and 
highlighted), Select All selects all 
recorded tracks. For more information on 
the distinction between Tracks mode and 
Events mode, see Two Windows in One 
(pg. 203).
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Split Notes (Command-\)

Choose Split Notes to open a dialog that 
allows notes to be selected based on their 
harmonic position.

Figure 42.6: Split Notes dialog

There are three ways to split notes:

A Selects a specified number of 
notes based on their position 
(highest or lowest) within a 
chord.
This option could be used for 
extracting parts.

B Selects a specified number of 
(highest or lowest) notes that 
occur throughout the entire 
length of the track.
This option could be used to select 
one or more drum notes.

C Selects notes occurring within a 
specified number of semitones of 
the highest or lowest note in each 
chord.
This option could be used to select all 
notes played with the right hand.

1
2
3
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Select Duplicates

Use this command to recover from the 
rare situation in which a track has two of 
every event in it. Usually the events occur 
at the same time, have the same value, 
and are the result of a MIDI transmission 
or keyboard error. If they are separated 
by a few ticks then set the “units” field to a 
number slightly greater than 0.

Figure 42.7: Select Duplicates dialog

You may not be able to see the selected 
events in a graphic window because they 
are covered up by their twin events. Nev-
ertheless, choosing Edit>Cut or 
Edit>Clear will cause them to disappear.

NOTE: This command is particularly 
useful when a track is accidentally recorded 
with a layered MIDI channel.
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NUDGE SUBMENU

This submenu contains the following 
Nudge commands, which move or trans-
pose selected events (as specified by the 
Nudge amount defined in the Settings 
Window; see page 332).

Earlier (Command-¬)

Choose this command to nudge the 
selected events back in time by the 
amount specified in the current Nudge 
Settings in the Settings Window.

Later (Command-®)

Choose this command to nudge the 
selected events forward in time by the 
amount specified in the current Nudge 
Settings in the Settings Window.

Up (Command-­)

Choose this command to transpose the 
selected notes up by the value specified in 
the current Nudge Settings in the Set-
tings Window.

Down (Command-¯)

Choose this command to transpose the 
selected material up by the value speci-
fied in the current Nudge Settings in the 
Settings Window.
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MUTE SUBMENU

The Mute submenu contains the follow-
ing commands for muting and unmuting 
sequence events and audio events:

Mute Seq & Audio Events

Choose this command to mute the 
selected sequence events and audio 
events. Muted events become grayed out 
in the Track Overview area of the Tracks 
Window and do not sound during 
playback.

Unmute Seq & Audio Events

Choose this command to unmute the 
selected sequence events and audio 
events.

Toggle Mutes

Choose this command to toggle the mute 
status of selected events—muted events 
become unmuted, unmuted events 
become muted.
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Figure 43.1: Setups menu
Vision & Studio Vision Pro — MIDI Reference M
KEYBOARD THRU

When checked, Keyboard Thru routes 
all MIDI events it receives to the Current 
Thru Instrument’s device and channel. If 
an Input Map is enabled, Vision routes 
MIDI to the appropriate devices accord-
ing to the map. 

If Keyboard Thru is unchecked, Vision 
sends MIDI data during playback only.

THRU IN BACKGROUND

When checked, Thru in Background 
continues to route MIDI events (to either 
the Current Thru Instrument or Input 
Map) even when you switch to a different 
application. When unchecked, Vision sus-
pends “Thruing” until you bring Vision to 
the front.

For this item to be available, Run MIDI 
in background must be checked in the 
OMS MIDI Setup dialog (see page 430).
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INPUT EFFECT ENABLED

This menu item turns on and off the Input 
Effect. When checked, MIDI input is pro-
cessed according to the configuration of 
the Input Effect Window.

You can also check and uncheck Input 
Map Enabled from the menu in the 
Input Effect Window. For details on using 
the Input Effect, see Input Effect Window 
(pg. 115).

INPUT MAP ENABLED

This menu item turns on and off the Input 
Map. When checked, MIDI is routed 
according to the current Input Map (as 
long as Keyboard Thru is enabled).

When unchecked, Vision instead routes 
MIDI to the Current Thru Instrument; in 
addition, all lines in the Input Map 
Window are grayed out.

You can also check and uncheck Input 
Map Enabled from the menu in the 
Input Map Window. For details on using 
an Input Map, seeChapter 34: The Input 
Map Window.

MIDIKEYS ENABLED

When checked, this item activates the 
current set of MIDIKeys. You can also 
check and uncheck MIDIKeys Enabled 
from the menu in the MIDIKeys Window. 
See The MIDIKeys Window (pg. 171) for 
details.
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FADER REMOTES ENABLED

When checked, faders in the Faders and 
Console Windows can be controlled from 
an external MIDI source. You can also 
check and uncheck Fader Remotes 
Enabled from the menu in the Faders 
and Console Windows.

RECORD QUANTIZE ENABLED

This menu item turns on and off Record 
Quantize. When checked, Vision quan-
tizes all recorded performances based on 
the Play Quantize settings of the record 
track. When Record Quantize is enabled, 
it is indicated in the Record Mode pop-up, 
see Figure 43.2.

Figure 43.2: Record Quantize Indicator

NOTE: Since each track has its own set-
tings for Play Quantize, recorded MIDI 
data is quantized differently for each track.

NOTE: Record Quantize can also be dis-
abled or enabled by clicking the Record 
Quantize button in the Play Quantize area 
of the Tracks and Pulse Windows.

Record Quantize enabled
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RECORD FILTER

This menu item opens the Record Filter 
dialog, where you can select the types of 
data Vision records.

Figure 43.3: Record Filter dialog

Use the three radio buttons to tell Vision 
whether you want to record all events, 
only the events selected in this dialog, or 
all events except those selected in this dia-
log. For instance, in Figure 43.3, all events 
are recorded except “Channel Aftertouch” 
and “Old DX7 Aftertouch.”

Up to eight continuous controllers can be 
specified in the Record Filter dialog. 
Simply choose the desired controllers 
from any of the pop-ups and click the cor-
responding checkboxes.
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ENABLE INPUT DEVICES

This menu item opens the Enable Input 
Devices dialog:

Figure 43.4: Enable Input Devices dialog

Use this dialog to specify the devices from 
which you will record MIDI data. Input 
devices are enabled by clicking their 
checkboxes. Vision only listens to these 
devices when recording or routing MIDI.

The devices from your current Studio 
Setup are listed in this dialog. If multiple 
devices are connected to the same port of 
your MIDI interface, all devices on that 
port appear as single input device. 

NOTE: Disabled input devices can still be 
defined as sync sources in the Sync Options 
dialog.
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OMS STUDIO SETUP

Choose this menu item to launch or acti-
vate the OMS Setup application with the 
current Studio Setup.

OMS MIDI SETUP

This menu item opens the OMS MIDI 
Setup dialog.

Figure 43.5: OMS MIDI Setup dialog

Following is a brief description of the 
items in the OMS MIDI Setup dialog:

1

2

3

4

5
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A External ports to use determines 
which serial ports OMS uses for 
MIDI communication.

B Run MIDI in background retains 
control of the serial ports used by 
MIDI interfaces until all OMS applica-
tions have quit. This means you can 
begin playing in Vision, switch to 
another application, and Vision will 
continue to play in the background.

C New Easy Setup starts the “Easy 
Setup” procedure for configuring a 
new OMS Studio Set. See your OMS 
Manual for details.

D Edit Custom Setup opens the cur-
rent Studio Setup in the OMS Setup 
application. See your OMS Manual 
for a full explanation of the OMS 
Setup application.

E Error Log opens a dialog displaying 
a report of serial errors that have 
occurred since installing Vision.

Figure 43.6: OMS Serial Port Errors dialog
Opcode Systems, Inc.



CHAPTER 44: The Setups Menu
UNDEFINED CHANNELS

Choose this command to open the 
Undefined Channels dialog. You also 
encounter this dialog automatically when 
channels become undefined in Vision 
(such as when opening a file, or after 
changing your current Studio Setup). 

Figure 43.7: Undefined Channels dialog

A list of undefined devices appears in ital-
ics in the left column, they represent 
devices no longer in your current Studio 
Setup. Therefore, to hear any existing 
tracks assigned to these devices, you 
must remap them.
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To remap a device, simply select from the 
device pop-up directly to its right (these 
pop-ups are labeled as “Undefined”).

Figure 43.8: Device pop-up

If the option for Remap all matching 
channels is checked, remapping a single 
device channel automatically remaps all 
other channels for that device. This saves 
you from individually remapping each 
channel in a device.

Check the option for Remember remap-
pings to reapply later and Vision will 
automatically apply these remappings 
when encountering the same undefined 
channels. You can edit these remappings 
in the Auto Remappings dialog, see Auto 
Remappings (pg. 432).

And if you check the option for Auto-
open this dialog when needed, this 
dialog appears whenever Vision encoun-
ters undefined channels.

Remappings affect assignments for 
tracks, Instruments, Metronome Sound 
settings, Input Maps, faders and consoles, 
MIDIKeys, and many others.
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AUTO REMAPPINGS

This menu item opens the Auto Remap-
pings dialog. Use it to edit the 
remappings for undefined channels.

NOTE: The information in the Auto 
Remappings dialog is stored in the current 
Studio Setup document.

Figure 43.9: Auto Remappings dialog

The undefined channels, listed on the left, 
represent devices and channels not in the 
current Studio Setup. When encountering 
a Vision file with undefined channels, they 
are mapped automatically to the devices 
and channels listed on the right.

To edit a remapping, simply choose from 
the Device and Channel pop-ups for the 
desired line. To delete a remapping, 
select it and click the Remove Line 
button.
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COMMANDS

Choose this menu item to open the Com-
mands Window, which lets you assign 
key equivalents and MIDI events to prac-
tically any function or menu item in 
Vision. See The Commands Window 
(pg. 169) for details.

COLORS

This menu item opens a dialog that lets 
you modify the display colors used by 
Vision’s MIDI and Audio Instruments.
Opcode Systems, Inc.



CHAPTER 45: The Options Menu
Figure 44.1: Options menu

SYNC OPTIONS

Choose this menu item to open the Sync 
Options dialog. The Sync Options dialog 
specifies the Receive Sync Mode and 
device, the Send Sync format and device, 
and the SMPTE format. For detailed infor-
mation on each item, see Anatomy of the 
Sync Options Dialog (pg. 433).
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Anatomy of the Sync Options 
Dialog

As you can see in Figure 44.2, the Sync 
Options dialog contains numerous 
options, each of which is discussed in this 
section.

Figure 44.2: Sync Options dialog
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A Receive Sync Mode: This pop-up 
menu specifies the type of sync used 
by Vision. The choices include:

“Internal” uses the internal clock of 
the Macintosh. In this mode, 
sequences play at their own tempo.
“External Beat Clock” uses the sync 
from an external source, usually from 
a hardware-based sequencer or drum 
machine. In this mode, sequences 
play at the tempo of the external sync 
device, and locate and play as deter-
mined by MIDI Song Pointer 
messages.
“MIDI Time Code” uses time code 
from a SMPTE or MTC source. This 
sync source is usually a tape track but 
could be from another application or 
MIDI device that sends MTC. In this 
mode, Vision reads the incoming time 
code and begins playback when the 
sequence’s SMPTE offset is encoun-
tered; the sequence uses it’s own 
tempo.
“MTC/Machine Control” syncs 
Vision to an MMC compatible device. 
In this mode, Vision automatically 
sends MMC commands to control the 
sync device.
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B Receive Sync Device: This pop-up 
menu displays a list of available sync 
sources. Choose an item from this list 
to make it the active sync source.
Vision receives all Song Pointer, 
MIDI Beat Clock, MIDI Time Code, 
or MIDI Machine Control messages 
from the Receive Sync device and 
ignores these messages from all 
other devices. Any devices that are 
defined as “sending” sync in the cur-
rent Studio Setup appear in this 
pop-up.

C Remote Start: Check this option to 
automatically start or stop Vision 
from an external device or program.
For example, when syncing to MTC 
or Beat Clock, enabling Remote Start 
“slaves” Vision to the start/stop con-
trols of the sync source.
In addition, if Vision’s Receive Sync 
Mode is set to Internal, then Galaxy 
(or any other OMS Timer-compatible 
application) can be used to start/stop 
playback.
With Remote Start enabled, Vision’s 
Play button flashes in the Control 
Bar, indicating that it is waiting for 
you to start the remote machine.

D Lock Audio to Tape: When 
checked, this option adjusts the 
sample rate playback of audio to com-
pensate for fluctuations of incoming 
SMPTE time code.
For more details on this feature, con-
sult your Audio Reference Manual.
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E Send Sync: Check this box to enable 
Vision to send synchronization infor-
mation. If unchecked, no MIDI Time 
Code or MIDI Beat Clock will be sent 
to any device, regardless of the state 
of the MIDI Time Code and Beat 
Clock Enable checkboxes.
You can send Beat Clock (usually to a 
drum machine or hardware 
sequencer) or MIDI Time Code (usu-
ally to an external sync box, or to 
another application). Choose “none” 
if you don’t want to send any sync.
NOTE: When choosing Beat Clock, 
MIDI Song Pointer information is also 
transmitted.

F MIDI Time Code Enable: Check 
this box to enable Vision to send 
MIDI Time Code to one or more 
devices (as defined in the MIDI Time 
Code Send Sync Device List).
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G MIDI Time Code Send Sync 
Device(s): This is a list of devices 
from your current Studio Setup that 
are set to “receive” MIDI Time Code.

Figure 44.3: MIDI Time Code Send Sync 
Device List

To send sync to one or more devices, 
simply check the box to the left of 
each device. Devices are available as 
MIDI Time Code sync destinations if 
they are defined as such in your cur-
rent OMS Studio Setup.
In the example shown in Figure 44.3, 
the BRC is enabled to receive MIDI 
Time Code.

NOTE: When using a MIDI interface that 
does not channelize sync information 
(such as the MIDI Timepiece or Studio 
4), only the interface, not the connected 
devices, appears as a sync destination. 
Sending sync to this type of MIDI inter-
face sends it to all connected devices.

H MIDI Beat Clock Enable: Check 
this box to enable Vision to send 
MIDI Beat Clock to one or more 
devices (as defined in the MIDI Beat 
Clock Send Sync Device List).
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I MIDI Beat Clock Send Sync 
Device(s): This is a list of devices 
from your current Studio Setup that 
are set to “receive” MIDI Beat Clock.

Figure 44.4: MIDI Beat Clock Send Sync 
Device List

To send sync to one or more devices, 
simply check the box to the left of 
each device. Devices are available as 
sync destinations if they are defined 
as such in your current OMS Studio 
Setup.
In the example shown in Figure 44.4, 
the LinnDrum and Wavestation are 
enabled to receive MIDI Time Code. 
The BRC is disabled and, therefore, 
will note receive MIDI Time Code.

NOTE: When using a MIDI interface that 
does not channelize sync information 
(such as the MIDI Timepiece or Studio 
4), only the interface, not the connected 
devices, appears as a sync destination. 
Sending sync to this type of MIDI inter-
face sends it to all connected devices.
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J SMPTE Format: This pop-up menu 
determines the SMPTE format Vision 
uses in all displays and calculations. 
This format must match the format of 
the SMPTE time code to which you 
are syncing. If you change the format, 
Vision will adjust the SMPTE offset 
frame number of all your sequences.

Vision stores the SMPTE format with 
each Vision file, and recomputes the 
SMPTE start time (if it differs from 
the current format) when it reads the 
file. For more information on these 
formats, see SMPTE Time Code Rates 
(pg. 150).

K Remember these settings in 
sequence files: Check this option if 
you want to save the sync settings 
with the sequence file. If you enable 
this option, then every file can have 
its own set of sync options, which is 
convenient if your studio works with 
many different types of media.
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SEND SYNC ENABLED 
(COMMAND -)

This menu item turns on and off the trans-
mission of sync. The type of sync sent is 
determined by the settings in the Sync 
Options dialog (see Sync Options 
(pg. 433)).

CLICK IN RECORD (OPTION-[)

This menu item turns on and off the met-
ronome sound for recording.

CLICK IN PLAY (OPTION-])

This menu item turns on and off the met-
ronome sound for playback.

CLICK IN COUNTOFF ONLY

When this menu item is checked, the met-
ronome sound plays only during the 
countoff.
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METRONOME SOUND 
(OPTION-\)

Choose this menu item to open the Met-
ronome Sound dialog. This dialog 
determines whether the metronome 
sound is a MIDI note or a click from the 
Macintosh speaker. In addition, the menu 
items for Click in Record/Play/Countoff 
Only are duplicated here as checkbox 
options.

To configure the metronome sound:

a Choose Options>Metronome 
Sound.

The Metronome Sound dialog opens.

Figure 44.5: Metronome Sound dialog

b Specify MIDI Note as the type of 
click youÕll use.
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c Select the desired Instrument from 
the Channel pop-up for Accented and 
Unaccented.

d Select the desired click sound from 
the Note pop-ups.

You can also highlight the Note fields 
and play a note from your MIDI 
controller.

e Adjust the Velocity and Duration 
fields as desired.

COUNTOFF IN PLAY

This menu item turns on and off the met-
ronome sound for the countoff.

This item has no effect if the Begin 
Record Toggle (see page 190) is set to 
Wait for Note.
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STOP AT PUNCH OUT

If this item is checked, Vision automati-
cally stops at the Out Point when “punch” 
recording.

REAL TIME CAPTURE

If you disable Real Time Capture and 
type sequence letters while a track 
records, the sequences are recorded as 
sequence events.

If you enable Real Time Capture and 
type sequence letters while a track 
records, the sequences are played in real 
time and captured to the track. This 
allows you to record, in real time, any 
changes you make as that sequence plays 
(such as quantize values, track mutes and 
solos, or generated sequence parame-
ters). Changes in the Instruments 
Window are not recorded.

Punch Out Point

Punch Toggle (enabled)
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LOCAL SEQUENCE TIMES

When this item is checked, double-click-
ing a sequence event block opens an edit 
window that numbers its first measure as 
bar 1. In addition, these windows will play 
and record independently of the parent 
sequence.

If Local Sequence Times is not 
checked, the sequence event is treated 
within the context of its parent sequence. 
Double-clicking the sequence event block 
opens an edit window that numbers its 
first measure according to the sequence 
event’s location within its parent 
sequence. Playing or recording from 
these windows also plays the parent 
sequence so you can hear the sequence 
event in context.
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anual 439



PART 7: Menus
440
 Opcode Systems, Inc.



CHAPTER 46: The Windows Menu
Figure 45.1: Windows menu

Choose one of the following menu items 
to open or activate the corresponding 
window.
Vision & Studio Vision Pro — MIDI Reference M
SEQUENCES WINDOW 
(OPTION-Q)

The Sequences Window lists all 
sequences, segments, and sequence tem-
plates for the current file. For more 
information, see Chapter 24: The 
Sequences Window on page 197.

TRACKS WINDOW (OPTION-S)

The Tracks Window displays tracks for 
the current sequence and allows global 
selections and edits. For more informa-
tion, see Chapter 25: The Tracks Window 
on page 203.

LIST WINDOW (OPTION-L)

The List Window displays a chronological 
list of all events in a track, which can 
include MIDI notes, copyright notices, 
system exclusive data, lyrics as text, and 
many others. For more information, see 
Chapter 29: The List Window on page 261.
anual 441



PART 7: Menus
PULSE WINDOW (OPTION-D)

The Pulse Window displays and edits all 
drum tracks for the current sequence. 
The Pulse Window contains a Note Grid 
area for creating and editing drum pat-
terns. For more information, see 
Chapter 26: The Pulse Window on 
page 221.

GRAPHIC WINDOW (OPTION-E)

The Graphic Window allows display of 
MIDI data in a “piano roll” format. 
Although only one track can be displayed 
at a time, many Graphic Windows can be 
open at the same time.

For more information, see 
Chapter 27: The Graphic Window.

NOTATION WINDOW 
(OPTION-N)

The Notation Window displays MIDI 
information using standard music nota-
tion. Vision interprets the MIDI 
information and displays it in a staff. Each 
track is normally represented by a single 
staff. Multiple tracks can be viewed in this 
window and several Notation Windows 
can be open simultaneously.

For more information, see 
Chapter 30: The Notation Window on 
page 275.
442
INSTRUMENTS WINDOW 
(OPTION-I)

The Instruments Window provides access 
to all settings for the MIDI Instruments. 
For more information, see 
Chapter 32: The Instruments Window on 
page 293.

AUDIO INSTRUMENTS 
(OPTION-J)

Choose this command to open the Audio 
Instruments Window.

Figure 45.2: Audio Instruments Window for Acadia

NOTE: Your Audio Instruments Window 
may look different depending on your par-
ticular audio hardware.
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Use the Audio Instruments Window to set 
various audio playback parameters, 
including:

• playback voice assignments
• audio output assignments
• Audio Instrument mute/solo
• Audio Instrument names

There are many other important aspects 
to this window. To learn about it in detail, 
consult your Audio Reference Manual. 

SELECT & MODIFY WINDOW 
(OPTION-Y)

Choose this menu item to open the Select 
& Modify Window in its most recent con-
figuration. The Select & Modify Window 
performs a wide range of select functions 
and modify operations. For more informa-
tion, see Chapter 16: Select & Modify on 
page 119.

NAMES WINDOW (OPTION-P)

The Names Window allows assignment of 
names to patches, controllers, and notes. 
It’s much easier to refer to these items by 
name rather than number.

When using Galaxy™ the Universal 
Librarian, Vision can subscribe to Bun-
dles created by Galaxy. This enables 
automatic updating of patch names in the 
Names Window whenever they are 
changed. For more information about Gal-
axy, contact Opcode.
Vision & Studio Vision Pro — MIDI Reference M
For more information, see 
Chapter 33: The Names Window on 
page 305.

INPUT MAP WINDOW 
(OPTION-M)

The Input Map Window allows assign-
ment of MIDI channels for each device to 
a different range, Instrument, and/or 
sequence. For more information, see 
Chapter 34: The Input Map Window on 
page 325.

MIDIKEYS WINDOW 
(OPTION-K)

The MIDIKeys Window allows events 
generated from a MIDI controller to map 
to virtually any computer key combina-
tion. For more information, see The 
MIDIKeys Window (pg. 171).

FADERS WINDOW (OPTION-F)

Vision supports up to 800 faders, the first 
32 of which are accessed through the 
Faders Window. Faders can be set to 
send any MIDI controller (other than 
pitch bend or aftertouch) or perform a 
velocity scale on any Instrument. One 
fader can control the tempo. For more 
information, see Chapter 37: The Faders 
Window on page 343.
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CONSOLE WINDOWS

The 668 faders not controlled by the 
Faders Window are accessed through the 
Console Windows. For more information, 
see Chapter 38: The Console Windows on 
page 351.

CONTROL BAR (OPTION-A)

The Control Bar contains the major con-
trols for Vision. It’s normally located just 
below the application menu bar. For more 
information, see Chapter 23: The Control 
Bar on page 183.

COUNTER

Choose this menu item to open the 
Counter Window. This window provides a 
much larger display of the Control Bar’s 
Counter.

Figure 45.3: Counter Window

Use the menu in the Counter Window to 
specify the displayed font, and which time 
formats (bar/beat/unit, absolute SMPTE, 
or relative SMPTE) are used.
444
To make the Counter Window larger or 
smaller, simply resize it like any other 
normal Macintosh Window.

For more information, see The Counter 
(pg. 191).

RECORD MONITOR (OPTION-W)

Choose this menu item to open the 
Record Monitor Window. 

Figure 45.4: Record Monitor Window for Acadia

NOTE: Your Record Monitor Window may 
look different depending on your particular 
the audio hardware.

Use the Record Monitor Window to 
record digital audio. For details, consult 
your Audio Reference Manual.

INPUT EFFECT

The Input Effect Window processes notes 
from your MIDI controller. Depending on 
the mode of the Input Effect, the pro-
cessed notes are either repeated or 
arpeggiated. For more information, see 
Input Effect Window (pg. 115).
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PLAYERS & QUEUE

With the Players & Queue Window you 
can “queue up” several sequences to audi-
tion a playback order, and you can even 
have multiple sequences playing at the 
same time on different “Players.” For 
more information, see Players & Queue 
Window (pg. 113).

SETTINGS

The Settings Window contains preference 
settings for a number of different editing 
and display options. For more informa-
tion, see Chapter 35: The Settings Window 
on page 331.

MMC

The MMC Window lets you control MIDI 
Machine Control devices from Vision. For 
more information, see Chapter 39: The 
MMC Window on page 375.

QUICKTIME MOVIE

Use the QuickTime Movie Window to 
open and play QuickTime movies in sync 
with your Vision sequences. For more 
information, see Chapter 40: The Quick-
Time Movie Window on page 385.
Vision & Studio Vision Pro — MIDI Reference M
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CHAPTER 47: The Help Menu
In addition to the Apple Help items and 
All Notes Off command, there are sev-
eral Vision help screens accessible from 
the Help menu.

Figure 46.1: Help menu

ABOUT ONLINE HELP 
(COMMAND-/)

This command displays basic information 
about accessing Vision’s online help.

MIDI DATA FLOW

This command illustrates Vision’s MIDI 
data flow.
Vision & Studio Vision Pro — MIDI Reference M
VISION FILES

This command displays basic information 
about Vision files and what gets saved 
with them. For for more information, see 
Chapter 19: What’s Saved Where.

GENERATED SEQUENCES

This command displays some basic infor-
mation about generated sequences. When 
you have finished reading one window, 
click in the window to display the next 
page. For more information, see 
Chapter 14: Generated Sequences.

SEQUENCES AND SEGMENTS

This command displays general informa-
tion about sequences and segments—for 
example, how to chain existing sequences 
to make song structures, and how to turn 
existing track material into segments for 
looping.

For details, see Chapter 13: Segments, 
Loops, and Sequence Events
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POP-UP HELP

If you check this option, Vision’s online 
help screens stay up until you click the 
mouse. For details, see Vision On-Screen 
Help (pg. 16).

ALL NOTES OFF (!)

This command sends note-off messages 
for all 128 notes on all Instruments. It also 
turns off all sustain pedals and centers 
pitch bend.
448
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Index
INDEX

A

Absolute SMPTE
Graphic window menu 238
List window menu 272
Notation window menu 282
Pulse window menu 231

Add (Select & Modify) 126
Add Amount tool, Strip Chart 244
Add Bank (Patches menu) 318
Add Line

(Input Map window menu) 328
Add Line to Instrument

Instruments window menu 300
Add Mode (in Patches menu) 317
Adding to selection 120
Aftertouch

in Strip Chart 253
inserting in List Window 266
poly aftertouch in Strip Chart 253

Aftertouch Sets Effect Velocity
in Real-Time 335

All Instruments In Use
building Console from 364

All Notes Off command 448
Always Make from Studio Setup 300
Always use current patches 309
Appearance

Fader Slots in Instrument Color 336
Window Background 336

Arpeggiator
with Input Effect 115

Arranging and mixing 85
Arranging sequences 85

example 85
Arrow tool 57

selecting blocks in Track Overview 216
Assign GM equivalents to all patches 319
Assigning key commands 170
Opcode Manual Template
Attribute conditions for select 122
Attribute types for select 122
Audio edits occur...

in Real-Time 335
Audio Events

inserting in List Window 264
Audio Instruments

building Console from 365
Audio Instruments In Use

building Console from 365
Audio Instruments Window 442
Audio Pan

in Strip Chart 254
inserting in List Window 266

Audio Sends
in Console Window menu 356

Audio Volume
in Strip Chart 254
inserting in List Window 266

Auto Map (Select & Modify) 135
Auto Map transpose 135
Auto Remappings dialog 432
Auto Scroll

Graphic window menu 237
List window menu 272
Notation window menu 281
Pulse window menu 231

Auto Scroll Top Window Only
in Settings>Editing 333

Automatically number patches in bank 319
Automatically Remove Unused Segments 93,

98
Automation submenu

in List Window 266
in Strip Chart 254

Auto-open this dialog when needed
in Undefined Channels 431

B

B0 B32 PC 264
B0 PC 264
B32 PC 264
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Bank 305
Bank Select 264, 319
Bank Select/Numbering

0-127 319
1-128 319
A11-B88 319
Assign GM equivalents to all patches 319
Automatically number patches in bank 319
in Patches menu 319
Prefix 319

Bar/Beat/Unit
fields, editing with Markers pop-up 28
fields, typing into 28
Graphic window menu 237
Notation window menu 281
Pulse window menu 231

Barline thru System 287
Bars per Line 286
Base

in Input Map window 326
Begin Record toggle 32, 190

Countoff 191
Wait for Note 190

Blocks 62
Blocks mode, Track Overview 214
Build Console From

All Instruments In Use 364
Audio Instruments 365
Audio Instruments in Use 365
Enabled Rewire Channels 365
in Console Window menu 363
MIDI Instruments In Use 365
Selected Tracks’ Instruments 364

C

C 347
Capture Seq->Seq 414
Capture Seq->Track 414
Capture Sequence command 414
Chaining sequences 85
Change

Patch names 324
452
Change Duration (Select & Modify) 124
Change Release Velocity (Select & Modify)

124
Change Tempo command 422
Change Tempo dialog 139
Change Value (Select & Modify) 124
Change Velocity (Select & Modify) 124
Changing (Select & Modify) 126
Changing controller values

in Select & Modify Window 126
Changing note durations

in Notation window 278
Channel column

in Names Window 307, 310
Channel Width

and remote devices 360
in Console Window menu 355
Narrow 356
Wide 356

Channels
showing all in the Names Window 313

Choose 5
Chromatic (Select & Modify) 134
Chromatic transpose 134
Clean Tempo Display

in Settings>Editing 334
Clear All

Input Map window menu 328
Clear Beat/Unit when Entering Bar

in Settings>Editing 333
Clear Clip & Undo 301
Clear command 408
Clear Console

in Console Window menu 365
Clear Name List

in Patches menu 317
Clear Subscription 312
Click in Countoff Only command 437
Click in Play command 437
Click in Record command 437
Click track

for Reclock 142
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Clone command 411
Close All command (in File menu) 400
Close command 400
Close Window command 400
Cntls 320

in Patch Name Editor 315
Colors 432

for Instruments 294
initializing 301

Columns
re-ordering 23
resizing 23

Combine Tracks command 413
Commands Window 169

Commands section 169
Digits section 169

Commands Window menu 170
Comments

in Sequences Window 199
in Tracks Window 210

Compress (Select & Modify) 126
Compress tool

in Strip Chart 245
Console Layout Templates

opening 367
saving 366

Console Name
in Console Window menu 363

Console strips
rearranging 371

Console Window menu 355
Audio Sends 356
Build Console From 363
Channel Width 355
Clear Console 365
Console Name 363
EQs 357
Fader Remotes Enabled 362
Load Console Layout 366
Master Instrument 362
Narrow 356
Plug-Ins 357
Opcode Manual Template
Save Console Layout 365
Save Console Layout As 366
Show All Fader Info 359
Show Masking Tape 361
Show Remote Devices 360
Show Selected Fader Info 357
Wide 356

Consoles 351
about 351
anatomy of 352
build from 363
channels 352
grouping faders 367
Loading a template 366
Masking Tape 361
rearranging audio plug-ins 372
rearranging strips 371
saving a snapshot 407
Saving a template 365

Constant (Select & Modify) 126
Constrain to Scale (Select & Modify) 134
Continuous Trigger

in Input Map window 327
Control Bar 13, 183

Begin Record toggle 190
big green "S" 302
Counter 191
Current Patch pop-up 186
Current Sequence pop-up 184
Current Track pop-up 184
Global Instrument Solo Indicator 302
Marker pop-up 193
Memory Display pop-up 193
opening the Names browser 321
Punch and Loop controls 194
Record Mode pop-up 183
Sync pop-up 189
Tempo Display 192
Thru Instrument pop-up 184
transport controls 187
Window buttons 196

Control names
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default 320
Controller

Show Selected Fader Info 358
Controller events

changing values 126
in Strip Chart 253
inserting in List Window 266
reassigning 127, 418
Set Density 127
thinning in Strip Chart 245

Controllers
Favorite Controllers 336

Controllers to notes
in Substitute window 420

Controls
for looping 194
for punching 194
for sequences 53
for tracks 54
for tracks, Graphic window 55
for tracks, List window 55

Copy command 407
Copy Faders command 89, 347, 407

example 89
inserts Mute/Solo events 347

Copy Name List
in Patches menu 316

Copy Patches command 88, 421
Copy Subscription 312
Copying

blocks in Track Overview 63
fader values 89, 347, 407
patch events 88, 421

Copyright
in Strip Chart 251

Counter Window 444
Counter, Control Bar 191
Countoff in Play command 438
Countoff mode, Begin Record toggle 32, 191
Cue Points

in Strip Chart 252
Current Page 287
454
Current Patch pop-up 186
Current Sequence pop-up 184
Current Track pop-up 184
Cursor Display 37, 58, 215

SMPTE 215
Cursor Quantize 37, 58
Cursor tools 57
Custom Instruments 177

in overflow mode 179
layered 177
splits 178

Cut command 406

D

Default Edit Window
in Settings>Editing 334

Default Modes
in Patches menu 318

Define Middle C
in Settings>Editing 334

Delete (Select & Modify) 125
Delete command 412
Delete Selected Time command 412

vs. Cut command 406
Delete Template

Select & Modify Window menu 125
Deleting

Instruments, Clear Clip & Undo 301
selected time 412
tracks 412

Density
in Strip Chart 256
in Strip Chart & Nudge 332

Detailed Track Overview 220
Device column

in Names Window 307
Device Mode Column 310
Diatonic (Select & Modify) 134
Diatonic transpose 134
Display modes

for Note Grid 225
for Track Overview 214
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Index
Do menu 417, 418
Change Tempo 422
Copy Patches 421
Insert Bar Marker 422
Insert SMPTE Marker 423
Modify 418
Mute submenu 426
Nudge submenu 425
Play from Selection 423
Play Selection 423
Quantize Selection 421
Reassign 418
Reclock 422
Reverse Time 422
Scale Time 422
Select & Modify 421
Select All 424
Select by Rule 423
Select Duplicates 425
Select Split Notes 424
Set Instrument 418
Substitute 419
Transpose 418
Window submenu 417

Do window
Select/Modify Templates 421

Don’t Make (Patch names) 324
Don’t Make Current 312
Don’t Send (Patch names) 324
Double button (Select & Modify) 124, 125
Drum Instruments

defining 295
with transpose 295

Drum machine style recording 45
configuring record quantize settings 46
example 45
repeated notes 45
setting up MIDIKeys 45
using Input Effect 45
using the erase MIDIKey 46

Drum Map (Select & Modify) 136
Drum Map transpose 136
Opcode Manual Template
Drum note line columns
re-ordering 23
resizing 23

Drum Note lines 224
Play Quantize settings 225
rearranging 225
removing 225
re-ordering with move cursor 22
selecting 225
selector dots 22
using Separate Multi Track 225

Drum tracks 11, 223
see also Pulse window
Drum Track column 55
playback notes 223
toggle 207

Duration
cursor 60
editing in Strip Chart 249
in Insert Note window 332
in Select & Modify 122

E

Edit Custom Setup
in OMS MIDI Setup 430

Edit menu 405
Capture Sequence 414
Clear 408
Clone 411
Combine Tracks 413
Copy 407
Copy Faders 407
Delete 412
Delete Selected Time 412
Get Times from Clipboard 411
Insert 411
Insert Blank Time 411
Insert Clipboard 409
Make Segment/Loop 415
Merge 409
Move Events 413
New Record Track 416
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Paste 407
Redo 405
Repeat Paste 410
Separate Multi Track 413
Undo 405
Unmake Sequence Event 415

Edit Points 66
Edit Selected Patch

in Names browser menu 323
Edit windows 14

Ruler 59
Editing

Auto Scroll Top Window Only 333
basic procedures 57
changing pitches without rhythms 420
Clean Tempo Display 334
Clear Beat/Unit when Entering Bar 333
commands you cannot undo 405
Cursor Display 58
Cursor Quantize 58
cursor tools 57
Default Edit Window 334
Define Middle C 334
dragging blocks in Track Overview 217
durations in Strip Chart 249
edit indicators in Ruler 59
events in List Window 273
Exact Mode 59
field values 27
in Note Grid 228
in Track Overview 213
making music fit on a page 286
Meter track 210
Modify Window Option 334
music recorded without a metronome 142
note properties with mouse 60
note velocities in the Strip Chart 61
notes in Graphic window 236
notes in List Window 61
notes in Notation Window 277
options in Settings Window 333
pasting without replacing (merging) 409
456
patch names 313
permanently quantizing track data 74
permanently shifting track data 77
Punch Points follow Edit Points 333
Quantize templates 163
random editing in Strip Chart 247
reassigning controller types 127
reclocking to a click track 144
referenced sequence events 100
release velocities 273
rubato performances 144
segment loop lengths 96
Select & Modify templates 165
sequence events 98
sequence events in List Window 103
Set Insertion Point to... 333
setting density of controller values 127
thinning controllers in Strip Chart 245
tools 57
tracks recorded without a metronome 144
Transpose templates 163
values with a MIDI controller 27
velocities in Note Grid 229
velocities in Strip Chart 249
while looping 66
with note edit cursors 60
working with track blocks 62
zooming 24

Enable Input Devices command 429
Enabled (record mode) 379
Enabled Rewire Channels

building Console from 365
Enabling

fader receive 428
input devices 429
Input Effect 428
Input Map 428
Keyboard Thru 427
MIDIKeys 428
Record Quantize 428
send sync 437

EQ Band Enable
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in Strip Chart 255
inserting in List Window 268

EQ Band Frequency
in Strip Chart 255
inserting in List Window 268

EQ Band Gain
in Strip Chart 255
inserting in List Window 268

EQ Band Parameter submenu
in List Window 268
in Strip Chart 255

EQ Band Type
in Strip Chart 255
inserting in List Window 268

EQ Band Width
in Strip Chart 255
inserting in List Window 268

EQ Enable
in Strip Chart 255

EQ Enable inserting in List Window 267
EQs

in Console Window menu 357
Erase MIDIKey 173
Error Log

in OMS MIDI Setup 430
Event end times

in List Window 273
Event Type (Select & Modify) 122
Exact Mode 59
Export as MIDI File command 402
Export as QuickTime Movie command 403
Export Audio Events command 404
Export Audio Mix command 403
Export to Clipboard command 403
Exporting

as QuickTime movie 403
audio events 404
audio mix 403
MIDI files 402
to Clipboard 403

Extend MIDIKey 173
External Beat Clock, sync mode
Opcode Manual Template
External Beat Clock 434
External ports to use

in OMS MIDI Setup 430
External sync

and Auto Punch 149
and Wait for Note 149
switching to internal automatically 149

F

Factory/General MIDI names 311
fader events

changes 347
Fader Remotes Enabled 358, 360, 428

in Console Window menu 362
Fader Slots in Instrument Color

and Faders Window 344
in Settings>Appearance 336

Fader Values
inserting using Copy Faders 89

Faders
about 343
changes from previous versions 347
controlling the tempo with 138
controlling velocity 346
copying values 347
device assignments 344
enabling external control 428
example (recording, viewing, playing) 348
grouping 367
moving as a group 368
Absolute Fading 368
Proportional Fading 369
Snap Fading 370
remappping MIDI controllers 346
saving a snapshot 407
sliders 344
Tempo Fader Range 345
the new way 348
the old way 348
using (the new way) 348
values 344

Faders Window 344
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1 346
17 346
32 346
display modes 346
Rcv 345
Send 345
Send/Receive settings 345
tempo fader 344

Favorite Controllers
in Settings>Controllers 336

File menu 397
Close 400
Close All 400
Close Window 400
Cut 406
Export as MIDI File 402
Export as QuickTime Movie 403
Export Audio Events 404
Export Audio Mix 403
Export to Clipboard 403
Import Audio 403
Import Audio Using QuickTime 403
New 397
Open 398
Page Setup 404
Print 404
Print Preview 404
Quit 404
Revert 402
Save 400
Save a Copy As 401
Save As 400
Save As Setup 401

Find Patch 313
Finding soloed instruments 303
Fine Controller Values

in Settings>Controllers 336
in Strip Chart 254

Fitting music
to bars 422
to click track 142

Flat shape
458
in Strip Chart 247
Font

changing in Print Preview 288
Free shape

in Strip Chart 246

G

Gated
in Input Map window 327
Sequence Event 104

Generated sequences
about 107
Attack mode 109
creating 108
Duration mode 110
looping 112
Note track 111
Order mode for tracks 112
Rhythm track 111

Get Times from Clipboard command 411
Global Instrument Solo Indicator 186

blinking 302
lit 302

GM Equiv column
in Patch Name Editor 315

Go Back
Patch names 324

Grand Staff 288
Graphic mode, Note Grid 226
Graphic window 233

Changing a Note’s Duration 236
clicking to select 234
I-beam tool 234
Marquee tool 234
modifying notes 39, 236
Moving Notes 236
pencil tool 39
selecting a pitch range 235
selecting a time range 234
track controls 55
Transposing Notes 236
viewed Instruments 238
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X events 233
Graphic window menu

Absolute SMPTE 238
Auto Scroll 237
Bar/Beat/Unit 237
Jump to Selection 237
Play Edited Note 239
Relative SMPTE 238
Set Default Location 238
show piano keyboard 239
Show Vertical Line 239
Tools 237
View 238
Zoom Back 237
Zoom to Fit 237

Grid Quantize 69
parameters 130

Groove Quantize 70
applying to a track region 75
example 75
making your own grooves 167
parameters 133

Grooves file 167
Grouping faders 367

H

Hand cursor
scrolling with 25

Harmonize 82
Harmonize button (Select & Modify) 124
Help menu 447

About Online Help 447
All Notes Off 448
Generated Sequences 447
MIDI Data Flow 447
Pop-up Help 448
Sequences and Segments 447
Vision Files 447

Help, online 16
Hide

Note Grid 221
Track Overview 204
Opcode Manual Template
I

I-beam tool 57
in Graphic Window 234
in Notation Window 277
in Strip Chart 243
in Track Overview 216

Import Audio command 403
Import Audio Using QuickTime 403
Importing QuickTime movies 385
In Point field 195
Info area

in Pulse window 222
in Tracks Window 205
Play Quantize settings 72
sequence event parameters 96

Information toggle 54, 212
Initialize Colors 294, 301
Input Channel

in Input Map window 325
Input Device

in Input Map window 325
Input Effect

Arpeggiate 115
duration 116
recording with 117
Repeat 115
spacing 116
with Grid or Groove Quantize 116

Input Effect Enabled command 428
Input Effect MIDIKey 173
Input Effect Window 115
Input Map

and Trigger modes 327
enabling/disabling 327
keyboard splits 329
multi-channel recording 329
Multiple Keyboards 329
triggering sequences 326
when to use 328

Input Map Enabled command 428
Input Map window 325

Base 326
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Continuous Trigger 327
Gated 327
Input Device and Channel 325
input lines 325
Player 326
Range 325
Sequence 326
Thru/Trigger 326
Transpose Mode 326
trigger 327
trigger modes 327

Input Map window menu 327
Add Line 328
Clear All 328
Input Map Enabled 327
Load From 328
Make One Line per Channel 328
Remove Line 328

Insert
+ Sequence Event 104
Gated Sequence Event 104
Stop Sequence 104
Transpose (Sequence Event) 104

Insert Bar Marker command 422
Insert Blank Time command 411
Insert Clipboard command 409
Insert command 411
Insert into track

in Repeat Paste 410
Insert Note

Spacing 331
Insert Note window

duration 332
velocity 332

Insert SMPTE Marker command 423
Inserting

bar markers 422
blank time 411
Clipboard 409
events in List Window 263
notes in List Window 263
notes with Magic Drumstick tool 40, 227
460
notes with Pencil tool 37
patch events in List Window 264
patch events in Strip Chart 251
sequence events in List Window 103, 270
SMPTE markers 423
tracks 411
velocities in Pulse window 227
see also List window

Installation 3
Instrument

Show Selected Fader Info 358
Instrument (Select & Modify) 122
Instrument pop-up 55
Instruments 293

and multi-tracks 413
and OMS Studio Setup 299
assigning in Tracks Window 208
color 294
creating splits 178
custom 177
customizing colors 294
drum instruments 295
finding soloed Instruments 302
finding soloed instruments 303
Global Instrument Solo Indicator 186
in Strip Chart 251
initializing colors 294
key range 298
Layered mode 177, 296
Make from Studio Setup 300
Mono mode 297
multi-line Instruments 296
muting and soloing 294
naming 294
naming vs. using Masking Tape 361
output channel (Chan) 297
output device 297
Overflow mode 179, 296
remapping 431
re-ordering with move cursor 22
selecting unused 301
selector dots 22
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setting 418
simple transposing 298
Thru Instrument pop-up 184
transpose 295
transpose maps 295
transposing 83
unsoloing all 303
velocity fader 298
Velocity Scale 297
Velocity Scale % 298

Instruments button 186
Instruments window 293

names 294
opening with Instruments button 186

Instruments window menu 299
Add Line to Instrument 300
Clear Clip & Undo 301
Initialize Colors 301
New Instrument 299
Remove Line from Instrument 300
Select Unused Instruments 301
Show Use of Selected Instruments 301

Internal (sync mode) 434
Internal Click (metronome sound) 437
Interval (Select & Modify) 134
Interval transpose 134
Invert (Select & Modify) 135
Invert transpose 135
is (Select & Modify) 122
is from… thru (Select & Modify) 122
is not (Select & Modify) 122
is not from… thru (Select & Modify) 122
is… or (Select & Modify) 122
is… or less (Select & Modify) 122
is… or more (Select & Modify) 122

J

Jump to Selection
Graphic window menu 237
List window menu 272
Notation window menu 281
Pulse window menu 231
Opcode Manual Template
K

Keep (Patch names) 324
Keep Sequences End-to-End 99, 262
Keep using these patches 309
Key equivalents

for commands, reassigning 169
for sequences 198

Key range
for Instruments 298

key signature changes
in Meter track 210
in Notation window 279
inserting in List window 271

Key/Scale (Select & Modify) 135
Key/Scale transpose 135
Keyboard Splits

with Input Map 329
Keyboard Thru command 427

L

Layered 296
Legato tool, Strip Chart 244
List window 261

see also inserting
Automation submenu 266
editing notes 61
EQ Band Parameter submenu 268
inserting Aftertouch 266
inserting Audio Events 264
inserting Audio Pan 266
inserting Audio Volume 266
inserting Controller events 266
inserting EQ Band Enable 268
inserting EQ Band Frequency 268
inserting EQ Band Gain 268
inserting EQ Band Type 268
inserting EQ Band Width 268
inserting EQ enable 267
inserting key changes 271
inserting markers 271
inserting meter changes 270
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inserting MIDI events 265
inserting Mute events 267
inserting Notes 263
inserting patch events 264
inserting phase invert events 267
inserting pitch bend 265
inserting plug-in bypass events 267
inserting Poly aftertouch 266
inserting send level events 267
inserting sequence events 270
inserting solo events 267
inserting system exclusive events 269
inserting tempo changes 271
inserting text-type events 265
inserting Velocity Scale events 266
Meter track 270
moving events 274
Plug-in Parameter submenu 268
re-ordering jsimultaneous events 274
sequence events 103
showing event durations 273
showing release velocities 273
Tempo track 271
track controls 55
track lengths 55
viewed events and Instruments 272

List window menu 271
Absolute SMPTE 272
Auto Scroll 272
Jump to Selection 272
No SMPTE 272
Play Edited Note 273
Relative SMPTE 272
Set Default Location 272
Show Event Durations 273
Show Event End Times 273
Show Release Velocities 273
View 272

Load Console Layout
in Console Window menu 366

Load From
Input Map window menu 328
462
Select & Modify Window menu 125
Local Sequence Times command 100, 439
Locator buttons 189
Lock Audio to Tape 434
Lock Event SMPTE Times 263
Lock to Timing

and SMPTE offsets 392
in QuickTime Movie window menu 389

Locking track and sequence lengths 206
Loop

editing (example) 66
in Make Segment/Loop 415
recording 35
toggle 194

Looping
and editing 66
generated sequences 112
in the middle of a track 95
loop indicators in Ruler 59
sequences 207
track regions with segments 95
tracks 207

Lyrics
in Strip Chart 251
inserting in List Window 265

M

Magic Drumstick tool 40, 57
inserting notes in Pulse window 40

Make Current 312
Don’t Make Current 312
Patch names 323
Send the patches 312

Make from Studio Setup 300
Make One Line per Channel

Input Map window menu 328
Make one segment with multiple tracks 87, 94
Make Segment/Loop 86, 94, 415

Loop 415
Make single-track segments 415
Name 415
Start/End 415
Opcode Systems, Inc.
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Make single-track segments 87
in Make Segment/Loop 415

Manual
conventions 5
how to use this manual 4
organization 4

Manual Map (Select & Modify) 136
Manual Map transpose 136
Margin

zooming in the 25
Marker pop-up 193
Markers 211

bar markers 422
in Strip Chart 250
inserting in List window 271
Marker pop-up 193
merging as text 409
Next Marker button 188
Previous Marker button 188
SMPTE markers 423

Markers Break Blocks 63, 214
Marquee tool 57

extening selection 64
in Graphic window 234
in Notation Window 276
in Track Overview 216
selecting with 63

Masking Tape 361
in Consoles 361
vs. naming Instruments 361

Master Instrument
in Console Window menu 362

Master Tempo display 192
Matrix mode, Note Grid 226
Max Limit to (Select & Modify) 126
Max Limit tool

in Strip Chart 244
Maximum Fader Position

and Faders Window 344
Maximum Playable Tracks

in Real-Time 336
Memory display 193
Opcode Manual Template
Menus
window specific menus 26

Merge command 409
Merge markers as text 409
Merge with track

in Repeat Paste 410
Meter

changing in Notation window 279
meter vs. meter track 53

Meter changes
inserting in List window 270

Meter track
constant vs. changing meter 210
in List Window 261
in List window 270
in Tracks Window 210
switching to in the List Window 20

Metronome Sound dialog 437
MIDI

about 7
common misconceptions 9
terminology 8

MIDI Beat Clock
Enable (in Sync Options) 435
Send Sync Device(s) 436

MIDI column
in Patch Name Editor 314

MIDI files
about 399
exporting 402

MIDI Instruments In Use
building Console from 365

MIDI Machine Control
MMC Window 375
real-world example 381
setting up a device 375
sync mode 434
with Tascam DA-88 381

MIDI submenu
in List Window 265
in Strip Chart 252

MIDI Time Code
463
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Enable (in Sync Options) 435
MIDI Time Code (MTC) 434
MIDIKeys

defining 174
drum machine-style loop recording 45
enabling 174
for sequences 199
special 172

MIDIKeys Enabled command 428
MIDIKeys Window 171
MIDIKeys Window menu 174
MIDIShift MIDIKey 173
Min Limit to (Select & Modify) 126
Min Limit tool

in Strip Chart 244
Mix settings, saving 89
MMC

real-world example 381
MMC Communications Setup

in MMC window 377
MMC window 375

anatomy of 375
Enabled (record mode) 379
MMC Communications Setup 377
Num 378
PreRoll 378
Rec Tracks (Track Enable Buttons) 378
Rehearse (record mode) 380
Reset Debug Logs 378
Safe (record mode) 380
Test device 377
transport controls 376

MMC Window menu 380
Reset MMC System 380

MMC, sync mode
MTC/Machine Control 434

Mode 306, 307
Mode Name

in Patches menu 318
Modify command 418
Modify types 124
Modify Window Option
464
in Settings>Editing 334
Modifying note properties

in Select & Modify Window 126
Mouse

editing notes with 60
scrubbing with 26
zooming with 25

Move (Select & Modify) 124
Move Amount

in Strip Chart & Nudge 332
Move cursor 22, 60

with multiple items 22
Move Events command 77, 413
Moving

barlines to fit notes 144
blocks in Track Overview 63, 217
events in List Window 274
events with Move command 413
notes in Notation window 278
rearranging Instruments in window 22
rearranging lines in Pulse window 22
rearranging sequences in window 22
rearranging tracks in window 22

Moving columns 23
MTC/Machine Control

in Sync Options 434
Multi-channel recording 46

example 48
with Input Map 329

Multi-line instruments 296
Multiple Keyboards

and Input Map 329
Multiple Pulse windows 230
Multiple tracks

in Notation Window 21
in Strip Chart 257

Multi-tracks
reassigning Instruments 208

Mute column 54
Mute command 426
Mute events

in Strip Chart 254
Opcode Systems, Inc.
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inserted with Copy Faders command 347
inserting in List Window 267

Mute QuickTime Audio
in QuickTime Movie window menu 389

Mute submenu
Mute Seq & Audio Events 426
Toggle Mutes 426
Unmute Seq & Audio Events 426

Muting
Instruments 294
sequence events 97
tracks 54, 206
tracks vs. instruments 295

N

Name
in Make Segment/Loop 415

Name Setup 306
Name Setup control

in Names Window 307
Names

Instruments 294
Patch Name Provider 306

Names browser 321
By name 321
By number 321
General MIDI groups 321
grouping 321
menu 322

Names browser menu
Edit Selected Patch 323
Show Patches In All Selected Group(s)

323
Show Patches In Any Selected Group(s)

323
Sort By Name 323
Sort by Number 323

Names menu 311
Show Channels 310

Names Window 305
see also Patch Names
always use current patches 309
Opcode Manual Template
anatomy of 307
Channel column 307, 310
control names 320
current patch name documents 309
Device column 307
Device Mode column 307, 310
Keep using these patches 309
missing patch name documents 309
Name Setup control 307
Names menu 311
note names 320
opening with Patch button 187
Patch Name Document column 307, 308
Patch Name Editor 314
Patches menu 316
subscribing 308
Use Factory/GM Names 308

Names Window menu
Clear Subscription 312
Copy Subscription 312
Don’t Make Current 312
Find Patch 313
Make Current 312
New Patch Document 312
Open Patch Document 313
Paste Subscription 312
Send Patches to Device 313
Send the patches 312
Show Channels 313
Tell patch Provider 313
Use Current Instead 312
View/Edit Patch Names 312

Naming
Instruments 294
sequences 198
tracks 206

Narrow (Channel Width) 356
Navigation techniques 19
Nested

loops, from pasting 410
sequence events 101

New command 397
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New Drum Track 223, 230
New Easy Setup

in OMS MIDI Setup 430
New Instrument

Instruments window menu 299
New Patch Document 312
New Record Track command 416
Next Marker button 188
No SMPTE

List window menu 272
Non-Continuous Events

in Strip Chart 248
Notation

and swing 291
avoiding ledger lines 291
octave shift 290
troubleshooting 291

Notation Resolution 280
Notation terms

Grand Staff 288
part 289
system 289
voice 289

Notation tips
changing track order 289
shfting by octaves 290

Notation troubleshooting
extra rests 291
fitting on a page 291
ledger lines 291
looking good vs. sounding good 292
notes tied together 292
other applications 292
printing off the page 291
printing problem dialog box 291
single staff 292
swing eigth notes/triples 291
too many voices 291

Notation Window 275
changing key 279
changing meter 279
changing note durations 278
466
changing track order 21
getting rid of rests 279
inserting notes with Pencil tool 38
meter changes 279
modifying notes 277
Moving Notes 278
multiple tracks 21
Notation resolution 280
octave selections 290
resolution 280
selecting a pitch range 277
selecting a time range 277
selecting tracks in 275
shifting octaves 280
showing and hiding tracks 21
Transposing Notes 278
viewed Instruments 282

Notation window menu 281
Absolute SMPTE 282
Auto Scroll 281
Bar/Beat/Unit 281
Jump to Selection 281
Play Edited Note 283
Relative SMPTE 282
Set Default Location 282
Show Vertical Line 283
Tools 281
View 282
Zoom Back 281
Zoom to Fit 281

Note edit cursors 60
in Graphic window 236
in Notation Window 277
in Pulse Window 228

Note Grid 225
Display modes 225
editing notes in 228
Graphic mode 226
Matrix mode 226
showing/hiding 221
toggle 221

Note names
Opcode Systems, Inc.
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default 320
Note Names window 320
Notes

editing durations in Strip Chart 249
editing velocities in Strip Chart 249
inserting in List Window 263
modifying in Graphic window 236
modifying in Notation Window 277
modifying in Note Grid 228

Notes column
in Patch Name Editor 315

Nudge
Down 425
Earlier 425
in Pulse window 229
Later 425
Up 425

Nudge command 425
Nudging

events forward or back in time 78
pitches up or down 80

Num
in MMC window 378

Number column
in Patch Name Editor 314

Number of Pages 287
Numericals, editing values 27

O

Oct (transposing Instruments) 298
Octave Map (Select & Modify) 135
Octave Map transpose 135
Octave shift 280
Octaves (Select & Modify) 134
Off/Speed/Start 54
Offset, SMPTE 54, 212
OMS

about 11
OMS Studio Setup 11
opening current Studio Setup 430
Studio Setup document 156

OMS MIDI Setup dialog 430
Opcode Manual Template
OMS Studio Setup 430
and Instruments 299

Online help 16
Opcode

contacting 4
software registration 3

Open command 398
Open Music System

see OMS
Open Patch Document 313
Open Windows pop-up 21
Opening

Console Layout Templates 367
MIDI Files 399
QuickTime movies 385
Use Setup Instruments 399
What to Open 398

Options menu 433
Click in Countoff Only 437
Click in Play 437
Click in Record 437
Countoff in Play 438
Local Sequence Times 100, 439
Metronome Sound 437
Real Time Capture 438
Send Sync Enabled 437
Stop at Punch Out 438
Sync Options 433

Opts menu 99, 262
Keep Sequences End-to-End 99, 262
Lock Event SMPTE Times 263
Song Track 99, 262

Oscillating (Select & Modify) 127
Oscillator shapes

Strip Chart 247
Waveform Period 248

Out Point field 195
output channel (Chan)

Instruments 297
output device

Instruments 297
Overdub (record mode) 31
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Overflow 296

P

Page Properties 285
Page Setup command 288, 404
Parabola shape

Strip Chart 246
part 289
Paste command 407
Paste Name List

in Patches menu 317
Paste over track

in Repeat Paste 410
Paste Subscription 312
Pasting

MIDI data 408
nested loops 410
sequences 408
tracks 408

Patch 305
Patch button 187
Patch change types 264
Patch column

Tracks window 88
Patch events

and Tracks Windows 209
copying 88
inserting in List Window 264
inserting in Strip Chart 251
inserting in Tracks window 88
inserting using Copy Patches 88
placement 89
saving 88

Patch Name column
in Patch Name Editor 314

Patch Name Document column
in Names Window 307, 308

Patch Name Documents
current 306, 309
editing 311
missing 309
where to find 308
468
Patch Name Editor
Cntls 315
GM Equiv 315
MIDI column 314
Notes 315
number column 314
opening Control Names window 320
opening Note Names window 320
Patch Name column 314
Program Selector Dot 315

Patch Name Provider 306
Patch names

see also Names Window
about 12
bank definition 305
bank select 319
Browser Window 321
Change 324
default control names 320
default note names 320
document 306
Don’t Make 324
Don’t Send 324
editing 313
Factory/General MIDI names 311
Go Back 324
grouping 321
Keep 324
Make Current 323
Mode 306, 307
mode examples 306
Name Setup 306
patch definition 305
Send 324
subscribing 311
terminology 305

Patch popup
Tracks window
patch popup 55

Patches menu
Add Bank 318
Add Mode 317
Opcode Systems, Inc.
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Bank Select/Numbering 319
Clear Name List 317
Copy Name List 316
Default Modes 318
Mode Name 318
Paste Name List 317
Remove Bank 318
Remove Mode 317
Save 316
Save As 316
Saving Note/Control Names 316

Pause button 188
PC (program change) 264
PC PC 264
Pencil tool 37

click-dragging with 39
in Notation Window 38
in Pulse Window 227
in Strip Chart 243
inserting notes with 37
painting notes with 39

Phase Invert events
in Strip Chart 255
inserting in List Window 267

Phrase 62
Phrases mode, Track Overview 214
Pickup measures 212
Pitch (Select & Modify) 122
Pitch Bend

in Strip Chart 252
inserting in List Window 265

Play Edited Note
Graphic window menu 239
List window menu 273
Notation window menu 283
Pulse window menu 232

Play from Counter button 188
Play from Selection command 423
Play from Start button 187
Play Quantize 72

Drum Note lines vs. drum tracks 225
enabling 56, 72
Opcode Manual Template
settings 55
settings for sequence events 98

Play Selection command 423
Play Shift 73

enabling 56, 73
Player

in Input Map window 326
Players 113

and sequence events 97
and Sync mode 114
and Trigger modes 114
stopping 114

Players & Queue Window 113
Playing

from selection 423
Play from Counter button 188
Play from Start button 187
selection 423
with the Command key 26

Plug-in Bypass events
in Strip Chart 255
inserting in List Window 267

Plug-in Parameter submenu
in List Window 268
in Strip Chart 256

Plug-Ins
in Console Window menu 357

Poly aftertouch
in Strip Chart 253
inserting in List Window 266

Pop-up fields, selecting from 27
Position (Select & Modify) 122
Position in bar (Select & Modify) 122
Position in beat (Select & Modify) 122
Position in every group (Select & Modify) 122
Position is between bracketed events (Select &

Modify) 122
Prefix

in Bank Select/Numbering 319
PreRoll (in MMC window) 378
Preserve options

in Substitute window 420
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Previous Marker button 188
Print command 404
Print Preview

adding text to a page 288
Barline thru System 287
bars per line 286
changing font 288
Current Page 287
margins 286
Number of Pages 287
Show Bar Numbers 287
Show Page Numbers 287
staff indentation 286
staff spacing 286
System Spacing 286
systems per page 287
Title Font 287
title space 285
Units of Measurements 287

Print Preview command 404
Print Preview Window 285

opening 404
Printing

page properties 285
Program Selector Dot

in Patch Name Editor 315
Pulse window 221

see also drum note lines
see also drum tracks
adding a new drum track 230
divider 222
editing velocities 229
info area 222
inserting notes in drum track 40
Magic Drumstick tool 227
nudge 229
opening multiple 230
Quantize settings 224
similarities with Tracks window 221
Strip Chart 222
velocities of inserted notes 227
velocity toggle 228
470
viewing velocities 228
Pulse window menu 230

Absolute SMPTE 231
Auto Scroll 231
Bar/Beat/Unit 231
Jump to Selection 231
New Drum Track 223
Play Edited Note 232
Relative SMPTE 231
Set Default Location 231
Show Offset Info 232
Show Vertical Line 232
Tools 231
Zoom Back 231
Zoom to Fit 231

Punch controls 194
Punch Points follow Edit Points

in Settings>Editing 333
Punch recording 34
Punch toggle 194

Q

Quantize 418
about 69
applying 70
command 74
duration and velocity (Groove) 133
durations 132
enabling Record Quatize 428
experimenting with 76
for Input Effect 116
Grid parameters 130
Groove (example) 75
Groove parameters 133
Groove source 133
parameters 129
Play Quantize 72
Quantize Type pop-up 130
Quantize Value pop-up 75
Record Quantize 76
Record Quantize Source 335
sensitivity 130
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shift 132
shortcuts with Quantize Value pop-up 75
smear 132
strength 130
swing 132
templates 163
value 130
while recording 428
with Grid 69
with Groove 70

Quantize (Select & Modify) 124, 129
Quantize command 74, 421
Quantize Value pop-up 75
Queue mode 113
QuickTime Movie Window 385

anatomy of 387
size of window 391

QuickTime Movie Window Anatomy 387
QuickTime Movie window menu 389

Lock to Timing 389
Mute QuickTime Audio 389
Show SMPTE Counter 390
Show SMPTE Offset 390
Window Size 391

QuickTime movies
exporting 403
importing 385
referencing in Vision 385
scoring with General MIDI module 394
setting SMPTE frame rates 391
SMPTE offsets 392
using (tutorial) 393

Quit command 404

R

Random shape
in Strip Chart 247

Range
in Input Map window 325
Instruments window 298
Tempo Fader 345

Rcv
Opcode Manual Template
in Faders Window 345
Real Time Capture command 438
Real-Time

Aftertouch Sets Effect Velocity 335
Audio edits occur... 335
Maximum Playable Tracks 336
Record Quantize Source 335
Silent when Paused 334
Solo Audio and MIDI independently 335
Sustain Audio Across Segments 335
Sustain Notes across Segments 334
System Exclusive Thru 335

rearranging
audio plug-in order 372
Console Strips 371
drum note lines 225
Instruments in Instruments window 22
lines in Pulse window 22
sequences in sequence window 22
tracks in tracks window 22

Reassign (Select & Modify) 124, 127
Reassign command 127, 418
Rec Tracks (Track Enable Buttons)

in MMC window 378
Recalling patch selections 88
Receive sync device 434
Receive sync mode 434
Reclock command 422
Reclock dialog 143
Record

button in sequence info area 97
record-enable track 54

Record button 187
Record Filter dialog 429
Record Indicator button 183
Record Mode 31

pop-up 183
Record mode

Enabled (in MMC window) 379
Rehearse (in MMC window) 380
Safe (in MMC window) 380

Record Monitor Window 444
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Record Quantize 76
Record Quantize Enabled command 428
Record Quantize Source

in Real-Time 335
Record setup 31
Recording

advanced techniques 45
Begin Record toggle 32
choosing what to record 429
enabling neighboring tracks 416
from an external sequencer 47
in real time 33
in step time 42
In/Out Point fields 195
into a single-track sequence event 97
key equivalents 31
loop recording 35
multi-channel (example) 48
multiple channels from Input Map 329
on multiple channels 46
punch recording 34
Record button 187
Record Mode pop-up 183
record modes 31
Step Window 337
stop at punch out 438
tempo changes 137
Undo command and editing 406
viewing received MIDI 183
while in external sync 149
with an Input Map 47
with Input Effect 117
with metronome 32
with quantize 76, 428

Redo command 405
References for sequences and segments 100
Refining selection 120
Rehearse (record mode) 380
Relative SMPTE

Graphic window menu 238
List window menu 272
Notation window menu 282
472
Pulse window menu 231
release velocities in List Window 273
Remap all matching channels

in Undefined Channels 431
Remapping undefined channels 431
Remember remappings to reapply later

in Undefined Channels 431
Remember these settings in sequence files

in Sync Options 436
Remote Device

Show Selected Fader Info 358
Remote Device Channel (Chan)

Show Selected Fader Info 358
Remote start 434
Remove Bank

in Patches menu 318
Remove Line

Input Map window menu 328
Remove Line from Instrument

Instruments window menu 300
Remove Mode

in Patches menu 317
Re-ordering columns 23
Re-ordering simultaneous events (in List win-

dow) 274
Repeat Paste command 410
Repeated notes

with Input Effect 115
Replace (record mode) 31
Replace each event...

in Substitute window 419
Reset Debug Logs

in MMC window 378
Reset MMC System

in MMC Window menu 380
resizing

columns 23
Strip Chart 258

Reverse Time command 422
Revert command 402
Rubato performances

editing 144
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reclocking 144
Ruler

edit indicators 59
in edit windows 59
loop indicators 59
scaling time in 141
selecting in Track Overview 217
zooming in the 25

Run MIDI in background
in OMS MIDI Setup 430

S

Safe (record mode) 380
Save

in Patches menu 316
Save a Copy As command 401
Save As

in Patches menu 316
Save As command 400
Save as Setup command 401
Save command 400
Save Console Layout 365

in Console Window menu 365
Save Console Layout As

in Console Window menu 366
Save Settings

Select & Modify Window menu 125
Save Settings As

Select & Modify Window menu 125
Saving

a mixer snapshot 89
Console Layouts 365
patch events 88
Save a Copy As 401
Save As 400
Save As Setup 401
volume and pan settings 89
What to Save 400

Sawtooth shape
in Strip Chart 247

Scale
in Strip Chart 244
Opcode Manual Template
Scale by (Select & Modify) 126
Scale Time command 422
Scale Time dialog 140
Scaling tempos 139
Scaling time

in the Ruler 141
to fit audio loops 141

Scrolling
with hand cursor 25

Scrubbing
with the mouse 26
with the Shuttle bar 188

Segments
about 93
Automatically Remove Unused Segments

93
differences from sequences 93
looping in the middle of a track 95
looping track regions 95
making 86, 94
references 100
resizing graphically 96

Select 5
Select & Modify

Add 126
attribute conditions 122
attribute types 122
Auto Map 135
Change Duration 124
Change Release Velocity 124
Change Value 124
Change Velocity 124
Changing 126
Chromatic 134
Compress 126
Constant 126
Constrain to Scale 134
Delete 125
Diatonic 134
Double button 124, 125
Drum Map 136
Duration 122
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Event Type 122
Harmonize button 124
Instrument 122
Interval 134
Invert 135
is 122
is from... thru 122
is not 122
is not from... thru 122
is... or 122
is... or less 122
is... or more 122
Key/Scale 135
making a selection 123
Manual Map 136
Max Limit to 126
Min Limit to 126
modify types 124
Move 124
Octave Map 135
Octaves 134
Oscillating 127
Pitch 122
Position 122
Quantize 124, 129
Reassign 124, 127
Scale by 126
select attributes 121
Set Density 124, 127
Set Instrument 125
Set Legato to 126
Set to 126
Substitute 125
templates 165
Transpose 124, 134
Trim Start Time 125, 129
Value 122
Velocity 122

Select & Modify Window 119
anatomy of 120
buttons 121
Event Type pop-up 120
474
Modify Type pop-up 120
Select & Modify Window menu 125

Delete Template 125
Load From 125
Save Settings 125
Save Settings As 125
Templates 125

Select All command 424
Select attributes 121
Select by Rule command 423
Select Duplicates command 425
Select Unused Instruments

Instruments window menu 301
Select/Modify Templates command 421
Selected Tracks’ Instruments

building Console from 364
Selecting

a pitch range 65
a time range 64
all 424
another sequence 19
another track 19
by rule 423
complex selections 123
data regions 63
duplicates 425
multiple drum note lines 65
multiple tracks 65
names 321
notes in Graphic Window 234
playing only the current selection 423
sequences 198
split notes 424
tracks 205
tracks in Notation Window 275
unused Instruments 301
with Add To 120
with I-beam tool 64
with Marquee tool 63
with Refine 120

Selector dots 22
Send
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in Faders Window 345
Patch names 324

Send Level events
in Strip Chart 254
inserting in List Window 267

Send Patches to Device 313
Send Sync Enabled command 437
Send the patches 312
Sending sync 151
Separate Multi Track command 413

example 49
with Drum Note lines 225

Seq button 184
Sequence

in Input Map window 326
Sequence columns

re-ordering 23
resizing 23

Sequence events 104
about 96
and players 97
cloning 411
in List Window 103
inserting in List Window 103, 270
Local Sequence Times 100, 439
muting 97
nested 101
parameters 96
parent-child relationship 98
recording into single-track 97
resizing graphically 96
step recording 85
sync mode 98
transposing 97
types 103

Sequence information 54
SMPTE Offset 54
Start Point 54
Sync Mode 54

Sequence Length 53
Sequence Loop 53
Sequence Select pop-up 19
Opcode Manual Template
Sequence templates 161
Sequence/segment pop-up 97
Sequences

about 13
and pickup measures 212
breaking into segments 86
capturing 414
capturing in real time 438
chaining 85
controls for 53
Current Sequence pop-up 184
duplicating 200
key equivalents 198
locking length 206
looping 207
MIDIKeys for 199
naming 198
pasting 408
references 100, 199
re-ordering with move cursor 22
selecting 198
selector dots 22
SMPTE offset 54, 212
Start Point 212
step recording as sequence events 85
switching the current sequence 19
Sync Mode 212
templates 161
triggering from Input Map 326
triggering in real time 113

Sequences Window 197
column descriptions 198
comments 199
opening with Seq button 184
references 100, 199
Segments section 197
Sequences section 197
setting default location 201
Templates section 197

Sequences Window menu 200
Set Default Location

Graphic window menu 238
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List window menu 272
Notation window menu 282
Pulse window menu 231

Set Density (Select & Modify) 124, 127
Set In Point button 195
Set Insertion Point to End of Paste Region

in Settings>Editing 333
Set Instrument (Select & Modify) 125
Set Instrument command 418
Set Legato to (Select & Modify) 126
Set Out Point button 195
Set to (Select & Modify) 126
Settings Window

Appearance 336
see also Appearance
Controllers 336
see also Controllers
Editing 333
see also Editing
Insert Note 331
see also Insert Note
Real-Time 334
see also Real-Time
Strip Chart & Nudge 332
see also Strip Chart & Nudge

Setup file 155
Setups menu 427

Auto Remappings 432
Colors 432
Commands 432
Enable Input Devices 429
Fader Remotes Enabled 428
Input Effect Enabled 428
Input Map Enabled 428
Keyboard Thru 427
MIDIKeys Enabled 428
OMS MIDI Setup 430
OMS Studio Setup 430
Record Filter 429
Record Quantize Enabled 428
Thru in Background 427
Undefined Channels 431

Shift
476
permanently shifting track data 77
Play Shift 73

Show 220
Note Grid 221
offset info in Tracks Window 220
Track Overview 204
use of selected Instruments 301

Show All Fader Info
in Console Window menu 359

Show Bar Numbers 287
Show Channels 310, 313

editing device mode when off 311
editing device mode when on 310

Show Event Durations
List window menu 273

Show Event End Times
List window menu 273

Show Masking Tape 361
Show Offset Info

Pulse window menu 232
Show Page Numbers 287
Show Patches In All Selected Group(s)

in Names browser menu 323
Show Patches In Any Selected Group(s)

in Names browser menu 323
Show Piano Keyboard 239
Show Release Velocities

List window menu 273
Show Remote Devices

in Console Window menu 360
Show Selected Fader Info 360

Controller 358
in Console Window menu 357
Instrument 358
Remote Device 358
Remote Device Channel (Chan) 358
Value (fader value) 358

Show SMPTE Counter
in QuickTime Movie window menu 390

Show SMPTE Offset
in QuickTime Movie window menu 390

Show Use of Selected Instruments
Opcode Systems, Inc.
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Instruments window menu 301
Show Vertical Line

Graphic window menu 239
Notation window menu 283
Pulse window menu 232

Shuttle bar 188
Silent when Paused

in Real-Time 334
Sine shape

in Strip Chart 247
Slaving to external sync device 147
SMPTE

frame rates 150
frames and bits 192
offset 150
time code, viewing in Counter 191

SMPTE cursor display 215
SMPTE Offset

for QuickTime movies 392
for sequences 54, 212

Snapshot of Faders 407
Solo

inserted with Copy Faders command 347
Solo Audio and MIDI independently

in Real-Time 335
Solo column 55
Solo events

in Strip Chart 254
inserting in List Window 267

soloed instruments
finding 303
unsoloing 303

Soloing
Instruments 294
tracks 55, 206
tracks vs. instruments 295, 302

Song Track 99, 262
Sort By Name

in Names browser menu 323
Sort by Number

in Names browser menu 323
sound effects track
Opcode Manual Template
using Lock Event SMPTE Times 263
Spacing

in Insert Note 331
Special MIDIKeys 172
Split Notes command 424
Splits

with custom Instruments 178
with Input Map 329

Square shape
in Strip Chart 247

Staff Indentation 286
Staff Spacing 286
Standard MIDI files 399
Start

sequence information 54
Start/End

in Make Segment/Loop 415
Step Overdub (record mode) 31
Step recording 42

Changing Spacing Size 44
Deleting Notes 43
Entering Chords 43
Entering Patch Events 43
Entering Rests 43
Sequence Events 43
sequence events 85
Step Window 337
Sustaining Individual Notes 43
tips 43

Step Replace (record mode) 31
Step Window 337

Duration settings 339
Spacing settings 337
Spacing, changing with keystrokes 338
tuplets 338
Velocity settings 341

Stop at Punch Out command 438
Stop Sequence 104
Straight shape

in Strip Chart 246
Strip Chart

about 241
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Add Amount 244
Aftertouch 253
Audio Pan 254
Audio Volume 254
Automation submenu 254
Compress tool 245
Contents pop-up 242
Controllers 253
Copyright 251
Cue Points 252
Density setting 256
drawing fade outs 246
Duration 249
Edit Shapes pop-up 246
editing velocities 61
EQ Band Enable 255
EQ Band Frequency 255
EQ Band Gain 255
EQ Band Parameter submenu 255
EQ Band Type 255
EQ Band Width 255
EQ Enable 255
event types 241
Flat shape 247
for multiple tracks 257
Free shape 246
I-beam tool 243
in Tracks Window 205
Instruments 251
Lyrics 251
Markers 250
Max Limit tool 244
MIDI submenu 252
Min Limit tool 244
modifying events 243
Mute events 254
Non-Continuous Events 248
opening 242
Oscillator shapes 247
Oscillator shapes & Waveform Period 248
Parabola shape 246
patch events 251
478
Pencil tool 243
Phase Invert 255
Pitch Bend 252
Plug-in Parameter submenu 256
Poly aftertouch 253
Random shape 247
resizing 258
Sawtooth shape 247
Scale 244
Send Levels 254
Sine shape 247
Solo events 254
Square shape 247
Straight shape 246
tempo events 250
Text 251
Text-type submenu 251
Thin tool 245
tools 243
Triangle shape 247
uses 249
Variable pop-up 243
Velocity 249
Velocity Scale 253
zooming 258

Strip Chart & Nudge
Density 332
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